2011-10-10
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Introduction to the EPM Add-in.</td>
<td>13</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Installation and Update</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>2.1 Installation</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>2.2 Update</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>2.3 Re-activating the EPM Add-In</td>
<td>16</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Log On and Connections</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>3.1 Log On and Log Off</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>3.2 Connection Management</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>3.3 Active Connection for the Current Sheet</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>3.4 Types of Connections</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>3.5 Selecting Connections</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>3.6 Selectively connecting or disconnecting one sheet/connection couples</td>
<td>21</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>About the EPM add-in Interface</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>4.1 Main Interface Areas</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>4.2 Perform Actions without the Mouse</td>
<td>24</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Features Available</td>
<td>25</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Security on Data or Members</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>6.1 Security on Data (Planning and Consolidation, version for SAP NetWeaver)</td>
<td>27</td>
</tr>
<tr>
<td>Chapter 7</td>
<td>Open and Save a File</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>7.1 Open a Report when Dimensions or Members have Changed</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>7.2 Open a File from a Web Portal</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>7.3 Open and Save a File for Planning and Consolidation</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>7.3.1 Open and Save Connection</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>7.3.2 Open Actions</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>7.3.3 Save Actions</td>
<td>32</td>
</tr>
</tbody>
</table>
### Chapter 7.3.4
Open and Save Dialog Box Description and Actions ............................................................. 34
Server Folder Structure .......................................................................................................... 34

### Chapter 8

#### 8.1
Context Display Options ........................................................................................................ 36

### Chapter 9

#### 9.1
Report Layout Rules .............................................................................................................. 37
Overall Layout Rules ............................................................................................................. 37
Basic Layout Rules.................................................................................................................. 38
Dimension Layout Restrictions .............................................................................................. 39
Page Axis ................................................................................................................................ 40
Row Axis .................................................................................................................................. 40
Simple Row Axis ..................................................................................................................... 41
Multidimensional or Nested Row Axis .................................................................................... 41
Asymmetric Row Axis ............................................................................................................ 43
Row Axis Restrictions ............................................................................................................ 44
Column Axis ........................................................................................................................... 45
Simple Column Axis ............................................................................................................... 46
Multidimensional or Nested Column Axis .............................................................................. 46
Asymmetric Column Axis ....................................................................................................... 47
Column Axis Restrictions ...................................................................................................... 48
Data Grid Considerations ...................................................................................................... 48

#### 9.2
Row Axis .................................................................................................................................. 40

#### 9.3
Simple Row Axis ..................................................................................................................... 41
Multidimensional or Nested Row Axis .................................................................................... 41
Asymmetric Row Axis ............................................................................................................ 43
Row Axis Restrictions ............................................................................................................ 44

#### 9.4
Column Axis ........................................................................................................................... 45
Simple Column Axis ............................................................................................................... 46
Multidimensional or Nested Column Axis .............................................................................. 46
Asymmetric Column Axis ....................................................................................................... 47
Column Axis Restrictions ...................................................................................................... 48

#### 9.5
Data Grid Considerations ...................................................................................................... 48

### Chapter 10

#### 10.1
Member Identification and Properties ..................................................................................... 51
Member Identification ............................................................................................................. 51
Member Properties ................................................................................................................ 52
Report Creation using the EPM Pane ..................................................................................... 52
Report Creation using the Report Editor ................................................................................. 54
Report Editor's Layout Tab Presentation .................................................................................. 55
Dimension Placement in the Report Editor ............................................................................ 56
Member Selection in the Report Editor ................................................................................... 57
Position of each Dimension in the Page Axis using the Report Editor .............................. 57
Report Move in the Sheet using the Report Editor ............................................................... 58
Shift Insertion Between the Data Grid of the Report and its Row and Column Axis ........ 58
Report Creation Directly in a Sheet ....................................................................................... 59
Member Recognition .............................................................................................................. 59

#### 10.2
Member Entry Using the Member Selector ............................................................................ 63

#### 10.3
Member Entry Using the Insert Members Dialog Box ......................................................... 71
<p>| Chapter 10.5 | Report Creation using Copy/Paste ........................................................................................72 |
| Chapter 11 | Asymmetric Report Creation ................................................................................................73 |
| Chapter 12 | Ownership-based Hierarchies ...............................................................................................75 |
| Chapter 13 | Actions and Options Specific to the Current Report.............................................................77 |
| 13.1 | Report Options.........................................................................................................................77 |
| 13.1.1 | Freeze Data Refresh ................................................................................................................78 |
| 13.1.2 | Display only Base Level Data................................................................................................78 |
| 13.1.3 | Do not Store Connection and Do not Store Environment in the Connection .........................78 |
| 13.2 | Data Sorting, Ranking and Filtering ..................................................................................79 |
| 13.2.1 | Data Sorting .........................................................................................................................79 |
| 13.2.2 | Data Filtering .......................................................................................................................81 |
| 13.2.3 | Data Ranking .........................................................................................................................83 |
| 13.3 | Read-only Data .....................................................................................................................84 |
| 13.4 | Local Members ......................................................................................................................84 |
| 13.4.1 | Local Member Automatically Detected ..............................................................................85 |
| 13.4.2 | Local Member Creation ......................................................................................................87 |
| 13.5 | Renaming Members .............................................................................................................88 |
| 13.6 | Excluding Members ............................................................................................................89 |
| 13.7 | Member Insertion Filtering ..................................................................................................90 |
| Chapter 14 | Several Reports in a Sheet ....................................................................................................91 |
| 14.1 | Restrictions when Several Reports in a Sheet .....................................................................92 |
| 14.2 | Report Highlight ..................................................................................................................92 |
| 14.3 | Delete Reports .....................................................................................................................93 |
| Chapter 15 | Report Refresh ..............................................................95 |
| 15.1 | Refreshing Reports .............................................................................................................96 |
| Chapter 16 | User Options .....................................................................................................................97 |
| Chapter 17 | Sheet Options ....................................................................................................................99 |
| 17.1 | General Sheet Options .......................................................................................................99 |
| 17.1.1 | Expand Options ..................................................................................................................99 |
| 17.1.2 | Use as Input Form ..............................................................................................................100 |
| 17.1.3 | Member Recognition Activation ......................................................................................100 |
| 17.1.4 | EPM Worksheet ...............................................................................................................100 |</p>
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.1.5</td>
<td>Totals Placement</td>
</tr>
<tr>
<td>17.1.6</td>
<td>Empty Row and Column Behavior</td>
</tr>
<tr>
<td>17.1.7</td>
<td>Show as Microsoft Excel Comments</td>
</tr>
<tr>
<td>17.2</td>
<td>Formatting Sheet Options</td>
</tr>
<tr>
<td>17.2.1</td>
<td>Row Header Indentation</td>
</tr>
<tr>
<td>17.2.2</td>
<td>Display Name</td>
</tr>
<tr>
<td>17.2.3</td>
<td>Auto Fit Column Width</td>
</tr>
<tr>
<td>17.2.4</td>
<td>Repeat Row Headers and Repeat Column Headers</td>
</tr>
<tr>
<td>17.2.5</td>
<td>Empty Cell Default Value</td>
</tr>
<tr>
<td>17.2.6</td>
<td>Apply Dynamic Formatting</td>
</tr>
<tr>
<td>17.3</td>
<td>Refresh Sheet Options</td>
</tr>
<tr>
<td>17.3.1</td>
<td>Keep Formula on Data and Show Source Data in Comments</td>
</tr>
<tr>
<td>17.3.2</td>
<td>Calculate Parents in Hierarchies</td>
</tr>
<tr>
<td>17.3.3</td>
<td>Refresh Data on the Whole File when Opening it</td>
</tr>
<tr>
<td>17.3.4</td>
<td>Clear Data on the Whole File when Saving it</td>
</tr>
<tr>
<td>17.3.5</td>
<td>Show Unauthorized Cell Text</td>
</tr>
</tbody>
</table>

Chapter 18

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.1</td>
<td>Report Navigation</td>
</tr>
<tr>
<td>18.2</td>
<td>Going Back in the Navigation Actions</td>
</tr>
<tr>
<td>18.3</td>
<td>Row and Column Axes Switch</td>
</tr>
<tr>
<td>18.3.1</td>
<td>Expand on Nested Axis</td>
</tr>
<tr>
<td>18.4</td>
<td>Collapse on Nested Axis</td>
</tr>
<tr>
<td>18.5</td>
<td>Keep Member</td>
</tr>
<tr>
<td>18.6</td>
<td>Exclude Member</td>
</tr>
<tr>
<td>18.7</td>
<td>Double-Click Actions</td>
</tr>
</tbody>
</table>

Chapter 19

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.1</td>
<td>Drill-Through</td>
</tr>
</tbody>
</table>

Chapter 20

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.1</td>
<td>Quick Links</td>
</tr>
<tr>
<td>20.2</td>
<td>Creating Quick Links</td>
</tr>
<tr>
<td>20.3</td>
<td>Deleting Quick Links</td>
</tr>
</tbody>
</table>

Chapter 21

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>21.1</td>
<td>Custom Members</td>
</tr>
<tr>
<td>21.2</td>
<td>Creating custom members</td>
</tr>
<tr>
<td>21.3</td>
<td>Custom Members Order</td>
</tr>
<tr>
<td>21.4</td>
<td>Modifying Custom Members</td>
</tr>
<tr>
<td>21.5</td>
<td>Enabling or Disabling all the Custom Members Defined for a Sheet/Connection</td>
</tr>
<tr>
<td>21.6</td>
<td>Deleting Custom Members</td>
</tr>
</tbody>
</table>
## Chapter 29

### EPM Functions

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>29.1</td>
<td>EPMUser</td>
<td>188</td>
</tr>
<tr>
<td>29.2</td>
<td>EPMSServer</td>
<td>188</td>
</tr>
<tr>
<td>29.3</td>
<td>EPMEnvDatabaseDesc</td>
<td>189</td>
</tr>
<tr>
<td>29.4</td>
<td>EPMEnvDatabaseID</td>
<td>189</td>
</tr>
<tr>
<td>29.5</td>
<td>EPMModelCubeID</td>
<td>189</td>
</tr>
<tr>
<td>29.6</td>
<td>EPMModelCubeDesc</td>
<td>190</td>
</tr>
<tr>
<td>29.7</td>
<td>Functions on Reports</td>
<td>190</td>
</tr>
<tr>
<td>29.7.1</td>
<td>EPMDimensionOverride</td>
<td>190</td>
</tr>
<tr>
<td>29.7.2</td>
<td>EPMAxisOverride</td>
<td>193</td>
</tr>
<tr>
<td>29.7.3</td>
<td>EPMCopyRange</td>
<td>194</td>
</tr>
<tr>
<td>29.7.4</td>
<td>EPMInsertCellsBeforeAfterBlock</td>
<td>194</td>
</tr>
<tr>
<td>29.7.5</td>
<td>EPMMemberID</td>
<td>195</td>
</tr>
<tr>
<td>29.7.6</td>
<td>EPMReportOptions</td>
<td>195</td>
</tr>
<tr>
<td>29.7.7</td>
<td>EPMMemberSortingOverride</td>
<td>197</td>
</tr>
<tr>
<td>29.8</td>
<td>EPMReportID</td>
<td>198</td>
</tr>
<tr>
<td>29.9</td>
<td>EPMFullContext</td>
<td>199</td>
</tr>
<tr>
<td>29.10</td>
<td>EPMContextMember</td>
<td>199</td>
</tr>
<tr>
<td>29.11</td>
<td>EPMDimensionProperty</td>
<td>200</td>
</tr>
<tr>
<td>29.12</td>
<td>EPMMemberDesc</td>
<td>200</td>
</tr>
<tr>
<td>29.13</td>
<td>EPMMemberProperty</td>
<td>201</td>
</tr>
<tr>
<td>29.14</td>
<td>EPMMemberOffset</td>
<td>201</td>
</tr>
<tr>
<td>29.15</td>
<td>EPMSelectMember</td>
<td>202</td>
</tr>
<tr>
<td>29.16</td>
<td>EPMCellRanges</td>
<td>202</td>
</tr>
<tr>
<td>29.17</td>
<td>EPMRefreshTime</td>
<td>203</td>
</tr>
<tr>
<td>29.18</td>
<td>EPMScaleData</td>
<td>203</td>
</tr>
<tr>
<td>29.19</td>
<td>EPMRetrieveData</td>
<td>204</td>
</tr>
<tr>
<td>29.20</td>
<td>EPMDimensionList</td>
<td>204</td>
</tr>
<tr>
<td>29.21</td>
<td>EPMSaveComment</td>
<td>205</td>
</tr>
<tr>
<td>29.22</td>
<td>EPMSaveData</td>
<td>205</td>
</tr>
<tr>
<td>29.23</td>
<td>EPMWorkStatus</td>
<td>206</td>
</tr>
<tr>
<td>29.24</td>
<td>EPMComparison</td>
<td>206</td>
</tr>
<tr>
<td>29.25</td>
<td>EPMDimensionType</td>
<td>207</td>
</tr>
<tr>
<td>29.26</td>
<td>EPMCommentFullContext</td>
<td>208</td>
</tr>
<tr>
<td>29.27</td>
<td>EPMCommentPartialContext</td>
<td>208</td>
</tr>
<tr>
<td>29.28</td>
<td>EPMURL</td>
<td>209</td>
</tr>
<tr>
<td>29.29</td>
<td>EPMBook</td>
<td>211</td>
</tr>
<tr>
<td>29.30</td>
<td>EPMLink</td>
<td>212</td>
</tr>
</tbody>
</table>
Chapter 30

Data Input and Save

30.1 Data Input
30.2 Planning Features
30.2.1 Spread
30.2.2 Trend
30.2.3 Weight
30.3 Comments
30.3.1 Comment Creation and Modification
30.3.2 Comment Display in a Cell
30.3.3 Comment Search
30.4 Data Save
30.5 Data Validation
30.6 Work Status

Chapter 31

Accessing Journals

Chapter 32

Business Process Flows

Chapter 33

Report and Input Form Templates

Chapter 34

Other Features

34.1 Metadata Cache
34.2 Log File
34.3 Information on Cubes
34.4 MDX Display

Chapter 35

EPM Add-in for Microsoft Office Word and PowerPoint

35.1 Common Features to the Add-in for Microsoft Office Excel, Word and PowerPoint
35.2 Additional Features in the Add-in for Microsoft Office Word and PowerPoint
35.3 Options in the Add-in for Microsoft Office Word and PowerPoint

Chapter 36

Data Manager

36.1 About Data Manager
36.1.1 About Data Manager
36.2 Standard Packages
Introduction to the EPM Add-in

The EPM add-in is an add-in to Microsoft Office Excel, Microsoft Office Word and Microsoft Office PowerPoint.

The EPM add-in enables you to analyze data. The EPM add-in is designed to give access to SAP Business Objects EPM Solutions’ product data, transforming that data in real time into a form which supports reporting, and providing reporting and delivery tools. The add-in also permits analysis of data from several EPM solutions at the same time.

The EPM add-in enables you to analyze the data of the OLAP data sources below:
- SSAS cubes created with SAP BusinessObjects Financial Consolidation, cube designer.
- SAP NetWeaver BW InfoCubes created with SAP BusinessObjects Financial Consolidation, cube designer.
- SAP BusinessObjects Profitability and Cost Management models.
- SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver, models
- SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform, models.

The EPM add-in also enables you to enter data on SAP BusinessObjects Planning and Consolidation models, provided that you use the appropriate connection. For more information on connections, see Types of Connections.

Note:
Depending on the connection you use, some EPM features are not supported and therefore the commands are automatically hidden or greyed out.

You can use the EPM add-in on any other non-EPM SSAS cubes and SAP Business Warehouse InfoCubes.

When working on a Planning and Consolidation connection, the Data Manager tab is added to the Microsoft Office Excel ribbon. The Data Manager is a Planning and Consolidation module that helps you move data into the system, copy or move data within and across applications, and export data from an application for use in an external tool. In addition, the Data Manager supports mapping and complex transformations of data. The Data Manager also allows you to export transactional and master data from an application within Planning and Consolidation to a file that you can use in an external tool. For more information, see the Data Manager section.
Installation and Update

You can install the EPM add-in in two ways.

If using a Planning and Consolidation connection, once the EPM add-in is installed on your local machine, you can install the updates.

2.1 Installation

There are two ways of installing the EPM add-in for Microsoft Office.

- Launch the setup.
- Download the EPM add-in from the SAP BusinessObjects Enterprise BI launch pad. Once you are logged to the BI launch pad, launch the installation in the Preferences area.

  **Note:**
  When the EPM add-in is not installed and you try to open an existing EPM workbook or to create a new one, a popup appears, indicating that the application is not installed. When you click OK, another dialog box opens, offering to install the application by clicking the Install the EPM add-in for Microsoft Office button.

- Download the EPM add-in from the SAP BusinessObjects Planning and Consolidation web client. Once you are logged on to Planning and Consolidation, select Install EPM add-in for Microsoft Office.

  The add-in is automatically loaded when you open Microsoft Office Excel, Microsoft Office Word or Microsoft Office PowerPoint.

  To find out more about hardware and software prerequisites for installing EPM add-in, refer to the SAP BusinessObjects EPM Solutions, add-in for Microsoft Office Installation guide.

2.2 Update

**Applies to:**
SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver and SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform.
Once the EPM add-in is installed, you can install the updates, depending on the update policy defined on the server side.

- You can ask to be notified whenever an update is available, select the **Notify me when updates are available** option in the User Options. When connecting to a Planning and Consolidation server, a message will pop-up every time an update is available, asking you whether you want to want to install it now or later.

**Note:**

- If you do not want to be notified again for updates, you can either click the **Do not show this message again** option in the message box that pops up or deselect the **Notify me when updates are available** option in the User Options. These two options are synchronized, meaning that when the first one in the message box is checked, the user option is automatically unchecked.
- The **Notify me when updates are available** option is effective and the **Do not show this message again** option is displayed only for updates that are defined as "user update" on the server side. For updates that are defined as "auto update" on the server side, without specifying anything on your side, when connecting to a Planning and Consolidation server, a message will pop-up every time an update is available, asking you whether you want to install it now or later.
- When updates are mandatory, (defined as "force update" on the server side), a message will pop up on your local machine, prompting you to install the update. If you do not install the update, you will not be able to use the EPM add-in.
- You can always check yourself if updates are available or not. To do so, when using a connection to a Planning and Consolidation server, select **EPM > About > Check for Updates**.

**Related Topics**

- **User Options**

### 2.3 Re-activating the EPM Add-In

If the EPM add-in has been deactivated, you can re-activate it.

1. In Microsoft Office Excel 2007, click the **Office** button, then click the **Excel Options** button.
2. In the **Excel Options** dialog box, select **Add-Ins**.
3. Select **Disabled Items** from the **Manage** drop-down menu and click the **Go** button.
4. In the **Disabled Items** dialog box, select the SAP BusinessObjects EPM Solutions, add-in for Microsoft Office and click the **Enable** button.
5. Click the **Close** button.
Log On and Connections

To access a specific cube or model with the EPM add-in, you need to use a connection. A connection establishes a connection between a specific data source and a report. The connections are managed in the Connection Manager dialog box.

3.1 Log On and Log Off

Logging on enables you to establish a first connection between all the workbooks (for one Excel instance) and a cube or model.

To log on, select EPM > Log On. Once you are connected to a data source, the Log On ribbon button is hidden and the Log Off button is displayed.

When you log on, you select a first connection for the workbooks. The Logon dialog box proposes the default connection, if you have defined one, or is left blank and you need to click the ellipsis button and select a connection in the Connection Manager that opens. The connection selected is considered as the active connection.

When you open a workbook containing reports and you perform a log on on a specific connection, all the other connections used by the other reports are automatically connected - unless the connection has been deleted for example, and you may have to enter the login and password to the connections. If you open another workbook containing reports, the connections will also be automatically connected.

The log off disconnects all the connections used in the current workbook.

Related Topics
• Active Connection for the Current Sheet

3.2 Connection Management

The connections are managed in the Connection Manager dialog box.
The Connection Manager can be opened by selecting EPM > Report Actions > Manage Connections. This dialog box also opens: when you click Log On, then select the ellipsis button; and when you select Select Another Connection, from the Active Connection drop-down list of the EPM pane.

When you open the Connection Manager, all the connections that you have once selected are displayed, including local connections, provided that the Display Local Connections option is selected. If you want local connections to be always displayed when you open the Connection Manager, select the Display Local Connections option in the User Options.

You perform the following actions in the Connection Manager:

- Select a connection.
- Set a default connection. You can set a connection as the default one. The connection will be proposed by default when you log on. To do so, in the Connection Manager, select a connection in the list and click Set as Default.
- Selectively connect or disconnect one or several sheet/connection couples. For example, when a workbook contains a great number of sheets that you do not want to be connected, you can disconnect several sheets at the same time.
- Edit or delete a connection.
- Duplicate a Planning and Consolidation connection.

Related Topics
- Features Available
- Report Creation
- EPM Functions
- Types of Connections
- Selecting Connections
- Selectively connecting or disconnecting one sheet/connection couples

3.3 Active Connection for the Current Sheet

The active connection is the one that is used when you create a report or enter an EPM function.

When you perform a log on, you select a first connection. This connection is the active connection for all the workbooks. Then, at any time, you can select another connection that will become the active connection for the current sheet.

The active connection is selected in the Active Connection drop-down list of the EPM pane. In this list, the connections that are available are the connections that you have connected since you have opened a Microsoft Office Excel instance. The connection you select in the list is the active connection for the current sheet until you select another one.

Related Topics
- Several Reports in a Sheet
- EPM Functions
3.4 Types of Connections

There are three types of connections: Local, SAP BusinessObjects Enterprise and Planning and Consolidation.

Using a Local or an SAP BusinessObjects Enterprise connection, the EPM add-in enables you to analyze the data of the OLAP data sources below:

• SSAS cubes created with SAP BusinessObjects Financial Consolidation, cube designer.
• SAP NetWeaver BW InfoCubes created with SAP BusinessObjects Financial Consolidation, cube designer (note that only the following objects of the SAP BW ODBO provider are supported: InfoCube, MultiProvider and VirtualProvider).
• SAP BusinessObjects Profitability and Cost Management models.
• SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver, models.
• SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform, models.

Using a Planning and Consolidation connection, the EPM add-in also enables you to enter data on SAP BusinessObjects Planning and Consolidation models.

**Note:**
Administrators create the cubes and models to which you connect your reports. They can modify the structure of the cubes and models at any time.

In the Connection Manager, you can use and select the three types of connection:

• SAP BusinessObjects Enterprise connections. These are connections that are stored on the SAP BusinessObjects Enterprise platform. If you have opened the EPM add-in from the BI launch pad, you can use these connections.
• Local connections. Local connections are .oqy files. These connections can be stored on your machine or another machine on the network.

You can select folders in which your administrator stores the local connections. To do so, click the Local Connection Folder button in the Connection Manager and select the folder in the dialog box that opens. Any connection that will be added afterwards to this folder will be automatically retrieved and you will only need to select the ones you need.

**Note:**

• If the connection has not been created using the EPM add-in, the authentication method has not been defined and a message appears when trying to connect. Using the Connection Manager, you must edit the connection and specify its authentication method.
• When you choose to connect to an SAP NetWeaver BW InfoCube, you need to enter the user name and password to the SAP NetWeaver BW platform, and select your working language.

**Planning and Consolidation connections.**

**Note:**

• To find out more about connections and their authentication method, please refer to the SAP BusinessObjects EPM Solutions, add-in for Microsoft Office Installation guide.
Depending on the connection you use, some features are not supported and therefore the commands are automatically hidden or greyed out.

**Note:**
When connecting to a cube/model, you can clear the cache if you want to load the whole structure and not just the data. Note that the cube/model will take some extra time to load.

**Related Topics**
- Features Available
- Metadata Cache

### 3.5 Selecting Connections

1. Select one of the following:
   a. **EPM > Log On**
   b. From the **Active Connection** drop-down list of the **EPM** pane, select **Select Another Connection**.
   c. **EPM > Report Actions > Manage Connections**.
      
      The **Connection Manager** opens, displaying the list of all the connections that you have once selected, including local connections, provided that the **Display Local Connections** option is selected.

      **Note:**
      - If you want local connections to be always displayed when you open the **Connection Manager**, select the **Display Local Connections** option in the **User Options**.
      - You can select folders in which your administrator stores the local connections. To do so, click the **Local Connection Folder** button in the **Connection Manager** and select the folder in the dialog box that opens. Any connection that will be added afterwards to this folder will be automatically retrieved.

2. To select a connection, simply select it from the list and click **OK**.

3. If the connection you want to use is not in the list, click **Create** and do as follows:
   - To create a Planning and Consolidation connection, select **Planning and Consolidation**, then enter the URL to the Planning and Consolidation server, select the platform version.
   - If you have opened the EPM add-in from the BI launch pad, you can select the **SAP BusinessObjects Enterprise** option. Enter the name you want for the connection, then select an EPM connection in the list, and select the cube or model.

**Note:**
If you have not opened the EPM add-in from the BI launch pad, when you select this type of connection, the list of EPM connections is empty.

- To create a **Planning and Consolidation** or a **Local** connection, refer to the **SAP BusinessObjects EPM Solutions, add-in for Microsoft Office Installation Guide**.
When you choose to connect to an SAP NetWeaver BW InfoCube, you need to enter the user name and password to the SAP NetWeaver BW platform, and select your working language.

**Note:**
To find out more about connections and their authentication method, refer to the *SAP BusinessObjects EPM Solutions, add-in for Microsoft Office Installation Guide*.

### 3.6 Selectively connecting or disconnecting one sheet/connection couples

1. Select one of the following:
   a. **EPM > Log On**
   b. From the **Active Connection** drop-down list of the **EPM** pane, select **Select Another Connection**.
   c. **EPM > Report Actions > Manage Connections**
      The **Connection Manager** opens.

2. Click **Report Connections**.
   The **Report Connections** dialog box opens. All connected sheets in all open workbooks in the current session of Microsoft Office Excel appear in the tree view list displaying cubes/models, sheets and reports.

   **Note:**
   You can choose the way you want to display the sheet/connection couples by clicking the **Display by Sheet** or **Display by Connection** button.

3. You can perform the following actions:
   - To connect or disconnect a specific sheet/connection couple, select or deselect the sheet check box and click **OK**.
   - To connect or disconnect all the sheets linked to a cube/model, select or deselect all the sheet check boxes individually, or select or deselect the cube/model check box and click **OK**.
   - To connect all the sheet/connection couples, click the **Select All** button and then click **OK**.
   - To disconnect all the sheet/connection couples, click the **Unselect All** button and then click **OK**.
   - To change a connection, select the cube/model, the sheet or the report and click the **Change Connection** button.

   **Note:**
   If you connect a report to a different cube or model, the previous cube/model will be disconnected. In other words, one report can only be connected to one cube/model at a time.

If you connect or disconnect a sheet/connection couple, the **EPM Worksheet** option in the **General** tab of the **Sheet Options** is consequently selected or deselected. For more information on this option, see **EPM Worksheet**.
About the EPM add-in Interface

4.1 Main Interface Areas

The EPM add-in for Microsoft Office adds the following areas to Microsoft Office Excel, Microsoft Office Word and Microsoft Office PowerPoint:

- In the ribbon, the EPM tab is the main entry to perform reporting and data input actions.
  
  **Note:**
  
  - When positioning your cursor on a command in the EPM tab, a tooltip appears, explaining the command.
  - Depending on the Microsoft Office application, the EPM tab does not contain all the same commands.

- The EPM Context bar is displayed by default horizontally and below the ribbon.
  
  The bar displays the dimensions that are included in the current cube/model and the members that are used in the current display of a report (or the saved members in an offline report).
  
  You can hide the bar by deselecting the Display EPM Context Bar option in EPM > Options > User Options. This bar can also be displayed inside the EPM pane by checking the Display Context inside EPM Pane option. You can also move the bar into and back from the pane, using the mouse move pointer.

- The EPM pane is displayed by default vertically on the right side of the window.
  
  This pane include the following areas: the active connection, information about the selected report, including the connection used by the report, the name of the report, all the dimensions available, the page axis dimensions, the row axis dimensions and the column axis dimensions.
  
  You can hide the pane by deselecting the Display EPM Pane option in EPM > Options > User Options. Selecting the title bar of the pane and using drag and drop, you can move the pane to the left side of the window or anywhere else in the window.
  
  **Note:**
  
  The EPM Context bar and the EPM pane can be both hidden or displayed at one time by clicking the Show Pane & Context button in the EPM tab.

- Cell Context menu. Only in Microsoft Office Excel, a cell context menu appears when you right-click on any cell in the spreadsheet. The add-in adds one menu item to the top of it: EPM. This allows you to continue to use the existing Microsoft Office Excel features (such as the following features: cut, copy, paste, insert, etc.) and does not take up much space.
**Persistent resizing**
You can resize the pane, the bar and the dialog boxes. Their resizing is persistent.

**Related Topics**
- Context
- Report Creation using the EPM Pane
- EPM Add-in for Microsoft Office Word and PowerPoint

### 4.2 Perform Actions without the Mouse

The EPM add-in menus and commands can be reached without using the mouse.
- The **EPM** tab can be reached by pressing the **Alt** key and then pressing the character that is displayed on the EPM tab.
- Inside the **EPM** tab, the commands can be reached by pressing the character that is displayed on the command you want to use.
- Inside a dialog box:
  - Press the **Alt** key to display the shortcuts on commands. Then, click the underlined letter.
  - To select another tab, if any, use the right/left arrow keys.
  - To move to the next control (list, check boxes, options), press the **Tab** key.
  - To move to the previous control, press the **Shift** and **Tab** keys.
  - To move between items in a list or set of options, press the up/down arrow keys.
  - To select or deselect a check box, press the **Space** bar.
  - To close a dialog box or cancel the context menu (if there is one up), press the **Esc** key.
- Context menus that require the right-mouse button can be brought up by using the Context Menu key (or sometimes called "exclusive" key). Once the menus are activated, they can then be navigated using the arrow keys.
Features Available

The EPM add-in features that are available depend on:

- The connection you use.
- The task profiles that are assigned to you.

Connection
Depending on the connection you use, some commands are automatically hidden or greyed out in the ribbon or in other interface sections, such as dialog boxes. For example, if you create on the same sheet several reports using different connections, depending on which report you select, the commands available may change.

Note:
In this documentation, when the feature described is not available or relevant to all cubes or models supported by the EPM add-in, a paragraph called "Applies to" specify for which type(s) of connection the feature is available or relevant.

Note:
When installing the EPM add-in, you specify the applications you use. When opening the add-in after the installation, the display of the EPM tab in the ribbon is initialized, depending on your selection in the installation setup. For example, if you have specified you would use Financial Consolidation, the Data Input group in the ribbon is not displayed since it is not relevant for this application. If you want to use Planning and Consolidation later on, you can display the commands that are related to Planning and Consolidation. To display or hide the commands or group of commands in the ribbon, select EPM > Options > Command Display Options.

Task Profiles
The features available also depend on the task profiles that have been assigned to you in the EPM application you are connected to.

For more information on task profiles, see the Help for the EPM application you use.

Related Topics
- Introduction to the EPM Add-in
- Log On and Connections
Security on Data or Members

The security defined in the models or cubes you connect to is applied in the EPM add-in.

- For all cubes or models, the security is defined on members. For example, user 1 is not authorized to view any data on the Actual member. In a report, if you retrieve some data you are not authorized to view, all the corresponding cells are left blank by default.
- For Planning and Consolidation, version for SAP NetWeaver, models, the security can alternatively be defined on combinations of members, that is on data. This is called the matrix security. For example, user 2 is not authorized to view data at the intersection of the Actual member and the Entity 1, Entity 3 and Entity 4 members. Therefore, he can only view the data for Actual and Entity 2.

Related Topics
- Security on Data (Planning and Consolidation, version for SAP NetWeaver)

6.1 Security on Data (Planning and Consolidation, version for SAP NetWeaver)

Applies to:
Planning and Consolidation, version for SAP NetWeaver, connections.

When using a model on which Matrix Security has been defined, and if security is activated on the server, the security on data is applied in the EPM add-in.

Therefore, in a report, the cells containing data that you are not authorized to view are left blank by default.

Text to display in unauthorized cells
Instead of blank cells, you can have a text display in the unauthorized cells.

- By default, the text is #unauthorized but you can enter another text in the Unauthorized Cell Text field, by selecting EPM > Options > User Options.
- So that the text is displayed in the unauthorized cells, you must select the Show Unauthorized Cell Text option:
  - In the Sheet Options, if you want the text to be displayed in any report in the current sheet.
**Note:**
If you use the `EPMRetrieveData` function to retrieve data on members that are not authorized to you, the cell in which you have entered the function also displays the default or specified text.

- In the **Options** tab of the **Report Editor**, if you want the text to be displayed on a specific report.

**Note:**
The text is displayed after a refresh action.

**General warning message**
Also, if the **Display Matrix Security Warning** option is selected in the **User Options** (the option is selected by default), a warning message pops up when a report containing unauthorized cells is refreshed. This message indicates that some data are not displayed.

**Note:**
In the message box, an option enables you to ask that the warning message does not pop up anymore. If you select this option, the **Display Matrix Security Warning** option is consequently deselected in the **User Options**. So that the message warning be displayed again, select the user option again.

**Related Topics**
- [EPMRetrieveData](#)
Open and Save a File

Using the EPM add-in, you can open and save files in different ways, depending on the connections you use.

If you do not open a file from a web portal, nor work with a Planning and Consolidation connection, you can always use the Microsoft Office Excel, Word or PowerPoint standard open and save features.

**Note:**
When using Microsoft Office Excel, you can open or save files with the following formats: xls, xlsx, xlsm, xlt, xltx and xltm.

7.1 Open a Report when Dimensions or Members have Changed

When you open a report that contain dimensions or members that have changed compared to the last connection, you may have to perform the following actions:

- Dimensions. If some of the dimension names have changed, you need to manually remap these dimensions. A dedicated dialog box automatically opens when needed.
- Members. If some of the members used in the report are not recognized as valid members in the cube or model (for example, a member has been deleted), you can choose between the following behaviors:
  - You do not want to keep the unrecognized members rows, columns and formulas on data, if any. In this case, you can ask that the columns and rows for unrecognized members are automatically deleted as soon as you perform a refresh of the report. Consequently, if there were formulas entered in the data cells, the formulas are also deleted. To do so, uncheck the **Keep Rows and Columns of Unrecognized Members** option in the User Options.
  - You want to keep the unrecognized members rows, columns and formulas on data, if any. In this case, you can ask that the columns and rows of unrecognized members are kept along with any formula entered in the data cells. Consequently, the unrecognized members are automatically converted into "blank" members as soon as you perform a refresh of the report. To do so, check the **Keep Rows and Columns of Unrecognized Members** option in the User Options. If you want to be warned that members are not recognized but will be kept, you can check the **Warn if Rows and Columns of Unrecognized Members will be Kept** option in the User Options: just for your information, a message will be displayed after a refresh, listing the members that are not recognized in the report. If you do not want to show the message again, select the option in the message box and click **OK** (clicking **Cancel** will not take into account the option selection) or uncheck the **Warn if Rows and Columns of Unrecognized Members will be Kept** option in the User Options: these two options are synchronized.
Note:
To place a valid member instead of a blank member, use the Insert Member feature. For more information on this feature, see Member Entry Using the Insert Members Dialog Box.

Note:
A report structure (dimensions and members) may have changed in the following cases:
- You open a report on the same connection on which the report was created, but some dimensions or members may have changed.
- You open a report that has been created on a specific connection and you connect it to a different connection. Even though the two data sources behind the connections have a similar structure, some dimensions or members may be different.

### 7.2 Open a File from a Web Portal

You can open the EPM workbooks, documents or presentations from two different web portals.

**Open a file from the BI launch pad**
If you are using SAP BusinessObjects Enterprise, you can open an existing EPM file from the BI launch pad. In the BI launch pad tree structure of the **Document List**, select the appropriate folder, then double-click the file. Depending on the type of file, it opens in Microsoft Office Excel, Microsoft Office Word or Microsoft Office PowerPoint, displaying the **EPM** tab.

You can also create an EPM workbook, document or presentation from the BI launch pad. In the BI launch pad tree structure of the **Document List**, select one of the following: **New > EPM Workbook**, **New > EPM Document** or **New > EPM Presentation**. A new file opens in Microsoft Office Excel, Word or PowerPoint, displaying the **EPM** tab.

**Note:**
When in Microsoft Office Excel, Word or PowerPoint, you can publish an EPM workbook, document or presentation to the BI launch pad. For more information, see Report Publication to a Web Portal.

**Open a file from Planning and Consolidation (web client)**
If you are using SAP BusinessObjects Planning and Consolidation, you can open an existing EPM file from the Documents view. For more information, see the SAP BusinessObjects Planning and Consolidation help.

**Note:**
When in Microsoft Office Excel, Word or PowerPoint, you can publish an EPM workbook, document or presentation to the Planning and Consolidation Documents view. For more information, see Report Publication to a Web Portal.
7.3 Open and Save a File for Planning and Consolidation

**Applies to:**
Planning and Consolidation connections

If you use Planning and Consolidation connections, you can use dedicated features to open and/or save files, using the server folder structure.

The dedicated features are: **EPM > Open** and **EPM > Save**.

**Note:**
If you do not want to use the server folder structure, you can always use the Microsoft Office Excel standard open and save features.

Here are the files that you can open and save:

- Using Microsoft Office Excel, you can open and save workbooks containing reports, input forms, book publication templates and distribution templates.
- Using Microsoft Office Word, you can open and save documents containing reports.
- Using Microsoft Office PowerPoint, you can open and save presentations containing reports.

**Note:**
When using Microsoft Office Excel, you can open or save files with the following formats: xls, xlsx, xlsm, xlt, xltx and xltm.

7.3.1 Open and Save Connection

**Applies to:**
Planning and Consolidation connections

Both Open and Save are performed on one specific connection.

The connection on which Open and Save actions are performed is the first connection you have used in the workbook.

If you use more than one Planning and Consolidation connection in the workbook, the first connection will still be used by default. For this reason, as soon as you use more than one connection, specify the connection on which you want to perform Open and Save actions. If you want to perform Open and Save actions on a different connection than the first one, select **EPM > Open > Change Connection** or **EPM > Save > Change Connection**.
7.3.2 Open Actions

**Applies to:**
Planning and Consolidation connections

When you select **EPM > Open**, different commands enable you to open a file from the following locations:

- **Local location for reports and input forms:** you can open reports or input forms that are stored on your local machine in dedicated folders.

  The Planning and Consolidation server folder structure is duplicated on your machine for two folders: "Reports" and "Input Schedules".
  - When you select the **Open my Reports**, the local "Reports" folder is selected by default in the dialog box that opens.
  - When you select the **Open my Input Forms**, the local "Input Schedules" folder is selected by default in the dialog box that opens.

**Note:**
In Microsoft Office Word and PowerPoint, only the **Open my Reports** command is available.

- **Server location for reports and input forms:** you can open reports or input forms that are stored on the Planning and Consolidation server, in dedicated folders: "Report" and "Input Schedules".
  - When you select the **Open Server Report Folder**, the Company (Public) "Reports" folder is selected by default in the dialog box that opens.
  - When you select the **Open Server Input Form Folder**, the Company (Public) "Input Schedules" folder is selected by default in the dialog box that opens.

**Note:**
In Microsoft Office Word and PowerPoint, none of the two above commands are available.

- **Server location for any file:** you can open reports, input forms, book publication templates or distribution templates that are stored on the Planning and Consolidation server, in dedicated folders.

  When you select the **Open Server Root Folder**, the root folder is selected by default in the dialog box that opens.

**Note:**
- For more information on the dialog box, see [Open and Save Dialog Box Description and Actions](#).
- For more information on the folder structure on the server, see [Server Folder Structure](#).

7.3.3 Save Actions
Applies to:
Planning and Consolidation connections

When you select EPM > Save, different commands enable you to save a file to the following locations:

- Local location for reports and input forms: you can save reports or input forms to your local machine in dedicated folders.

  The Planning and Consolidation server folder structure is duplicated on your machine for two folders: "Reports" and "Input Schedules".

  - When you select the Save my Report, the local "Reports" folder is selected by default in the dialog box that opens.
  - When you select the Save my Input Forms, the local "Input Schedules" folder is selected by default in the dialog box that opens.

Note:
In Microsoft Office Word and PowerPoint, only the Save my Reports command is available.

- Server location for any file: you can save reports, input forms, book publication templates or distribution templates on the Planning and Consolidation server, in dedicated folders.

  When you select the Save to Server Root Folder, the root folder is selected by default in the dialog box that opens.

Note:
- For more information on the dialog box, see Open and Save Dialog Box Description and Actions.
- For more information on the folder structure on the server, see Server Folder Structure.

Connection Information not Stored in the Report

- You can save a report without storing the connection used to create the report, that is without storing the environment nor the model of the connection. This way, you will then be able to use the report on other connections, provided that the models have similar structures.

  To do so, in the Options tab of the Report Editor, select the Do not Store Connection option.

- You can also save a report without storing the environment of the connection used to create the report. This way, you will then be able to use the report on other connections using other environments, provided that the models' environments have similar structures.

  To do so, in the Options tab of the Report Editor, select the Do not Store Environment in the Connection option.

Note:
If you have already selected the Do not Store Connection option, the Do not Store Environment in the Connection option is greyed out.

For more information, see Do not Store Connection and Do not Store Environment in the Connection.
7.3.4 Open and Save Dialog Box Description and Actions

Applies to:
Planning and Consolidation connections.

When opening or saving a file from/to the server, the dialog box that opens can contain the following buttons on the left side, depending on the rights you are granted:

- "Local". The folders and files displayed are the merge result of folders and files on your local machine and folders and files on the server for "Company (Public)".
- "Company (Public)”. The folders and files displayed are the ones on the server.
- "[team]". If you have access to a team, a button with the name of the team is displayed. The folders are the same as for "Company (Public)".

By right--clicking a folder in the middle part of the dialog box, you can create or delete a folder, and you can search for the name of a file.

By right--clicking a file in the right part of the dialog box, you can copy, paste, delete or rename a file.

7.3.5 Server Folder Structure

Applies to:
Planning and Consolidation connections

For each model, the Planning and Consolidation and Consolidation server folder structure is as follows:

- Root folder
  - "Books": this folder contains book publication templates.
  - "Input Schedules": this folder contains input forms. Inside this folder, the folder "Templates" contains templates for input forms.
  - "PDBooks": this folder contains distribution templates.
  - "Reports": this folder contains reports. Inside this folder, the folder "Templates" contains templates for reports.
  - "Migration Copy": this folder contains original workbooks that have been migrated (only if the Do not move original workbooks in a different folder option is selected in the migration dialog box). For more information, see Launching the EvDRE Migration.

Note:
Some folders appear only when corresponding files have been created.

Related Topics
- Report and Input Form Templates
The context specifies the dimensions and associated members for a specific connection.

The context represents the following:
- The dimensions that are included in the current cube/model.
- The members that are used in the current display of a report (or the saved members in an offline report).

The context enables to define, for each dimension of a selected cube/model, a member corresponding to the default member to be applied for unspecified dimensions in any EPM function or in any report created.

**Note:**
The members that are selected in the axes of a report override the members selected in the context.

The context applies to the user for a connection. If you open other workbooks and connect to the same cube or model, the context will be same even if you have modified it in one of the workbooks.

The context is displayed in the dedicated **EPM Context** bar.

**Note:**
- When using a Planning and Consolidation connection, the name of the current model is displayed in the bar.
- You can alternatively display the context settings inside the **EPM** pane by selecting the **Display Context inside EPM Pane** option in the **User Options** dialog box.

However, you can set a specific member on a specific workbook or worksheet. When you set a member, you automatically lock its dimension and you cannot select another member from the **EPM Context** bar: the dimension drop-down list is greyed out.

**Note:**
If you set a member on a specific workbook, the member is also set on all the sheets of the workbook.

To change the context in a report, you can select other members from the **EPM Context** bar. The data displayed changes to reflect the new context settings. To select another member for a dimension, select a dimension drop-down list, then select **Select Other Members**. The **Member Selector** opens and you can make your selection.

**Note:**
If the drop-down list is greyed out, you cannot select another member: this is because the dimension has been locked in the **Context Options**.
To lock a dimension on a workbook or worksheet, select **EPM > Options > Context Options**. In the **Context Lock** tab, select the level from the drop-down menu, then click the member and select the one you want from the **Member Selector** that opens. The **Lock** checkbox is automatically checked for the dimension.

**Note:**
You can set a workbook to refresh automatically upon selecting a member from the context by selecting the **Automatic Refresh on Context Changes** option in the **User Options** dialog box.

### 8.1 Context Display Options

You can specify display settings for the context by selecting **EPM > Options > Context Options**. All these settings will be applied to the **EPM Context** bar.

- **Hiding dimensions.** You can decide not to display a dimension in the **EPM Context** bar. To do so, select the **Hide** checkbox. The checkbox is available in both **Context Display** and **Context Lock** tabs. For example, if you have locked a dimension on the worksheet, you may want to hide it from the **EPM Context** bar.
- **Dimension and member name display.** By default, in the **EPM Context** bar, the name of the dimension and the name of the member are displayed. If you want that only the member name and not the dimension name be displayed, you can uncheck the **Show Dimension Name** option.
- **Dimension colors.** In the **EPM Context** bar, colors are applied by default to all dimensions. You can define the colors you want for each dimension by clicking the colored area in the **Color** column. You can also choose not to display the colors at all by unchecking the **Show Dimension Color** option.
- **Dimension order.** You can modify the default order of the dimensions as they appear in the **EPM Context** bar, by selecting a dimension and clicking the **Up** or **Down** button.

**Note:**
you can access the three features above in the **Context Display** tab.
Report Layout Rules

There are some basic rules that you have to follow in laying out your report so that the EPM add-in can interpret it. These rules are simple and logical and also helps ensure that your report is readable for others.

9.1 Overall Layout Rules

This layout structure needs to be followed for each sheet that you refresh but can appear anywhere on the worksheet. In addition, you can also request a refresh on ranges of selected cells and in those cases, only the selected range needs to contain a valid layout of recognizable members.

The overall layout sections and terminology is as follows:

Page axis members are members that act as a specification (filter) for the whole report. An axis is a set of one or more dimensions that define the row axis or column axis in a report - see the red and blue boxes in the layout picture above. The data grid is where the numbers from the database are read into.

Here is a sample report with the same highlighted borders to indicate all four sections. Notice that the three axes contain more than one dimension:
### Note:
Formatting and spacing is completely up to you.

#### 9.1.1 Basic Layout Rules

The compulsory items are the column axis and the row axis. That is, you need to have at least one dimension member in the row axis and one in the column axis - forming the two axes. For example, a report can be as small as this:

```
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Jan</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Revenue</td>
<td>14,44</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Note that it does not matter where these two member cells appear on the worksheet, as long as the column header (in this example: Jan) is somewhere above and to the right of the row header (in this example: Revenue) - and they are both recognizable members of the connected data source. The data returned by a refresh request will appear in the intersecting cell that appears towards the bottom-right (in this example: B4).

As another example, this is also a valid minimal report:
### 9.1.2 Dimension Layout Restrictions

A dimension/hierarchy can only appear once in the whole layout. For example, in a page axis, you cannot place two members of the same dimension/hierarchy in different cells. The following is an invalid report since you cannot tell if the whole report is supposed to contain data for Canada or for the USA:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA</td>
<td></td>
<td>Canada</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Jan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td>Jan</td>
<td>Feb</td>
</tr>
<tr>
<td>4</td>
<td>Revenue</td>
<td>???</td>
<td>???</td>
<td>???</td>
</tr>
<tr>
<td>5</td>
<td>COGS</td>
<td>???</td>
<td>???</td>
<td>???</td>
</tr>
</tbody>
</table>

**Note:**
However, you can perform a multi-selection of members for a dimension/hierarchy in the page axis.

Similarly, a dimension/hierarchy in the row axis cannot have a member appear in the page axis or in the column axis or vice-versa.

The following reports are also invalid since there is no data that represents both January and April at the same time:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>January</td>
<td>February</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>March</td>
<td>???</td>
<td>???</td>
</tr>
<tr>
<td>4</td>
<td>April</td>
<td>???</td>
<td>???</td>
<td></td>
</tr>
</tbody>
</table>

Period dimension appears both in the row and the column axis.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA</td>
<td></td>
<td>Apr</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Revenue</td>
<td>???</td>
<td>???</td>
<td>???</td>
</tr>
<tr>
<td>5</td>
<td>COGS</td>
<td>???</td>
<td>???</td>
<td>???</td>
</tr>
</tbody>
</table>

Period dimension (Apr) appears in the page axis and in the column axis.
9.2 Page Axis

The page axis define filters for the whole report.

- The page axis is optional.
- The page axis can appear anywhere as long as it is above the column axis.
- At least one row should be inserted between the page axis and the column axis, otherwise the page axis could be interpreted as the column axis.

You can see in this example that the page axis is above the column axis and that a row (in green) is inserted between the page axis and the column axis.

<table>
<thead>
<tr>
<th></th>
<th>Source</th>
<th>Act2002</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Jan</td>
<td>Feb</td>
</tr>
<tr>
<td>Chips</td>
<td>Revenue</td>
<td>5.223</td>
</tr>
<tr>
<td></td>
<td>COGS</td>
<td>3.127</td>
</tr>
<tr>
<td>Cookies</td>
<td>Revenue</td>
<td>2.177</td>
</tr>
<tr>
<td></td>
<td>COGS</td>
<td>1.383</td>
</tr>
</tbody>
</table>

You can select several dimension members for a page axis dimension. When you select several members for a dimension that is part of the page axis, the data on the members are automatically aggregated in the report.

Related Topics
- Overall Layout Rules

9.3 Row Axis

The row axis defines the member row headers for a report, that is, the labels that indicate what data should appear in each row.

Related Topics
- Overall Layout Rules
9.3.1 Simple Row Axis

The simplest row axis you can have is member(s) from one dimension in one column like this:

| Revenue | COGS | GP |

In this case we have Revenue, COGS (Cost of Goods Sold) and GP (Gross Profit) which are all in the Accounts dimension.

Note:
If you type in the member names yourself, you do not have to get the case or the indentation correct. The EPM add-in will automatically correct the case and indent the members as specified in the sheet options.

You do not need to have them all in adjacent cells. That is, you can spread them out like this:

<table>
<thead>
<tr>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>COGS</td>
</tr>
<tr>
<td>GP</td>
</tr>
</tbody>
</table>

This is useful if you need to put your own Microsoft Office Excel formulas or annotations in between the report lines.

9.3.2 Multidimensional or Nested Row Axis

To add an additional dimension to further qualify the row axis, you simply add its members to the column immediately on the left, for example:

<table>
<thead>
<tr>
<th>Chips</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>COGS</td>
</tr>
<tr>
<td></td>
<td>GP</td>
</tr>
<tr>
<td>Popcorn</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>COGS</td>
</tr>
<tr>
<td></td>
<td>GP</td>
</tr>
<tr>
<td>Pretzels</td>
<td>Revenue</td>
</tr>
<tr>
<td></td>
<td>COGS</td>
</tr>
<tr>
<td></td>
<td>GP</td>
</tr>
</tbody>
</table>
This is what is called a "nested" axis. There are now two dimensions in the row axis. Chips, Popcorn and Pretzels are all in the Product dimension. The Accounts are nested inside of the Products. You do not have to repeat the product row headers on each line. They implicitly apply to all members on the inside dimension (e.g. Accounts above) until another member from their dimension appears. For example, the following color coded blocks define the data in the corresponding rows:

<table>
<thead>
<tr>
<th>Chips</th>
<th>Revenue</th>
<th>COGS</th>
<th>GP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Popcorn</td>
<td>Revenue</td>
<td>COGS</td>
<td>GP</td>
</tr>
<tr>
<td>Pretzels</td>
<td>Revenue</td>
<td>COGS</td>
<td>GP</td>
</tr>
</tbody>
</table>

**Note:**
What is called "block" is basically a grouping of members. In the example above, there are three blocks. The first block is the first three rows in green color.

This is a very common and logical reporting standard.

However, if you really want the outer dimension members repeated explicitly, it is allowed and maintained if the relevant option is selected in the sheet options. For example:

<table>
<thead>
<tr>
<th>Chips</th>
<th>Revenue</th>
<th>COGS</th>
<th>GP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chips</td>
<td>COGS</td>
<td>GP</td>
<td></td>
</tr>
<tr>
<td>Popcorn</td>
<td>Revenue</td>
<td>COGS</td>
<td>GP</td>
</tr>
<tr>
<td>Popcorn</td>
<td>GP</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

There is virtually no limit to the number of dimensions that you can nest together in an axis. For example, the following report has four dimensions in the row axis and is valid:
The four dimensions from outside to inside are Currency, Reporting Unit, Product and Accounts. The row spacing shown is completely optional.

**Related Topics**
- Repeat Row Headers and Repeat Column Headers

### 9.3.3 Asymmetric Row Axis

In the report below, all of the inner dimension member lists are repeated in all occurrences. Specifically Canada and USA, Chips and Pretzels, and Revenue and COGS. This is what is called a symmetric report.
An important feature of the EPM add-in is that the inside members do not have to be identical repeated sets of members. The axis can be asymmetric like this:

<table>
<thead>
<tr>
<th>Source</th>
<th>Canada</th>
<th>Chips</th>
<th>Revenue</th>
<th>Cost of Goods Sold (COGS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>Chips</td>
<td>Revenue</td>
<td>COGS</td>
<td></td>
</tr>
<tr>
<td>USA</td>
<td>Pretzels</td>
<td>Revenue</td>
<td>COGS</td>
<td></td>
</tr>
<tr>
<td>USD at Actual Rates</td>
<td>Canada</td>
<td>Chips</td>
<td>Revenue</td>
<td>Cost of Goods Sold (COGS)</td>
</tr>
<tr>
<td>USD at Actual Rates</td>
<td>Pretzels</td>
<td>Revenue</td>
<td>COGS</td>
<td></td>
</tr>
</tbody>
</table>

The products in each grouping above are not identical, but it is a valid report. This asymmetry is actually very common once you start using the following features: delete empty rows, delete Microsoft Office Excel rows, asymmetric expand or collapse.

### 9.3.4 Row Axis Restrictions

It is important to note that you must not leave members blank on the inside dimension like this:
Note:
The formal definition of the nested dimension member rule is: all inner dimension's members must be stated when an outer dimension contains a member on the same row.

The correct row axis for what the above report likely means is this:

<table>
<thead>
<tr>
<th>Revenue</th>
<th>Chips</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Popcorn</td>
</tr>
<tr>
<td></td>
<td>Pretzels</td>
</tr>
<tr>
<td>COGS</td>
<td>Chips</td>
</tr>
<tr>
<td></td>
<td>Popcorn</td>
</tr>
<tr>
<td></td>
<td>Pretzels</td>
</tr>
</tbody>
</table>

Notice that the Accounts are now the outside dimension and the Products are now on the inside. This is called re-nesting the dimensions. This can be done by re-typing or moving the cells around, but it is usually much easier to use the Report Editor or the EPM pane and just re-order the dimensions in the row axis section.

Although you are allowed to put blank rows anywhere throughout the axis, you must not put a blank column in between the nested dimensions like this:

<table>
<thead>
<tr>
<th>Chips</th>
<th>Revenue</th>
<th>COGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Popcorn</td>
<td>Revenue</td>
<td>OP</td>
</tr>
<tr>
<td></td>
<td>COGS</td>
<td></td>
</tr>
</tbody>
</table>

9.4 Column Axis

The column axis defines the member column headers for a report, that is, the labels that indicate what data should appear in each column.

Note:
At least one row should be inserted between the page axis and the column axis, otherwise the page axis could be interpreted as the column axis.

Related Topics
• Overall Layout Rules
• Page Axis
9.4.1 Simple Column Axis

The simplest column axis you can have is member(s) from one dimension in one row like this:


In this case, we have Act2001 (Actual 2001), Act2002, and Act2003 which are all in the Reporting ID dimension.

You do not need to have them all in adjacent cells. That is, you can spread them out like this:


This is useful if you need to put your own Microsoft Office Excel formulas or annotations in between the report columns.

9.4.2 Multidimensional or Nested Column Axis

To add an additional dimension to further qualify the column axis, you simply add its members to the row immediately above it, for example:

<table>
<thead>
<tr>
<th>Jan</th>
<th>Feb</th>
</tr>
</thead>
</table>

This is what is called a "nested" axis. There are now two dimensions in the column axis. Jan and Feb are all in the Period dimension. The Reporting ID are nested inside of the Months. Notice that you do not have to repeat the Period column headers in each column. They implicitly apply to all members on the inside dimension (e.g. Reporting ID above) until another member from their dimension appears. For example, the following color coded blocks define the data in the corresponding columns:

<table>
<thead>
<tr>
<th>Jan</th>
<th>Feb</th>
</tr>
</thead>
</table>

Note:

What is called "block" is basically a grouping of members. In the example above, there are two blocks. The first block is the first three columns in green color.

This is a very common and logical reporting standard.

However, if you want the outer dimensions to be centered over their inner dimensions, then just use Microsoft Office Excel's Merge and Center feature or Center across Selection like this:
Note:
In merged cell column headers, the member name must actually be entered into the left-most merged cell.

Alternatively, if you really want the outer dimension members repeated explicitly, it is allowed and maintained. For example:

<table>
<thead>
<tr>
<th>Jan</th>
<th>Jan</th>
<th>Jan</th>
<th>Feb</th>
<th>Feb</th>
<th>Feb</th>
</tr>
</thead>
</table>

There is virtually no limit to the number of dimensions that you can nest together in an axis. For example, the following report has four dimensions in the column axis and is valid:

<table>
<thead>
<tr>
<th>Canada</th>
<th>Revenue</th>
<th>COGS</th>
<th>USA</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>Feb</td>
<td>Jan</td>
<td>Feb</td>
<td>Jan</td>
</tr>
</tbody>
</table>

The four dimensions from outside to inside (top to bottom) are Reporting Unit, Account, Reporting ID, and Period.

9.4.3 Asymmetric Column Axis

In the report below, all of the inner dimension member lists are repeated in all occurrences. Specifically Revenue and COGS, Act2001 and Act2002, and Jan and Feb. This is what is called a symmetric report.

<table>
<thead>
<tr>
<th>Canada</th>
<th>Revenue</th>
<th>COGS</th>
<th>USA</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>Feb</td>
<td>Jan</td>
<td>Feb</td>
<td>Jan</td>
</tr>
</tbody>
</table>

An important feature of the EPM add-in is that the inside members do not have to be identical repeated sets of members. The axis can be asymmetric like this:

| Canada | | | | USA | |
|--------|----|----|----|-----||
| Jan | Feb | Mar | Apr | Mar | Apr |
The months in each grouping above are not identical, but it is a valid report. This asymmetry is actually very common once you start using the following features: delete empty columns, delete Microsoft Office Excel columns, asymmetric expand or collapse.

9.4.4 Column Axis Restrictions

It is important to note that you must not leave members blank on the inside dimension like this:

<table>
<thead>
<tr>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Act2001</td>
<td></td>
<td></td>
<td>Act2002</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
The formal definition of the nested dimension member rule is: all inner dimension’s members must be stated when an outer dimension contains a member in the same column.

The correct column axis for what the above report likely means is this:

<table>
<thead>
<tr>
<th>Act2001</th>
<th></th>
<th></th>
<th>Act2002</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
</tr>
</tbody>
</table>

Notice that now the Reporting IDs are now the outside dimension and the Periods are now on the inside. This is called “re-nesting” the dimensions. This can be done by re-typing or moving the cells around, but it is usually much easier to use the Report Editor or the EPM pane and just re-order the dimensions in the column axis section.

Although you are allowed to put blank columns anywhere throughout the axis, you must not put a blank row in-between the nested dimensions like this:

<table>
<thead>
<tr>
<th>Jan</th>
<th>Jan</th>
<th>Jan</th>
<th>Feb</th>
<th>Feb</th>
<th>Feb</th>
</tr>
</thead>
</table>

9.5 Data Grid Considerations

The EPM add-in data grid is loosely defined as all cells that form the intersection of recognized database dimension member axis. A data grid cell will have a valid column axis above it and a valid row axis to the left of it. The data grid is the collection of cells that the application fills in with data from the OLAP data source. For example, it is shown as the light-blue shaded area in the following simple sample:
However, the application offers a lot more flexibility than the above tight grid layout. There are a lot of things that you can add in and around the data grid to form a custom formatted report with additional calculations. The following picture contains exactly the same data grid as above, but demonstrates several things that you can do that will not prevent you from re-refreshing it with the application.

Note that the unusual text and background formatting is only used here to help you differentiate the areas of the report.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chips</td>
<td>Act2002</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>USD at Actual Rates</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Connecticut</td>
<td>Revenue</td>
<td>Jan</td>
<td>Feb</td>
<td>Qtr1</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>113,972</td>
<td>94,185</td>
<td>320,250</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>COGS</td>
<td>71,891</td>
<td>88,635</td>
<td>192,373</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>GP</td>
<td>42,081</td>
<td>35,380</td>
<td>127,877</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Massachusetts</td>
<td>Revenue</td>
<td>364,591</td>
<td>327,208</td>
<td>1,053,943</td>
</tr>
<tr>
<td>8</td>
<td>COGS</td>
<td>221,338</td>
<td>195,306</td>
<td>637,724</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>GP</td>
<td>143,253</td>
<td>131,212</td>
<td>416,219</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
9.5.1 Data Grid Important Tips

Here are some important tips regarding the data grid:

• Any number of blank rows and/or columns can be put anywhere throughout the grid. In other words, the grid can be split up.

• You can format the cells any way that you want using Microsoft Office Excel formatting including scaling the data. It will be retained by the application. However, if you expand on or pivot your report, the formatting will not move with the cells. Therefore, it is recommended that you do all formatting last or apply a dynamic formatting on the reports you want to analyze.

• Your own Microsoft Office Excel formulas can safely be put anywhere except in a grid cell and they will be retained in a subsequent Refresh. However, they will not be retained if you do a navigational action (Expand, Collapse, Keep, etc.) that will change the size of the report. It is recommended that you put in your custom formulas after you are finished doing ad-hoc manipulations to the layout and content.

**Note:**
If the Local Member Recognition is activated, any Microsoft Office Excel formula is automatically converted into local members.

• You can put anything outside of the report area. It will be completely ignored by the application unless you expand your report.

Related Topics
• Blank Row and Column Insertion
• Dynamic Formatting
• Local Members
• Member Recognition
Report Creation

You can create reports in three different ways.

- Creating reports using the EPM pane.
- Creating reports using the Report Editor.
- Creating reports directly in a sheet.
- Creating reports using the Copy and Paste features.

A report is created by default on the active connection of the worksheet. The active connection is displayed in the Active Connection drop-down list of the EPM pane and in the Layout tab of the Report Editor.

Related Topics

- Log On and Connections

10.1 Member Identification and Properties

10.1.1 Member Identification

In the EPM add-in, each member that is part of a report is identified by a formula beginning with =EP M0lap.
10.1.2 Member Properties

You can display the properties of a selected member. To display this information, select a member, then select EPM > More > Member Properties.

**Note:**
On a Planning and Consolidation connection, you can view if the member is calculated or not, for example.

10.2 Report Creation using the EPM Pane

You can create and modify a report by using the EPM pane.

**Note:**
If you work with several reports, you can only create the first report using the pane. To create additional reports, you must use the New Report button.

**Report creation by drag and drop in the pane**

In the Current Report area of the pane, you can drag and drop one or several dimensions to the following sections to create a report:

- Page Axis. This is optional.
- Row Axis.
- Column Axis.
As soon as you drag and drop at least one dimension in the row axis and one dimension in the column axis - and provided that the Defer Layout Update option is not checked, the report with the selected dimensions is displayed in the worksheet.

By default, each time that you make a change in the axes sections, the report layout is automatically updated. To improve performance when you are accessing a large amount of data, you can switch to manual update. When you switch to manual update, you cannot use the report until you switch back to automatic update. However, you can quickly add, move, and remove dimensions from the dimensions section to the axes sections, and then switch back to automatic update to see your results. To enable manual update, select the Defer Layout Update option. The Update button is enabled. When you finish changing the report layout, click Update to see the layout in the worksheet.

By default the member taken into account for a dimension is the one defined in the context, with the Member and Children relationship. Once a dimension has been added to an axis section, you can select another member for the dimension by clicking the dimension name that appears as a link. The Member Selector opens and you can select the member you want.

When placing several dimensions in one axis, you can reorder the dimensions by selecting a dimension row (click on the right of the dimension link, not on the link itself) and performing a drag and drop.

In the page axis section, you can click on the cell reference of the dimension (D7 for example). Using the Cell Selection dialog box that opens, select the cell you want in the sheet to move the page axis dimension. An error message appears if you have selected a cell that is below the column axis.

Alternatively to some of the above features, you can perform the following actions:

- In the dimension list section, using the arrow context menu (right-click), you can add the selected dimension to:
  - The page axis by clicking the Move to Page Axis command.
  - The row axis by clicking the Move to Row Axis command.
  - The column axis by clicking the Move to Column Axis command.

- In the page, row and column axes sections, clicking the arrow that appears when you mouse over a member, you can:
  - Select members for the selected dimension by clicking the Select Dimension Members command. The Member Selector opens and you can select the members you want.
  - Move the dimension to another axis, by clicking the Move to Page Axis, Move to Row Axis or Move to Column Axis command.
  - Remove the dimension from the axis by clicking the Remove command.

- In the row and column axes sections only, you can reorder the dimensions if you have selected more than one dimension in an axes. To do so, use the Move to the Top, Move Up, Move to the Bottom and Move Down commands.

- In the pages axis section only, you can click the Change Cell... command. Using the Cell Selection dialog box that opens, select the cell you want in the sheet to move the page axis dimension.

Report creation by drag and drop in the worksheet

You can drag and drop dimensions or hierarchies from the Current Report list directly to the worksheet to create a report.
• For a Planning and Consolidation connection. The member that is selected in the context is displayed by default in the report, with the following relationship: **Member Only**. Therefore, when you change a member in the **EPM Context** bar, the member will also change in the report.

• For a local or SAP BusinessObjects Enterprise connection. The context member or the default member is displayed by default in the report, with the following relationship: **Member Only**. When several hierarchies exist for a dimension, a member node that belongs to one hierarchy may not belong to another hierarchy. For this reason, the context member is taken into account if the member belongs to the hierarchy you drag and drop. If the context member does not belong to the hierarchy you drag and drop, it is the default member of the hierarchy (this is defined in the cube or model) that is taken into account.

**Related Topics**

• **Several Reports in a Sheet**

---

### 10.3 Report Creation using the Report Editor

The **Report Editor** dialog box plays several roles:

• It can act as a graphic user-interface for defining an initial report on a blank worksheet.

• It can be used to define other reports on a sheet already containing a report.

• It can be used at any time on a valid report to re-arrange the layout or change the members in each section of the report: move (pivot) one or more dimensions between the page headers, row axis and column axis; reorder the nesting of dimensions within an axis; or change the selection or order of members of one or more dimensions in the report.

• It can be used to define report position: moving a report in a sheet, inserting separation between axis and data, moving each page axis dimension individually.

You can perform all the above actions in the **Layout** tab of the **Report Editor**.

**Note:**

Using the other tabs of the **Report Editor**, you can also define specific options for the current report, enter customized names for the members, exclude members from the report, define sorting, filtering and ranking on the current report data.

You can access the **Report Editor** dialog box by clicking **Edit Report** in the ribbon. The **Report Editor** does perform a refresh after it closes since the report must be valid to close it.

**Related Topics**

• **Report Editor's Layout Tab Presentation**

• **Several Reports in a Sheet**
10.3.1 Report Editor’s Layout Tab Presentation

To define or modify your report layout, click on Edit Report in the EPM tab of the ribbon. The Report Editor dialog box opens, displaying the Layout tab by default.

- You can perform drag and drop operations between the three axis and the Dimensions areas.
- On the left side is the Dimensions area which displays all the available dimensions, along with their hierarchies.

**Note:**
If named sets are included in SSAS cubes created with Financial Consolidation Cube Designer, they will also appear along with the dimensions at the hierarchy level. The hierarchies appear in black, whereas the named sets appear in blue. When a named set is created in SAP BusinessObjects Financial Consolidation, cube designer, the default hierarchy (flat list) automatically comes along. As a consequence, both the named set and the default hierarchy appear below the dimension in the Report Editor. Note that, once you have included the named set in the view, you cannot include the default hierarchy anymore.

- On the right side is an intuitive view of the dimensional layout of the report.

**Note:**
Note that you can add an unused dimension in the Dimensions area to any section, and remove a dimension from any axis area by dragging it back into the Dimensions area.

- On the right side, you can dynamically modify your report at any time with actions such as pivoting, re-nesting (reordering dimensions within an axis) or changing the member selections. On the right side, you can also:
  - Define a shift between the data grid of the report and its row and column headers.
  - Move the whole report by defining the position of the top left cell of the data grid.
  - Define the position of each dimension of the page header.

When you click OK in the Report Editor, the report is re-refreshed automatically.

**Note:**
Alternatively to some of the main features, using the context menu (right-click) in the dimension list section and the three axes sections, and depending on the section you are in, you can perform the following actions:

- In the dimension list section, you can add the selected dimension to:
  - The page axis by clicking the Move to Page Axis command.
  - The row axis by clicking the Move to Row Axis command.
  - The column axis by clicking the Move to Column Axis command.

- In the page, row and column axes sections, you can:
  - Select members for the selected dimension by clicking the Select Dimension Members command. The Member Selector opens and you can select the members you want.
  - Move the dimension to another axis, by clicking the Move to Page Axis, Move to Row Axis or Move to Column Axis command.
• Remove the dimension from the axis by clicking the Remove command.
• In the row and column axes sections only, you can order the dimensions if you have selected more than one dimension in an axes. To do to, use the Move to the Top, Move Up, Move to the Bottom and Move Down commands.
• In the pages axis section only, you can click the Change Cell... command. Using the Cell Selection dialog box that opens, select the cell you want in the sheet to move the page axis dimension.

10.3.2 Dimension Placement in the Report Editor

You can use the Report Editor at any time on a valid report to re-arrange the layout or change the members in each section of the report: move (pivot) one or more dimensions between the page axis, row axis and column axis; reorder the nesting of dimensions within an axis; or change the selection or order of members of one or more dimensions in the report.

To define your layout, simply drag and drop your required dimensions to the correct sections of the report. This includes moving the dimension name from one section to another or changing the order of them within a section.

On the Dimensions area, the dimensions/hierarchies with a red cross are the ones that already appear in the report. Dimensions that are not in the report yet can be dragged into the layout from there. To remove a dimension from the layout, drag it to the Dimensions area.

If you add a dimension to the page axis section, it will default to the cell on the right side of the page axis that you drop it under.

To remove all dimensions from the layout, click Reset Report.

Example:

In the following example you can see the effect of the order of the dimensions in an axis. This applies to the column axis also.

<table>
<thead>
<tr>
<th>Account Before Product</th>
<th>Product Before Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Axis Dimensions:</td>
<td>Row Axis Dimensions:</td>
</tr>
<tr>
<td>Account</td>
<td>Account</td>
</tr>
<tr>
<td>Product.Family</td>
<td>Product.Family</td>
</tr>
<tr>
<td></td>
<td>Account</td>
</tr>
</tbody>
</table>
10.3.3 Member Selection in the Report Editor

You can select the members to be displayed in the report directly from the Report Editor.

- To modify the member selection for a dimension in the Row Axis Dimensions area or the Column Axis Dimensions area, click on the dimension name. The Member Selector opens and you can select the members you want.
- To modify the member selection for a dimension in the Page Axis Dimensions area, click on the dimension or on the member name. The Member Selector opens and you can select the members you want.

**Note:**

- You can also select the members directly on a spreadsheet in a valid report by double-clicking on a dimension of the page axis. When you click OK in the Member Selector, the report is refreshed automatically. This allows you to quickly change the page axis members.
- When you select several members for a dimension that is part of the page axis, the data on the members are automatically aggregated in the report. If you often use a specific selection of members for a page axis dimension, you should convert the selection into a custom member.

**Related Topics**

- Member Selection
- Page Axis Dimension Members Modification using the Member Selector

10.3.4 Position of each Dimension in the Page Axis using the Report Editor
Each dimension in the page axis can be positioned individually.

You can position a page axis dimension anywhere as long as it is above the column axis

In the page axis area of the Report Editor, click on the cell reference of the dimension (D7 for example). Using the Cell Selection dialog box that opens, select the cell you want in the sheet to move the page axis dimension. An error message appears if you have selected a cell that is below the column axis.

10.3.5 Report Move in the Sheet using the Report Editor

You can move a report in the sheet simply by choosing one cell in the Report Editor.

The cell displayed by default in the middle of the four blue arrow buttons in the Report Editor, corresponds to the top left cell of the data grid (B22 for example). You can change it by entering the cell reference or using the arrow buttons. The whole report is moved based on this cell, as soon as you click OK.

10.3.6 Shift Insertion Between the Data Grid of the Report and its Row and Column Axis

Using the Report Editor, you can insert a separation between the data grid and:

• The row axis.
• The column axis.

To do so, use the Shift area.

Note:
You can enter negative numbers for the row axis. In this case, the row axis will be positioned on the right side of the data grid.

Example:

• If you enter 2 in the Shift area below the column axis area, you want one column to be inserted between the data grid and the column axis.
• If you leave 1 by default in the Shift area on the right of the row axis area, you want that no row separates the data grid and the row axis.
10.4 Report Creation Directly in a Sheet

You can create a report manually.

You can enter dimension members and create local members directly in a cell of a report. You can also use the Auto Fill feature to automatically fill in cells with all the members of the same level in the hierarchy order. To do so, you use the Member Recognition and the Local Member Recognition features.

When you manually create a report, you can also get assistance to select members

- Using the Member Selector that you access through the Report Editor, the EPM pane or by double-clicking a member located in the report page axis.
- Using the Insert Members dialog box that you access by right-clicking in the row or columns axis of a report.

10.4.1 Member Recognition

You can enter members directly in a cell of a report. You can also enter Microsoft Office Excel formulas.

When the Member Recognition feature is activated, the members are automatically recognized.

When the Local Member Recognition feature is activated, the Microsoft Office Excel formulas are automatically converted into local members.

The Member Recognition features can be activated or deactivated at the user level. Then, you can activate or deactivate them by sheet.

10.4.1.1 Member Entry Directly in a Sheet

Instead of using the Report Editor dialog box, you can enter text and figures directly in the cells of a sheet if you know the names of the members you want to retrieve. The Member Recognition feature must be activated.

You can enter a complete dimension member name or just a part of it. If you correctly enter the complete dimension member name, as soon as you press the Enter key, a green flash briefly appears in the cell, indicating that the member has been recognized. If you enter a part of a dimension member name:

- If the member name fragment is unique in the cube, as soon as you press the Enter key, the name is automatically completed and a green flash briefly appears in the cell, indicating that the member has been recognized.
• If the member name fragment is not sufficient to identify the member, the **Ambiguous Name** dialog box opens, displaying all the members contained in the cube that might match the entered member.

**Note:**

• The recognized members are uniquely identified. When you select a member in the sheet, the Microsoft Office Excel Formula bar displays:= EPMOlapMember(xxx).
• You can define a member based on a formula. If the member is unique, it is converted into a member and the link will be kept inside the formula. For example, you can have "=Sheet2!D4" picking up the value "Ohio" from another worksheet. This allows you to create reporting templates where you can change "Ohio" to say "New York" in one place and then update (Refresh) all the related reports to get "New York" data.

### 10.4.1.2 Blank Row and Column Insertion

In a report, you can insert a Microsoft Office Excel blank row or column to add a formula, a text or to be used as a separation row or column.

When you perform a refresh of the report, the inserted row or column remains.

Note that a row or column is inserted at a fixed location (cells 6B for example).
• If you want a blank row or column to be specifically attached to a member for example, you should create a local member.
• You can also create a blank member that behaves like any standard member, using the **Selection Relationship** area of the **Member Selector**.

**Related Topics**

• Local Members
• Selection Relationship

### 10.4.1.3 Excel Formula Entry Directly in a Sheet

You can use Microsoft Office Excel formulas to perform calculations. All Microsoft Office Excel formulas are automatically converted into local members.

**Related Topics**

• Blank Row and Column Insertion
• Local Members
10.4.1.4 Auto Fill

When the Member Recognition is activated, the standard Microsoft Office Excel Auto Fill feature enables you to automatically fill in cells with all the members of the same level in the hierarchy order.

Example:
In your report, only France Eau is displayed. You want to display same level members for France Eau.

You want to display the three members that come after France Eau in the hierarchy. By selecting France Eau cell and dragging the pointer (in the lower right corner of the cell) to cover the three following cells, here is an example of what you get:

You want to display the five members that come before France Eau in the hierarchy. By selecting France Eau cell and dragging the pointer (in the lower right corner of the cell) to cover the five above cells, here is an example of what you get:

10.4.1.5 Auto Completion in Nested Axes
When a row or a column axis contain several dimensions (nested dimensions), provided that the Member Recognition is activated, when entering a member for example in the outer dimension, members in the inner dimension are automatically entered, as shown in this example.

Example: *Auto completion in a nested axis*

In the row axis, the outer dimension is Period and the inner dimension is Currency. You have already entered the following members:

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>USD</td>
</tr>
</tbody>
</table>

Now, you enter the Period member 2009. The member is recognized as an EPM member and the Period members EUR and USD are automatically entered:

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>USD</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>USD</td>
</tr>
</tbody>
</table>

### 10.4.1.6 Activating or Deactivating the Member Recognition Options

1. Select **EPM > Options > User Options**.
2. To activate the Member Recognition, select the **Activate Member Recognition by Default** option. To activate the Local Member Recognition, select the **Activate Local Member Recognition by Default** option.
   The Member Recognition and/or the Local Member Recognition is activated by default for all the files used by the user.
3. Select **EPM > Options > Sheet Options**.
   By default, since the Member Recognition and/or the Local Member Recognition has been activated in the **User Options**, it is also activated here.
4. If you do not want the Member Recognition and/or the Local Member Recognition to be applied to the current sheet, you can deselect the **Activate Member Recognition** or the **Activate Local Member Recognition** option.
10.4.2 Member Entry Using the Member Selector

When you manually create or modify a report, you can get assistance from the Member Selector dialog box which allows you to select any dimension members to help you construct your report layout.

10.4.2.1 Member Selector Presentation

The Member Selector can be accessed through the Report Editor, the EPM pane or by double-clicking a member located in the report page axis.

The Member Selector is composed of the following areas:

- In the title bar, the name of the dimension/hierarchy is displayed.
- Hierarchy or list display. Using the drop-down list, you can display the members in a simple list or in the hierarchy in the Dimension Members area.
- Member names to display. You can choose other members names to display as alternatives to the captions, depending on what has been defined in the cube or model. Use the list icon.
- Member filtering by properties. To help you selecting members, you can filter the members by property value.
- Member search. You can search for a specific member. Using the binoculars icon, enter your search text into the Find What text box and then click on the Find button.

Note:

- The search is not case sensitive (e.g. "Shares" and "shares" will be treated the same).
- You do not need the full member name (see "shares" example in the picture above").
- It starts from the selected (highlighted) member and goes down.
- It searches through all members, not just the visible ones.
- It will expand and scroll the tree to display each member found.
- It will tell you when it reaches the bottom and ask you if you want to re-start at the top.
- It will tell you if there are no occurrences at all.

- Member Sorting & Grouping button. You can sort and group the selected members based on property values.
- Dimension Members list. This list contain all the members of the current dimension. The member tree can be expanded by clicking the + icon, and contracted by using the - icon as necessary to view and select members.
**Note:**

- If you have created custom members for a specific dimension, they will appear in the **Dimension Members** list.
- If you have entered a customized name for a member, it will appear in this list.
- Buttons to select members.
- **Selected Members** area. It is where you select and order the members of the currently selected dimension that you want to appear on the report.
- **Selection Relationship** drop-down list. It allows you to select many members at once based on their relationship to selected (checked) members.
- **Hierarchy Levels** options. For some dynamic relationships, you can define the levels of the hierarchy you want to display.

**Related Topics**

- [Renaming Members](#)

### 10.4.2.2 Member Selection

- Even though you have not selected any member to display in the report, when you open the **Member Selector**, a member is selected by default.
  - For a Planning and Consolidation connection: the member that is selected in the context is selected by default in the **Member Selector**, with the following relationship: **Member and Children**. Therefore, if you choose to keep the context member selection in your report, when you change a member in the **EPM Context** bar, the member will also change in the report.
  - For a local or SAP BusinessObjects Enterprise connection: the context member or the default member is selected by default in the **Member Selector**. When several hierarchies exist for a dimension, a member node that belongs to one hierarchy may not belong to another hierarchy. For this reason, the context member is taken into account if the member belongs to the current hierarchy. If the context member does not belong to the current hierarchy, it is the default member of the hierarchy (this is defined in the cube or model) that is taken into account.
  - Members can be placed on (or removed from) the **Selected Members** list using the buttons representing arrows to the right and to left to add or remove the selection made in the **Dimension Members** list.

**Note:**
The arrow to the right button will copy the checked members, and any related members depending on the **Selection Relationship** choice, to the bottom of the selected members list. The arrow to the left button will remove the selected members from the **Selected Members** list.

**Note:**
The parents of members default to the bottom of their children on the **Selected Members** list. This is because in most reporting situations, totals and sub-totals appear at the bottom.
• When selecting several items (members or filters by properties), by default, all the items will be displayed in the report: the + operator (=OR) is applied by default when you add an item in the **Selected Members** area. You can select the & operator (=AND), so that only the members at the intersection of the different items are displayed. The & operator takes precedence over the + operator. Colors indicate how the items are combined.

• You can reorder the members in the list by selecting one or more of the members and then using the re-order buttons.

**Note:**
Alternatively, you can also drag and drop a selected member or members within the list to reorder them. Use the Ctrl and/or Shift keys to select multiple members like in any standard Microsoft list. You can also delete member(s) by selecting them and then hitting the **Delete** key.

**Related Topics**
• [Context](#)

### 10.4.2.3 Blank Member

Using the **Member Selector**, you can create and insert a blank member for the current dimension. This member behaves like any other standard member.

When you open the **Member Selector**, do not select any member in the **Dimension Members** area, and select **Blank Member** from the **Selection Relationship** drop-down menu. Then, add it to your member selection by using the arrow-to-the-right button. Once the blank member is displayed in the **Selected Members** area, order it as it will appear in the report.

**Note:**
• You can insert a Microsoft Office Excel blank row or column that will be fixed (cells 6B for example).
• If you want a blank row or column to be specifically attached to a member for example, you should create a local member.

**Related Topics**
• [Blank Row and Column Insertion](#)
• [Local Members](#)

### 10.4.2.4 Member Name to Display

You can choose other members names to display as alternatives to the captions, depending on what has been defined in the cube or model.
You can select the names to display from the drop-down list next to hierarchy/list drop-down list.

The following items are available depending on the connection and the application:

- Local and SAP BusinessObjects connections:
  - Financial Consolidation: code, short description, long description, extra-long description. Properties and attributes can also be available.
  - Profitability and Cost Management: only the captions are available.
  - Planning and Consolidation connections: ID, description, ID-description.

**Related Topics**
- Display Name

### 10.4.2.5 Selection Relationship

The **Selection Relationship** list allows you to automatically select members based on their relationship to the selected (checked) members in the **Dimension Members** List. This can save you a lot of time. For example, you may want all the children of a specific member or members. Similarly, you can say that you want the member and all its ascendants.

If you select the **Dynamic** option (selected by default), each time you will perform a refresh on the report, the report will automatically pick up new members or remove members that have been deleted from the cube or model.

The following shows the list of supported relationships.

**Note:**

- The first time you open the **Member Selector**, the default relationship is **Member and Children**. The selection you then make is persistent: the next time you will open the **Member Selector**, the relationship that will be selected by default will be the last one you have selected.

- **Member Only**
- **Member and Children**
- **Children**
- **Member and Descendants**
- **Descendants**
- **Base Level**
- **Same Level**
- **Siblings**
- **Member and Ascendants**
- **Ascendants**
- **Member and Base Level**
- **Member Offset**
When selected, the **Member Offset** area is displayed. This feature enables you to display a member related to another member by specifying an offset from a given member to retrieve the previous or subsequent member.

You can also specify a hierarchy level. By default (*Member Level* option), the member at the same level as the member specified is incremented. You can also choose a specific level.

**Note:**

However, when you choose a specific level using the *Level* option, note that only the members that are above the selected member or at the same level in the hierarchy, will be displayed. If you specify a level that is below the selected member, the level will be ignored. See the second example below.

- Example with the **Member Level** option: you select 2009.Q1 in the list of dimensions and you specify an offset of 2. The 2009.Q3 member will be displayed in the report.

- Example with the **Level** option: you select Quarter 1 in the list of dimensions, then you specify an offset of 3, then you specify the level 2. The member displayed in the report will be the third member (increment based on member Quarter 1) at the same level of Quarter 1: Quarter 4. As the second level of the hierarchy is below Quarter 1 level in the hierarchy, the level is therefore ignored.

**Member Property**

When selected, the **Member Property** area is displayed and enables you to select a property. This feature enables you to display the property value of the selected member, that is another member of the same dimension.

For example, you check the member ACTUAL, then select **Member Property** from the **Selection Relationship** list, then select the COMPARISON property. In your report, the member BUDGET is displayed, as this is the comparison value for the ACTUAL member. If there is no property value for a member, the member is retrieved in the report cell.

**Dimension Property**

You can select **Dimension Property** when there are two dimensions in the current axis (row or column axis) and when you do not select any member in the **Dimension Members** area of the **Member Selector**. Once **Dimension Property** selected, the **Dimension Property** area is displayed and enables you to select a dimension and a property for the dimension. This feature enables to display the property values for the displayed members of a dimension, based on another dimension's members. If no property value exists, the context member of the dimension is displayed in the report.

For example, the row axis contains the two dimensions Entities and Reporting Currency. Open the **Member Selector** for the Reporting Currency dimension: select **Dimension Property** from the **Selection Relationship** list, then select the Entity dimension and the CURRENCY property. In your report, here is what is displayed: in the first column are listed USA and France; in the second column are listed USD and EUR.

**Note:**

On some relationships (relationships including ascendants, descendants and base level), you can define the levels of the hierarchy you want to display in the report, using the **Hierarchy Levels** area.

Using the **Selection Relationship** list, you can also create a blank member. This member behaves like any other member. **Blank Member**
Related Topics

- Hierarchy Levels to Display

### 10.4.2.6 Hierarchy Levels to Display

On some relationships (relationships including ascendants, descendants and base level), you can define the levels of the hierarchy you want to display in the report.

- By default, all the levels of the hierarchy are displayed and the All Levels option is selected.
- You can select the number of levels you want to display, knowing that level 1 is the highest level of the hierarchy. If you select 3, levels 1, 2 and 3 will be displayed in the report. Use the Number of Levels option.
- You can also select only one level to display. Use the Only Level option.

### 10.4.2.7 Member Sorting and Grouping by Properties

You can sort the selected members based on property values. To do so, click the Member Sorting and Grouping button and select the Enable Member Sorting options.

You can perform the following actions:

- Sort the members based on their names, by ascending or descending order. If the members are organized in a hierarchy, the members are sorted and therefore the hierarchy may be broken. To do so, use the Ascending or Descending options.
- Additionally, you can sort the members based on a property, in ascending or descending order, depending on the option you have selected. The values of the specified property are ordered by ascending or descending order. Inside each node, the members are sorted in ascending or descending order. To do so, select the Group by Property option, then select a property from the drop-down list.
- Create a grouping local member in the dimension based on the property selected for the sorting. To do so, follow these steps:
  - To position the local member before the set of members (or property group), select the Before Group tab. To position the local member after the set of members (or property group), select the After Group tab.
  - In the Create a Local Member Named area, enter a name for the grouping local member (or leave the default name). This name will not be displayed in the report but in the Local Member Selection tab when defining a specific format for the local member. For more information on how to define a format for a local member, see Dynamic Formatting Template Definition.
  - In the Display area, you can enter the name for each grouping local member that will be displayed in the report. This name can be either static or dynamic, that is containing the property value or the property value description (can be selected from the drop-down list), a prefix and a suffix.
**Example:**
For the Currency dimension, property values are EUR and USD; property value descriptions are Euro and US Dollar.

**Note:**
If a property value description cannot be displayed, the property value is displayed instead.

- You can then define the calculation to be performed for the grouping local member. The calculation is performed the same way as for local members. If you do not enter anything in the Formula area, totals and sub-totals calculation will be performed for a hierarchy.

**Example: **Entities grouped by country
In this example, a grouping local member has been created for the Entities dimension, based on the Country property. All the entities are grouped under the country to which they belong to. The following items are specified in the Member Sorting and Grouping area of the Member Selector: the Ascending order option is selected, the Country property is selected in the Group by Property drop-down list; in the Display area of the Before Group tab, the entered prefix is "Country: " and the Property Value is selected from the drop-down list. No formula is entered. Therefore, sub-totals calculation are performed on the countries.

<table>
<thead>
<tr>
<th>Country: DEU - Germany</th>
<th>13629</th>
</tr>
</thead>
<tbody>
<tr>
<td>R0160 - Deutsche Rohre</td>
<td>5678</td>
</tr>
<tr>
<td>R0190 - Deutsche Getränke</td>
<td>5609</td>
</tr>
<tr>
<td>R0240 - Deutsche Valuebank AG</td>
<td>2342</td>
</tr>
<tr>
<td>Country: FRA - France</td>
<td>28010</td>
</tr>
<tr>
<td>R0140 - France Alimentation</td>
<td>7654</td>
</tr>
<tr>
<td>R0170 - France Eau</td>
<td>7895</td>
</tr>
<tr>
<td>R0250 - France Gourmet TV</td>
<td>9008</td>
</tr>
<tr>
<td>R60 - France Loisirs</td>
<td>3452</td>
</tr>
<tr>
<td>Country: GBR - United Kingdom</td>
<td>21793</td>
</tr>
<tr>
<td>R0260 - UK Beverages</td>
<td>3427</td>
</tr>
<tr>
<td>R0270 - UK Snacks</td>
<td>8476</td>
</tr>
<tr>
<td>R0280 - UK Music Ltd.</td>
<td>9890</td>
</tr>
</tbody>
</table>

**Related Topics**
- Local Members

**10.4.2.8 Member Filtering by Properties**

You can filter the members by property.
To do so, click the filter icon in the Member Selector and define the filter(s) in the Member Filtering by Properties area that appears.

- To define a filter, select one of the properties available for current dimension/hierarchy using the Property drop-down list.

Then select an operator and property values:
- \(=\): equal. For example, to filter all the entities that belong to the France value for the Country property: Country=France
- \(<>\): not equal. For example, to filter all the entities except the ones that belong to the France value for the Country property: Country<>France
- LIKE: equals the entered value. You can enter text or figures and use the * character before or after the entered value. For example, to filter the chart of accounts beginning with "10", enter "10*": Chart of Accounts LIKE 10*.
- BT: range between a low and high value. For example, to filter the chart of accounts for values between 1000 and 1100: Chart of Accounts BT 1000 1100.

- The Dimension Members area displays only the members that meet the filter criteria because the Display Only Filtered Members option is selected by default.

**Note:**
When the Display Only Filtered Members option is selected, the members appear in a list, not in a hierarchy anymore. Therefore, the drop-down menu on the top left corner of the dialog box automatically displays List. If you unselect the option, all the members for the current dimension/hierarchy are displayed in a hierarchy and the drop-down menu on the top left corner of the dialog box automatically displays Hierarchy.

- To perform a selection, you can do one of the following:
  - Check the members you want and click the arrow to the right button. The checked members, and any related members depending on the Selection Relationship choice, are moved to the bottom of the selected members list.
  - Select the filter itself. The filter is dynamic, meaning for example that if a member with a specified property is created in the cube or model, it will be automatically added to the report. To select the filter itself, click the Add Dynamic Filter button.

**Note:**
- You can define criteria for a filter. For example, all the entities that have the "Euro" property value and all the ones that have the "USD" property value.
- If you define several criteria using the same property, the operator OR is used between each criteria.
- If you define several criteria using different properties, the operator AND is used between each criteria.

### 10.4.2.9 Page Axis Dimension Members Modification using the Member Selector

You can modify the members for a dimension in the page axis directly from the sheet.
To do so, double-click the member cell. The **Member Selector** that opens, displays a sub-part of the one opened from the **Report Editor** or the **EPM** pane.

However, it includes an additional option called **Allow Multi-Selection**. Using this option, you can select several dimension members for a page axis dimension. When you select several members, the data on the members are automatically aggregated in the report.

**Note:**
- You cannot select more than 30 members.
- If you often use a specific selection of members for a page axis dimension, you should convert the selection into a custom member.
- You can display the members in a hierarchy or a list, you can select the member names to display in the report, and you can search for a specific member.

**Related Topics**
- Member Selector Presentation
- Custom Members

### 10.4.3 Member Entry Using the Insert Members Dialog Box

You can insert members for the dimensions that are in the row or column axis of the current report.

To do so, right-click in a cell that belongs to the row or the column axis and select **EPM > Insert Members**. The **Insert Members** dialog box displays the dimensions that are in the axis you are on. For each dimension, you can select the members you want to add to the report: select a dimension, then click **Select Members**. The **Member Selector** opens. If a filter has been previously defined to restrict the member insertion on the dimension, the **Member Selector** enables you to select only the filtered members. For more information, see **Member Insertion Filtering**.

You can specify where in the axis you want to insert the selected members: at the selected cell or at the end of the axis.

If you have specified that you want to insert the members at the selected cell, you can also specify:
- if you want to insert the members and move down accordingly the members below in the axis,
- or if you want that the selected members replace the current members. Example: you have selected two members to insert, the axis contains four members and the cell selected when performing the right-click is the second member cell. The second and third members in the axis will be replaced by the two selected members.

**Note:**
- The selection you make is persistent: the next time you will open the **Insert Members** dialog box, the default options will be the ones you have selected the previous time.
- Empty rows and columns behavior for inserted members. Let's say you have selected the **Remove Empty Rows** or **Remove Empty Columns** option in the **Sheet Options**. Then, you have inserted
members using the **Insert Members** dialog box. Some of the inserted members do not have any data. However, when you refresh the report, the columns or rows for the members that do not contain data, remain in the report. Empty rows or columns are not hidden either, even if you have selected the **Hide Empty Rows** or the **Hide Empty Columns** option in the Sheet Options. For more information on empty columns and rows behavior, see [Empty Row and Column Behavior](#).

**Related Topics**
- [Member Entry Using the Member Selector](#)

### 10.5 Report Creation using Copy/Paste

You can copy and paste an existing report from and to:
- a Microsoft Office Excel worksheet
- a Microsoft Office Word document
- a Microsoft Office PowerPoint presentation

The connection is copied along and the report is automatically connected.

**Note:**
You can see the report connection in the **Layout** tab of the **Report Editor** and also above the dimension list in the **EPM** pane.

To copy and paste a report, select **EPM > Report Actions > Copy Report > Paste Report**.
Asymmetric Report Creation

To create asymmetric reports, you can use several commands.

• Use the Keep and Exclude commands from the EPM tab. The excluded members are automatically stored in the report and appear in the Excluded Members tab of the Report Editor.
• Exclude members using the Excluded Members tab in the Report Editor.
• Delete Microsoft Office Excel rows or columns.

**Note:**
If you delete a row or column, it can break the excluded member selection.

• Enter members directly in the cells.

Example:

In the following simple example, all three product members (Chips, Cookies and Pretzels) are selected members of the Product.Family dimension. This is a symmetric axis:

<table>
<thead>
<tr>
<th>Canada</th>
<th>Chips</th>
<th>Cookies</th>
<th>Pretzels</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>Chips</td>
<td>Cookies</td>
<td>Pretzels</td>
</tr>
</tbody>
</table>

You exclude Pretzels for Canada and Cookies for USA. This is an asymmetric axis:

<table>
<thead>
<tr>
<th>Canada</th>
<th>Chips</th>
<th>Cookies</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>Chips</td>
<td>Pretzels</td>
</tr>
</tbody>
</table>

Related Topics

• Asymmetric Row Axis
• Asymmetric Column Axis
• Keep Member
• Exclude Member
• Excluding Members
Ownership-based Hierarchies

**Applies to:**
Planning and Consolidation connections

Ownership-based hierarchies support the legal structure of statutory consolidations. An ownership-based hierarchy combines Groups and Entity members, where entities can be differently connected to or disconnected from groups according to Category and Time.

Ownership-based hierarchies are set up in the Consolidation Central view of Planning and Consolidation.

You can display in a report how the group structure has been evolving through the time. To do so, create a report for the appropriate Category and Time, and that displays the dimensions Groups and Entity in the same axis, whether it is the row or column axis. For each Groups member, its main entity is displayed in the cell before or after.

**Note:**
- Ownership-based hierarchies are only available in consolidation and ownership type models.
- The Exclude Member feature can be confusing when used in a report containing ownership-based hierarchies. For example, if you exclude the period member, February 2010, the entities are still displayed for February 2010. This behavior is standard with the Exclude Member feature. For more information about excluding members, see [Exclude Member](#) and [Excluding Members](#).

**Example:** Entity difference between January and February

Here is the group structure for the Actual category in January 2010.

**Note:**
The main entity to Group 1 is Entity 1 and the main entity to Group 2 is Entity 3.

<table>
<thead>
<tr>
<th>Group</th>
<th>Entity</th>
<th>ACTUAL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Jan 2010</td>
</tr>
<tr>
<td>Group 1</td>
<td>Entity 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Entity 2</td>
<td></td>
</tr>
<tr>
<td>Group 2</td>
<td>Entity 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Entity 4</td>
<td></td>
</tr>
</tbody>
</table>

Here is the group structure for the Actual category in February 2010.
Entity 5 is new in Group 1.

Assuming that the group structure has not changed for the Actual category from February to March 2010, here is the group structure for the first Quarter of 2010.

<table>
<thead>
<tr>
<th>Group 1</th>
<th>Entity 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Entity 2</td>
</tr>
<tr>
<td></td>
<td>Entity 5</td>
</tr>
<tr>
<td>Group 2</td>
<td>Entity 3</td>
</tr>
<tr>
<td></td>
<td>Entity 4</td>
</tr>
</tbody>
</table>

The quarter displays the union of the entities.
**Actions and Options Specific to the Current Report**

You can perform some actions and specify some options that are specific to the current report by using the **Report Editor**.

### 13.1 Report Options

You can modify the options that are specific to the current report in the **Options** tab of the **Report Editor**. By default, the report options are the one defined for the current worksheet in the **Sheet Options**.

- To keep the options as they are defined in the **Sheet Options**, leave the **Inherit Sheet Options** option selected as it is by default in the **Options** tab of the **Report Editor**. All the options that are inherited from the sheet options are greyed out.
- To modify the options for the current report, deselect the **Inherit Sheet Options** option. All the options are made available for selection.

The following options are available for selection and are not necessarily related to the Sheet Options:

- **Freeze Data Refresh**. Independently, this option can also be activated for any use of the EPM add-in in the **User Options**.

  **Note:**
  
The option is always available for selection. Independently, this option can also be activated for any use of the EPM add-in in the **User Options**.

- **Do not Store Connection** and **Do not Store Environment in the Connection**. These options only apply to Planning and Consolidation connections.
- **Display only Base Level Data**. This option only applies to Planning and Consolidation, version for the Microsoft platform, connections.

  **Note:**
  
  - To read explanations about the options that are common to the sheet and the report, refer to **Sheet Options**.
  - Depending on the cube or model the report is connected to, the options displayed are not always the same.

**Related Topics**

- **Sheet Options**
- **Freeze Data Refresh**
13.1.1 Freeze Data Refresh

You can deactivate the data refresh. Freezing the refresh of data enables you to navigate in a report as you wish and the data is not loaded from the data source. Then, when you are finished navigating in the report, you can activate the refresh again and retrieve the latest data.

If you have selected Inherit Sheet Options in the Options tab of the Report Editor, the Freeze Data Refresh option is selected or not, depending on if you have selected the option or not in EPM > More or in EPM > User Options.

Related Topics
• Report Refresh

13.1.2 Display only Base Level Data

Appplies to:
Planning and Consolidation, version for the Microsoft platform, connections.

If you only want to display the data that are not aggregated - that is data on base level members -,
select the Display only Base Level Data option. The data calculations will not be performed and the data for base level members will be displayed more quickly.

13.1.3 Do not Store Connection and Do not Store Environment in the Connection

Appplies to:
Planning and Consolidation connections.

• You can save a report without storing the connection used to create the report, that is without storing the environment nor the model of the connection. This way, you will then be able to use the report on other connections, provided that the models have similar structures.

To do so, in the Options tab of the Report Editor, select the Do not Store Connection option.

Tip:
Select this option for reports that you want to use as templates.
• You can also save a report without storing the environment of the connection used to create the report. This way, you will then be able to use the report on other connections using other environments, provided that the models' environments have similar structures.

To do so, in the Options tab of the Report Editor, select the Do not Store Environment in the Connection option.

Note:
If you have already selected the Do not Store Connection option, the Do not Store Environment in the Connection option is greyed out.

As the connection or the environment is not stored:
• dimensions are identified with their types (for example: E for Entity) and not with their names.
• dimension members are identified with their relationships (for example: context member + children) and not with their names.

Note:
therefore, as soon as you select (or manually enter) a member that is not a context member, a message warns you that, as the report contains at least one member that is not a context member, these members may not be recognized if you use the report later on with another connection.

13.2 Data Sorting, Ranking and Filtering

You can sort, rank or filter the data of the current report. You define the sorting, ranking and filtering on data in three dedicated tabs of the Report Editor.

13.2.1 Data Sorting

You can sort the data of the current report using the Report Editor.

You can sort the data in your report in ascending or descending order, based on:
• Either a specified dimension member and for each dimension in the column axis.

Note:
You might sort by more than one column when you have data that you want to group by the same value in one column, and then sort another column within that group of equal values. For example, if you have a Department and Employee column, you can first sort by Department (to group all the employees in the same department together), and then sort by name (to put the names in alphabetical order within each department).
• Or the first or the last column.
The Sort Inside Level option enables you to sort parent members and their children in each level of the hierarchy, while still preserving the hierarchy.

Note:

- The sorting inside the levels is performed if the row axis contains only one dimension.
- Data sorting is not supported on local members.

13.2.1.1 Sorting Data

   The Report Editor opens.
2. Select the Sorting tab.
3. Select the Sort Data Using the Following Criteria option.
   The rest of the tab is activated.
4. Select Member, First Column or Last Column.
5. If you have selected Member:
   a. By default, you sort data based only on a member that is displayed in the column axis of the report. If you want to sort data based on a member that is not part of the column axis, deselect the Show Only Members Displayed in the Report option.
   b. Click the ellipsis button.
   c. In the Column Selector dialog box that opens, select the member on which the sort will be based and click on OK.
   d. Indicate whether data will be sorted in Ascending or Descending order by selecting one of the options.
   e. If you want to sort data on another member, click Add Criteria and repeat step 5.
6. If you have selected First Column or Last Column, indicate whether data will be sorted in Ascending or Descending order by selecting one of the options.
   Note:
   If you have selected First Column or Last Column, you cannot add criteria for the sorting.
7. To perform the sort in each level of the hierarchy, select the Sort Inside Level option.
8. To delete the entire sorting query, click on the Clear Expression button.
   Note:
   If the Sort Data Using the Following Criteria option is not selected, this tab is disabled. However, if you have already entered settings, they are not deleted.
13.2.2 Data Filtering

You can filter the data of the current report using the Report Editor.

You can specify one or more conditional dimension member value filters on the report. In the Filtering tab, you can specify the individual criteria and you can combine all the criteria in an expression.

- By default, only the members in rows or columns that meet the filtering criteria will be displayed in the report.
- The system can also check if the criteria is met on each column or row member in the report. So that none of the members are displayed in the report if at least one of the members does not meet the filtering criteria, select the Filter on all Columns/Rows option.

Besides, the following options enables you to define specific actions on top of the filtering criteria.

- **Retain Members** option: you can select one (or more) specific member that you want to display in the report, whether or not it meets the filtering criteria.
- **Keep Blocks** option: when a member is displayed in the report because it meets the filtering criteria, the whole block to which it belongs is displayed.

**Note:**
The Keep Blocks option appears in the Filtering tab only if the row axis contains more than one dimension.

- **Retain Members** and **Keep Blocks** options both selected: In the case the row axis contains more than one dimension, you can also ask that not only the retained member be displayed in the report but also the block to which the selected member belong.

**Note:**
- To find out what a block is, see Multidimensional or Nested Row Axis and Multidimensional or Nested Column Axis.
- Data filtering is not supported on local members.

Related Topics
- Multidimensional or Nested Row Axis
- Multidimensional or Nested Column Axis

13.2.2.1 Filtering Data

   The Report Editor dialog box opens.
2. Select the **Filtering** tab.
3. Select the **Filter Data Using the Following Criteria** option.
   The rest of the tab is activated.
4. If you want that specific members appear in the report, regardless the filtering criteria, select **Retain Members**.
   
   **Note:**
   In case the row axis contains more than one dimension, the **Keep Blocks** option is available. If you want that not only members appear in the report but also the block they belong to, select this option.
5. In the **Filtering Criteria** area, use the **Based on** drop-down menu to select **Row** or **Column**.
6. By default, you filter data based only on a member that is displayed in the column or row axis of the report. If you want to filter data based on a member that is not part of the column or row axis, deselect the **Show Only Members Displayed in the Report** option.
7. Click on the ellipsis button at the end of the **Based on** field.
   The **Column Selector** dialog box opens.
   
   **Note:**
   If there is more than one dimension in the column axis, you can select one member for each dimension to be filtered on.
8. Select the member in row or column on which the filter will be based and click on **OK**.
9. So that none of the members are displayed in the report if at least one of the members does not meet the filtering criteria, select the **Filter on all Columns/Rows** option.
10. Define the filter criteria using the three radio buttons and the corresponding drop-down menus. The square brackets show the choices available in the drop-down menus:
   - [is | is not] NULL (Empty).
   - [= | > | >= | < | <= | <>] a specified constant (must be numeric, i.e. real number).
   - [= | > | >= | < | <= | <>] another column specified using the **Column Selector** dialog box.
11. Click on the **Add Criteria** button.
    The filter criteria defined is added to the **Filter Expression** area and the **Filtering Criteria** area is cleared.
12. If you want to add more filter criteria select the **AND** or the **OR** operator and repeat steps 5 to 11.
    Each expression will be entered on a new line in the **Filter Expression** area.
13. To delete the entire expression from the **Filter Expression** area, click on the **Clear All Expressions** button.
14. To modify a criteria, select the criteria line in the **Filter Expression** area, click **Edit**, modify the criteria and click **Modify Criteria**.
    
    **Note:**
    To cancel the modification of the criteria, click **Cancel Edit**.
15. To delete a criteria, select the criteria line in the **Filter Expression** area and click on **Delete**.
16. If you also define a ranking on data in the **Ranking** tab, to avoid any conflict, the filtering takes precedence by default over the ranking. Therefore, the **Perform Filtering, then Ranking** option is
selected by default. You can deselect it to change the precedence and the Perform Ranking, then Filtering option in the Ranking tab is automatically checked.

**Note:**
If the Filter Data Using the Following Criteria option is not checked, this tab is disabled. However, if you have already entered settings, they are not deleted.

### 13.2.3 Data Ranking

You can rank the data of the current report using the Report Editor.

You can specify top or bottom 'N' ranking based on a specified dimension member and for each dimension in the column axis. Only the top or bottom "N" rows will be displayed in the report.

**Note:**
Data ranking is not supported on local members.

#### 13.2.3.1 Ranking Data

   The Report Editor dialog box opens.
2. Select the Ranking tab.
3. Select the Rank Data Using the Following Criteria option.
   The rest of the tab is activated.
4. Select Member, First Column or Last Column.
5. If you have selected Member:
   a. By default, you rank data based only on a member that is displayed in the column axis of the report. If you want to rank data based on a member that is not part of the column axis, deselect the Show Only Members Displayed in the Report option.
   b. Click the ellipsis button.
   c. In the Column Selector dialog box that opens, select the member on which the ranking will be based and click on OK.

**Note:**
If there is more than one dimension in the column axis, you can select one member for each dimension to be ranked.

6. Indicate whether data will be ranked from the Top or the Bottom by selecting one of the options.
7. Select how many items will be included in the ranking, e.g. top 10 sales figures.
8. If you also define a filtering on data in the Filtering tab, to avoid any conflict, the filtering takes precedence by default over the ranking. Therefore, the Perform Ranking, then Filtering option is not selected by default. You can select it to change the precedence and the Perform Filtering, then Ranking option in the Filtering tab is automatically unchecked.

9. To delete the entire ranking query, click on the Clear Expression button.

**Note:**
- 0 is not a valid value in this field.
- If the Rank Data Using the Following Criteria option is not checked, this tab is disabled. However, if you have already entered settings, they are not deleted.

### 13.3 Read-only Data

**Applies to:**
Planning and Consolidation connections.

For a specific input form, you can choose not to save the data entered on:
- Specific dimension members.
- The intersection of specific members.

In the Read-only Data tab of the Report Editor, select a dimension, then click Select Members and select the member(s) for which data will not be saved to the server. You can select one or more members for one or more dimensions.

So that only data at the intersection of the selected members is not saved, select the At Intersection Only option.

**Note:**
As data can be entered and saved only on base members, selecting a node will have no consequence.

**Related Topics**
- Data Save

### 13.4 Local Members

You can create members mainly for calculations on the current report. These members are called "local members". Local members have the same behavior as any other member, but they contain standard Microsoft Office Excel formula or EPM functions.

There are two ways of creating local members:
• Enter an Excel formula. When the Local Member Recognition is activated, all Microsoft Office Excel formulas are automatically converted into "local members". You can then view and modify the local member in the Local Members tab of the Report Editor.
• Create a local member directly in the Local Members tab of the Report Editor.

Note:
You can also create a grouping local member in the Member Selector, when grouping members by property.

Note:
• Local members are specific to the current report. If you want to reuse a local member in other reports for the same sheet/connection couple, you can convert the local member into a custom member. To convert a local member into a custom member, right-click on the local member in the report and select EPM > Convert to Custom Member. You can create custom members only when using a local or SAP BusinessObjects Enterprise connection.
• Precedence rules: in case of conflicts between local members on row and column axis, local members on the columns axis overrides the ones on the row axis.
• You can apply a specific formatting to local members.

Related Topics
• Dynamic Formatting Template Definition
• Custom Members
• Member Sorting and Grouping by Properties

13.4.1 Local Member Automatically Detected

You can insert a row or a column, enter text as the header of the row or column, then enter a formula. When you enter in a report a Microsoft Office Excel formula, the formula is automatically converted into a local member, provided that the Local Member Recognition is activated. All Microsoft Office Excel formulas are converted into local members.

Note:
If a member refered to in a local member is deleted, the local member becomes invalid.

The formula is automatically detected and is attached to one of the following items:

Note:
If you do not enter a text to describe the local member, a default name is generated, beginning with (fn).

• Member combination. The axis to which the formula applies contains more than one dimension and you have entered a formula that references two different members in the outer dimension. For example, there are two dimensions in the column axes. In cell D3, you enter the following formula: =B3-C3
The formula is automatically converted into a local member. When you edit it in the Local Members tab of the Report Editor, you can see that the member is attached to the combination of members: Budget and 2009. If you enter this combination of members somewhere else in the report, the Difference local member will also be displayed.

- Hierarchy/dimension. A formula that refers all the members displayed in the report for a specific hierarchy/dimension. For example, you want to calculate the sum for the first quarter of 2010 based on January, February and March. In cell E2, you enter the following formula: =SUM(B2:D2)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Actual</td>
<td>Budget</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2009</td>
<td>2009</td>
<td>(fn) Difference</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sales</td>
<td>32510</td>
<td>30450</td>
<td>2060</td>
</tr>
</tbody>
</table>

The formula is automatically converted into a local member. When you edit it in the Local Members tab of the Report Editor, you can see that the member is attached to the Period hierarchy.

**Note:**
As you have specified a member range by entering =SUM(B2:D2), the selection is dynamic and if you remove February for example, the sum is updated accordingly. If you had entered =B2+C2+D2, the sum would not be updated accordingly.

- Row or column axis. A formula that gives information about the members in the opposite axis. For example, you want to display the currencies for the entities displayed in the row axis. In cell D2, you enter a formula that includes the EPMMemberProperty formula to return the currency properties for the members.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jan. 2010</td>
<td>Feb. 2010</td>
<td>March 2010</td>
<td>(fn) Quarter 1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sales</td>
<td>2134</td>
<td>2303</td>
<td>2405</td>
<td>6842</td>
</tr>
</tbody>
</table>

The formula is automatically converted into a local member. When you edit it in the Local Members tab of the Report Editor, you can see that the member is attached to the column axis.

- A member. In all other cases, the formula is converted to a local member that is attached to a specific member.

The local member position depends on the options selected in the **User Options: Default Totals to the Top on Row Axis** and **Default Totals to the Left on Column Axis**.
13.4.2 Local Member Creation

In the **Local Members** tab of the **Report Editor**, you can modify the automatically converted local member or you can create a new local member. In this tab, you can perform the following actions:

- Modify or select the item to which the formula is attached.
- Name the local member. The name will appear in the list of local members on the left side.
- Enter a description. The description appears in the report. You can enter a suffix, a prefix and also include the text of the outer member by selecting **Outer Member** in the drop-down list.

**Note:**
When you have entered a formula in cell and you have not entered a text to describe the local member, a default name is generated, beginning with (fn).

- Change the position of the local member, after or before the item to which the formula is attached.
  
  If the item to which the local member is attached is Dimension or Hierarchy (depending on the connection you use), you can also specify a position using the **Insert at Position** drop-down menu.

- Enable or disable a local member by checking the **Enable** option. When a local member is enabled, it is taken into account in the current report.

- When you have finished defining a local member, click **Add**.

In the **Formula** field, you can enter one of the following variables:

- **EPM_MEMBER**, to attach the local member to a specific member.
- **EPM_MEMBER_COMBINATION**, to attach the local member to a combination of members belonging to nested dimensions.
- **EPM_SELECTED_MEMBERS**, to attach the local member to a specific hierarchy or dimension.
- **EPM_DIM_CURRENT_MEMBER**, to attach the local member to the current axis.
- **EPM_POSITION(n)**, to reference a row or column of the report, not a member. For example, if you create a local member on a row axis or column axis that displays context members, when you change the context, the row or column axis will update accordingly and the local member will continue to work.

In this example, in the context, 2007 is selected. As the row axis of the report below contains context members, 2007 periods are displayed.
You create a local member in the dedicated tab with the following formula: 
\[ \text{=EPMPOSITION(1)+EPMPOSITION(2)} \]. The local member will calculate the sum of members that are on the first and the second rows of the report.

You change the context and select 2008. The report is updated accordingly and the local member continues to work.

If you attach this local member to a dimension, as explained above, you can select any member of the dimension and the calculation will be performed. If you attach this local member to an axis, you display members in the axis for any dimension and the calculation will be performed.

- **EPMALLMEMBERS**, to perform a calculation (sum, average, etc.) on all the members displayed in a row or column axis, whether the axis contains one or several dimensions. You create a local member in the dedicated tab and enter a formula like, for example, \[ \text{=SUM(EPMALLMEMBERS)} \] or \[ \text{=AVERAGE(EPMALLMEMBERS)} \] and attach the local member to the columns or the row axis.

**Caution:**
In the formula, if you reference a sheet, the local member is not created. For example: Sheet!C4.

**Note:**
You can also create a local member that inserts a blank row or column to a specific member for example. In the **Local Members** tab, simply enter a name for the local member, select the position where you want to insert the row or column and select the member to which you want to attach the blank row or column, using the ellipsis button. As this local member is attached to another member, it will move along with the member. Note that you can also insert a blank member that behaves like any other member and is not attached to a specific member. For more information, see **Blank Member**.

### 13.5 Renaming Members
For a specific report, you can define the name you want for any member. The name you choose for a member overrides all the other names of the member (caption, description, etc.) coming from the cube or model and available for selection in the Member Selector. Therefore, the customized name is displayed in the report and in the Member Selector. If you delete the customized name, the name chosen in the Member Selector (caption, description, etc.) is displayed again.

In the Member Names tab of the Report Editor, select a dimension, then select the member for which you want to enter a name and click Override.

**Note:**
In the Member Names tab, you can enter a name for each member contained in the cube or model, not only for members currently displayed in the report. Even though you do not use certain members, if you decide to display them later, the customized name will be displayed.

To delete the entered name, select the checkbox corresponding to the name you want to delete and click Delete.

### 13.6 Excluding Members

For a specific report, you can choose not to display specific members.

There are two ways of excluding members:

- You can exclude a member from a report by clicking the Exclude button in the ribbon. The excluding member action is persistent and the excluded members automatically appear in the Excluded Members tab of the Report Editor. If you want to exclude a member and do not want to save this action in the current report, then delete the member row or column, and the member will appear again as soon as you perform a Refresh.

- You can exclude a member or a combination of members using the Excluded Members tab of the Report Editor. Click the ellipsis button, then select a dimension and the member that you want to exclude and click OK. A field is automatically added to enable you to select another member. This way, you can specify a combination of members to exclude. When you have finished selecting the dimensions and members, click Add. The combination of members is added to the list on the left part of the tab.

**Note:**
- The members of a combination are excluded in the report if they belong to the same axis.
- A combination of members must include members that do not belong to the same dimension/hierarchy.

**Related Topics**
- Exclude Member
13.7 Member Insertion Filtering

For a specific report, you can create filters in order to restrict the member selection list when using the Insert Members functionality.

You create the filters in the Member Insertion Filtering tab of the Report Editor. Select a dimension, then click Edit Filter. In the Member Selector that opens, select the members that will be possible to insert in the current report. You can modify the filter by clicking Edit Filter or you can delete it by clicking Remove Filter.

Once you have created a filter on a specific dimension, you will be able to insert in the report the members specified in the filter. For more information on how to insert members, see Member Entry Using the Insert Members Dialog Box.

Note:
Even if the worksheet or workbook is protected, you will be able to insert in the report, the members specified in the filter. For more information on protection, see Worksheet Protection.

Related Topics
- Member Entry Using the Member Selector
Several Reports in a Sheet

You can define several reports in the same sheet, whether the reports are connected to the same cube/model or different ones.

Once a first report has been added to a sheet, the New Report button is enabled. When selecting it, the Report Editor appears.

Before defining the content of the report, you need to connect the report.
- By default, the report is created on the active connection. The active connection is the one selected in the Active Connection drop-down list.
- If you want to create the new report on another connection than the current one, select it from the Active Connection drop-down list. In this list, the connections that are available are the connections that you have connected since you have opened an Excel instance.
- If you want to create the new report on a connection that has not been yet connected, select Select Another Connection from the Active Connection drop-down list. The Connection Manager opens.

The name of the connection the report is using is displayed in the Layout tab of the Report Editor and in the Current Report area of the EPM pane.

Each report has a name. A default name is given to each new report. The first report created in a sheet is named Default Report. You can modify the names of each report in the Name area of the Layout tab of the Report Editor. The names of the report will appear in the dialog box where you can delete the reports.

You can define a shift between the data grid and the row and column axis using the Shift areas. You can enter negative numbers for the row axis only. In this case, the row axis will be positioned on the right side of the data grid. However, restrictions exist when sharing axis.

Sharing Axes
You can share axes between several reports belonging to the same sheet and using the same connection.

You can share the row axis, the column axis or the page axis of another report, using the [...] Axis Shared With drop-down menus.

Note:
The three axes can be shared from three different reports as long as the page axis remains above the two other axes.

When sharing axes, the reports are aligned on the sheet for readability. However, it may not be easy to distinguish the different reports from one another. Use the icon under Current Report in the EPM pane to distinguish them at one glance. When mousing over the icon, a tooltip indicates that clicking the icon highlight the current report.
Any action performed on shared axes (such as expand, collapse) applies to all the reports using the shared axes. The **Current Report** drop-down list in the **EPM** pane enables you to determine which report the selected cell belongs to. You are therefore sure to perform an action in the correct report.

**Related Topics**

- Report Editor's Layout Tab Presentation
- Delete Reports
- Report Highlight
- Connection Management
- Active Connection for the Current Sheet

### 14.1 Restrictions when Several Reports in a Sheet

When a sheet contains several reports, you cannot use the hide empty rows or columns.

Restrictions exist when sharing axes between several reports.

- **Shift** feature: you can enter a negative number for the row axis only in the report that is the owner of its row axis. If the report uses the row axis of another report, the **Shift** feature is not applied.
- Only the report (master report) on which the axes are shared can be moved in the sheet. The other reports that are based on the master report axes are moved along with the master report.
- Adding a dimension on a shared axis. Report 2 shares the row axis of report 1 (master report). When adding a dimension in the column axis of a report 2, report 1 is not moved along. Solution: add a shift of 1 in the column axis of the report 1. Report 2 inherits the shift. A blank row is displayed in report 2 and you can add a dimension on this row.

**Related Topics**

- Empty Row and Column Behavior

### 14.2 Report Highlight

When a sheet contains several reports, you can use the highlight icon below **Current Report** in the pane. When mousing over the icon, a tooltip indicates that clicking the icon highlight the current report. This feature enables you to differentiate reports from one another.

The different areas of the report are highlighted using colors: page axis, row axis, column axis and data grid.

To highlight a report, select a cell belonging to the report you want to highlight and click the icon in the **EPM** pane.
14.3 Delete Reports

You can delete one or more reports from a sheet.

**Note:**
Deleting rows or columns using Excel standard commands does not delete a report from the worksheet.

To delete reports, select **Report Actions > Delete Reports**. The **Delete Reports** dialog box that opens. In the **Delete** column, check the boxes corresponding to the reports you want to delete.

**Note:**
The first report created in the sheet is considered as the default report and it cannot be deleted.

The **Delete Reports** dialog box is composed as follows:

- In the **Default Report** column, the default report is checked. You cannot modify this.
- The **Axis Shared By Reports** column displays information when several reports share the same header in the sheet.
- The **Clear Report Cells** option is selected by default. If you uncheck this option, the reports will still appear but they will be disconnected. For example, unchecking this option can be useful if you do not need to navigate in a report nor to refresh the data, but you want to keep the data. Therefore, this option enables you to keep the report as a simple copy in the sheet.
To populate or refresh your report with the currently connected data source, use the **Refresh** command. The **Refresh** command causes the application to scan the selected report or all the reports for valid reports, formulate and execute the query and then retrieve the data into the corresponding data grid.

You can refresh:

- The selected report.
- All reports in the current worksheet.
- All reports in all sheets of the current workbook.
- The selected data. You can refresh one cell range at a time and all the cells of the range must belong to the same report.

**Note:**
A report is not refreshed with data unless you connect and do a **Refresh**. Therefore you are in full control of when the data is updated and you can ensure that the data has not changed since you last saved the workbook.

The application refreshes hidden rows and columns for valid members that may affect the layout.

When you perform a Refresh, and a report is not connected, the connection dialog box automatically opens.

**Note:**
In the **Report Refresh** area of the **User Options**, you can specify if you want a warning message to pop up when the current report contains more cells than the limit number you have specified.

A refresh of the data source is automatically performed after navigational and layout operations that apply to valid reports:

- Expand
- Collapse
- Keep member
- Exclude member
- Changes in the **Report Editor**
- Selection changes in the page axis

You can deactivate and reactivate the data refresh feature by selecting **EPM > More > Freeze Data Refresh** or by selecting the **Freeze Data Refresh** option in the **EPM > User Options**. Freezing the refresh of data enables you to navigate in a report as you wish and the data is not loaded from the data source. Then, when you are finished navigating in the report, you can activate the refresh again and retrieve the latest data.
**Note:**
When you select **Freeze Data Refresh** from the More menu, it is automatically selected in the **User Options**, and vice versa. Both are synchronized.

**Note:**
You can also freeze the data refresh for a specific report in the **Options** tab of the **Report Editor**.

**Related Topics**
- **Freeze Data Refresh**

## 15.1 Refreshing Reports

1. If you want to refresh the current report and if the current sheet contains several reports, select a cell belonging to the report you want to refresh. If you want to refresh specific data cells, select them.

   **Note:**
   If the current sheet contains only one report, you do not need to select a cell. If the current sheet contains several reports, and if you select a cell that does not belong to any report, the default report will be refreshed.

2. Depending on what you want to refresh, select:
   - **EPM > Refresh > Refresh Selected Report**.
   - **EPM > Refresh > Refresh Worksheet**.
   - **EPM > Refresh > Refresh Workbook**.
   - **EPM > Refresh > Refresh Selected Data**.

   When you click the **Refresh** button (without selecting an option in the drop-down list), the worksheet is refreshed, meaning the reports and the EPM functions.

**Related Topics**
- **EPM Functions**
User Options

You can define options that will apply to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel, Microsoft Office Word or Microsoft Office PowerPoint is closed and reopened.

**Note:**
Some options are only related to features available in Microsoft Office Excel and therefore have no impact when using Microsoft Office Word or Microsoft Office PowerPoint.

The following options are described in other sections of the help documentation. To read explanations about these options, follow the associated links.

The options are organized into three tabs:

- **Navigation** tab:
  - **Enable Double-Click.** See Double-Click Actions.
  - **Expand/Collapse on Single Member.** See Expand on Nested Axis and Collapse on Nested Axis.
  - **Keep/Exclude on Single Member.** See Keep Member, Exclude Member and Asymmetric Report Creation.
  - **Automatic Refresh on Context Changes.** See Context.
  - **Warn if Navigation will Break Dynamic Selection.** See Report Navigation.
  - **Freeze Data Refresh.** See Freeze Data Refresh.

  **Note:**
  When you select Freeze Data Refresh from the More menu, it is automatically selected in the User Options, and vice versa. Both are synchronized.

  - **Activate Metadata Cache and Clear Metadata Cache Frequency.** See Metadata Cache.
  - **Refresh Charts Automatically.** See Dynamic Charts.
  - **EPM Worksheets by default.** See EPM Worksheet.
  - **Keep Rows and Columns of Unrecognized Members.** See Open a Report when Dimensions or Members have Changed.
  - **Rows and Columns of Unrecognized Members Will be Kept.** See Open a Report when Dimensions or Members have Changed.

- **Server Configuration** tab:
  - **SAP BusinessObjects Enterprise Server Name.** Explained in the SAP BusinessObjects EPM Solutions, add-in for Microsoft Office Installation Guide.
  - **SMTP Server Configuration options.** See Workbook Distribution.

- **Others** tab:
  - **Quick Links** options. See Quick Links.
- **Activate Member Recognition by Default** and **Activate Local Member Recognition by Default**. See Member Recognition.
- **Warn if Report Exceeds** option. See Report Refresh.
- **Languages** option. See Languages.
- **Notify me when updates are available** option. See Update.
- **Totals** options. See Totals Placement.
- **Auto Fit Column Width**. See Auto Fit Column Width.
- **Display Context inside EPM Pane**. See Context and Main Interface Areas.
- **Display Local Connections**. See Connection Management.
- **Display Warning when Saving Data or Comment**. See Data Save and Comment Creation and Modification.
- **Display Matrix Security Warning** and **Unauthorized Cell Text**. See Security on Data (Planning and Consolidation, version for SAP NetWeaver).
- **Context Bar and Pane** options. See Main Interface Areas.
Sheet Options

The sheet options apply to the current worksheet.

**Note:**
However, the two following options apply to all the worksheets of the workbook: **Refresh the Whole File when Opening it** and **Clear Data on the Whole File when Saving it**.

For the options that are common to the **Sheet Options** and the **User Options**, the sheet options are initialized by the user options, meaning that the sheet options inherit the user options just once, when you open a blank workbook.

The sheet options apply by default to any report on the sheet.

The sheet options persist for the sheet when the workbook is saved.

**Note:**
The report options are accessible in the **Options** tab of the **Report Editor**.
If you copy a worksheet, then the sheet options will also be copied to the new sheet.
To access the **Sheet Options** dialog box, select **EPM > Options > Sheet Options**.

### 17.1 General Sheet Options

#### 17.1.1 Expand Options

This option controls what scope of member expansion occurs when you perform an expand on a member.

The options are as follows:
- **Member and Children**. This is the default option.
- **Children**
- **Member and Descendants**
- **Descendants**
• **Custom Expand.** When you select Custom Expand, a dialog box opens and you can define the levels you want to display and if you want to include the selected member or not. For example: only level 4, the selected member and down to level 3, etc.

The option you select for the sheet applies by default when you perform an expand on a member in a report. However, using the Expand list in the EPM tab of the ribbon, you can apply another option.

**Related Topics**
• Expand
• Collapse

### 17.1.2 Use as Input Form

**Applies to:**
Planning and Consolidation connections.

If you encounter long loading time when opening reports and if you do not want to use the reports as input forms (to input and save data to the server), you can deselect the Use as Input Form option.

If you want to enter and save data, select the option, then perform a refresh on the sheet. You can then enter data and save them to the server.

**Related Topics**
• Data Save

### 17.1.3 Member Recognition Activation

The Member Recognition and the Local Member Recognition can independantly be activated or deactivated at the user level. Then, you can activate or deactivate them by sheet.

**Related Topics**
• Activating or Deactivating the Member Recognition Options

### 17.1.4 EPM Worksheet
At the user level, you can decide whether all the worksheets are EPM worksheets by default or not. Then, you can activate or deactivate them by sheet.

By default, any worksheet is considered as an EPM worksheet, that is a worksheet that uses one or more connections and on which you can use the EPM add-in features.

You can disconnect a worksheet by deselecting the EPM Worksheet option in the Sheet Options. Consequently, the checkbox corresponding to the current sheet is unchecked in the Report Connections dialog box.

You can re-connect a worksheet at any time by selecting the EPM Worksheet option, or using the Report Connections dialog box.

**Tip:**
Using the Report Connections dialog box, you can connect or disconnect several sheets at the same time.

**Related Topics**
- Selectively connecting or disconnecting one sheet/connection couples

### 17.1.5 Totals Placement

By default, totals are displayed:
- At the bottom on the row axis.
- On the right side on the column axis.

You can change the totals placement for the current sheet in the General tab of the Sheet Options by using the Totals Placement options. The changes will be taken into account by default for any report in the sheet. You can then modify the totals placement for a specific report in the Options tab of the Report Editor.

You can modify the default placement in the User Options.

**Example:**
If the Top and the Left options are selected, the data is displayed as shown below.
If the **Bottom** and the **Right** options are selected, the data is displayed as shown below.

<table>
<thead>
<tr>
<th>Sales - TP-R100</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS Consolidated Amount Product</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Total Products</th>
<th>Period.All</th>
<th>Period.2001</th>
<th>Period.2002</th>
<th>Period.2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Products</td>
<td>64,632,513</td>
<td>3,941,968</td>
<td>7,466,460</td>
<td>53,424,085</td>
</tr>
<tr>
<td>Products.Insurance</td>
<td>5,677,933</td>
<td>5,70,511</td>
<td>690,945</td>
<td>4,416,477</td>
</tr>
<tr>
<td>Insurance Data</td>
<td>4,563,731</td>
<td>434,525</td>
<td>547,542</td>
<td>3,081,664</td>
</tr>
<tr>
<td>Personal</td>
<td>1,114,203</td>
<td>135,986</td>
<td>143,403</td>
<td>834,813</td>
</tr>
<tr>
<td>Products.Finance</td>
<td>19,376,371</td>
<td>9,567,732</td>
<td>2,032,856</td>
<td>16,347,544</td>
</tr>
<tr>
<td>Finance Data</td>
<td>5,229,976</td>
<td>415,110</td>
<td>441,211</td>
<td>4,363,655</td>
</tr>
<tr>
<td>Personal</td>
<td>5,156,396</td>
<td>500,627</td>
<td>1,590,885</td>
<td>11,983,088</td>
</tr>
<tr>
<td>Products.Media</td>
<td>8,232,930</td>
<td>440,726</td>
<td>863,473</td>
<td>7,188,729</td>
</tr>
<tr>
<td>Products.Music</td>
<td>1,647,377</td>
<td>168,329</td>
<td>193,249</td>
<td>1,282,765</td>
</tr>
<tr>
<td>Products.Publishing</td>
<td>2,636,701</td>
<td>220,939</td>
<td>308,039</td>
<td>2,107,003</td>
</tr>
<tr>
<td>Products.IV</td>
<td>3,940,772</td>
<td>50,460</td>
<td>490,150</td>
<td>3,418,162</td>
</tr>
<tr>
<td>Total Products</td>
<td>3,311,776</td>
<td>270,883</td>
<td>418,944</td>
<td>2,621,949</td>
</tr>
<tr>
<td>Drinks Data</td>
<td>2,187,889</td>
<td>17,674</td>
<td>299,423</td>
<td>1,870,793</td>
</tr>
<tr>
<td>Products.Water</td>
<td>468,907</td>
<td>79,247</td>
<td>52,818</td>
<td>336,042</td>
</tr>
<tr>
<td>Products.Wine and spirits</td>
<td>654,979</td>
<td>173,962</td>
<td>66,703</td>
<td>414,314</td>
</tr>
<tr>
<td>Products.Food</td>
<td>27,397</td>
<td>1,571,894</td>
<td>3,241,746</td>
<td>22,583,489</td>
</tr>
<tr>
<td>Products.Fast food</td>
<td>1,362</td>
<td>91,220</td>
<td>99,276</td>
<td>645,076</td>
</tr>
</tbody>
</table>

If the **Bottom** and the **Right** options are selected, the data is displayed as shown below.
17.1.6 Empty Row and Column Behavior

You can select options that deal with rows or columns that contain no data in the reports.

**Note:**

- By default, empty rows and empty columns are kept in the report.
- When empty rows or columns have been inserted using the [Insert Members](#) dialog box, even though you select one the options described below, the empty rows and columns are kept in the report and cannot be hidden either. For more information on the Insert Members feature, see [Member Entry Using the Insert Members Dialog Box](#).
- The settings you define for the sheet applies to all the reports of the sheet. However, you can modify the settings for a specific report in the [Options tab of the Report Editor](#). Note that you cannot hide the empty columns and the empty rows for a report. Only the [Keep](#) and [Remove](#) options are available.
- The [Remove Empty Rows](#) option automatically removes any row in the report that has no data after every operation that refreshes the cube or model. It can be very useful when you expand to lower levels in a sparse portion of the cube or model that has a lot of empty lines.

**Note:**

- In a nested axis, this may result in an asymmetric report.
- The removed rows will not come back even if the missing rows subsequently contain data in the cube or model, for example the next month.
- To avoid confusion, this option cannot be turned on at the same time as the [Hide Empty Rows](#) option below.

- The [Remove Empty Columns](#) option automatically removes any column in the report that has no data after every operation that refreshes the cube or model. It can be very useful when you expand to lower levels in a sparse portion of the cube or model that has a lot of empty columns.

**Note:**

- In a nested axis, this may result in an asymmetric report.
- The removed columns will not come back even if the missing columns subsequently contain data in the cube - for example the next month.
- To avoid confusion, this option cannot be turned on at the same time as the [Hide Empty Columns](#) option below.

- The [Hide Empty Rows](#) option automatically hides any row in the report that has no data and unhides any row that does have data. This is a standard Microsoft Office Excel hide (right-click on a Microsoft Office Excel row header and then the context command [Hide](#)). The rows can be manually unhidden using the regular Microsoft Office Excel commands.

Since the rows are just hidden and therefore still read by the add-in, they will be automatically unhidden if a subsequent Refresh is performed and they now contain data. For example, when you change a page axis member to a different product, region or time period.
This is useful to create more concise and printable reports that have a large percentage of rows that are empty but may vary based on the page axis member selections.

Note:
- When the Hide Empty Rows option is turned off, the add-in will not automatically unhide every row since you may have some rows hidden for other reasons. Therefore, you must explicitly unhide them yourself if you want to display all rows back.
- To avoid confusion, this option cannot be turned on at the same time as the Remove Empty Rows option above.

- The Hide Empty Columns option automatically hides any column in the report that has no data and unhides any column that does have data. This is a standard Microsoft Office Excel hide (right-click on a Microsoft Office Excel column header and then select the context command Hide). The columns can be manually unhidden using the regular Microsoft Office Excel commands.

Since the columns are just hidden and therefore still read by the add-in, they will be automatically unhidden if a subsequent Refresh is performed and they now contain data. For example, when you change a page axis member to a different product, region or time period.

This is useful for creating more concise and printable reports that have a large percentage of empty columns that may vary based on the page axis member selections.

Note:
- When the Hide Empty Columns option is turned off, the add-in will not automatically unhide every column since you may have some columns hidden for other reasons. Therefore, you must manually unhide them if you want to display all columns back.
- To avoid confusion, this option cannot be turned on at the same time as the Remove Empty Columns option above.

Related Topics
- Asymmetric Report Creation

17.1.7 Show as Microsoft Excel Comments

Applies to:
Planning and Consolidation connections.

When you use an EPM function that retrieves a comment, the comment is displayed by default in the cell in which you have entered the function. This Show as Microsoft Excel Comments option enables to display the comment as a standard Microsoft Office Excel comment, when you mouse over the cell.

Related Topics
- Comment Display in a Cell
- EPMCommentFullContext
17.2 Formatting Sheet Options

17.2.1 Row Header Indentation

The **Row Header Indentation** options controls the indentation of child members relative to their parents in the row axis of all the reports of the current sheet.

The options are as follows:
- No Indentation
- Indent Children. This is the default option.
- Indent Parents

Indentation is very useful during ad-hoc navigation as a visual clue to the relationship of members. The indentation is often kept in final reports as well. The indentation is achieved by modifying the indent setting that can be seen in the Microsoft Office Excel menu **Alignment** tab of the **Format Cells** dialog box. It can also be modified using the Microsoft Office Excel increase and decrease indent buttons.

**Note:**
You can specify a different row header indentation for a specific report in the **Options** tab of the **Report Editor**.

17.2.2 Display Name

You can choose the type of member name you want to use in the reports.
- **Caption.** This name is the one that has been defined in the cube or model as the default name.

  **Note:**
  In a report, you can then choose other members names to display as alternatives to the captions. For more information, see **Member Name to Display**.

- **Full Unique Name.** This name is the fully qualified member name, including the dimension and the hierarchy.

Here are some examples from the "FoodMart 2000 Sales cube":

• EPMCommentPartialContext
### 17.2.3 Auto Fit Column Width

When the **Auto Fit Column Width** option is selected, the application automatically changes the width of all columns of the report so that they fit the contents after any refresh operation. This is equivalent to selecting all the columns containing the report and double-clicking on the right boundary of the Microsoft Office Excel column header after each EPM add-in operation. This feature can be beneficial when you are doing ad-hoc analysis.

### 17.2.4 Repeat Row Headers and Repeat Column Headers

In a nested axis, you can repeat all the outer dimension row or column headers so that there are no blank cells in the nested row axis.

To do so, select the **Repeat Row Headers** or **Repeat Column Headers**.

This feature can be beneficial if you subsequently apply Microsoft Office Excel filtering or export the report sheet to a tab or comma delimited file. These two options are not selected by default since reports are more readable without the row headers repeated.

For the following report, the **Repeat Row Headers** is not selected:

<table>
<thead>
<tr>
<th>Caption</th>
<th>Full Unique Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>Gender.All Gender.M</td>
</tr>
<tr>
<td>San Diego</td>
<td>Store.All Stores.USA.CA.San Diego</td>
</tr>
<tr>
<td>Alice Cantrell</td>
<td>Customers.All Customers.USA.CA.Altadena.Alice Cantrell</td>
</tr>
</tbody>
</table>
17.2.5 Empty Cell Default Value

The Empty Cell Default Value is the label that can be displayed in any report cell of the current sheet that has no data.

You are supplied with three choices or you can put in your own value:

• Blank. The cell is left blank.
• 0. The number zero appears in the cell.
• N/A. "N/A" appears in the cell.
• Custom. Type in your own value (e.g. #N/A, #Missing).

Note:

• Empty cells (no data) are not the same as cells with zero in them although they are often best to be treated as zero in calculations.
• You can specify a different empty cell value for a specific report in the Options tab of the Report Editor.

17.2.6 Apply Dynamic Formatting

You can apply a specific dynamic formatting to the current sheet.
To do so, select the **Apply Dynamic Formatting** option. The **Default Formatting Sheet** drop-down menu is made available. Select one of the dynamic formatting sheets you have defined, in order to apply it to the reports of the current sheet.

If the reports you want to apply dynamic formatting to, already contains formatting applied by another add-in than the EPM add-in, you can do as follows:

- Keep the existing formatting and override it with the dynamic formatting. To do so, deselect the **Clear Report Format before Applying Dynamic Formatting** option.
- Clear the existing format so that only the EPM dynamic formatting is applied. To do so, select the **Clear Report Format before Applying Dynamic Formatting** option.

**Note:**
- If the **Apply Dynamic Formatting** option is not available for selection, it means that you first need to display at least the default formatting sheet by clicking **View Formats** in the **EPM** tab of the ribbon.
- You can specify a different dynamic formatting for a specific report in the **Options** tab of the **Report Editor**.

**Related Topics**
- **Dynamic Formatting**

### 17.3 Refresh Sheet Options

#### 17.3.1 Keep Formula on Data and Show Source Data in Comments

You can enter a formula in a cell that already contains data. When you perform a refresh, the formula is removed. If you want that the formulas entered on data remain after a refresh, select the **Keep Formula on Data** option.

**Note:**
The formula are not kept in the following situations:

- When you perform an axis sharing with another report.
- When you change or add dimensions in the different axes.
- When you switch the row and the column axes.
- When you move the row axis on the other side of the data grid using the shift feature in the **Report Editor**.

After a refresh, the data displayed is the result of the formula and not anymore the source data from the cube or model. You can still display the source data as a Microsoft Office Excel comment (that you
can view by mouse over the cell). To do so, select the Show Source Data in Comments option and perform a refresh.

**Note:**
- Once you have displayed the source data in comments, if you uncheck the Show Source Data in Comments option, the comments will still remain in the report. If you want to delete them, do it manually.
- Comments displaying source data take precedence over all other comments in the report.

### 17.3.2 Calculate Parents in Hierarchies

For simulation purposes, you can ask to perform a sum on each parent in the hierarchies included in a report. The data on each parent is replaced by a sum formula. You can then enter data on the children and the sum is calculated on the parent nodes.

To do so, select the Calculate Parents in Hierarchies and perform a refresh.

**Note:**
- A sum is performed on a parent only if all the children of a parent are displayed in the report.
- In a nested axis, the sum is performed on the parents that are placed in the outer and the inner dimension.

**Note:**
You can modify these options for a specific report in the Options tab of the Report Editor.

**Example: example with several dimensions in an axis**

<table>
<thead>
<tr>
<th>EUR - Euro</th>
<th>Financial Accounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>30</td>
</tr>
<tr>
<td>FC00-Opening</td>
<td>10</td>
</tr>
<tr>
<td>FC01 - Net Equity</td>
<td>20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>USD - US Dollar</th>
<th>All</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>60</td>
</tr>
<tr>
<td>FC00-Opening</td>
<td>15</td>
</tr>
<tr>
<td>FC01 - Net Equity</td>
<td>45</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>All</th>
<th>All</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>90</td>
</tr>
<tr>
<td>FC00-Opening</td>
<td>25</td>
</tr>
<tr>
<td>FC01 - Net Equity</td>
<td>65</td>
</tr>
</tbody>
</table>

A sum formula is added on each node of the hierarchies.
17.3.3 Refresh Data on the Whole File when Opening it

You can ask that all the data are refreshed for all the reports contained in the whole workbook, when opening it.

To do so, select EPM > Options > Sheet Options and select Refresh Data on the Whole File when Opening it.

17.3.4 Clear Data on the Whole File when Saving it

You can ask that all the data are cleared from the reports contained in the whole workbook, when saving it.

To do so, select EPM > Options > Sheet Options and select Clear Data on the Whole File when Saving it.

17.3.5 Show Unauthorized Cell Text

 Applies to:
Planning and Consolidation, version for SAP NetWeaver, connections.

If you are using a model on which security on data has been defined, in a report, the cells containing data that you are not authorized to view are left blank by default. To display a text in the report cells, select the Show Unauthorized Cell Text option. The text that is displayed is defined in the Unauthorized Cell Text field in the User Options.

Related Topics
• Security on Data (Planning and Consolidation, version for SAP NetWeaver)
Report Navigation

You can navigate in a report.

**Note:**
When you perform an expand, collapse or keep operation, you can ask that a message warns you that the operation will break the dynamic selection. To ask for a warning message, select the **Warn if Navigation will Break Dynamic Selection** option in the **User Options**. For example, if you select the member Europe with the **Member and Children** relationship, and you perform a keep on one of its children in your report, the message pops up. If you click **OK**, the keep operation is performed but the dynamic selection is broken. Click **Cancel** to cancel the keep operation.

### 18.1 Going Back in the Navigation Actions

The **Back** command will undo up to the five most recent EPM add-in navigation operations that you have performed on your Microsoft Office Excel spreadsheet, your Microsoft Office Word document or your Microsoft Office PowerPoint presentation.

The **Back** command can undo the following navigation operations, even in the case where axes are shared between several reports:

- Expand
- Collapse
- Keep Member
- Exclude Member

**Note:**
The four operations above do not apply to Microsoft Office Word nor to Microsoft Office PowerPoint.

- Entering a member when the Member Recognition is activated.
- Row and column axes switch.
- **EPM** pane changes.
- **Report Editor** changes.
- **Member Selector** changes.
- Refresh data.

The **Back** navigation action can be executed from the ribbon. It will persist (be enabled) on a spreadsheet until you do something else on the same spreadsheet using Excel, or another EPM add-in operation on any spreadsheet. Its purpose is to let you immediately back out of a navigational action, layout change, or refresh of the cube that was done in error or gave you undesirable results.
18.2 Row and Column Axes Switch

You can invert the row and the column axes of a report.

To switch the report axes, click the button located between the Row Axis and Column Axis areas in the EPM pane or right-click in the report and select EPM > Switch Axes.

**Note:**
- A message indicates that if you have defined sorting, ranking or filtering criteria in the report, the criteria will be lost.
- You cannot switch the row and column axes of a report that shares an axis with another report. In this case, the button is deactivated.

18.3 Expand

The **Expand** command on a member selected in a report, drills down to the members below (depending on the expansion relationship behavior chosen) and all occurrences of the same member.

- the children of the selected parent and the parent itself
- the children of the selected parent
- the descendants of the selected parent and the parent itself
- the descendants of the selected parent

You can also define a custom expand. For example: drill down to all members at level 4, or display only members at level 2.

To specify the expansion relationship behavior you want to apply by default, select an option in the **Expand Options** area in EPM > Options > Sheet options > General. The option selected applies by default:

- When you click the Expand button in the EPM tab. However, using the Expand button list, you can select other behaviors, the same as in the sheet options that are listed above.

**Note:**
- When you select Custom Expand, a dialog box opens and you can define the levels you want to display and if you want to include the selected member or not. So that the selection is taken into account, you must select the Apply Custom Expand option.
- Also, if you select the **Enable Double-Click** option in the User Options, the fastest way to perform an expand is to double-click on the member you want to expand on. This allows you to quickly drill down to find what you are looking for.

The expand action automatically does a refresh after it has expanded.
In this example, if you wanted to expand on the USA member in the row axis, you could select the USA cell and then click on the **Expand**, or you could just double-click on the USA cell shown here:

<table>
<thead>
<tr>
<th>Canada</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
</tr>
</tbody>
</table>

This will expand USA into all of its children like this:

<table>
<thead>
<tr>
<th>Canada</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecticut</td>
</tr>
<tr>
<td>Florida</td>
</tr>
<tr>
<td>Massachusetts</td>
</tr>
<tr>
<td>New York State</td>
</tr>
<tr>
<td>Ohio</td>
</tr>
<tr>
<td>Pennsylvania</td>
</tr>
<tr>
<td>Tennessee</td>
</tr>
<tr>
<td>Texas</td>
</tr>
<tr>
<td>USA data</td>
</tr>
<tr>
<td>USA</td>
</tr>
</tbody>
</table>

Note that the children are shown indented above their "total" parent. Indentation is an option. Totals are put at the bottom but you can change them into totals at the top.

**Note:**

- **Expand** will not work on a page axis dimension member since it has no place to expand to.
- When the data sorting, ranking and filtering are activated, the expand works in the column axis only if the following options are selected in the **Expand Options** area in the **Sheet options** dialog box:
  - **Member and Children**
  - **Member and Descendants**

  The Expand does not work in the column axis when the other options are selected.

When the data sorting, ranking and filtering are activated, the Expand never works in the row axis.

When the data sorting, ranking and filtering are activated, the way the Expand works also applies to the Collapse feature.

**Related Topics**

- **Expand Options**

**18.3.1 Expand on Nested Axis**

In a multidimensional (nested) axis, if you expand on an outer dimension, the behavior is the same as in a simple axis. (see example 1)
In a multidimensional (nested) axis, if you expand on an inner dimension, then you can have one of the following behaviors:

- all child members will be repeated for each member of the outer dimension. This is called symmetrical expand. (see example 2)
- only the child member for the selected member of the outer dimension will be displayed. This is called asymmetrical expand. This is the default behavior. (see example 3)

For example if you expand on Chips below to show its children (Regular Chips and Sun Style):

<table>
<thead>
<tr>
<th>Chips</th>
<th>Qtr1</th>
<th>Qtr2</th>
<th>Qtr3</th>
<th>Qtr4</th>
<th>Full Year</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regular Chips</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sun Style</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chips</td>
<td>Qtr1</td>
<td>Qtr2</td>
<td>Qtr3</td>
<td>Qtr4</td>
<td>Full Year</td>
</tr>
</tbody>
</table>

You would get this:

Example 1

The Expand/Collapse on Single Member option in the EPM > Options > User options dialog box enables you to perform asymmetrical expand and out on a nested axis. If you want to perform symmetrical expand and out, uncheck the option.

Note:
This option is not specific to any sheet but applies to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel is closed and reopened.

Using symmetrical mode, if you expand on an inner dimension, then the changes will be applied to all occurrences of this dimension. For example, if you expand on Qtr1 (shown above), you would get the following:

Example 2
The months Jan, Feb and Mar have been added in all places. This saves you from having to repeat the same changes throughout the report layout.

You can also use the asymmetrical expand by selecting the **Expand/Collapse on Single Member option in EPM > Options > User options.**

**Note:**
This user option is not specific to any sheet but applies to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel is closed and reopened.

Using asymmetrical mode, if you expand on an inner dimension, then the changes will be applied only to the selected member cell. For example, if you expand on 'Qtr1' in 'Regular Chips' (shown previously), you would get the following:

**Example 3**

<table>
<thead>
<tr>
<th>Regular Chips</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qtr1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Year</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sun Style</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qtr1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Year</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chips</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qtr1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qtr4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Year</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The months Jan, Feb and Mar have been added only for Regular Chips. This enables you to eliminate unnecessary cells throughout the report layout.

### 18.4 Collapse

The **Collapse** command will:

- Collapse to the parent of the child member selected in the report, when you click the **Collapse** button in the EPM tab of the ribbon.
- Collapse to the selected parent member, when you double-click a parent member.

**Note:**

You can perform a double-click when you select the **Enable Double-Click** option in the **User Options**.

When you perform a collapse, all descendants of the parent of the selected member are removed.

The member you select must be a member that is part of an axis but can be applied to either the row or column axes. The collapse feature enables you to quickly collapse to the top of a hierarchy. Combine that with the expand feature and you can move up and down very easily.

This action automatically does a refresh after it is contracted.

For example, if you want to collapse to the USA member in the row axis, you can select any child of USA (e.g. Florida shown below) and then click on **Collapse**.
This will collapse of Florida (and the rest of the States) to its parent (USA) like this:

<table>
<thead>
<tr>
<th>Canada</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecticu</td>
</tr>
<tr>
<td>Florida</td>
</tr>
<tr>
<td>Massachusetts</td>
</tr>
<tr>
<td>New York State</td>
</tr>
<tr>
<td>Ohio</td>
</tr>
<tr>
<td>Pennsylvania</td>
</tr>
<tr>
<td>Tennessee</td>
</tr>
<tr>
<td>Texas</td>
</tr>
<tr>
<td>USA data</td>
</tr>
<tr>
<td>USA</td>
</tr>
</tbody>
</table>

When the data sorting, ranking and filtering are activated, the Collapse works in column axis only if the following options are selected in the **Expand Options** area in the **Sheet options** dialog box:

- Member and Children
- Member and Descendants

When the data sorting, ranking and filtering are activated, the Collapse does not work in the column axis when the other options are selected.

When the data sorting, ranking and filtering are activated, the Collapse never works in the row axis.

### 18.4.1 Collapse on Nested Axis

In a multidimensional (nested) axis, if you collapse on an outer dimension, the behavior is the same as in a simple axis.

In a multidimensional (nested) axis, if you collapse on an inner dimension, then you can have one of the following behaviors:

- all child members will be removed for each member of the outer dimension. This is called symmetrical collapse. (See example 1)
- only the child member for the selected member of the outer dimension will be removed. This is called asymmetrical Collapse. This is the default behavior. (See example 2)

If you want to perform symmetrical collapse and out, uncheck the **Expand/Collapse on Single Member** option in **EPM > User > User Options**.

**Note:**
This general option is not specific to any sheet but applies to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel is closed and reopened.
If you collapsed on Qtr2 in Sun Style:

<table>
<thead>
<tr>
<th>Regular Chips</th>
<th>Jan</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Feb</td>
</tr>
<tr>
<td></td>
<td>Mar</td>
</tr>
<tr>
<td></td>
<td>Qtr1</td>
</tr>
<tr>
<td></td>
<td>Qtr2</td>
</tr>
<tr>
<td></td>
<td>Qtr3</td>
</tr>
<tr>
<td></td>
<td>Qtr4</td>
</tr>
<tr>
<td></td>
<td>Full Year</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sun Style</th>
<th>Jan</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Feb</td>
</tr>
<tr>
<td></td>
<td>Mar</td>
</tr>
<tr>
<td></td>
<td>Qtr1</td>
</tr>
<tr>
<td></td>
<td>Qtr2</td>
</tr>
<tr>
<td></td>
<td>Qtr3</td>
</tr>
<tr>
<td></td>
<td>Qtr4</td>
</tr>
<tr>
<td></td>
<td>Full Year</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chips</th>
<th>Jan</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Feb</td>
</tr>
<tr>
<td></td>
<td>Mar</td>
</tr>
<tr>
<td></td>
<td>Qtr1</td>
</tr>
<tr>
<td></td>
<td>Qtr2</td>
</tr>
<tr>
<td></td>
<td>Qtr3</td>
</tr>
<tr>
<td></td>
<td>Qtr4</td>
</tr>
<tr>
<td></td>
<td>Full Year</td>
</tr>
</tbody>
</table>

In symmetrical mode, you would end up with this:

**Example 1**

<table>
<thead>
<tr>
<th>Regular Chips</th>
<th>Full Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun Style</td>
<td>Full Year</td>
</tr>
<tr>
<td>Chips</td>
<td>Full Year</td>
</tr>
</tbody>
</table>

Notice that it does not matter which group you select. Also in this example, more than one level has been removed (i.e. the months and the quarters) since you collapsed on a quarter (Qtr2).

You can use the asymmetrical collapse by selecting the **Expand/Collapse on Single Member** option in the dialog box that you can access by selecting **EPM > Options > User options**.

In asymmetrical mode, you would end up with this:

**Example 2**
In this example, only the months and the quarters on Sun Style have been removed, since you asked to collapse on a quarter (Qtr2) in Sun Style.

### 18.5 Keep Member

The **Keep** command will keep all occurrences of the selected members including all occurrences in an inner nested dimension. All other members are excluded. They must be members that are part of an axis, but the Keep can be applied to either the column or row axes.

This action automatically does a Refresh afterwards.

This navigation action can be executed by clicking **Keep** in the EPM tab of the ribbon. This will allow you to quickly keep what you are interested in analyzing further.

For example, if you want to keep Qtr2 and Qtr3 in the row axis, you select both of them (using the *Shift* and/or *Ctrl* keys) and then click on **Keep**.
This will keep only Qtr2 and Qtr3 like this:

```
<table>
<thead>
<tr>
<th>Regular Chips</th>
<th>Qtr2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Qtr3</td>
</tr>
<tr>
<td>Sun Style</td>
<td>Qtr2</td>
</tr>
<tr>
<td></td>
<td>Qtr3</td>
</tr>
<tr>
<td>Chips</td>
<td>Qtr2</td>
</tr>
<tr>
<td></td>
<td>Qtr3</td>
</tr>
</tbody>
</table>
```

Note that it does not matter which occurrence of Qtr2 and Qtr3 you select. Like Expand and Collapse, the Keep gets applied to all occurrences of the selected members in a multidimensional axis - as in the above example. Also the selected members do not need to be adjacent cells, using the Ctrl key, you can select separate ones (e.g. Qtr2 and Full Year).

If you just wanted to keep Qtr2 and Qtr3 in one of the groupings, but leave the rest as is, you can simply delete the unwanted lines using Microsoft Office Excel. You can also select Keep/Exclude on Single Member in EPM > Options > User Options.

**Note:**
This user option is not specific to any sheet but applies to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel is closed and reopened.

**Related Topics**
- Asymmetric Report Creation

### 18.6 Exclude Member

The Exclude command takes away all occurrences of the selected members including all occurrences in an inner nested dimension. All other members are kept. They must be members that are part of an axis but it can be applied to either the row or column axis.

The excluded members automatically appear in the Excluded Members tab of the Report Editor, and the selection is persistent for the current report.

This action automatically does a Refresh afterwards.

This navigation action can be executed by clicking the Exclude button in the EPM tab of the ribbon. This will allow you to quickly exclude what you are not interested in analyzing further which is sometimes easier than doing a Keep.

For example, if you wanted to exclude Qtr1 and Qtr2 in the row axis, you select both of them (using the Shift and/or Ctrl keys) and then click on Exclude.
This will exclude Qtr1 and Qtr2 and leave you with this:

Note that it does not matter which occurrence of Qtr1 and Qtr2 you select. Like Expand and Collapse, the exclude feature gets applied to all occurrences of the selected members in a multidimensional axis - as in the above example. Also the selected members do not need to be adjacent cells. Using the Ctrl key, you can select separate ones (e.g. Qtr2 and Full Year).

If you just wanted to exclude Qtr1 and Qtr2 in one of the blocks, but leave the rest as is, you can simply delete the unwanted lines using Microsoft Office Excel. You can also select EPM > Options > User Options and select the Keep/Exclude on Single Member option.

Note: This user option is not specific to any sheet but applies to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel is closed and reopened.

Related Topics
• Asymmetric Report Creation
• Excluding Members

18.7 Double-Click Actions
The double-click allows you to control whether or not the EPM add-in assumes control over the mouse double-click in Microsoft Office Excel. To enable double-click actions, select **Enable Double-Click** in EPM > Options > User Options.

**Note:**
This user option is not specific to any sheet but applies to any use of the EPM add-in. Changes to this option will persist when Microsoft Office Excel is closed and reopened.

If you are using other functionality or add-ins in Microsoft Office Excel that require the double-click then you should disable this. However, if you enable double-click actions for the EPM add-in, you will have fast access to three very useful features - namely expand, collapse and page axis selection.

**Related Topics**
- Expand
- Collapse
- Page Axis Dimension Members Modification using the Member Selector
**Drill-Through**

**Applies to:**
Planning and Consolidation connections.

The drill-through feature enables you to view information on source data that make up the content of a selected cell in a report in Microsoft Office Excel. Drill-through definitions are previously set up in the Planning and Consolidation Administration view.

There are two types of drill-through: drill-through to URL and drill-through to table.

**Drill-through to URL**

A drill-through to URL enables to display information in a web browser, for any URL and specific parameters that have been specified in the Administration view. For example: a Planning and Consolidation web report; the URL to the SAP BusinessObjects Financial Information Management server (this particular case is called: Drill through to origin); a google page, a BEx report.

As soon as you are connected to a Planning and Consolidation model, if a drill-through to URL has been defined in Planning and Consolidation Administration on this model, a command appears in EPM > Drill Through > Drill Through to URL. The command is named after the description entered in Planning and Consolidation Administration.

To access the drill-through information, select a cell that belongs to the report, then select the command from the ribbon. A web browser opens. The information displayed depends on the following items:

- The URL that has previously been specified in the Administration view.
- The URL parameter(s) that has (have) previously been specified in the Administration view.

**Note:**
The URL and the URL parameters appear in the browser address bar.

- In some cases, the data cell that you have selected in the report.

**Note:**
If the cell you have selected in the worksheet is out of the report, an error message appears.

Example for a google search on the account member description. The drill-through definition has been set up as follows in the Administration view:

- URL: http://www.google.com/search?
- URL parameter 1: member description for the Account dimension. The member description will vary, depending on the cell you will select in the report.
- URL parameter 2: 2010. The time period is hard coded. Even is the report contains data on 2009, the search will be performed on 2010.
In a report:

- when you select a data cell for the Account member "Operating Costs", then select the drill-through to URL command, the web browser opens and the results of the google search on the "Operating+Costs+2010" terms is displayed.
- when you select a data cell for the Account member "Advertising Costs", then select the drill-through to URL command, the web browser opens and the results of the google search on the "Advertising+Costs+2010" terms is displayed.

**Note:**
Even if the selected cell does not contain any data, the drill-through is performed.

**Drill-through to table**

**Applies to:**
Planning and Consolidation, version for the Microsoft platform, connections.

A drill-through to table enables to display information from external databases or the Journals database, for a specific query file and specific properties (called drillkeys) that have been specified on dimensions members in the Administration view. You can choose to display the table either in a web browser or in a Microsoft Office Excel sheet.

As soon as you are connected to a Planning and Consolidation model, if a drill-through to table has been defined in Planning and Consolidation Administration on this model, two commands appear in **EPM > Drill Through > Drill Through to Table**.

To access the drill-through information, select the appropriate cell. Then click one of the two commands in the **Drill Through to Table** command in the ribbon. Depending on the link selected, the drill-through information is displayed in a web browser or in another sheet of the current workbook. The information displayed depends on:

- The drillkey propertie(s) that has (have) previously been specified in the Administration view. A drillkey is defined for one or more members for a specific dimension.
  
  **Note:**
  If several drillkeys have been defined on several dimensions, when you view the drill-through information, a dialog appears and you must select the dimension for which you want to view the information.

- The data cell that you have selected in the report.
  
  **Note:**
  If the cell you have selected in the worksheet does not meet any member for which drillkeys have been defined, a message appears, indicating that no drill-through information is available.

Example for viewing information from an external database on the Actual member of the Category dimension. In the Administration view, the drillkey property has been added to the Actual member of the Category dimension, and the name of a query file has been specified.

In a report:

- when you select a data cell for the Actual member, then select one of the drill-through to table command, the web browser or sheet opens and displays the table for Actual data.
- when you select a data cell for Budget member, then select one of the drill-through to table command, a message appears, indicating that no drill-through information is available.
**Note:**
For more information about drill-through setup, see the SAP BusinessObjects Planning and Consolidation help.
Quick Links

You can create quick links in a report to another report contained in another Microsoft Excel workbook, Word document or PowerPoint presentation. Quick links can be used to guide you through ad-hoc analysis.

You can define three types of quick links, depending on your analysis needs:

- Quick link defined on a specific data. The linked workbook inherits the definition of the selected data cell:
  - members at the cell intersection, meaning the member in the row axis and the member in the column axis (or several members in the case of nested dimensions)
  - members in the context
  - members in the page axis

- Quick link defined on a specific member. The linked workbook inherits the definition of the member cell:
  - the selected member (or several members in the case of nested dimensions)
  - members in the context
  - members in the page axis

- Quick link defined on the current report. The linked workbook inherits the definition of the report:
  - members in the page axis
  - members in the context

**Note:**
As a link is always attached to a combination of members and not a specific cell or cell range, if you move the members in the report, the links follow.

If you have defined a link to another workbook, the linked workbook opens in a new instance of Excel (the latest modification that you have made in the user context in the first workbook are taken into account).

Precedence rules: a quick link defined on a data takes precedence over a link defined on a member, which takes precedence over a link defined on the whole report.

The workbooks to be opened using the quick links can be located on:

- the Planning and Consolidation server
- another location

You can select the workbook location in the **User options** dialog box. If you select the **Planning and Consolidation Server** option, when creating a quick link and specifying the workbook to be opened, the server file selection dialog box opens. If you select the **Local** option, when creating a quick link and specifying the workbook to be opened, the standard file selection dialog box opens.
Symbols with a default color-coding differentiates quick links defined on a specific data and quick links defined on a specific member. You can change the colors in the User options dialog box.

You can hide the quick link symbols by clicking the Show Link Symbols button.

**Note:**
- When the symbols are hidden, the quick links are not active and therefore cannot be clicked on.
- After clicking the Show Link Symbols button, you must perform a refresh.

You can open a linked workbook by clicking a quick link symbol or by clicking the link that appears in the EPM pane. The link that appears in the EPM pane depends on the selected cell in the report since the precedence rules apply.

### 20.1 Creating Quick Links

1. Depending on your analysis needs, select a data cell, a member cell or any cell in your report and click Quick Links in the ribbon, then select one of the following commands: Add Cell Link, Add Member Link or Add Report Link.

   **Note:**
   You can also right-click on a cell and select the appropriate command from the EPM menu.

   The file selection dialog box opens.

   **Note:**
   In the User options dialog box, if you have selected the Planning and Consolidation Server option, the server file selection dialog box opens.

2. Select the workbook you want to link to.

   If the Quick Links > Show Link Symbols command is activated, the following symbols are displayed:
   - For a data link, the symbol — green by default — appear in the selected cell.
   - For a member link — blue by default — appear on the cell of the member selected.

   **Note:**
   If the Quick Links > Show Link Symbols command is not activated, select it and perform a refresh so that the link symbols are displayed in the report.

### 20.2 Deleting Quick Links

- Depending on the type of link you want to delete, select a data cell, a member cell or any cell in your report and click Quick Links, then Delete Data Link, Delete Member Link or Delete Report Link.
**Custom Members**

**Applies to:**
Local and SAP BusinessObjects Enterprise connections.

**Caution:**
Creating custom members may lower the performances of the system.

You can create members for calculations on a specific sheet/connection couple. These members are called "custom members".

Custom members are not stored in the cube/model, they are created only for a sheet/connection and can be shared with other users by sending the sheet.

Custom members have the same behavior as any other member on the sheet.

Custom members enable you to create simple calculations such as differences or relative periods. They also enable you to create MDX queries.

You can either create a custom member in the dedicated dialog box or convert a local member into a custom member.

- **Custom member creation.** Custom members are manually created in the **Custom Member Editor** dialog box, which provides all MDX functions. When you insert a function, the whole syntax is provided. You just need to insert the appropriate parameters inside the quotation marks. You can use a button to insert dimension members. Auto-completion enables you to insert functions, dimensions, hierarchies and dimension members.
  - **Color coding.** Reading formulas is made easier with color coding. MDX functions, dimension members and punctuation characters are displayed in different colors.
  - **Auto-completion.**
    - For MDX functions: enter the first character of a function, then enter Ctrl + Space. A contextual menu automatically appears, displaying the list of MDX functions.
    - For dimensions, hierarchies and dimension members: enter [. A contextual menu automatically appears, displaying the list of elements available, depending on the location in the formula.

**Note:**
A tooltip displays the name of a member used in a formula.

**Restriction:**
When connected to an SAP NetWeaver BW cube, the following custom member features are not supported in the **Expression** area of the **Custom Member Editor** dialog box: auto-completion, color coding and tooltip that displays the name of a member used in a formula.

- **Custom members converted from a local members.** To convert a local member into a custom member, right-click on the local member in the report and select **EPM > Convert to Custom Member.**
**Tip:**
Each time you select several dimension members for a page axis dimension, the total of the members is calculated. If you often use a specific selection of members for a page axis dimension and if you want to reuse it in other reports for the same sheet/connection couple, you can create a custom member.

Not all local members can be converted into custom members. The following functions and operators are supported:
- +, -, *, /
- MIN, MAX, MEDIAN
- COUNT
- SUM, AVERAGE
- abs
- >, <, =
- AND, OR
- IF, ISBLANK

**Note:**
If you change the connection of a report, the EPM add-in will perform the merge of all custom members (from the former and the new connection). If two custom members have the same name, the custom member of the former connection will be deleted.

Once created, a custom member behaves like any other member. It can be displayed in the sheet by selecting it along with other members in the Member Selector dialog box or by entering it completely or partially in a cell (if the Member Recognition is activated, the member is recognized).

A custom member can be deleted but can also be disabled (meaning deactivated) so that it can be enabled and used again.

**Note:**
Limitations:
- You cannot create a local member based on a custom member.
- Custom members are not displayed for selection in the EPM Context pane.

**Related Topics**
- Member Entry Using the Member Selector
- Local Members

### 21.1 Creating custom members

1. Select EPM > Custom Members > Manage Custom Members.
   The EPM - Custom Member Manager dialog box appears.
2. Choose the way you want to display the sheet/connection couples by clicking the **Display by Sheet** or **Display by Connection** button.

3. Select the sheet/connection couple you want to create the custom member for.

4. Click the **Add** button.

   The Custom Member Editor dialog box appears.

5. In the **Name** field, enter a name for the custom member, such as it will appear in the sheet.

6. Click the **Choose Dimension** button.

   The Dimension Selector dialog box opens.

7. Select the dimension for which you want to create the custom member.

8. Click the **OK** button.

9. Back in the Custom Member Editor dialog box, in the **Expression** field, enter the expression that will perform the calculations you want.

   To insert a function, drag and drop an MDX function from the **MDX Functions** section to the **Expression** section.

   **Tip:**
   To display all the MDX functions, check the **Show all functions** option.

   To insert a dimension member inside parameter quotation marks, select the parameter, then click the **Insert Member** button.

   To insert functions, dimensions, hierarchies and dimension members, use the auto-completion function by entering specific characters. See Custom Members.

10. Click the **Check Syntax** button to check if the expression is correct.

   **Tip:**
   To delete the expression, click the **Clear Expression** button.

11. Click the **OK** button.

**Related Topics**

- Custom Members

---

**21.2 Custom Members Order**

When you create more than one custom member, it is very important that you order them according to the calculations order you want.

You can define the order you want by using the arrow buttons on the right-hand side of the Custom Member Manager dialog box, which you can access by selecting EPM > Custom Members > Manage Custom Members.
Example: **Two custom members are created.**

- "Variance", based on the Period dimension, calculates the 2003 variance compared to 2002. The **Custom Member Editor** would appear as follows:
  - **Name**: Variance
  - **Dimension**: Period
  - **Expression**: \([\text{Period}].[\text{All}].[\text{2003}]- [\text{Period}].[\text{All}].[\text{2002}]\)

- "Net profit / Profit b. Tax", based on the Account dimension, calculates the net profit percentage compared to profit before tax. The **Custom Member Editor** would appear as follows:
  - **Name**: Net profit / Profit b. Tax
  - **Dimension**: Accounts
  - **Expression**: \([\text{Accounts}].[\text{All}].[\text{1-PL-Profit and Loss}].[\text{TR800 - Net Profit}]/[\text{Accounts}].[\text{All}].[\text{1-PL-Profit and Loss}].[\text{TR800 - Net Profit}].[\text{TR700 - Group profit before min int}].[\text{TR600 - Prof from ordinary activities}].[\text{TR500 - Profit before tax}]\)

Depending on the order you chose for the custom members, the resulting calculation in the cell at the intersection of the two members is different.

- If you choose the order Variance and then Net Profit/Profit by tax, the result (98%) will be as follows:

<table>
<thead>
<tr>
<th>Accounts</th>
<th>2011</th>
<th>2012</th>
<th>2013</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>36,343,788</td>
<td>300</td>
<td>1,136,650</td>
<td>905</td>
</tr>
<tr>
<td>1-PL - Profit and Loss</td>
<td>85,239,846</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR800 - Net profit</td>
<td>85,239,846</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR700 - Group profit before min int</td>
<td>85,239,846</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR600 - Prof from ordinary activities</td>
<td>84,290,654</td>
<td>2,440,654</td>
<td>8,057,249</td>
<td>73,732,761</td>
</tr>
<tr>
<td>TR500 - Profit before tax</td>
<td>86,005,330</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR410 - Extraordinary items</td>
<td>1,008,161</td>
<td>-59,074</td>
<td>189,123</td>
<td>678,107</td>
</tr>
<tr>
<td>TR710 - Minority interest</td>
<td>98%</td>
<td>94%</td>
<td>100%</td>
<td>98%</td>
</tr>
</tbody>
</table>

- If you choose the order Net Profit/Profit by tax and then Variance, the result (-2%) will be as follows:

<table>
<thead>
<tr>
<th>Accounts</th>
<th>2011</th>
<th>2012</th>
<th>2013</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>36,343,788</td>
<td>300</td>
<td>1,136,650</td>
<td>905</td>
</tr>
<tr>
<td>1-PL - Profit and Loss</td>
<td>85,239,846</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR800 - Net profit</td>
<td>85,239,846</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR700 - Group profit before min int</td>
<td>85,239,846</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR600 - Prof from ordinary activities</td>
<td>84,290,654</td>
<td>2,440,654</td>
<td>8,057,249</td>
<td>73,732,761</td>
</tr>
<tr>
<td>TR500 - Profit before tax</td>
<td>86,005,330</td>
<td>2,391,581</td>
<td>8,246,377</td>
<td>74,610,888</td>
</tr>
<tr>
<td>TR410 - Extraordinary items</td>
<td>1,008,161</td>
<td>-59,074</td>
<td>189,123</td>
<td>678,107</td>
</tr>
<tr>
<td>TR710 - Minority interest</td>
<td>98%</td>
<td>94%</td>
<td>100%</td>
<td>98%</td>
</tr>
</tbody>
</table>

| Net Profit/Profit b tax | 98% | 94% | 100% | 98% | -2% |
21.3 Modifying Custom Members

1. Select EPM > Custom Members > Manage Custom Members. The EPM - Custom Member Manager dialog box appears.
2. Choose the way you want to display the sheet/connection couples by clicking the Display by Sheet or Display by Connection button.
3. Select the sheet/connection couple you want to modify the custom member for.
4. Select the custom member you want to modify.
5. Click the Edit button. The Custom Member Editor dialog box appears.
6. Make the changes you want.
7. Click the OK button.

21.4 Enabling or Disabling all the Custom Members Defined for a Sheet/Connection

1. Select EPM > Custom Members > Manage Custom Members. The EPM - Custom Member Manager dialog box appears.
2. Choose the way you want to display the sheet/connection couples by clicking the Display by Sheet or Display by Connection button.
3. Select the sheet/connection couple you want to enable or disable the custom members for.
4. Choose one of the following:
   • To enable them, click the Enable All button. You will be able to select the custom members in the reports.
   • To disable them, click the Disable All button. You will not be able to select the disabled custom members in the reports. But you may want to enable them again later on.
5. Click the OK button.

21.5 Deleting Custom Members

1. Select EPM > Custom Members > Manage Custom Members. The EPM - Custom Member Manager dialog box appears.
2. Choose how you want to display the sheet/connection couples by clicking the Display by Sheet or Display by Connection button.
3. Select the sheet/connection couple you want to delete the custom members for.
4. Choose one of the following:
   • To delete one specific custom member, select it, then click the Delete button.
   • To delete all the custom members, click the Delete All button.
5. Click the OK button.

### 21.6 Custom Members Export

Custom members can be exported and stored in .xml files.

Once the custom members are stored in a file, they can be imported in other reports. You can also re-use the formula for other purposes.

A dedicated wizard enables you to export custom members. The export can be performed for several EPM sheets and connections at the same time.

- For convenience, the connections, sheets and custom members are displayed in a tree view.
- You can choose the way you want to display them: by sheet or by connection.
- You can use the expand and collapse features.
- You can also display the formulas defined in the custom members, in addition to the custom member names.

#### 21.6.1 Exporting Custom Members

1. Select EPM > Custom Members > Export Custom Members....
   The EPM - Custom Member Export Wizard appears.
2. Choose the way you want to display the sheet/connection couples by clicking the Display by Sheet or Display by Connection button.
   **Tip:**
   • When the dialog box displays a certain amount of items, for more convenience, you can use the menu displaying a + icon, and expand all the items, collapse to the sheet level or collapse to the connection level.
   • You can display the formulas defined in the custom members by clicking the Show Details button.
3. Check the boxes corresponding to the custom members you want to export.
**Tip:**
To select all the members at the same time, click the **Select All** button.

4. Click the **Next** button.
5. In the **File Name** area, enter the path and the name of the file in which you want to export the custom members.
6. Click the **Finish** button.
   A message appears, informing you whether the export has been successful or not.
7. Click the **OK** button.

### 21.7 Custom Members Import

You can import custom members that are stored in an XML file.

Once you have selected from the file the custom members you want to import, you must choose the sheet/connection couples where you want to import the custom members.

A dedicated wizard enables you to import custom members.

The **Source Custom Members** screen of the wizard is the same as for the custom members export. In this screen, you will choose the custom members you want to import.

- For convenience, the connections, sheets and custom members are displayed in a tree view.
- You can choose the way you want to display them, that is by sheet or by connection.
- You can use the expand and collapse features.
- You can also display the formulas defined in the custom members, in addition to the custom member names.

In the next screen of the wizard, **Target Sheets/Connections**, you will choose the sheet/connection couples where you want to import the custom members.

- If the custom members already exist, you can choose to replace them by the one you are importing. To do this, select the **Replace custom members if exist** option.

In the next screen of the wizard, **Syntax Check**, you will see if there are errors on any of the custom members.

Custom members with errors are indicated by a red cross. They will not be imported.

**Tip:**
To only display custom members with errors, click the **Show only errors** button.
21.7.1 Importing Custom Members

1. Select EPM > Custom Members > Import Custom Members....
   The EPM - Custom Member Import Wizard appears.

2. In the File Name area, click the button and select the path and the file containing the custom members you want to import.

3. Click the Next button.
   The next screen of the wizard displays the custom members contained in the file.

4. Choose how you want to display the sheet/connection couples by clicking the Display by Sheet or Display by Connection button.
   **Tip:**
   - When the dialog box displays a certain amount of items, for convenience, you can use the menu displaying a + icon, and expand all the items, collapse to the sheet level or collapse to the connection level.
   - You can display the formulas defined in the custom members by clicking the Show Details button.

5. Check the boxes corresponding to the custom members you want to import.
   **Tip:**
   To select all the members at the same time, click the Select All button.

6. Click the Next button.
   The next screen of the wizard displays the sheet/connection couples where you can import the selected custom members.

7. Check the boxes corresponding to the sheet/connection couples where you can import the selected custom members.

8. If the custom members already exist, you can choose to replace them by the one you are importing by selecting the Replace custom members if exist option.

9. Click the Next button.
   **Tip:**
   To only display custom members with errors, click the Show only errors button.
   The next screen of the wizard displays the status of the custom members. The ones with errors are indicated by a red cross. They will not be imported.

10. Click the Finish button.
    A message appears, informing you whether the import has been successful or not.

11. Click the OK button.
Flash Objects

By inserting Flash objects (files with the .swf extension), you can perform a powerful and graphical analysis of your reports and what-if analysis.

You can design a dashboard and export it in Flash format, in SAP BusinessObjects Dashboard Design. You can then insert the Flash object in a report in Microsoft Office Excel, Word and PowerPoint, using the EPM add-in.

22.1 Flash Object Creation, using EPM Connector

**Applies to:**
Local or SAP BusinessObjects Enterprise connections.

You can design a dashboard and export it to Flash format in SAP BusinessObjects Dashboard Design, using EPM Connector.

EPM connector is a component of the EPM add-in. It is installed as an add-in to SAP BusinessObjects Dashboard Design.

**Note:**
To design a dashboard, you must be familiar with the Dashboard Design application and functionality.

To create a dashboard and export it to Flash format, follow the steps below:

- If you want to retrieve data, create a report using the EPM add-in.
- Create and configure a connection using EPM Connector. It consists in specifying the type of data, inserting the appropriate components in the dashboard and linking the data to the dashboard components.

**Note:**
Only the two points above are explained in this help documentation section.

- Then, you can export the dashboard to Flash.

**Note:**
To export a dashboard to Flash, refer to the user guide of Dashboard Design.

**Related Topics**
- [Flash Object Insertion](#)


22.1.1 Connections and Operations

Connections
Each operation is specified in a connection. All the connections are created on the EPM Connector connection type, in the Data Manager dialog box of the Dashboard Design application. The Data Manager is a centralized location where you can add and configure all external data sources.

You can retrieve data and metadata from any data source listed below into a Dashboard Design toolset:
- SSAS cubes created with SAP BusinessObjects Financial Consolidation, cube designer.
- SAP NetWeaver BW InfoCubes created with SAP BusinessObjects Financial Consolidation, cube designer.
- SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver, models.
- SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform, models.

You can also enter and save data using a Dashboard Design toolset, for:
- SAP BusinessObjects Profitability and Cost Management models.
- SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver, models.

Note:
The Use as Source of Data for External Applications option must be selected for a model in the Administration view to be able to enter data on a model.

- SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform, models.

Creating a connection consists in the following steps:
- Entering a name for the connection.
- Selecting the application you want to connect to.
- Entering the host name.

Then, depending on the operation type you choose, you will configure the connection with different information.

Operations
You can perform the following operations and combine them.
- Retrieve data, using a report created with the EPM add-in.
- Retrieve the list of databases/environments/InfoAreas for a specific data source.
- Retrieve the list of cubes/models/InfoProviders for a specific database/environment/InfoArea.
- Retrieve the list of dimensions for a specific cube/model/InfoProvider.
- Retrieve members/characteristic values for a specific dimension.

The following operation types are only available for SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform and SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver.
- Input and save data.
• Retrieve Business Process Flows.

   **Note:**
   This operation is only available for SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform.

• Retrieve the list of context members.
• Retrieve text contained in a text file from the Documents view.
• Retrieve property values for dimension members.

   **Note:**
   Some terms differ and are listed and separated by the / character (see above), depending on the source.

**Features common to the operations**

• When a drop-down list contains a long list of items, you can enter the beginning of the item you want to select, then press **Enter**. The list is filtered and displays only the items beginning with the characters you have just entered.

• All the drop-down lists identified by a hand icon enables you to select or automatically retrieve items:
  - **Bind**. It enables you to select a cell in the sheet.
  - **Retrieve**. It automatically retrieves a list of items available for selection, depending on other filled in areas. For example, in the **Retrieve Dimension Members** operation, if the **Cube** area is already filled in, you can select **Retrieve** in the **Member** area and all the available dimensions and members specific to this cube are retrieved and available for selection.

• In the **Output** section, you select two refresh options:
  - **Refresh on Load**, to automatically refresh the data before refreshing all the **Dashboard Design** components.
  - **Refresh Every [number] Second**, to set an automatic refresh frequency.

   Some behaviors and areas are common to all the operations

---

**22.1.2 Creating a Connection in Dashboard Design**

1. Select **Data > Connections**.
   The **DataManager** dialog box opens.

2. Click **Add** and select **EPM Connector** from the list.
   The connection created is called by default "Connection [number]".

3. Select the "Connection [number]" created in the connection list.

4. In the **Name** area, enter a name for the connection you are creating.

5. Select the application you want to connect to by selecting it from the **Application** list.

6. In the home icon area, enter the URL to the server:
   - For SSAS cubes, enter the URL to the Data Pump server. The syntax is: `http://hostname/data pumpwebdirectory/msmdpump.dll`
• For SAP BW InfoCubes, enter the URL to the XMLA provider.
• For Planning and Consolidation models, enter the URL to the server. The syntax is:
  http://server:port/ or https://server:port/

**Tip:**
If you often use the same server URL, you can enter the URL in the data sheet. Therefore, in the home icon area, instead of entering the URL, you can click the cell selector button and select the cell in the data sheet. The cell reference will automatically appear in the home icon area.

7. To display the list of all the OLAP server names available, that is all data sources, click Retrieve in the Data Source drop-down list. If asked, enter the user ID and the password to the server and click OK.
   All the available data sources are automatically displayed in the Data Source list. Other elements can be retrieved, depending on the operation type you choose.

8. Configure the connection, depending on the operation type you choose, as described further in this document.

**22.1.3 Retrieve Data Using a Report**

You can create a connection to retrieve data using a report created with the EPM add-in.

**Step 1 - Creating a report**
Before creating the connection, you first need to create a report using the EPM add-in.

In a cell of the sheet that contains the report, enter the following function: =GetReportDefinition()

This function enables to link the default report and the connection. This function identifies the whole report using XML and MDX languages.

Any report identified by the =GetReportDefinition() function must use a local or an SAP BusinessObjects Enterprise connection.

**Note:**
The =GetReportDefinition() function without anything inside the parentheses, identifies the default report. If you create another report on the same sheet, you must enter again the function, including the name of the report inside the parentheses and with quotation marks, as in this example where the report is named sales2008: =GetReportDefinition("sales2008"). If the sheet contains several reports:
• If the name of the report you have entered is not correct, the default report is taken into account.
• If you do not enter the name of the report between the "", the default report is taken into account.

**Step 2 - Creating the connection**
Then, you can create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Select the EPM Report operation.
Then, use the Report Definition cell selector button to select the cell in which you have entered the =GetReportDefinition() function. All the following items for the report are automatically recognized: the name of the report, the database, the cube, members in the context, the page axis, the row axis and the column axis.

**Note:**
The Static Filters section includes the page axis members and the context members.

You can also select other members, including members based on properties, to filter the data to be retrieved. To do so, use the Dynamic Filters cell selector and select a range of cells in the sheet. The range must contain one column containing the IDs and x rows. For example:

<table>
<thead>
<tr>
<th>[Category].[H1].[ACTUAL]</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Category].[H1].[BUDGET]</td>
</tr>
</tbody>
</table>

**Tip:**
You can use the Retrieve Dimension Members operation to retrieve members for a dimension in two columns, one for the names and one for the unique IDs. Then, to select additional members for the EPM Report operation, using the Dynamic Filters cell selector, you can select the column displaying the IDs of members.

If needed, you can also select a cell using the cell selector button in the Message area of the Output section, so that any error message will be displayed.

**Step 3 - Using Dashboard Design components**
Once you have configured the operation, you should use the components that you think are the most appropriate to the final flash object.

**Related Topics**
- Creating a Connection in Dashboard Design
- Retrieve Dimension Members/Characteristic Values

### 22.1.4 Retrieve Databases/Environments/InfoAreas

You can create a connection to retrieve the databases/environments/InfoAreas for a specific OLAP data source.

**Step 1- Creating the connection**
To create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Depending on the application you have selected, select the Retrieve Databases or Retrieve Environments or Retrieve InfoAreas operation.
Select the data source for which you want to display the databases/environments/InfoAreas.

In the Result area of the Output section, use the cell selector button to select a destination cell range. We recommend that you select two columns (the first one for the names and the second one for the unique IDs) and a large amount of rows, so that all the databases/environments/InfoAreas will be displayed.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the Message area, so that any error message will be displayed.

### Step 2 - Using Dashboard Design components

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final Flash object.

Once you have configured the operation, we recommend that you place the appropriate components in the canvas area as follows:

- Grid. In the Properties panel on the right, click the Data cell selector button to select the cells in the spreadsheet that will contain the databases/environments/InfoAreas.
- Input Text Area (if you have selected a cell for messages to be displayed). In the Properties panel on the right, click the Link to Cell cell selector button to select the cell in the spreadsheet that will contain the error message text.
- Connection Refresh Button. In the Properties panel on the right, check the box next to the connection you have created, so that the connection will be refreshed when clicking the Refresh button.

**Related Topics**
- Creating a Connection in Dashboard Design

### 22.1.5 Retrieve Cubes/Models/InfoProviders

You can create a connection to retrieve the cubes/models/InfoProviders for a specific database/environment/InfoArea.

**Step 1- Creating the connection**

To create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Depending on the application you have selected, select the Retrieve Cubes or Retrieve Models or Retrieve InfoProviders operation.

Select the data source, then the database/environment/InfoArea for which you want to display the cubes/models/InfoProviders.
In the **Result** area of the **Output** section, use the cell selector button to select a destination cell range. We recommend that you select two columns (the first one for the names and the second one for the unique IDs) and a large amount of rows, so that all the cubes/models/InfoProviders will be displayed.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the **Message** area, so that any error message will be displayed.

**Step 2 - Using Dashboard Design components**

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the operation, we recommend that you place the appropriate components in the canvas area as follows:

- Grid. In the Properties panel on the right, click the **Data** cell selector button to select the cells in the spreadsheet that will contain the cubes/models/InfoProviders.
- Input Text Area (if you have selected a cell for messages to be displayed). In the Properties panel on the right, click the **Link to Cell** cell selector button to select the cell in the spreadsheet that will contain the error message text.
- Connection Refresh Button. In the Properties panel on the right, check the box next to the EPM connection you have created, so that the connection will be refreshed when clicking the Refresh button.

### 22.1.6 Retrieve Dimensions

You can create a connection to retrieve the dimensions for a specific cube/model/InfoProvider.

**Step 1- Creating the connection**

To create the connection, using the Dashboard Design **Data Manager** dialog box, see [Creating a Connection in Dashboard Design](#).

Select the **Retrieve Dimensions** operation.

Select the data source, then the database/environment/InfoArea, then the cube for which you want to display the dimensions.

In the **Result** area of the **Output** section, use the cell selector button to select a destination cell range. We recommend that you select two columns (the first one for the names and the second one for the unique IDs) and a large amount of rows, so that all the dimensions will be displayed.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.
If needed, you can also select a cell using the cell selector button in the Message area, so that any error message will be displayed.

**Step 2 - Using Dashboard Design components**

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the operation, we recommend that you place the appropriate components in the canvas area as follows:

- Grid. In the Properties panel on the right, click the Data cell selector button to select the cells in the spreadsheet that will contain the dimensions.
- Connection Refresh Button. In the Properties panel on the right, check the box next to the EPM connection you have created, so that the connection will be refreshed when clicking the Refresh button.

**Related Topics**
- Creating a Connection in Dashboard Design

---

**22.1.7 Retrieve Dimension Members/Characteristic Values**

You can create a connection to retrieve the members/characteristic values for a specific dimension.

**Step 1- Creating the connection**

To create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Depending on the application you have selected, select the Retrieve Dimensions or Retrieve Characteristic Values operation.

Select the data source, then the database/environment/InfoArea, then the cube/model/InfoProvider for which you want to display the dimension members/characteristic values.

Then, specify a member/characteristic value by selecting a cell or select Retrieve from the Member drop-down list. A screen opens. Click the cube/model/InfoProvider, then the dimension, then the hierarchy for which you want to display the members/characteristic values, then double-click a member/characteristic value. The member/characteristic value is displayed in the Member area. Select the option corresponding to the members you want to retrieve: only the member selected, the member selected and its ascendants, the member selected and its children, or the member selected and its siblings.

In the Result area of the Output section, use the cell selector button to select a destination cell range. We recommend that you select two columns (the first one for the names and the second one for the unique IDs) and a large amount of rows, so that all the dimension members/characteristic values will be displayed.
**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the Message area, so that any error message will be displayed.

**Step 2 - Using Dashboard Design components**

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the Display dimension members operation type, we recommend that you place the appropriate components in the canvas area as follows:

- Grid. In the Properties panel on the right, click the Data cell selector button to select the cells in the spreadsheet that will contain the dimension members/characteristic values.
- Connection Refresh Button. In the Properties panel on the right, check the box next to the EPM connection you have created, so that the connection will be refreshed when clicking the Refresh button.

**Related Topics**
- Creating a Connection in Dashboard Design

### 22.1.8 Input Data

**Applies to:**
SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform and SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver.

You can create a connection to enter data on specific members.

**Step 1- Creating the connection**

To create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Select the Input Data operation.

Select the data source, then the environment, then the model for which you want to enter data.

In the Cell Definition area:
- Static definition: use the menu and select Retrieve to retrieve the the list of dimensions. Then click the ellipsis button and select a member for each dimension. The member you select must a base member, not a node. To select a member, double-click on it.
- Dynamic definition: use the menu and select Bind to reference a cell range in the worksheet. The range you reference must contain 4 columns that will contain: the dimension name, the dimension unique ID, the member name, the member unique ID. You can retrieve dimensions and dimension
members by using the appropriate operations. See Retrieve Dimensions and Retrieve Dimension Members/Characteristic Values.

In the Cell Value area:

- You can retrieve the data that exist on the server for the specified members. To do so, select Retrieve from the menu.
- You can reference another cell from which the data will be taken from. To do so, select Bind from the menu.
- You can enter the data you want for the specified members. It will then be saved to the server.

In the Result area of the Output section, use the cell selector button to select a destination cell range. Select one cell.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the Message area, so that any error message will be displayed.

**Step 2 - Using Dashboard Design components**

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the operation type, we recommend that you place the appropriate components in the canvas area as follows:

- Grid. In the Properties panel on the right, click the Data cell selector button to select the cells in the spreadsheet that will contain the page axis dimensions.
- Input Text. In the Properties panel on the right, click the Link to Cell cell selector button and select the first cell of the data grid.
- Connection Refresh Button. In the Properties panel on the right, check the box next to the EPM connection you have created, so that the data will be sent when clicking the Refresh button.

**Note:**

- All data will be saved to the server, even if no changes are made.
- You should not check the Refresh On Load option of the Connection Refresh button because unexpected data might be saved.
- In the Label area, “Refresh” appears by default. You can rename the button to “Save” for example.

### 22.1.9 Retrieve Business Process Flows

**Applies to:**
SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform.

You can create an connection to be able to retrieve the Business Process Flows.
Step 1 - Creating the connection
To create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Select the Retrieve Business Process Flows operation.

Select the data source, then the environment, then the model, then the BPF model and the context for which you want to retrieve the business process flows.

**Tip:**
You can bind the context area with the cells resulting from the Retrieve Context operation.

Then, select the Business Process Flow properties you want to display by checking the boxes in the Details area.

In the Result area of the Output section, use the cell selector button to select a destination cell range. We recommend that you select as many columns as the number of details checked, and a large amount of rows so that all the Business Process Flows will be displayed.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the Message area, so that any error message will be displayed.

Step 2 - Using Dashboard Design components
**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the operation type, we recommend that you place the appropriate components in the canvas area as follows:

- Grid. In the Properties panel on the right, click the Data cell selector button to select the cells in the spreadsheet that will contain the Business Process Flows.
- Connection Refresh Button. In the Properties panel on the right, check the box next to the EPM connection you have created, so that the connection will be refreshed when clicking the Refresh button.

22.1.10 Retrieve Context

**Applies to:**
SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform and SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver.

You can create a connection to retrieve the web context members for a specific model.
**Step 1 - Creating the connection**

To create the connection, using the Dashboard Design **Data Manager** dialog box, see [Creating a Connection in Dashboard Design](#).

Select the **Retrieve Context** operation.

Select the data source, then the environment, then the model for which you want to retrieve the context members.

In the **Result** area of the **Output** section, use the cell selector button to select a destination cell range. We recommend that you select three columns (for the dimension name, the member name, the member unique ID) and a large amount of rows, so that all the members will be retrieved. The members that are retrieved are the members defined as default members.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the **Message** area, so that any error message will be displayed.

**Step 2 - Using Dashboard Design components**

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the operation type, we recommend that you place the appropriate components in the canvas area as follows:

- **Grid.** In the Properties panel on the right, click the **Data** cell selector button to select the cells in the spreadsheet that will contain the context members.
- **Input Text Area** (if you have selected a cell for messages to be displayed). In the Properties panel on the right, click the **Link to Cell** cell selector button to select the cell in the spreadsheet that will contain the error message text.
- **Connection Refresh Button.** In the Properties panel on the right, check the box next to the EPM connection you have created, so that the connection will be refreshed when clicking the Refresh button.

---

### 22.1.11 Retrieve Text From Documents View

**Applies to:**
SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform and SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver.

You can create a connection to retrieve the text contained in a file stored in the Documents view.

**Note:**
- The file must have the .txt extension.
• For SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver, you can only display Unicode type text (UTF-8).

**Step 1- Creating the connection**

To create the connection, using the Dashboard Design **Data Manager** dialog box, see [Creating a Connection in Dashboard Design](#).

Select the **Retrieve Text From Documents View** operation.

Select the data source, then the environment, then the model for which you want to retrieve text.

Click in the **File** area: the list of files for the model is displayed. Select a file.

In the **Result** area of the **Output** section, use the cell selector button to select a destination cell range. Select one cell.

**Tip:**
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the **Message** area, so that any error message will be displayed.

**Step 2 - Using Dashboard Design components**

**Note:**
In this section, the components we recommend are only suggestions. You should use the components that you think are the most appropriate to the final flash object.

Once you have configured the operation type, we recommend that you place the appropriate component in the canvas area as follows:

• **Input Text Area.** In the Properties panel on the right, click the **Link to Cell** cell selector button to select the cell in the spreadsheet that will contain the text of the selected file.

• **Connection Refresh Button.** In the Properties panel on the right, check the box next to the EPM connection you have created, so that the connection will be refreshed when clicking the Refresh button.

### 22.1.12 Retrieve Members Property Values

**Applies to:**
SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform and SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver.

You can create a connection to retrieve the values of a specific property for the members of a specific dimension.

For example, you want to retrieve the members that are calculated and the members for which you can enter data, using the **CALC** property.
Creating the connection

To create the connection, using the Dashboard Design Data Manager dialog box, see Creating a Connection in Dashboard Design.

Select the Retrieve Members Property Values operation.

Select the data source, then the environment, then the model for which you want to retrieve property values.

Then, select a dimension, a property and one or more members for the selected dimension. To select members, click in the Members area. In the list of members, double-click on a member: the member is displayed in the bottom part of the window. If you want to remove a member from the selection, double-click on the member in the bottom part of the window.

In the Result area of the Output section, use the cell selector button to select a destination cell range. We recommend that you select three columns (for the member unique ID, the member name, the property value), and as many rows as the number of members you have selected.

Tip:
Apply a color to the selected cells so that you can spot them easily afterwards.

If needed, you can also select a cell using the cell selector button in the Message area, so that any error message will be displayed.

22.2 Flash Object Insertion

You can then insert a Flash object in a report.

Note:
Of course, you should know the report on which you have created the Flash object and the report for which you want to insert the Flash object. They should have a similar structure.

An inserted Flash object takes into account the active connection and the context dimensions. For example, if you change a dimension member in the context, the Flash object updates accordingly to the report.

To manage Flash objects, select EPM > More > Flash Objects. In the Flash Object Manager, you can perform the following actions:

- Insert a Flash object. Click Add and select the Flash object you want to insert in your report. You can also enter a name for the object.
- Rename the Flash object by pressing F2.
- Remove the selected Flash object from the sheet by clicking Remove.
- Remove all the Flash objects from the sheet by clicking Remove all.

You can move a Flash object in the report and resize it to make it bigger or smaller. To do so, you need to display the Developer tab and activate the Design Mode in Microsoft Office Excel or Microsoft Office Word (the design mode is native in Microsoft Office PowerPoint). You can move or resize the Flash object as needed.
**Note:**
The following functions are not supported: nested dimensions in a row or column axis, data sorting, data ranking and data filtering.

**Related Topics**
- [Flash Object Creation, using EPM Connector](#)
Microsoft Office Excel enables you to insert charts. A chart will automatically reflect the changes in the report's data range.

**Note:**
- When adding a blank row or column, the Legend entries (Series) of the chart are not automatically refreshed.
- Only two-axis charts are automatically refreshed.

So that the charts are dynamically refreshed when performing actions in the report, such as expand or collapse, select the **Refresh Charts Automatically** in Options > **User Options**.
Dynamic Formatting

You can define specific dynamic formatting in a template to apply to sheets or reports you want.

Dynamic formatting is defined in dedicated sheets. A default template is provided with the add-in. You can create additional template sheets by copying the default sheet as you would copy a standard Microsoft Office Excel worksheet.

Tip:
As a dynamic formatting sheet is a standard Microsoft Office Excel sheet, you can copy and/or move the sheet to another Microsoft Office Excel workbook.

On each template, you can define a specific format (for example: font, color, size) for levels of a hierarchy, types of members, odd/even rows or columns and page axis dimensions.

24.1 Dynamic Formatting Template Definition

Dynamic formatting is defined in a dedicated sheet. A specific format (font, color, size, etc.) can be defined for levels of a hierarchy, types of members, odd/even rows or columns and page axis dimensions.

Precedence rules

- If you check more than one formatting section, the format settings in lower sections override the ones in upper sections in case of conflicts (for example: inconsistency between a member format and a level format).
- Inside each section, if you check several Apply checkboxes, the format settings are applied from the lowest area to the upper area.

Common actions to several formatting sections

- Check boxes. Check boxes enable you to specify the formatting sections (for example Hierarchy Level Formatting section) or formatting items inside a section (for example Base Level Format) that you want to apply to the reports.
- Priority to column or row format. These options enable you to specify which one of the defined formats for rows or for columns will be applied first in case of conflicts. When you click the Priority to Column option, the Column section is displayed first in the formatting section and the Row section is displayed in second position in the formatting section and the precedence rules apply.
- Formatting. You can define the format you want by using the standard Microsoft Office Excel cell formatting features in the 1000 and Label cells. By default, all the format settings are applied and ALL is displayed in the Use column. You can then specify which settings of the defined format you
want to apply, or define additional settings. To do so, directly enter the format settings in a **Use** cell, using a specific syntax - for example: (FontBold = Y) | (FontSize = 18), or double-click a **Use** cell and define the format settings in the dialog box that opens. In the dialog box, all the format items that you can override are displayed in red. Select one of them, click the **Override Selected Item** option, enter the format and click **Override**. So that no format is applied, leave the **Use** cell blank, or double-click the **Use** cell and select **None** in the dialog box.

- **Cell Protection.** The dynamic formatting sheet is locked. However, you can unlock (and re-lock again) cells on which you define formats. Right-click one or more cells and select **EPM > Unlock Selected Cells** or **EPM > Lock Selected Cells**.

**Hierarchy Level Formatting section**

This section enables you to define the formatting of levels of hierarchies.

**Note:**

In this particular section, the precedence rule is as follows: **Base Level Format**, then **Formatting on Specific Level**, then **Default Format**.

Actions specific to the **Hierarchy Level Formatting** section:

- **Apply Format to** option: If a row or column axis contains more than one dimension, you can specify which dimension you want the defined format to be applied to; the inner dimension being the last dimension, the outer dimension being the first dimension in the axis.
- In the **Default Format** area, you can define a default format for hierarchy levels.
- In the **Base Level Format** area, you can define a specific format for base level members, that is members that are not nodes and not calculated.
- You can define a formatting on specific levels. To add a new level, click on **Add New Level**. To remove a level, click on **Remove Last Level**.
  - By default, Level 1, Level 2, etc are the hierarchy levels just like they are defined in the structure of the source connection. The corresponding option is **Structure Levels**.
  - However, you can define format settings for the levels that will be displayed in the reports. To do so, use the **Relative Levels** option. For example, Country is the second level of the geographical hierarchy in the structure, but it is the first level that is displayed in a report.

**Note:**

When you select the **Relative Levels** option, the **Start formatting from the lowest level displayed** option is displayed. This option enables you to invert the level order, the lowest level is displayed in first position.

**Dimension Member/Property Formatting section**

This section enables you to define and apply the formatting defined to the following types of members:

- Custom members, calculated members, local members, when using any connection.
- Also Inputable members and changed members, when using a Planning and Consolidation connection.

**Note:**

An inputable member is a member on which you can enter data. A changed member is an inputable member on which you have already entered data but not yet saved it.

You can also define a specific formatting:
• on a specific member, property or local member: To do so, click the Add Member/Property cell and perform your selection in the Select Member/Property dialog box.

**Note:**
In the Local Member Selection tab, the name you must enter is the name of the local member as it appears in the Local Members tab of the Report Editor, or, for a grouping local member, as you have named it in the Member Sorting & Grouping area of the Member Selector.

• on a multiple item selection, that is a combination of any of these items: members, properties, local members. To do so, click the Add Member/Property cell and perform your selection in the Select Member/Property dialog box. In the first three tabs, the Add to Multiple Selection button enables you to add a member, a property or a local member (depending on the tab you are in) to the multiple selection. The item is automatically added to the Multiple Selection Overview tab.

**Caution:**
To validate your multiple selection, you must select the Multiple Selection Overview tab and click OK. If you click OK in one of the three other tabs, the multiple selection will not be taken into account.

**Tip:**
To remove an item from the selection in the Multiple Selection Overview tab, right-click in the tab and select Remove Selected Item(s).

**Example:**
You want to define a specific format for any data at the intersection of Actual and 2010 Total. Click the Add Member/Property. In the Member Selection tab, select Actual and click Add to Multiple Selection. Then, select 2010 Total and click Add to Multiple Selection. Select the Multiple Selection Overview tab and click OK. A new row is added to the formatting sheet, displaying: Actual||2010 Total. Define the format you want for the data.

To remove a member or property from the formatting sheet, click on the Remove cell.

**Row and Column Banding section**
This section enables you to choose one or two alternating format, that will be applied to data or headers or both. The chosen format in Odd Formatting and Even Formatting will alternate in rows or columns.

**Page Axis Formatting section**
This section enables you to define the formatting for all the dimensions of the page axis. You can also define formatting settings on specific dimensions that are part of the page axis, using the Add Dimension button.

### 24.1.1 Defining a Dynamic Formatting Template

1. Select EPM > View Formats.
   The dynamic formatting sheet appears. The sheet is called EPMFormattingSheet.
2. Define the format you want.
Related Topics
  • Dynamic Formatting Template Definition

24.2 Dynamic Formatting Applied to a Worksheet or to a Specific Report

You can apply a dynamic formatting template to:
  • the current worksheet. The chosen dynamic formatting template applies by default to all the reports created in the worksheet.
  • a specific report. If a default template has been selected for the worksheet, you can however choose another template to apply to a specific report. Also, if a sheet contains several reports, you can apply a dynamic formatting template by report.

If you modify a dynamic format which has already been applied to a specific worksheet, you will need to refresh the report to which you applied the dynamic formatting.

If the reports you want to apply dynamic formatting to, already contain formatting applied by another add-in than the EPM add-in, you can whether keep the existing formatting and override it with the dynamic formatting or simply clear the existing format and only apply the dynamic formatting.

24.2.1 Applying a Default Dynamic Formatting Template to the Worksheet

1. Select EPM > Options > Sheet Options
   The Sheet Options dialog box opens.
2. Select the Formatting tab.
3. Select the Apply Dynamic Formatting option.
4. Select the template you want to apply to the worksheet from the Default Formatting Sheet list.
5. If the reports you want to apply dynamic formatting to, already contain formatting applied by another add-in than the EPM add-in, do one of the following actions:
   • To keep the existing formatting and override it with the dynamic formatting, deselect the Clear report format before applying dynamic formatting option.
   • To clear the existing format so that only the EPM dynamic formatting is applied, select the the Clear report format before applying dynamic formatting option.
6. Click OK.

By default, the selected template applies to all reports in the worksheet.

To display the formatting on your report, refresh the report.
24.2.2 Applying a Default Dynamic Formatting Template to a report

1. Select a cell in the report to which you want to apply a dynamic formatting template.
   The Report Editor opens.
3. Select the Options tab.
   If a default dynamic formatting template has been selected for the whole workbook in the Sheet Options, then the Apply Dynamic Formatting option is already checked.
4. Select the template you want to apply.
5. If the report you want to apply dynamic formatting to, already contains formatting applied by another add-in than the EPM add-in, do one of the following actions:
   • To keep the existing formatting and override it with the dynamic formatting, deselect the Clear report format before applying dynamic formatting option.
   • To clear the existing format so that only the EPM dynamic formatting is applied, select the Clear report format before applying dynamic formatting option.
6. Click OK.
Workbook Sheets' Automatic Generation

You can ask to automatically generate several reports in several sheets within the current workbook, based on an existing report contained in a sheet.

This feature helps you creating quickly several worksheets inside a single workbook, based on a specific report but including variable dimension members, and it saves you from having to create several reports for different dimension members.

**Note:**
Each sheet is automatically named with the dimension member combinations, including the first sheet containing the initial report.

To automatically generate several sheets in the current workbook, you first need to create a report. Then, select **EPM > Report Actions > Worksheet Generation**. The **Worksheet Generation** dialog box opens. Select the dimension, then click **Select Members** and select the members you want for the dimension. If needed, repeat the selection for the other dimensions.

**Note:**
The number of selected members for all dimensions is displayed. Each time you select an additional member, the number is updated.

Each automatically created sheet displays the initial report, however with different dimension members: the members you have selected. The dimensions for which you have selected members are automatically locked in the context bar on each worksheet. You can then unlock the dimension. For more information about the context lock, see **Context**.

**Example: Creating as many reports as quarters**
For the year 2009, you want to create one sheet per quarter. Create a report that meets your needs. Select **EPM > Report Actions > Worksheet Generation**. In the dialog box that opens, select the Period dimension, then select the four quarters and click **OK**. Four sheets are automatically created in the current workbook. Each one contains the same report, except for the period members. The first sheet contains the report displaying data for quarter 1 of 2009; the second sheet contains the report displaying data for quarter 2 of 2009, etc.
Offline Mode

You can make the current workbook an offline workbook so any user can read it even the users that do not have the EPM add-in installed. When offline, a workbook behaves like a standard Microsoft Office Excel workbook.

To switch to offline mode, select EPM > Offline Mode. The context bar and the pane are automatically hidden. You can make your workbook available to any user.

Note:
This feature is used in an automatic way when distributing reports.

Related Topics
• Workbook Distribution
Worksheet Protection

To prevent a user from accidentally or deliberately changing, moving, or deleting important elements of the report, you can protect the current worksheet or the whole workbook with a password.

**Note:**
- Even if a worksheet or workbook is protected, you may be able to insert certain members in the report, provided that member insertion filters have been defined. For more information on how to insert members, see [Member Entry Using the Insert Members Dialog Box](#).
- If you protect a worksheet containing reports in which a user will enter data, all the cells of the report are locked, except for the inputable member cells.

To specify if you want to protect the sheet or the workbook, and to enter a password, select **EPM > Options > Sheet Options**, then select the **Protection** tab.

**Tip:**
Make sure that you choose a password that is easy to remember, because if you lose the password, you cannot gain access to the protected worksheet or workbook.

To unprotect a worksheet or workbook, select **EPM > Options > Sheet Options**. A message pops up in which you can enter the protection password. In the **Protection** tab of the **Sheet Options**, select **No Protection**.

**Note:**
The Excel sheet protection always overrides the EPM add-in sheet protection. You can unprotect a sheet using the Excel feature or the EPM add-in feature. However, to protect a sheet, you must use the EPM add-in feature.
Collaboration

There are different ways to make the reports available to other users.

- You can publish all the reports as they are on two web portals:
  - The BI launch pad, that is the web portal of SAP BusinessObjects Enterprise.
  - The SAP BusinessObjects Planning and Consolidation Documents view.
- You can publish automatically generated books based on a selection of variable members. At one time, you can export all the books to PDF format or print them. You can schedule the publication.
- You can distribute automatically generated reports based on a selection of variable members. At one time, you can make all the workbooks containing reports available to users by sending the workbooks by email or by storing the workbooks on a specific location to which users can access to. You can schedule the distribution.

28.1 Report Publication to a Web Portal

You can publish all the reports of a workbook on two web portals:

- The BI launch pad, that is the web portal of SAP BusinessObjects Enterprise.
- The SAP BusinessObjects Planning and Consolidation Documents view.

Publish Reports to BI launch pad

Applies to:
SAP BusinessObjects Enterprise connections.

The published reports will be available on the BI launch pad to users who have the necessary access rights.

Note:
You cannot publish reports on the BI launch pad:

- If you are using the EPM add-in in standalone mode.
- If you do not have the Publish right set in the Central Management Console for the EPM connection manager. For more information about rights, see the SAP BusinessObjects Financial Consolidation Security Guide.

To publish a workbook containing reports, select EPM > Portal Publication > Publish to BI launch pad. The dialog box that opens displays the folders that exist in the BI launch pad. The four buttons on the left part of the dialog box enable you to perform the following actions:

- Refresh the BI launch pad folders’ tree.
- Create a new folder in the BI launch pad.
- Rename an existing folder in the BI launch pad.
- Delete a folder from BI launch pad.

You can search for a specific folder by selecting a search criteria from the drop-down menu and by clicking the Search button.

The Description field enables you to enter a description for the workbook. The description will appear along with the workbook in the BI launch pad.

**Note:**
In the BI launch pad, you can add your comments on each workbook in the dedicated Discussions area. All the comments are historized.

**Publish reports to Planning and Consolidation Documents View**

**Applies to:**
Planning and Consolidation connections.

To publish a workbook containing reports, select EPM > Portal Publication > Open Planning and Consolidation Documents View. The Planning and Consolidation web client opens, displaying the Documents view. You can then, publish a report by using the web client dedicated features. For more information, see the SAP BusinessObjects Planning and Consolidation Help.

### 28.2 Publication and Distribution Connection

Both publication and distribution are performed on one specific connection.

The connection on which publication and distribution actions are performed is the first connection you have used in the workbook.

If you use more than one connections in the workbook, the first connection will still be used by default. For this reason, as soon as you use more than one connection, specify the connection on which you want to perform publication or distribution actions. If you want to perform publication or distribution actions on a different connection than the first one, select EPM > Book Publication > Change Connection or EPM > Distribution > Change Connection.

### 28.2.1 Book Publication

Using a template, you can generate books (that is static reports), based on:
- one or more reports,
- one or more variable members for one or more dimensions.
Each automatically created book displays the initial report(s), however with a different dimension member (or a combination of dimension members) of the dimension(s) for which variable dimension members have been defined.

Then, at one time, you can export all the generated books to PDF format or you can print them. You can launch the book publication or you can schedule it (for example, every Friday at 11:00 PM).

28.2.1.1 Book Publication Template

Before launching a book publication, you must create a book publication template in which you specify the information you want to include in the books, including specific settings on dimension members.

Note:
Choose carefully the names you enter for the publication template, the section(s) and the report workbook description(s) as they will appear as the names of the folders if you then choose to generate the books in PDF format.

• You should not use the following characters as they will be changed into the _ character in the folders and book names: \ / : * " < > | & + = ( ) { } [ ] $ %
• You should not enter a space at the beginning and the end of the names.
• Also, a section name and a workbook description must be unique within a template. If not, you cannot save the template.

Book Publication Template for a Local or SAP BusinessObjects Enterprise Connection

The creation or modification of a template consists of the following steps:

• Enter a name for the template.
• Section definition. A template can include one or several sections. A section is a part of the template. Each section includes at least a selection of variable dimension members. When launching the report generation, you will be able to select the section(s) of the template you want to take into account.

Note:
The tab of a section has no name until you enter it in the Section Name area.

• Enter a name for the section. The entered name is displayed on the section tab.
• Report workbook selection. Select the workbook containing the reports you want to generate using the current template.

Note:
The workbooks you select must contain reports that have the same connection than the template.

• Enter a description for the workbook you have selected.
• Dimension member selection:
  • One or more dimensions for which one or several members are variable. For a specific dimension, the members selected as variable will override the members if the dimension is displayed in the page axis or in the context of the report. Besides, one report will be created by member selected.
• One or more dimensions for which only one member is fixed. This is optional. A fixed member overrides any other member of the same dimension that is part of the report in the context or the page axis. For example, if you select the period 2009 as a fixed member and the period 2008 is displayed in the page axis of the report, 2009 will be taken into account.

**Note:**

• A suppressed member behaves exactly like a fixed member, but this feature remains for historical reasons.
• You cannot select fixed, suppressed and variable members for one dimension. All of them are mutually exclusive.

In the published reports, the members will be displayed according to the following precedence rule:

1. members in the row and column axes.
2. members selected as fixed members or as variable members in the publication template.
3. members in the page axis.
4. members in the context.

**Note:**

The template is saved as an .xltx file, by default to the following local folder: C:\Documents and Settings\[UserWindows]\My Documents\PC_LOC\[login]\books\[appset]\[application]\[team or localTeam]\WebExcel\ManageBook

Other actions available on a template:

• You can open an existing template, modify it and save it with a different name by selecting EPM > Book Publication > Open Template.

**Note:**

If a report workbook specified in the template does not contain valid reports, the template opens but the report workbook area is empty. If you want to save your template, you need to specify another workbook that contains valid reports.

• You can create a new section or a section based on existing one. You can also delete a section from the template. These actions are available in the template dialog box, under the section tab.

**Book Publication Template for a Planning and Consolidation connection**

The creation or modification of a template consists of the following steps:

• Enter a name for the template.

• When modifying a template, if you intend to generate the reports in PDF format, you can select an option in the **Add/Replace** drop-down menu. These options enable you to replace or add sections to a template based on the selected variable members. You can choose:

  • **Add**, to add new books (with different member combinations) to the current template. This means that new PDFs are created and the former ones remain. This option applies to all the sections of the template.

  • **Replace**, to replace books of the existing template with new books. This means that if a specified member combination is found, it overwrites the existing section. Therefore, the existing PDF files with the initial variable member selection are deleted on the server and replaced by the ones
generated from the latest variable member selection. This option applies to all the sections of the template.

**Note:**
When you create a new template, you must select Replace.

- **Specify by Section.** Select this option if you want to specify the Add or Replace settings by section, and not for the whole template.

- The **Variable Time** field is displayed. If no member is selected for the Time dimension in a section of the template as a variable or fixed member, the time member selected here applies to all the sections of the template and is hard coded. If you select a Time member in a section, it overrides the member selected in the **Variable Time** field for this section.

- Section definition. A template can include one or several sections. A section is a part of the template. Each section includes at least a selection of variable dimension members. When launching the report generation, you will be able to select the section(s) of the template you want to take into account.

**Note:**
The tab of a section has no name until you enter it in the **Section Name** area.

- Enter a name for the section. The entered name is displayed on the section tab.

**Note:**
If you have selected the **Specify by Section** option in the **Add/Replace** drop-down menu at the template level, select the setting you want to apply to the current section.

- Report workbook selection. Select the workbook containing the reports you want to generate using the current template.

**Note:**
The workbooks you select must contain reports that have the same connection than the template.

- Enter a description for the workbook you have selected.

- **Dimension member selection:**
  - One or more dimensions for which one or several members are variable. For a specific dimension, the members selected as variable will override the members if the dimension is displayed in the page axis or in the context of the report. Besides, one report will be created by member selected.
  - One or more dimensions for which only one member is fixed. This is optional. A fixed member overrides any other member of the same dimension that is part of the report in the context or the page axis. For example, if you select the period 2009 as a fixed member and the period 2008 is displayed in the page axis of the report, 2009 will be taken into account.

**Note:**

- A suppressed member behaves exactly like a fixed member, but this feature remains for historical reasons.
- You cannot select fixed, suppressed and variable members for one dimension. All of them are mutually exclusive.

In the published reports, the members will be displayed according to the following precedence rule:
1. members in the row and column axes.
2. members selected as fixed members or as variable members in the publication template.
3. members in the page axis.
4. members in the context.

**Note:**
The template is saved as an .xlt or .xltx file.

Other actions available on a template:

- You can open an existing template, modify it and save it with a different name by selecting **EPM > Book Publication > Open Template.**

**Note:**
- If a report workbook specified in the template does not contain valid reports, the template opens but the report workbook area is empty. If you want to save your template, you need to specify another workbook that contains valid reports.
- The **Save the template in a different location** is available and enables to choose another location on the server to save the template.
- You can create a new section or a section based on existing one. You can also delete a section from the template. These actions are available in the template dialog box, under the section tab.
- If you have opened a Planning and Consolidation publication template using the **EPM > Open > Open Server Root Folder**, that is without using the dialog box dedicated to the publication template, you can then use the **Save, Save as and Validate** commands available in **EPM > Book Publication.** See **Open Actions.**

### 28.2.1.1.1 Creating Publication Templates for a Local or SAP BusinessObjects Enterprise Connection

**Note:**
- You must be granted the right to create a book publication template or you will not be able to save the template.
- A template is created by default on the first connection used in the workbook. If you want to create a template on a different connection, select **EPM > Book Publication > Change Connection.** A template can only apply to reports using the same connection.
- Choose carefully the names you enter for the publication template, the section(s) and the report workbook description as they will appear as the names of the folders if you publish the reports in PDF format.
  - You should not use the following characters as they will be changed into the _ character in the folders and book names: \ / * ? " < > | & + = ( ) [ ] $ %
  - You should not enter a space at the beginning and the end of the names.
  - Also, a section name and a workbook description must be unique within a template. If not, you cannot save the template.

1. Select **EPM > Book Publication > New Template.**
   The **Book Publication Template** dialog box opens.
2. Enter a name for the template.
3. Enter a name for the section.
   The entered name is displayed on the tab of the section.
4. Select a workbook that contain the reports you want to publish and enter a description for the report workbook.
   **Note:**
   - The workbook you select must contain reports that use the same connection than the template.
   - When clicking the arrow next to the ellipsis button, the Local Browser is selected by default.
5. You can select other workbooks and enter a description for them by clicking the green cross icon.
6. Click **Select Dimensions**.
   The Dimension Selector opens.
7. Select the checkbox for a dimension and click the Add button of the area you want. You must add at least one dimension in the Variable Members area. The selection of dimensions for the fixed and the suppressed members is optional.
8. Click **OK**.
9. For each dimension selected, click the button next to it and select the members you want in the Member Selector. You can only select one member per dimension as a fixed or suppressed member.
   **Note:**
   Once a dimension has been selected, you can select an additional member by clicking the green cross icon.
10. You can create one or several sections by clicking the Add New Section button and repeat steps 3 to 9.
11. Click **Save**.
   **Note:**
   - If the Save button is disabled: check that you have performed all the above steps; check also that the names of the section(s) and the workbook description(s) you have entered are unique within the template; and check that you are granted the right for creating a book publication template.
12. In the Save As dialog box, select a format (.xlt or .xltx) and enter a name for the template file.
   The template is saved to the following local folder: C:\Documents and Settings\[UserWindows]\My Documents\PC_LOC\[login]\books\[appset]\[application]\[team or localTeam]\WebExcel\ManageBook.

28.2.1.1.2 Creating Publication Templates for a Planning and Consolidation connection
   **Note:**
   - You must be granted the right to create a book publication template or you will not be able to save the template.
   - A template is created by default on the first connection used in the workbook. If you want to create a template on a different connection, select EPM > Book Publication > Change Connection. A template can only apply to reports using the same connection.
• Choose carefully the names you enter for the publication template, the section(s) and the report workbook description as they will appear as the names of the folders if you publish the reports in PDF format.
  - You should not use the following characters as they will be changed into the _ character in the folders and book names: / : * ? " < > | & + = ( ) { } [ ] $ %
  - You should not enter a space at the beginning and the end of the names.
  - Also, a section name and a workbook description must be unique within a template. If not, you cannot save the template.

The Book Publication Template dialog box opens.

2. Enter a name for the template.

3. If you intend to publish the books in PDF format, select an option in the Add/Replace drop-down menu.

4. You can select a member of the Time dimension using the Variable Time field.

5. Enter a name for the section.
The entered name is displayed on the tab of the section.

6. If you have selected Specify by Section in the Add/Replace drop-down menu at the template level, select Add or Replace for the current section.

7. Select a workbook that contain the reports you want to publish and enter a description for the report workbook.

   **Note:**
   - The workbook you select must contain reports that use the same connection than the template.
   - When clicking the arrow next to the ellipsis button, the Server Browser is selected by default.

8. You can select other workbooks and enter a description for them by clicking the green cross icon.

9. Click Select Dimensions.
The Dimension Selector opens.

10. Select the checkbox for a dimension and click the Add button of the area you want. You must add at least one dimension in the Variable Members area. The selection of dimensions for the fixed and the suppressed members is optional.

11. Click OK.

12. For each dimension selected, click the button next to it and select the members you want in the Member Selector. You can only select one member per dimension as a fixed or suppressed member.

   **Note:**
   Once a dimension has been selected, you can select an additional member by clicking the green cross icon.

13. You can create one or several sections by clicking the Add New Section button and repeat steps 5 to 12.

14. Click Save.
**Note:**

If the Save button is disabled: check that you have performed all the above steps; check also that the names of the section(s) and the workbook description(s) you have entered are unique within the template; and check that you are granted the right for creating a book publication template.

The Save dialog box opens.

15. Select a format (.xlt or .xltx) and enter a name for the template file.

---

**28.2.1.2 Book Publishing**

Once you have created a template, you can publish the books now or schedule the publication, as books to print or as PDF files.

**Book Publication Scheduling**

- The schedules you create are automatically saved for the current connection in the Windows Scheduled Tasks.
- As you use Windows Scheduled Tasks to schedule a book publication, you need to be administrator of your machine. If you are not (for security reasons), you can still use Windows Scheduled Tasks if you are granted certain Windows rights. For more information, see "http://support.microsoft.com/kb/883273/en-us".

**Book Printing**

If you choose to print the books, you can use the following options:

- **Print one sheet for all dimensions members combination**. This option enables you to define the printing order. This option is not checked by default. For example, a workbook contains two sheets and the variable members that you have selected in the template are: Spain, Italy.
  - If you select the option, the printing will be performed in the following order: 'Sheet 1 - Spain', 'Sheet 1 - Italy', 'Sheet 2 - Spain', 'Sheet 2 - Italy'.
  - If you do not select the option, the printing will be performed in the following order: 'Sheet 1 - Spain', 'Sheet 2 - Spain', 'Sheet 1 - Italy', 'Sheet 2 - Italy'.

- **Print sheets with no data**. This option enables you to specify that a sheet will be printed even if any of the books in the sheet do not contain any data. This option is not checked by default.

**Book in PDF Format**

If you choose to export the books in PDF format, note that by default, one PDF file is generated by combination of variable member. If you want to generate all the books in one single PDF, select the **Single PDF** option.

The books in PDF format are stored at the following location, depending on the connection you use:

- If you use a Local or an SAP BusinessObjects Enterprise connection, the books are stored to the following local location: `C:\Documents and Settings\[UserWindows]\Local Settings\Temp\_PATH_PUBLISH`
• If you use a Planning and Consolidation connection, the books are stored to the server. You will then be able to view the books from Planning and Consolidation web client. For more information, see the *SAP BusinessObjects Planning and Consolidation Help*.

### 28.2.1.2.1 Launching Book Publication

Before launching a publication, you must have defined a publication template.

   The **Book Publication Wizard** opens.
2. Select **Publish Now** and click **Next**.
3. To print the books:
   a. Select **Printer**.
   b. Enter the printer path or select it, using the ellipsis button.
   c. Depending on the printing order you want, you can select the **Print one sheet for all dimensions members combination** option.
   d. To specify that a sheet will be printed even if any of the reports in the sheet do not contain any data, select the **Print sheets with no data** option.
4. To generate the books in PDF format:
   a. Select **Publish to PDF Format**.
   b. By default, one PDF file by combination of variable member is generated. If you want to generate all the reports in one single PDF, select the **Single PDF** option.
   c. If you are using a Planning and Consolidation connection and you have not selected **Single PDF**, select the location where the template you want use is stored (Public or a specific team).
   d. If you are using a Planning and Consolidation connection and you have selected **Single PDF**, specify is the PDF files should be only accessible to you (select **Private**), to all the users (select **Public**) or to a specific team (select **Team** and select the team from the drop-down list).
5. Select the templates, then the template sections you want to use to generate the books.
   When using a Planning and Consolidation connection, you can select a team so that all the templates for the selected team are displayed. You can then select the template and sections you want.
   A summary displays information about the books to be generated.
6. Click **Next**.
   The report generation is launched and the process steps are displayed.

When using a Local or an SAP BusinessObject Enterprise connection, the books in PDF format are stored by default at the following local location: C:\Documents and Settings\[UserWindows]\Local Settings\Temp\_PATH_PUBLISH

### 28.2.1.2.2 Scheduling Book Publication

• Before launching a publication, you must have defined a publication template.
• As you use Windows Scheduled Tasks to schedule a book publication, you need to be administrator of your machine or if you are granted certain Windows rights.

1. Select **EPM > Book Publication > Publish Books**.
   The **Book Publication Wizard** opens.
2. Select **Schedule the Publication** and click **Next**. If a schedule has already been defined for the current connection, the schedule is displayed.

   **Note:**
   You can only use one Windows Scheduled Task per connection.
   - If no schedule exist for the current connection or if you want to modify the schedule, click **Next**, enter the schedule information, enter your Windows account password twice, and click **Next** again.
   
   **Note:**
   - The **Enable Schedule** option is selected by default, meaning that Windows Scheduled Task is activated by default.
   - The schedules you create are automatically saved for the current connection in the Windows Scheduled Tasks.
   - If you want to deactivate the current Windows Scheduled Task, click the **Windows Scheduled Tasks** button. The **Scheduled Tasks** screen opens. Follow the Windows standard procedure: right-click the scheduled task, then select **Properties**. In the **Task** tab, uncheck the **Enabled** option.

3. To print the books:
   a. Select **Printer**.
   b. Enter the printer path or select it, using the ellipsis button.
   c. Depending on the printing order you want, you can select the **Print all sheets for one dimensions members combination** option.
   d. To specify that a sheet will be printed even if any of the reports in the sheet do not contain any data, select the **Print sheets with no data** option.

4. To generate the books in PDF format:
   a. Select **Publish to PDF Format**.
   b. By default, one PDF file by combination of variable members is generated. If you want to generate all the books in one single PDF, select the **Single PDF** option and click **Next**. Enter a name for the PDF and select the local folder in which you want the PDF to be generated.
      
      When using a Planning and Consolidation connection, you can specify other folders than a local folder, in which you want the PDF to be generated, depending on your rights: public, private, team.

5. Select the templates, then the template sections you want to use to generate the books.
   When using a Planning and Consolidation connection, you can select a team so that all the templates for the selected team are displayed. You can then select the template and sections you want.
   A summary displays information about the books to be generated.

6. Click **Next**.
7. Click **Process**.

When using a Local or an SAP BusinessObject Enterprise connection, if one PDF by combination of members has been generated (and not one single PDF), by default, the books in PDF format are stored at the following local location: C:\Documents and Settings\[UserWindows]\Local Settings\Temp\_PATH_PUBLISH
### 28.2.2 Distribution and Data Collection

**Applies to:**
The Data Collection feature only applies to Planning and Consolidation connections.

You can make workbooks (containing reports or input forms) available to a set of users.
- You can send the workbooks as attachments in emails.
- Or you can store the workbooks to a specific location.

Using a template, you can generate workbooks, based on:
- one or more reports,
- one or more variable members for one or more dimensions.

Each automatically created workbook displays the initial report(s), however with a different dimension member (or a combination of dimension members) of the dimension(s) for which variable dimension members have been defined.

Then, at one time, you can launch the distribution or you can schedule it (for example, every Friday at 11:00 PM).

The workbooks are stored on the specified folder or they are sent by email to the recipients you have specified in the template.

**Data Collection Purposes**
When using a Planning and Consolidation connection for data collection purposes, you will make available to users workbooks that contain input forms.

**Caution:**
So that the entered data are eventually saved to the server for the appropriate members, you must make sure that the members are specified and fixed for all dimensions in all of the input forms you distribute. You do not want to depend on the context. To do so, apply one of the following procedures:
- First possibility:
  1. When creating your input forms, place the dimensions you want in the various axes.
  2. Take all the remaining dimensions - that is the dimensions that are not placed in any of the three axes - and place them in the page axis.
  3. In the distribution template, specify the members that you set as variable.
  4. Specify all the other dimensions as fixed members.

    In a nutshell, you must use all the dimensions in your input forms and in the distribution template.

- Second possibility: you lock the dimensions for the workbooks, using the **Context Options** dialog box. However, note that users who do not have the EPM add-in installed and who will enter data, will not view the dimensions and members that are not included in the input forms. This may be puzzling for them. For more information on the context lock, see [Context](#).
The users will then enter data in the distributed workbooks and make them available: if the input forms have been sent to them by email, they can send them back by email once they have finished entering data.

The user that has distributed the workbooks can then collect the workbooks. The data entered by the various users are automatically saved to the server.

### 28.2.2.1 Distribution Template

Before distributing workbooks, you must create a distribution template. The template specifies the information you want to include in the workbooks, including specific settings on dimension members.

**Caution for data collection purposes:**
So that the entered data are eventually saved to the server for the appropriate members, you must make sure that the members are specified and fixed for all dimensions in all of the input forms you distribute. You do not want to depend on the context. To do so, apply one of the following procedures:

- **First possibility:**
  1. When creating your input forms, place the dimensions you want in the various axes.
  2. Take all the remaining dimensions - that is the dimensions that are not placed in any of the three axes - and place them in the page axis.
  3. In the distribution template, specify the members that you set as variable.
  4. Specify all the other dimensions as fixed members.

   In a nutshell, you must use all the dimensions in your input forms and in the distribution template.

- **Second possibility:** you lock the dimensions for the workbook, using the **Context Options** dialog box. However, note that users who do not have the EPM add-in installed and who will enter data, will not view the dimensions and members that are not included in the input forms. This may be puzzling for them. For more information on the context lock, see **Context**.

**Note:**
Choose carefully the names you enter for the distribution template, the section(s) and the report workbook description(s) as they will appear as the names of the folders.

- You should not use the following characters as they will be changed into the _ character in the folders and book names: \\ / : * ? " < > | & + = ( ) { } [ ] $ %
- You should not enter a space at the beginning and the end of the names.
- Also, a section name and a workbook description must be unique within a template. If not, you cannot save the template.

The creation or modification of a template consists of the following steps:

- Enter a name for the template.
- When using a Planning and Consolidation connection, the **Variable Time** field is displayed. If no member is selected for the Time dimension in a section of the template as a variable or fixed member, the time member selected here applies to all the sections of the template and is hard coded. If you select a Time member in a section, it overrides the member selected in the **Variable Time** field for this section.
• Section definition. A template can include one or several sections. A section is a part of the template. Each section includes at least a selection of variable dimension members. When launching the distribution, you will be able to select the section(s) of the template you want to take into account.

**Note:**
The tab of a section has no name until you enter it the **Section Name** area.

• Enter a name for the section. The entered name is displayed on the section tab.

• Workbook selection. Select the workbooks containing the reports or input forms you want to generate using the current template.

**Note:**
The workbooks you select must contain reports or input forms that have the same connection than the template.

• Enter a description for the workbook you have selected.

• Dimension member selection:
  • One or more dimensions for which one or several members are variable. For a specific dimension, the members selected as variable will override the members if the dimension is displayed in the page axis or in the context of the report. Besides, one workbook will be created by member selected.
  • One or more dimensions for which only one member is fixed. A fixed member overrides any other member of the same dimension that is part of the report in the context or the page axis. For example, if you select the period 2009 as a fixed member and the period 2008 is displayed in the page axis of the report, 2009 will be taken into account.

A user is associated to each variable member.

  • When using a Local or SAP BusinessObjects Enterprise connection, enter the users’ email address.
  • When using a Planning and Consolidation connection, enter the user names.

The entered user is the recipient of the report that will be generated on this variable member.

**Note:**
You cannot select fixed and variable members for one dimension. They are mutually exclusive.

• In the workbooks, the members will be displayed according to the following precedence rule:
  1. members in the row and column axes.
  2. members selected as fixed members or as variable members in the distribution template.
  3. members in the page axis.
  4. members in the context.

**Note:**
Once you have created a template, it is saved as an .xlt or .xltx file.

Other actions are available on a template:

• You can open an existing template, modify it and save it with a different name by selecting **EPM > Distribution > Open Template.**
Note:

- If a report workbook specified in the template does not contain valid reports, the template opens but the report workbook area is empty. If you want to save your template, you need to specify another workbook that contains valid reports.
- In the template dialog box of a template created on a Planning and Consolidation connection, the Save the template in a different location is available and enables to choose another location on the server to save the template.
- You can create a blank section or a section based on existing one. You can also delete a section from the template. These actions are available in the template dialog box, under the section tab.
- If you have opened a Planning and Consolidation publication template using the EPM > Open > Open Server Root Folder, that is without using the dialog box dedicated to the publication template, you can use the Save, Save as and Validate commands available in EPM > Distribution. See Open Actions.

28.2.2.1.1 Creating Distribution Templates

Note:

- A template is created by default on the first connection used in the workbook. If you want to create a template on a different connection, select EPM > Distribution > Change Connection. A template can only apply to reports or input forms using the same connection.
- Choose carefully the names you enter for the distribution template, the section(s) and the workbook description(s) as they will appear as the names of the folders.
  - You should not use the following characters as they will be changed into the _ character in the folders and book names: \\:/:*?"<>|&+=(){}[]$%
  - You should not enter a space at the beginning and the end of the names.
  - Also, a section name and a workbook description must be unique within a template. If not, you cannot save the template.

   The Distribution Template dialog box opens.
2. Enter a name for the template.
3. If you are using a Planning and Consolidation connection, you can select a member of the Time dimension using the Variable Time field.
4. Enter a name for the section.
   The entered name is displayed on the tab of the section.
5. Select a workbook that contain the reports or input forms you want to generate and distribute and enter a description for the workbook.

   Note:
   The reports or input forms and the template must be connected to the same source.
6. You can select other workbooks and the template must be connected to the same source.
7. Click Select Dimensions.
   The Dimension Selector opens.
8. Select the checkbox for a dimension and click the Add button of the area you want. You must add at least one dimension in the Variable Members area. Then, you can select dimensions for fixed members.

   Click OK.

9. For each dimension selected, click the button next to it and select the members you want in the Member Selector. You can only select one member per dimension as a fixed member.

   **Note:**
   Once a dimension has been selected, you can select an additional member by clicking the green cross icon.

10. For each variable dimension, enter:
    - Enter the users’ email address, when using a Local or SAP BusinessObjects Enterprise connection.
    - Enter the user names when using a Planning and Consolidation connection.
    The entered user is the recipient of the report that will be generated on this variable member.

11. You can create one or several sections by clicking the Add New Section button and repeat steps 4 to 10.

12. Click Save.

   **Note:**
   If the Save button is disabled, check that you have performed all the above steps and check also that the names of the section(s) and the workbook description(s) you have entered are unique within the template.

13. Depending on the connection you are using, perform the following action:
    - When using a Planning and Consolidation connection, in the Save As dialog box, select a format (.xlt or .xltx) and enter a name for the template file.
    - When using a Local or SAP BusinessObjects Enterprise connection, in the Save dialog box, select a format (.xlt or .xltx) and enter a name for the template file. The template is saved to the following local folder: C:\Documents and Settings\[UserWindows]\My Documents\PC_LOC\[login]\books\[appset]\[application]\[team or localTeam]\WebExcel\ManageBook C:\Documents and Settings\[UserWindows]\My Documents\PC_LOC\[login]\books\[appset]\[application]\[team or localTeam]\WebExcel\ManageDistributionList.

**28.2.2.2 Workbook Distribution**

Once you have created a template, you can distribute the workbooks now or schedule the distribution. You can send the workbooks by email as attachments, or store them to a specific location.

The workbooks are automatically switched to offline, meaning that the users will be able to work with a workbook in a disconnected state without using the EPM add-in.
Distribution Scheduling

- The schedules you create are automatically saved for the current connection in the Windows Scheduled Tasks.
- As you use Windows Scheduled Tasks to schedule a book publication, you need to be administrator of your machine. If you are not (for security reasons), you can still use Windows Scheduled Tasks if you are granted certain Windows rights. For more information, see "http://support.microsoft.com/kb/883273/en-us".

Distribution by Emails

If you want to send the workbooks by email, so that the distribution can be performed, you must enter the required information about the SMTP server you use to send the emails.

Select EPM > Options > User Options.

Note:
If you work on a Planning and Consolidation connection and if this connection returns the SMTP server information, you do not need to enter the SMTP information in the User Options.

Enter the following information in the SMTP Server Configuration area of the User Options dialog box:

- The SMTP server address.
- The port number. As a general rule, the port number is 25.
- Select the authentication type:
  - Anonymous. If you select this type, no authentication is required and you do not need to enter the information in the Authentication area.
  - Basic
  - NTML
- If you have selected the basic or the NTML authentication type, you must enter the login and password of the SMTP server.
- Select the Enable SSL option if needed.

28.2.2.2.1 Launching Distribution

- Before launching a distribution, you must have defined a distribution template.
- If you want to send the workbooks by email (and if you do not work on a Planning and Consolidation connection that returns the SMTP server information), so that the distribution can be performed, you must enter the required information about the SMTP server you use to send the emails. Select EPM > Options > User Options and enter the SMTP information in the SMTP Server Configuration area.

1. Select EPM > Distribution > Distribute.
   The Distribution Wizard opens.
2. Select Distribute Now and click Next.
3. To send the workbooks by email:
   a. Select Switch to offline mode and send by email and click Next.
   b. Enter standard email information.
4. To save the workbooks to a specific folder:
   a. Select **Switch to offline mode and save to folder** and click **Next**.
   b. In the **Folder Location** area, enter the path to the folder in which you want to save the workbooks or select the path by using the ellipsis button.

5. If you are using a Planning and Consolidation connection, select the location where the template you want use is stored (Public or a specific team).

6. Select the templates, then the template sections you want to use to generate the workbooks. When using a Planning and Consolidation connection, you can select a team so that all the templates for the selected team are displayed. You can then select the template and sections you want.

   A summary displays information about the workbooks to be generated.

7. Click **Next**.

   The distribution is launched and the process steps are displayed.

   The workbooks are generated and stored to the specified folder or the workbooks are sent by email as attachments, accordingly to the users specified for each variable member in the distribution template.

28.2.2.2.2 Scheduling Distribution

- Before launching a distribution, you must have defined a distribution template.

- As you use Windows Scheduled Tasks to schedule a distribution, you need to be administrator of your machine or if you are granted certain Windows rights.

1. Select **EPM > Distribution > Distribute**.

   The **Distribution Wizard** opens.

2. Select **Schedule the Distribution** and click **Next**. If a schedule has already been defined for the current connection, the schedule is displayed.

   **Note:**

   You can only use one Windows Sheduled Task per connection.

   - If no schedule exist for the current connection or if you want to modify the schedule, click **Next**, enter the schedule information, enter your Windows account password twice, and click **Next** again.

   **Note:**

   - The **Enable Schedule** option is selected by default, meaning that Windows Sheduled Task is activated by default.

   - The schedules you create are automatically saved for the current connection in the Windows Scheduled Tasks.

   - If you want to deactivate the current Windows Sheduled Task, click the **Windows Sheduled Tasks** button. The **Scheduled Tasks** screen opens. Follow the Windows standard procedure: right-click the sheduled task, then select **Properties**. In the **Task** tab, uncheck the **Enabled** option.

3. To send the workbooks by email:
   a. Select **Switch to offline mode and send by email** and click **Next**.

   b. Enter standard email information.
4. To save the workbooks on a specific folder:
   a. Select **Switch to offline mode and save to folder** and click **Next**.
   b. In the **Folder Location** area, enter the path to the folder in which you want to save the workbooks or select the path by using the ellipsis button.

5. Select the templates, then the template sections you want to use to generate the workbooks. When using a Planning and Consolidation connection, you can select a team so that all the templates for the selected team are displayed. You can then select the template and sections you want. A summary displays information about the reports to be generated.

6. Click **Next**.

7. Click **Process**.

### 28.2.2.3 Data Collection

**Applies to:**
Planning and Consolidation connections.

If users have entered data in the distributed workbooks, they can either email the workbooks back to the sender, or replace the workbooks in the specified distribution folder.

The sender can then collect the workbooks from the specified folder or the email folder.

The entered data are automatically saved to the server.

#### 28.2.2.3.1 Collecting Data

To collect data, you must have previously performed a workbook distribution on the same connection.

1. Select **EPM > Distribution > Collect**.
   The **Collection Wizard** opens.

2. Follow one these steps:
   - To collect data entered in workbooks that users have sent you by email, select the **Outlook Mailbox** option. Then click the ellipsis button in the **Working Folder** area. In the Microsoft Outlook dialog box, select the Outlook folder in which the emails with the workbooks are stored. Back in the **Collection Wizard**, select the emails containing workbooks that you want to collect and click **Next** twice.
   - To collect data entered in workbooks that users have stored in a specific folder, select the **Local Folder** option. Then click the ellipsis button in the **Working Folder** area. In the dialog box that opens, select the folder containing the workbooks you want to collect. Back in the **Collection Wizard**, select the workbooks that you want to collect and click **Next** twice.

The workbooks are automatically connected and the data are saved to the server.
EPM Functions

The EPM functions are formulas that enable to retrieve specific information or data and to make a
report behave in a certain way, providing power and flexibility to reports.

- You can enter an EPM function directly in the formula bar.

  To make it easier to create and edit formulas and minimize typing and syntax errors, use Microsoft
  Office Excel Formula AutoComplete. After you type =epm (or =EPM, as it is not case-sensitive), a
dynamic drop-down list of all the EPM functions is displayed below the cell.

- You can also use the Microsoft Office Excel standard Insert Function dialog box by clicking the
  Insert Function button from the EPM tab of the ribbon.

  The EPM dedicated functions are gathered under the EPMFunctions category.

Note:

- You should deactivate the Member Recognition and the Local Member Recognition functions when
  using the EPM functions.

General notes:

- The text entered in formulas is not case-sensitive.
- The string parameters must be entered between the "" characters. For example: "account".
- The separator character used to separate the parameters of a function depends on the "list
  separator" defined in your local settings.

An EPM function is created by default on the active connection of the sheet. The default connection is
displayed in the Active Connection drop-down list of the EPM pane. Using this drop-down list, you
can directly select another connection or you can select the command Select Another Connection,
then select another connection in the Connection Manager that opens.

Note:

- For technical reasons, the functions that are not supported on a specific data source are not greyed
  out nor hidden in the EPMFunctions category. All the functions are available for selection, regardless
  of the data source.
- The FPMXLCient.TechnicalCategory category is only used internally and must not be used by
  other users.
- If you work with reports that have been created with former versions of Planning and Consolidation
  (before version 10), some functions beginning with Ev continue to work but their names are not
  automatically converted into EPM. From version 10, the names of the functions begin with EPM. All
  the functions beginning with Ev are gathered under the EVFunctions (Deprecated) category. For
  more information on the former names and the corresponding new names, see the SAP
- The following Ev functions are not supported in the EPM add-in: EvALK, EvASV, EvBLK, EvCLK, EvDLK, EvENE, EvEXP, EvHOT, EvINP, EvLIK, EvLST, EvMEM, EvMSG, EvNXP, EvPLK, EvPOV, EvPXR, EvSEN, EvSET, EvSLK, OsAMT.
- EvMNU name is still supported but its former parameters are not recognized by the EPM add-in. For more information on the new parameters, EPMExecuteAPI.

**Referencing an EPMOlapMember**

In an EPM function formula, when you reference a cell that contains a member placed in one of the three axes of the report (that is a member identified by =EPMOlapMember), you must use the EPMMemberID function.

**Example:** with EPMMemberProperty

Do not define the function as follows: =EPMMemberProperty("connection1"; B4; "HLEVEL")

Define the function as follows: =EPMMemberProperty("connection1"; EPMMemberID(B4); "HLEVEL")

**Related Topics**

- Log On and Connections

**29.1 EPMUser**

This function retrieves the login for the specified connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
</tbody>
</table>

**29.2 EPMServer**

This function retrieves the server address for the specified connection.
### 29.3 EPMEnvDatabaseDesc

This function retrieves the description of the environment or database for the specified connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
</tbody>
</table>

### 29.4 EPMEnvDatabaseID

This function retrieves the name of the environment or database for the specified connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
</tbody>
</table>

### 29.5 EPMMModelCubeID

This function retrieves the name of the model or cube for the specified connection.
29.6 EPMModelCubeDesc

This function retrieves the description of the model or cube for the specified connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
</tbody>
</table>

29.7 Functions on Reports

Some EPM functions enable you to perform certain actions on reports.

**Note:**
- Do not enter the functions right next to a cell of a report. Leave a blank row or column between the function and the report. Also, you should enter the functions above the reports. Therefore, if you move the reports, the functions will not be moved along.
- After you enter a function, perform a refresh on the worksheet.

29.7.1 EPMDimensionOverride

Override the member selection for a specified dimension in one or several reports. The dimension member selection performed in the Member Selector is replaced by a specific cell or range of cells.
### reportID parameter

You can apply the selection to one or more reports, using the reportID parameter. For example: "000;001", where 000 corresponds to the first report of the sheet (also called the default report) and 001 corresponds to the second report of the sheet.

**Note:**

Use the ; character to separate the reports.

If you specify several reports in the reportID parameter, you can use the | character in the members parameter to separate the member override definition. The first member override definition will be applied to the first report, the second member override definition will be applied to the second report, and so on.

- If you define more member override definitions than reports, the exceeding member override definitions will not apply to any report.

For example: =EPMDimensionOverride("000;001;002","Category"," PLAN | ACTUAL,FORECAST | ACTUAL,FORECAST,PLAN | ACTUAL")

- In report 000, the Category dimension members will be overridden by the member PLAN.
- In report 001, the Category dimension members will be overridden by the members ACTUAL and FORECAST.
- In report 002, the Category dimension members will be overridden by the members ACTUAL, FORECAST and PLAN.
- The fourth member override definition ACTUAL will not be applied to any report.

- In report 002, the Category dimension members will be overridden by the members ACTUAL, FORECAST and PLAN.
- The fourth member override definition ACTUAL will not be applied to any report.
- If you define more reports than member override definitions, the exceeding reports will use the last member override definition.

For example: =EPMDimensionOverride("000;001;002;003","Category"," PLAN | ACTUAL")

- In report 000, the Category dimension members will be overridden by the member PLAN.
- In report 001, the Category dimension members will be overridden by the member ACTUAL.
- In report 002, the Category dimension members will be overridden by the members ACTUAL.
- In report 003, the Category dimension members will be overridden by the members ACTUAL.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reportID</td>
<td>ID of one or several reports</td>
</tr>
<tr>
<td>dimension</td>
<td>On a Planning and Consolidation connection, specify the dimension name. For other connections, specify the hierarchy name; to specify a hierarchy, enter: dimension.hierarchy</td>
</tr>
<tr>
<td>members</td>
<td>members you want to select for the specified dimension. The members will override the members selected before in the report.</td>
</tr>
</tbody>
</table>
Note:
The master report takes precedence over the other reports.

members parameter

For the members parameter, you can use the following values to specify a dynamic selection of members:

- MEMBERS. Retrieves all the members of the dimension.
- BASMEMBERS. Retrieves all the base level members of the dimension.
- BAS. Retrieves all the base level members that are below the context member of the dimension.
- DEP. Retrieves all the children of the context member of the dimension.
- ALL. Retrieves all the descendants of the context member of the dimension.
- SELF. Retrieves the context member of the dimension.
- LDEP(n). Retrieves all the descendants of the context member of the dimension until the level n in the hierarchy - including the members in the intermediate levels. For example: LDEP(2,2008.TOTAL) will retrieve the semester and the quarter members of 2008.

In addition, you can optionally use the y character to retrieve only the members for the level specified by n. For example: LDEP(2,2008.TOTAL,Y) will retrieve only the quarter members of 2008.

- LBAS(n). Retrieves all the base level members that are below the context member of the dimension, until the level n in the hierarchy - including the members in the intermediate levels. Optionally, you can use the y character to retrieve only the members for the level specified by n.
- LMEMBERS(n). Retrieves all the descendants of the "all" member of the dimension until the level n in the hierarchy - including the members in the intermediate levels. Optionally, you can use the y character to retrieve only the members for the level specified by n.
- LBASMEMBERS(n). Retrieves all the base level members of the "all" member of the dimension until the level n in the hierarchy - including the members in the intermediate levels. In addition, you can optionally use the y character to retrieve only the members for the level specified by n.
- NOEXPAND. Retrieves the members specified, then makes this selection static.
- PARENTAFTER. This value cannot be used alone. For example: MEMBERS,PARENTAFTER. Retrieves all the members of the dimension; displaying the totals at the bottom in the row axis, or displaying totals to the right in the column axis.

Note:
- The values above are not case-sensitive.
- So that members are recognized as members, enter member names between " " when member names contain spaces or special characters. For example:
  =EPMDimensionOverride("000","FL","'99 - Closing Balance'")

Examples:
- SELF. Context member. If you change the member in the context, the member is updated in the report.
- SELF, DEP. Context member and its children.
- SELF, ALL. Context member and its descendants.

Note:
- You can specify cells that are either in the current sheet or in other sheets.
- You can enter any Microsoft Office Excel formula.
This function is dynamic, meaning that if you have specified SELF, DEP and if, for example, a child of the context member is deleted in the data source, it is also deleted from the report.

### 29.7.2 EPMAxisOverride

This function enables to override one or several dimensions (and their members) for a specified axis (row or column axis).

When you enter the function and then click Enter, the member override is reflected in the EPM pane, but not in the report. To reflect the override, refresh the report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reportID</td>
<td>ID of one or several reports. Mandatory.</td>
</tr>
<tr>
<td>row axis</td>
<td>Specify which axis will be overridden. Enter TRUE to override the row axis, FALSE to override the column axis. Mandatory.</td>
</tr>
<tr>
<td>dimension1... to dimension5</td>
<td>On a Planning and Consolidation connection, specify the dimension name. For other connections, specify the hierarchy name; to specify a hierarchy, enter: dimension.hierarchy. Dimension1 is not mandatory</td>
</tr>
<tr>
<td>member1... to member5</td>
<td>members that will override the members currently in the report(s). member1 is mandatory.</td>
</tr>
</tbody>
</table>

- You can apply the selection to one or more reports, using the reportID parameter. See EPMDimensionOverride.

**Note:**
The master report takes precedence over the other reports.

- For the members parameter, see EPMDimensionOverride.
- To specify a dimension, you can select the cell in which a drop-down list retrieves the dimensions, thanks to the EPMDimensionList function. If another dimension is selected from the drop-down list, the dimension change will be taken into account in the EPMAxisOverride function.

**Note:**
- You should not use the EPMAxisOverride function more than once on the same axis and the same report.
- If you enter one function for the row axis and one for the column axis, the row axis takes precedence over the column axis.

**Related Topics**
- EPMDimensionOverride
- EPMDimensionList
29.7.3 EPMCopyRange

This function enables you to add and repeat the content of a range of cells until the bottom (columns) or the right side (rows) of a report is reached. The range is added to the data grid and in the shift zones (if there are ones), starting after the row axis and below the column axis.

- The following content of the specified source range is added to the report: all the format settings; formulas, data and fixed text in the report cells that do not contain any data.
- If the source range that you want to add is smaller than the report range, the following content of the source range is duplicated as long as the report range has not been reached: all the format settings; formulas and fixed text in the report cells that do not contain any data.
- If the source range is added to a blank zone (shift) of the report, and if the source range is larger than the blank zone, the beginning of the source range is added to the blank zone and the rest of the source range is duplicated in the data grid.

You can add the range to one or more reports, using the reportID parameter. For example: "000;001", where 000 corresponds to the first report of the sheet (also called the default report) and 001 corresponds to the second report of the sheet.

**Note:**
Use the ; character to separate the reports.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reportID</td>
<td>ID of one or several reports</td>
</tr>
<tr>
<td>Row</td>
<td>Specify where the range will be added. Enter TRUE to add the cells in rows, FALSE to add the cells in columns.</td>
</tr>
<tr>
<td>SourceRange</td>
<td>Specify the cell range containing the content that will be added to the rows or columns.</td>
</tr>
</tbody>
</table>

29.7.4 EPMInsertCellsBeforeAfterBlock

This function inserts cells before or after a block of members for a specified dimension.

If the source range that you want to insert is smaller than the destination range in the report:
- the first cells of the source range are inserted before the block of members.
- the subsequent exceeding cells of the source range are copied and duplicated in all the cells of the destination range until the end of the report is reached.
Note:
The inserted cells are considered as "fake" members. An inserted member is identified by a formula beginning with =EPMInsertedMember().

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reportID</td>
<td>ID of one or several reports</td>
</tr>
<tr>
<td>Dimension</td>
<td>On a Planning and Consolidation connection, specify the dimension name. For other connections, specify the hierarchy name; to specify a hierarchy, enter: dimension.hierarchy</td>
</tr>
<tr>
<td>Before</td>
<td>Specify where the cells must be inserted. Enter TRUE to insert the cells before the members, FALSE to insert the cells after the members.</td>
</tr>
<tr>
<td>Range</td>
<td>Specify the cell range containing the content that you want to insert</td>
</tr>
</tbody>
</table>

29.7.5 EPMMemberID

This function retrieves the unique name of a specified dimension member that is included in a report.

A unique name includes the following: [dimension name].[hierarchy name].[member name]

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>member</td>
<td>Member for which you want to retrieve the unique name. Mandatory.</td>
</tr>
</tbody>
</table>

29.7.6 EPMReportOptions

This function enables to override the options for one or more reports. The override applies to a report only if the Inherit Sheet Options option is not selected in the Options tab of the Report Editor.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reportID</td>
<td>ID of one or several reports. Mandatory.</td>
</tr>
<tr>
<td>options</td>
<td>Specify the options that will override the existing ones. Mandatory.</td>
</tr>
</tbody>
</table>

In the options parameter, you can specify one or more options. Use the ; character to separate the options.
Note:
All the report options are not described in this section. Follow the links to read explanations about the options.

Here is the list of values corresponding to the report options:

- **CalculateParentsInHierarchies.** To activate this option, enter: "CalculateParentsInHierarchies=true". To deactivate it, enter: "CalculateParentsInHierarchies=false".
  For more information, see [Calculate Parents in Hierarchies](#).  
- **KeepFormulaOnData.** To activate this option, enter: "KeepFormulaOnData=true". To deactivate it, enter: "KeepFormulaOnData=false".
  For more information, see [Keep Formula on Data and Show Source Data in Comments](#).  
- **ShowSourceDataInComments.** To activate this option, enter: "ShowSourceDataInComments=true". To deactivate it, enter: "ShowSourceDataInComments=false".
  For more information, see [Keep Formula on Data and Show Source Data in Comments](#).  
- **KeepEmptyRows.** To activate this option, enter: "KeepEmptyRows=true". To deactivate it, enter: "KeepEmptyRows=false".
  For more information, see [Empty Row and Column Behavior](#).  
- **KeepEmptyColumns.** To activate this option, enter: "KeepEmptyColumns=true". To deactivate it, enter: "KeepEmptyColumns=false".
  For more information, see [Empty Row and Column Behavior](#).  
- **RepeatRowHeaders.** To activate this option, enter: "RepeatRowHeaders=true". To deactivate it, enter: "RepeatRowHeaders=false".
  For more information, see [Repeat Row Headers and Repeat Column Headers](#).  
- **RepeatColumnHeaders.** To activate this option, enter: "RepeatColumnHeaders=true". To deactivate it, enter: "RepeatColumnHeaders=false".
  For more information, see [Repeat Row Headers and Repeat Column Headers](#).  
- **FreezeDataRefresh.** To activate this option, enter: "FreezeDataRefresh=true". To deactivate it, enter: "FreezeDataRefresh=false".
  For more information, see [Freeze Data Refresh](#).  
- **SetDefaultValueInEmptyCell and EmptyCellDefaultValue.** To activate the option, enter: "SetDefaultValueInEmptyCell=true". To deactivate it, enter: "SetDefaultValueInEmptyCell=false". Then, to define a default value, enter: "EmptyCellDefaultValue=[string]"
  For example, you want that "no data" appears in any cell that contains no value. Enter what follows in the options parameter: "SetDefaultValueInEmptyCell=true";"EmptyCellDefaultValue=no data"
  For more information, see [Empty Cell Default Value](#).  
- **RowHeaderIndentation.** Three values are possible.  
  - No indentation. Enter: "RowHeaderIndentation=0"  
  - Indent the children. Enter: "RowHeaderIndentation=1"
- Indent the parents. Enter: "RowHeaderIndentation=2"
  For more information, see Row Header Indentation.
- TotalAtLeft. To activate this option, enter: "TotalAtLeft=true". To deactivate it, enter: "TotalAtLeft=false"
  For more information, see Totals Placement.
- TotalAtTop. To activate this option, enter: "TotalAtTop=true". To deactivate it, enter: "TotalAtTop=false"
  For more information, see Totals Placement.
- ApplyDynamicFormatting and FormattingSheet. To activate the option, enter: "ApplyDynamicFormatting=true".
  Then, to specify the sheet to apply, enter: "FormattingSheet=[name of the sheet]"
  For example, enter what follows in the options parameter: "ApplyDynamicFormatting=true";"FormattingSheet=templateCompany"
  For more information, see Apply Dynamic Formatting.

Example: **Example with several options**

You want to indent the children members in the row axis and to apply the dynamic formatting sheet called "global" to the default report, enter what follows:

EPMReportOptions=("000","RowHeaderIndentation=1";"ApplyDynamicFormatting=true";"FormattingSheet=global")

---

**29.7.7 EPMMemberSortingOverride**

Override the member sorting and grouping that has been previously defined using the interface (Member Sorting and Grouping area in the Member Selector), for a specified dimension, in one or several reports.

For more information on how to sort or group members using the interface, see Member Sorting and Grouping by Properties.
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>reportID</td>
<td>ID of one or several reports</td>
</tr>
<tr>
<td>dimension</td>
<td>On a Planning and Consolidation connection, specify the dimension name. For other connections, specify the hierarchy name; to specify a hierarchy, enter: dimension.hierarchy</td>
</tr>
<tr>
<td>sort</td>
<td>Specify if you want to enable the member sorting. Enter TRUE to enable the sorting, FALSE if you do not want to enable the sorting.</td>
</tr>
<tr>
<td>ascendingOrder</td>
<td>Specify if you want to sort the members by ascending or descending order. Enter TRUE to sort members by ascending order, FALSE to sort members by descending order.</td>
</tr>
<tr>
<td>property</td>
<td>Name of the property to sort the members on. The values of the specified property will be ordered by ascending or descending order, depending on the ascending parameter.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> In the Property parameter, you can reference the cell in which the EPMDimension-Property function has been entered. For more information, <a href="#">EPMDimensionProperty</a>.</td>
</tr>
<tr>
<td>AddLocalMember-Before</td>
<td>Specify if you want to insert a grouping local member the before the set of members. Enter TRUE to insert the grouping local member.</td>
</tr>
<tr>
<td>AddLocalMember-After</td>
<td>Specify if you want to insert a grouping local member the after the set of members. Enter TRUE to insert the grouping local member.</td>
</tr>
</tbody>
</table>

**Related Topics**

- [Member Sorting and Grouping by Properties](#)

### 29.8 EPMReportID

This function retrieves the unique name of the report from which you specify a member.

If the specified member belongs to an axis that is shared by several reports, the ID of the master report is retrieved.
### 29.9 EPMFullContext

For the specified connection, this function retrieves the context dimension members and the members contained in the page axis for the specified report. For each dimension in the page axis, the context member is overridden by the page axis member.

**Note:**
If the value in the ReportID is unknown, only the context members are displayed.

The members are displayed in the selected cell, separated by the specified separator.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>separator</td>
<td>Separator character. Optional. If not specified, the List Separator of your local settings is used.</td>
</tr>
<tr>
<td>reportID</td>
<td>Specify the ID of one report. If not specified, 000 (default report) is taken into account.</td>
</tr>
</tbody>
</table>

### 29.10 EPMContextMember

This function retrieves the context member for the specified dimension. When you double-click the cell containing the function, a dialog box opens, displaying all the members for the specified dimension. You can select another member and the context is changed. The list of members can be optionally filtered, using the dimension properties.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>dimension</td>
<td>dimension name. Mandatory.</td>
</tr>
<tr>
<td>filter</td>
<td>Filter by property to return only members with specified property values. Optional.</td>
</tr>
</tbody>
</table>

Example:
EPMContextMember("Finance","Entity","CALC=N;GROUP=SALES"). For the Finance connection, the context member of the dimension Entity is displayed in the cell. If you double-click the cell, a dialog box displays a list of all entity members filtered by CALC=N and by GROUP=SALES.

### 29.11 EPMDimensionProperty

This function retrieves the properties of a specified dimension in a specified cell range.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>dimension</td>
<td>Name of the dimension for which you want to return the properties. Mandatory.</td>
</tr>
<tr>
<td>destination range</td>
<td>Cell range in which the properties will be displayed. Mandatory.</td>
</tr>
</tbody>
</table>

**Note:**
One property will be displayed in one cell. If you select a smaller number of cells that the number of properties, not all the properties will be displayed. Therefore, you should select a large destination range.

### 29.12 EPMMemberDesc

This function retrieves the description of the specified dimension member.
### 29.13 EPMMemberProperty

This function retrieves the value of a specified property for a specified member.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>member</td>
<td>Member name. Mandatory.</td>
</tr>
<tr>
<td>property</td>
<td>Property name. Mandatory.</td>
</tr>
</tbody>
</table>

### 29.14 EPMMemberOffset

This function retrieves a member related to another member by specifying an offset from a given member to retrieve the previous or subsequent member. The cell containing the EPMMemberOffset function increments members based on the member selected. By default, if the optional Level parameter is not included, the member at the same level as the member specified is incremented.

**Note:**
When you choose a specific level using the Level parameter, note that only the members that are above the member (the one specified in the member parameter) or at the same level in the hierarchy, will be displayed. If you specify a level that is below the member, the level will be ignored.

You can use a negative offset.
### EPMMemberOffset

**Description**
This function retrieves a specified dimension member. When you double-click the cell containing the function, a dialog box opens, displaying all the members for the dimension. You can select another member. The list of members can be optionally filtered, using the dimension properties.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>member</td>
<td>Member name. Mandatory.</td>
</tr>
<tr>
<td>offset</td>
<td>Specify the number of member increments. Mandatory.</td>
</tr>
<tr>
<td>level</td>
<td>Specify the hierarchy level. Optional.</td>
</tr>
</tbody>
</table>

**Example:**

```plaintext```
EPMMemberOffset("Finance",D4,"1")
```

If cell D4 contains 2009.Q1, and no level is specified, an increment of 1 returns the member 2009.Q2, and an increment of 2 returns 2009.Q3, and so on.

If cell D4 contains 2009.TOTAL, and no level is specified, an increment of 1 returns 2010.TOTAL.

### 29.16 EPMCellRanges

**Description**
This function enables you to define dynamic cell ranges.
### Parameters and Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>range1... to range26</td>
<td>Range of cell</td>
</tr>
</tbody>
</table>

### 29.17 EPMRefreshTime

This function retrieves the time and date of the last data refresh for the specified connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
</tbody>
</table>

### 29.18 EPMScaleData

This function retrieves data for a full set of members, and scales the data. Any member not specified is taken from the context.

The data is divided by the number entered in the scale parameter and the result is displayed in the selected cell.

When using a Planning and Consolidation connection, the division is performed only on for accounts that are scalable. If an account is not scalable, the original amount is displayed in the cell.

**Note:**
You can view the “scaling” property of an account by selecting it in the sheet and then selecting EPM > More > Member Properties.
### 29.19 EPMRetrieveData

This function retrieves data for a full set of members. Any member not specified is taken from the context.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>member1</td>
<td>Member name. Optional.</td>
</tr>
<tr>
<td>member25</td>
<td>Member name. Optional.</td>
</tr>
</tbody>
</table>

### 29.20 EPMDimensionList

This function retrieves the list of all the dimensions of the model or cube for the specified connection. You can choose to display:

- all the dimensions in the current cell, where a specified character separate the dimension names.
- all the dimensions in one or more drop-down lists.
### 29.21 EPMSaveComment

**Applies to:**
Planning and Consolidation connections.

This function enables you to enter or modify a comment for a full set of members, in a specified cell. Any member not specified is taken from the context. Once you have entered or modified a comment, you can perform a save, using the **Save Data** button. The comment is saved to the server.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell</td>
<td>Cell in which the comment will be retrieved/entered. Mandatory.</td>
</tr>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>member1...</td>
<td>Member name. Optional.</td>
</tr>
<tr>
<td>member24</td>
<td>Member name. Optional.</td>
</tr>
</tbody>
</table>

### 29.22 EPMSaveData

**Applies to:**
Planning and Consolidation connections.

This function enables you to enter or modify a data for a full set of members, in a specified cell. Any member not specified is taken from the context. Once you have entered or modified a data, you can perform a save, using the **Save Data** button. The modified data is saved to the server.
### 29.23 EPMWorkStatus

**Applies to:**
Planning and Consolidation connections.

This function retrieves information about the work status.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>parameter</td>
<td>Possible number values: 0=status, 1=user, 2=time. Mandatory.</td>
</tr>
<tr>
<td>member1</td>
<td>Member name. Optional.</td>
</tr>
<tr>
<td>member24</td>
<td>Member name. Optional.</td>
</tr>
</tbody>
</table>

### 29.24 EPMComparison

**Applies to:**
Planning and Consolidation connections. If you use this function on other connections, a simple subtraction is performed, as the account type cannot be retrieved.

Performs a better or worse comparison of two values, based on the account type property of the account member.

The account type property has the following values:
- INC (Income)
- EXP (Expense)
- AST (Asset)
- LEQ (Liabilities & Equity)
### Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>account</td>
<td>Name of the account member. Mandatory.</td>
</tr>
<tr>
<td>cell1</td>
<td>Cell reference of one of the values in the comparison. Mandatory.</td>
</tr>
<tr>
<td>cell2</td>
<td>Cell reference of the other value in the comparison. Mandatory.</td>
</tr>
</tbody>
</table>

**Example:**

EPMComparison("Finance","Revenue",B2,C2). If cell B2 is greater than cell C2 and the account is a revenue (income) account, the resulting variance is expressed as a positive. If the account is an expense account, the variance is negative.

### 29.25 EPMDimensionType

**Applies to:**

Planning and Consolidation connections.

This function retrieves a dimension depending on its type. The dimension types are: A, C, D, E, F, G, I, R, S, T and Un.

- A for Account.
- C for Category
- D for Data Source
- E for Entity
- F for Measures
- G for Ownership
- I for Intercompany
- R for Currency-type dimension
- S for Subtable
- T for Time
- Un: each user defined dimension is assigned a numeric value after the U, U1, U2, U3, and so on.
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>dimensionType</td>
<td>Type of the dimension. Mandatory.</td>
</tr>
</tbody>
</table>

#### 29.26 EPMCommentFullContext

**Applies to:**
Planning and Consolidation connections.

This function retrieve all comments associated to a set of dimension members that is fully defined. If there is no member specified for a dimension, its context member is used instead.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>member1</td>
<td>Name of the member from which to get associated comments. Optional.</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>member25</td>
<td>Name of the member from which to get associated comments. Optional.</td>
</tr>
</tbody>
</table>

**Note:**
A comment is displayed by default in the cell in which you have entered the function. However you can use the **Show as Microsoft Excel Comments** option in the **Sheet Options** to display the comment as a standard Microsoft Office Excel comment, when you mouse over the cell.

**Related Topics**

- [Show as Microsoft Excel Comments](#)

#### 29.27 EPMCommentPartialContext

**Applies to:**
Planning and Consolidation connections.

This function retrieves all comments associated to a set of dimension members that is partially defined. Any members not specified in the function is ignored.
For example, if your model contains the following dimensions: Account, Entity and Time. In the function, you do not specify a member for the Time dimension, then all comments entered for any period are returned.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connection name</td>
<td>Name of the connection. Optional. If not specified, the active connection is taken into account.</td>
</tr>
<tr>
<td>member1</td>
<td>Name of the member from which to get associated comments. Optional.</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>member25</td>
<td>Name of the member from which to get associated comments. Optional.</td>
</tr>
</tbody>
</table>

**Note:**
A comment is displayed by default in the cell in which you have entered the function. However you can use the **Show as Microsoft Excel Comments** option in the **Sheet Options** to display the comment as a standard Microsoft Office Excel comment, when you mouse over the cell.

**Related Topics**
- **Show as Microsoft Excel Comments**

---

**29.28 EPMURL**

This function retrieves a specified text on which you double-click to open in a browser a Planning and Consolidation web page or any other web page, depending on the URL address you have specified.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Web address or specific text to a Planning and Consolidation web page.</td>
</tr>
<tr>
<td>displayedText</td>
<td>Text in the cell to double-click on. Optional. If not specified, this text will appear: &quot;Navigate to&quot;.</td>
</tr>
</tbody>
</table>

**Access a specific web page of Planning and Consolidation**

**Applies to:** Planning and Consolidation connections.

To access a specific web page of Planning and Consolidation (objects such as a web report or a specific view; or features such as opening the Documents view), enter the text corresponding to the page you want to open as the **URL** parameter. The web server is automatically added (even though not visible in the URL parameter).

- To access a specific web page of Planning and Consolidation (objects such as a web report or a specific view; or features such as opening the Documents view), enter the text corresponding to the
page you want to open as the **URL** parameter. The web server is automatically added (even though not visible in the **URL** parameter).

- To access a specific web report, an input form, a workspace or a Flash dashboard (designed with SAP BusinessObjects Dashboard Design), do as follows: in the Library view, select the row of the object, then select and copy the **Direct Reference** displayed at the bottom of the page and paste it in the **URL** parameter of the EPMURL function.

- To access a specific document, do as follows: in the Documents view, right-click on the row of the document, then select **Copy Direct Reference** and perform a paste in the **URL** parameter of the EPMURL function.

- To access a specific book, you must open the book from the Planning and Consolidation web client, copy the entire URL and paste it in the **URL** parameter of the EPMURL function.

- To perform the following actions, copy the text from the second column and paste it to the **URL** parameter of the EPMURL function.

<table>
<thead>
<tr>
<th>Action</th>
<th>Text to insert as the URL parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a web report</td>
<td>action=createNewLiveReport</td>
</tr>
<tr>
<td>Create an input form</td>
<td>action=createNewInputSchedule</td>
</tr>
<tr>
<td>Create a workspace</td>
<td>action=createNewWorkspace</td>
</tr>
<tr>
<td>Open the <strong>Manage Comments</strong> tab</td>
<td>action=createCommentManager</td>
</tr>
<tr>
<td>Open the EPM add-in in Microsoft Excel</td>
<td>action=openXL</td>
</tr>
<tr>
<td>Open the EPM add-in in Microsoft PowerPoint</td>
<td>action=openPP</td>
</tr>
<tr>
<td>Open the EPM add-in in Microsoft Word</td>
<td>action=openWord</td>
</tr>
<tr>
<td>Open the <strong>Administration</strong> view</td>
<td>action=openAdmin</td>
</tr>
<tr>
<td>Open the <strong>Activities</strong> view</td>
<td>homePageFeature=MYACTIVITIES</td>
</tr>
<tr>
<td>Open the Process Monitor view</td>
<td>homePageFeature=PROCESSMONITOR</td>
</tr>
<tr>
<td>Open the Library view</td>
<td>homePageFeature=LIBRARY</td>
</tr>
<tr>
<td>Open the Documents view</td>
<td>homePageFeature=DOCUMENTS</td>
</tr>
<tr>
<td>Open the Consolidation Monitor view</td>
<td>homePageFeature=CONSOLIDATIONMONITOR</td>
</tr>
<tr>
<td>Open the Controls view</td>
<td>homePageFeature=CONTROLS</td>
</tr>
</tbody>
</table>
### Open another web page

To open another web page that is not related to Planning and Consolidation, enter the full URL in the **URL** parameter. For example: http://google.com

### 29.29 EPMBook

**Applies to:** Planning and Consolidation connections.

This function retrieves a specified text you can double-click to open a book published in Planning and Consolidation web client.

- If the books you want to view have been published in several PDFs, do not use the `locationType` nor the `teamID` parameters.
- If the books you want to view have been published in one single PDF, you must specify the `locationType` parameter, that is the location type that has been specified in the book publication template:
  - 2=Public
  - 3=Private
  - 4=Team. If you specify the team location type, you must then specify the `teamID` parameter.

When you double-click the cell, a web browser opens, displaying the book specified. All the variable members that have been specified in the book publication template can be selected, using the drop-down menus to the left part of the window. The data on the right part of the window are updated accordingly.

### Table

<table>
<thead>
<tr>
<th><strong>Action</strong></th>
<th><strong>Text to insert as the URL parameter</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the <strong>Journals</strong> view</td>
<td><code>homePageFeature=JOURNALS</code></td>
</tr>
<tr>
<td>Open the <strong>Ownership Manager</strong> view</td>
<td><code>homePageFeature=OWNERSHIPMANAGER</code></td>
</tr>
<tr>
<td>Open the <strong>Audit</strong> view</td>
<td><code>homePageFeature=AUDIT</code></td>
</tr>
<tr>
<td>Open the <strong>Analysis</strong> view</td>
<td><code>homePageFeature=ANALYSIS</code></td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>modelName</td>
<td>Name of the model. If not specified, the model for the active connection is taken into account.</td>
</tr>
<tr>
<td>templateName</td>
<td>Name of the book publication template.</td>
</tr>
<tr>
<td>sectionName</td>
<td>Name of the section.</td>
</tr>
<tr>
<td>locationType</td>
<td>(only for single PDF) Specify the location where the PDF has been published. 2=Public; 3=Private; 4=Team</td>
</tr>
<tr>
<td>teamID</td>
<td>(only for single PDF and for Team location) Specify the ID of the team for which the PDF has been published.</td>
</tr>
<tr>
<td>displayedText</td>
<td>Text in the cell to double-click on. Optional. If not specified, this text will appear: &quot;View [template name]&quot;.</td>
</tr>
<tr>
<td>member 1...</td>
<td>Specify the name of the variable member. Optional.</td>
</tr>
<tr>
<td>member 19</td>
<td>Specify the name of the variable member. Optional.</td>
</tr>
</tbody>
</table>

## 29.30 EPMLink

This function retrieves a specified text on which you double-click to open a report contained in another file, that is a Microsoft Excel workbook, a Word document or a PowerPoint presentation.

When you double-click the link, the specified file opens and the context is passed along. If you want to override certain context members, you can optionally specify other members.
### 29.31 EPMDocumentList

**Applies to:** Planning and Consolidation connections.

This function opens the Planning and Consolidation Documents view and retrieves a filtered list of documents. Then, you can double-click a document in the list to open it.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>modelName</td>
<td>Name of the model. If not specified, the model for the active connection is taken into account.</td>
</tr>
<tr>
<td>docType</td>
<td>Optional. The document type assigned to the documents. If you leave it blank, the system returns all document types.</td>
</tr>
<tr>
<td>docSubType</td>
<td>Optional. The sub-type assigned to the documents. If you leave it blank, the system returns all document subtypes.</td>
</tr>
<tr>
<td>docDescription</td>
<td>Optional. The description of the document.</td>
</tr>
<tr>
<td>startDate</td>
<td>A starting date from which to search the Documents list for the document. The format must be the one that is selected in your local settings. For example: mm-dd-yyyy.</td>
</tr>
<tr>
<td>endDate</td>
<td>An ending date to which to search the Documents list for the document. The format must be the one that is selected in your local settings. For example: mm-dd-yyyy.</td>
</tr>
<tr>
<td>sortField</td>
<td>Criteria on which you want to sort the documents. 0=title; 1=type; 2=sub-type; 3=model; 4=date. Optional.</td>
</tr>
</tbody>
</table>
### 29.32 EPMDocument

**Applies to:**
Planning and Consolidation connections.

This function retrieves a specified text you can double-click to open a document stored on the Planning and Consolidation Documents view. The document opens in a web browser.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sortOrder</td>
<td>Sorting order. 0=ascending; 1=descending. Optional.</td>
</tr>
<tr>
<td>targetWindow</td>
<td>Where in the web browser to display a document. Three possible values: &quot;0&quot;=same tab (default); &quot;1&quot;=new tab in the same window; &quot;2&quot;=new window. Optional.</td>
</tr>
<tr>
<td>displayedText</td>
<td>Text in the cell to double-click on. Optional. If not specified, this text will appear: &quot;View Documents&quot;.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>modelName</td>
<td>Name of the model. If not specified, the model for the active connection is taken into account.</td>
</tr>
<tr>
<td>docName</td>
<td>Name of the file to open.</td>
</tr>
<tr>
<td>team</td>
<td>Team that has access to this document. Optional.</td>
</tr>
<tr>
<td>docType</td>
<td>The document type assigned to the document. Optional.</td>
</tr>
<tr>
<td>targetWindow</td>
<td>Where in the web browser to display the document. Three possible values: &quot;0&quot;=same tab (default); &quot;1&quot;=new tab in the same window; &quot;2&quot;=new window. Optional.</td>
</tr>
<tr>
<td>displayedText</td>
<td>Text in the cell to double-click on. Optional. If not specified, this text will appear: &quot;View [name of the document]&quot;.</td>
</tr>
</tbody>
</table>

### 29.33 EPMExecuteAPI

This function enables you to execute APIs directly from a worksheet cell. When clicking the cell in which you insert the function, the API is executed.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APIName</td>
<td>Name of the API. Mandatory.</td>
</tr>
<tr>
<td>DisplayedText</td>
<td>Specify the text the user selects to execute the API.</td>
</tr>
</tbody>
</table>
| Parameter    | API parameter name. Mandatory (if the API has parameters). When several pa-
|              | rameters, use the list separator that is specified in your local settings.  |

**Note:**
The APIs are available in the IEPMExecuteAPI class.

**Related Topics**
- API
Data Input and Save

**Applies to:**
Planning and Consolidation connections.

Here is the workflow for the overall data input and save feature, provided that the appropriate task profiles are assigned to you:

- Enter data in an input form. You can use planning features to help you entering your data in an input form.

  **Note:**
  A report is called an input form when you can both enter data in it and save them to the server.

- Add comments to the data.

  **Note:**
  You can add comments using the EPM add-in in Microsoft Office Excel, Word or PowerPoint.

- Save the data entered. The data is written in the database.
- Validate data. This is only available a Planning and Consolidation, version for the Microsoft platform, connection.
- Change the work status so that you can lock a specific data region.

  **Note:**
  Task profiles are assigned in the Administration section of Planning and Consolidation.

30.1 Data Input

**Applies to:**
Planning and Consolidation connections.

There are two ways of entering data:

- Enter data directly in the cells of an input form.

  **Note:**
  To help you entering your data in an input form, you can:
  - Use planning features. For more information, see Planning Features.
  - Use the Keep Formula on Data option. For more information, see Keep Formula on Data and Show Source Data in Comments.
• Perform a sum on each parent in the hierarchies. For more information, see Calculate Parents in Hierarchies.
• Insert members that are not displayed in the input form. For more information on how to insert members, see Member Entry Using the Insert Members Dialog Box
• Enter data for a fully-specified data region, using the EPMSaveData function. For more information, see EPMSaveData.

You will be able to save the data you enter in an input form only if you meet the following criteria:
• You can enter data for a fully-specified data region where each member - for each dimension of the model - is an inputable member, that is a base level member (or not calculated member).

Tip:
To quickly and easily view for which members you can enter data, use the dynamic formatting sheet, select the Dimension Member/Property Formatting section, define a specific format in the Inputable Member Default Format row and perform a refresh on your input form worksheet. For more information, see Dynamic Formatting Template Definition.

Note:
To find out if a member is inputable or not, you can also select a member in your input form and select More > Member Properties. In the "CALC" property, "Y" indicates that the member is calculated and therefore not inputable; "N" indicates that the member is a base level member and is therefore inputable.

• You can enter data if you have been granted the appropriate profiles in the Administration view of Planning and Consolidation.

Related Topics
• Member Properties

30.2 Planning Features

Applies to:
Planning and Consolidation connections.

You can use planning features to help you entering your data in an input form.

You can use the following planning features:
• Spread. The spread feature enables you to take a value and allocate it among selected destination cells.
• Trend. The trend feature takes a value or percentage and grows it by a factor among selected cells. This option places the source value in the first cell of the destination range. Each subsequent cell in the destination increases by the amount or percentage specified.
• Weight. The weight feature lets you allocate a set of values by weighted factors in your spreadsheet.
30.2.1 Spread

**Applies to:**
Planning and Consolidation connections.

The spread feature enables you to take a value and allocate it among selected destination cells.

The value can be allocated equally, or it can be weighted by a range of values. For example, you can take the value 100,000 and spread it across a number of columns that represent each month of the year.

To perform a spread, select **Planning > Spread** and specify the following items in the **Spread** dialog box:

- **Source Value.** Specify the total value to be spread.
- **Destination.** Specify the destination cells in which the system writes the results of the spread.
- **Weights.** This is optional. Specify a range containing weight values upon which to base the spread. This range must contain the same number of cells as the destination range. The source value will be spread based on the selected weights. If you don’t specify weights, the source value will be spread evenly.
- **Select one of the Spread Result options:**
  - To take the spread amount to each cell and add it to any existing values already in the destination range, select the **Add to Existing Values** option.
  - So that the amount spread to each cell overwrites the amounts in the destination cells, select the **Overwrite Existing Values** option.

30.2.2 Trend

**Applies to:**
Planning and Consolidation connections.

The trend feature takes a value or percentage and grows it by a factor among selected cells.

This feature places the source value in the first cell of the destination range. Each subsequent cell in the destination increases by the amount or percentage specified.

To perform a trend, select **Planning > Trend** and specify the following items in the **Trend** dialog box:

- **Source Value.** Specify the initial value from which the trend begins.
- **Specify a value or a percentage:**
  - **By Percentage:** Specify a percentage of the previous value (previous cell) in the destination range. To create an increasing trend, use a positive percentage. To create a declining trend, use a negative percentage.
• **By Value**: Specify an amount over the previous value (previous cell) in the destination range. To create an increasing trend, enter a positive value. To create a declining trend, enter a negative value.

• Destination. Specify the destination cells in which the system writes the results of the trend.

• Weights. This is optional. Specify a range containing weight values upon which to base the spread. This range must contain the same number of cells as the destination range. The source value will be spread based on the selected weights. If you don't specify weights, the source value will be spread evenly.

• Select one of the **Trend Result** options:
  - To take the trend amount to each cell and add it to any existing values already in the destination range, select the **Add to Existing Values** option.
  - So that the amount trend to each cell overwrites the amounts in the destination cells, select the **Overwrite Existing Values** option.

### 30.2.3 Weight

**Applies to:** Planning and Consolidation connections.

The weight feature lets you allocate a set of values by weighted factors in your spreadsheet.

It enables you to take a set of values, grow them if desired, and then allocate the new amount based on the relative weights of the selected cells. The destination range is the same as the weight range. For example, you can weigh 12 months of revenue based on 12 months of cost of sales.

To perform a weight, select **Planning > Weight** and specify the following items in the **Weight** dialog box:

• Sum to allocate. Specify the initial sum from which the allocation begins. This amount defaults to the sum of the selected cells.

• Specify a value or a percentage:
  - **By Percentage**: Specify a percentage so that the sum to allocate will be increased by the specified percentage before allocating.
  - **By Value**: Specify an amount so that the sum to allocate will be increased by the specified value before allocating.
  - **None**: Select this option so that the sum to allocate remains unchanged before allocating.

• Destination. Specify a range of cells that contain relative weights, to which the results of the allocation are written.

### 30.3 Comments
Applies to:
Planning and Consolidation connections.

Comments provide a vehicle for submitting, storing, and retrieving text commentary associated with report data cells. This allows users to annotate data so other users can view supporting information associated with a particular data point.

You can perform the following actions on comments, using the EPM add-in:
• Add or modify a comment to a specific data region.
• Retrieve a comment in a cell, for a specific data region.
• Search for comments that meet specific criteria.

Note:
• You can also view a history of the comments and delete comments, in the web client of Planning and Consolidation.
• You can add or search for comments using the EPM add-in in Microsoft Office Excel, Word or PowerPoint.

30.3.1 Comment Creation and Modification

Applies to:
Planning and Consolidation connections.

Note:
When using a Planning and Consolidation, version for the NetWeaver platform, connection, to add or modify a comment, the option enabling comment creation in the Administration view must be selected.

There are two ways of adding a comment:

Add a comment using the dedicated dialog box
You can add a comment, using a dedicated dialog box.

Select Comments > Add Comment and specify the following items in the Add Comment dialog box:
• Select the desired priority level. The reports show comments in order of their priority level.
• Enter your comment. A comment is limited to 512 characters.
• Enter one or more keywords to organize and search for comments in the database.
  Do not use special characters for the keywords. The separator character used to separate the keywords is the comma.
• Select to which of the following you want to associate the comment to:
  • The active cell. The comment is applied to the data region associated with the selected cell.
  • The current context. The comment is applied to the context displayed in the EPM Context bar.
  • A custom context. This option allows you to specify a different context than the current one, to which to associate the comment. For each dimension, select: a member or none of the members. If you select None, the comment applies to any member for that dimension.
When you click **Save** in the **Add Comment** dialog box, unless there is an error, the comment is saved to the server.

**Note:**
If you want that the save result be displayed, select the **Display Warning when Saving Data or Comment** option in the **User Options**. If the option is selected, as soon as you click **Save** in the **Add Comment** dialog box, a pop-up will open, telling you if the comment has been saved or not.

**Add or modify a comment using the EPMSaveComment function**
You can add or modify a comment for a full set of members, using the EPMSaveComment function. For more information, see [EPMSaveComment](#).

**Note:**
if comments have already been entered on a combination of members, entering a comment on the same combination of members does not overwrite the previous comments. You can view a history of the comments in the web client of Planning and Consolidation.

### 30.3.2 Comment Display in a Cell

**Applies to:**
Planning and Consolidation connections.

You can retrieve comments in cells for specific combinations of members, using the following EPM functions:

- EPMCommentFullContext. For more information, see [EPMCommentFullContext](#).
- EPMCommentPartialContext. For more information, see [EPMCommentPartialContext](#).

**Note:**
- The comment is displayed by default in the cell in which you have entered the fonction. If you to display the comment as a standard Microsoft Office Excel comment, that is when you mouse over the cell, select **Sheet Options** > **General** > **Show as Microsoft Excel Comments**.
- if several comments have been entered on the combination of members specified in either one of the EPM functions, the latest comment entered is displayed.

**Related Topics**
- [EPMCommentFullContext](#)
- [EPMCommentPartialContext](#)
- [Show as Microsoft Excel Comments](#)
30.3.3 Comment Search

**Applies to:**
Planning and Consolidation connections.

You can retrieve comments that meet specific criteria.

Select **Comments > Find Comments** and specify the following search items in the **Find Comments** dialog box:

- Enter one or more keywords to return only comments with matching keywords.
  
  If you enter more than one keyword, use the comma as the separator character. You can only enter the beginning of a keyword and the search will be performed on all keywords beginning with what you entered.

- Select one or more priority options to return comments associated with that priority.

- Specify the author of the comment:
  - **Anyone.** This option returns comments entered by all users.
  - **Myself.** This option returns comments that you have entered.
  - **Specific Users.** This option returns comments entered by one or more users. To select the users, click the ellipsis button.

- Specify a date range for which to return comments. Use the **From** and **To** drop-down lists to specify the desired date range and select the checkboxes.

- Select which of the following is associated to the comments you are searching for:
  - The active cell. Returns comments associated with the members for the active cell.
  - The current context. Returns comments associated with the active context.
  - A custom context. Returns comments associated with a different context than the current one. For each dimension, select: a member or all members.

When you click **Find**, the list of comments found is displayed in the web client of Planning and Consolidation that opens.

30.4 Data Save

**Applies to:**
Planning and Consolidation connections.

To write data to the server, use the **Save Data** command in the **EPM** tab of the ribbon.

You can perform the following save-related actions:

- Save data entered on the current worksheet.
- Save data entered on the current workbook.
• Save data entered on the current worksheet and then perform a refresh.

  **Note:**
  This is the default save action when you directly click the **Save Data** button.

• Save data entered on the current workbook and then perform a refresh.

Either of the above save actions writes to the server all the following records that have been changed on the current worksheet or workbook:

• Data, whether the data have been entered directly in cells or have been entered using the **EPMSaveData** function.

• Comments that have been entered using the **EPMSaveComment** function.

  **Note:**
  If you want the save-related messages to be displayed, select the **Display Warning when Saving Data or Comment** option in the **User Options**. If the option is selected, as soon as you perform a data save, a first dialog box opens, asking to confirm or not the save of x data (if there is no data to save, the message says so); if you confirm, a pop-up opens, telling you if the data have been saved or not.

When you use either one of the save and refresh commands, data are first saved to the server, then data are refreshed in your input form, taking into account the data you have saved and recalculating the amounts accordingly. For example: you enter data for January, February and March. You select **EPM > Save Data > Save and Refresh Worksheet Data**. As the data form is refreshed from the server, the sum of the 3 months you have entered is displayed for Quarter 1 in the input form.

For a specific input form, you can choose not to save the data entered on specific members. For more information, see **Read-only Data**.

  **Note:**
  If you cannot save data, check that your administrator has granted you the appropriate rights and make sure that the **Use as Input Form** is selected in the current report options. For more information, see **Use as Input Form**.

**Related Topics**
- **EPMSaveData**
- **EPMSaveComment**

### 30.5 Data Validation

**Applies to:**
Planning and Consolidation, version for the Microsoft platform, connections.

Once you have entered and saved data, you can launch a data validation.

When launching a data validation, the system checks to make sure there are no work status locks or validity issues, respectively, on the data region. The validity check consists in checking that the Validation account equals 0.
Before launching a data validation, you must perform the following actions:

- Create a workbook (the validation report) and save it to one of the following locations on the server: Input Schedules or Input Schedules/Wizard
- In the Planning and Consolidation Administration, enter the name of the workbook as the value of the LOCKREPORT parameter.

To validate data, select **Save Data > Validate Data**.

If the data does not pass the validation, a message opens and offers you to run and open the validation report that will show you what is incorrect. You can then modify the data accordingly, save them and validate them again.

When the data is validated, you can change the work status.

### 30.6 Work Status

**Applies to:**
Planning and Consolidation connections.

Once you have entered and saved data, you can modify the work status for a specific data region. The work status feature enables you to apply a label to a data region and lock it for review, approval, and so on. For example, after saving data, you can set the work status to “Saved”. This locks the data region from being overwritten.

**Note:**
The work status is set up in the Administration view.

To change the work status for a data region, select **Save Data > Change Work Status**. The Change Work Status dialog box opens.

- In the **Change Status for** area, you define for which data region you want to change the work status. From 3 to 5 dimensions are available. For each dimension, the context member is displayed by default. You can select another member for a dimension by clicking the ellipsis button.

**Note:**
- For the first dimension, which is defined as the owner dimension in the Administration view, you can include in the selection all the descendant members of the specified member by selecting the **Include all Descendants** option.
- If you are working with Planning and Consolidation, for SAP NetWeaver, you must only select a base member for each dimension or you will not be able select another work status.
- You can change the work status only for members of which you are the owner or manager. This is defined in the Administration view.
- In the **New Work Status** area, the current status for the specified data region is displayed. You can select a work status that reflects the state of data.

**Note:**
The work status that are available for selection have been defined in the Administration view.
Accessing Journals

Applies to: Planning and Consolidation connections.

You use journals to record and make adjustments to data in the database. This is typically done as part of the month-end or quarter-end process.

From the EPM tab in Microsoft Office Excel, you can access the Journals view of SAP BusinessObjects Planning and Consolidation by clicking the Journals. Planning and Consolidation opens in a web browser, displaying the Journals view and the context for the model to which you are connected is passed along.

For more information, see the SAP BusinessObjects Planning and Consolidation help.
**Business Process Flows**

**Applies to:**
Planning and Consolidation connections.


In the Planning and Consolidation web client, when you click an activity or process covering actions that are to be performed using the EPM add-in in Microsoft Office Excel, the application opens, and the dedicated Process tab is displayed in the EPM pane. Same thing for Microsoft Office Word and Microsoft Office PowerPoint when the actions must be performed in these applications.

**Note:**
If Excel, Word or Powerpoint is already opened, a new instance of the application opens.

A list of actions is available. When you click an action, the sub-actions that are related to the action are displayed below the list of actions. When you click a sub-action link, it takes you to the place where you can perform the action.

When you are finished performing all the actions, click the button at the bottom of the tab. It takes you back to Planning and Consolidation.
Report and Input Form Templates

**Applies to:**
Planning and Consolidation connections.

In the "Shell" environment, dynamic templates are available within Microsoft Office Excel workbooks.

- For the "Finance" model:
  - 10 templates designed for reports.
  - 5 templates designed for input forms.
- For the "Rate" model:
  - 4 templates designed for reports.
  - 3 templates designed for input forms.
- For the "Ownership" model:
  - 2 templates designed for reports.
  - No template designed for input forms.

You can find the templates in the following folders on the Planning and Consolidation server:

- Templates for input forms are stored in the "Templates" folder of the "Input Schedules" folder.
- Templates for reports are stored in the "Templates" of the "Reports" folder.

Each workbook contains two worksheets:

- One sheet contains the template: you can connect the template to any model, then change the context members and the dynamic template continues to be valid.
- One sheet contains a dynamic formatting sheet that is applied to the template.

**Note:**
As a template can be used with various connections, the Do not Store Connection option in EPM > Edit Report > Options is selected by default.

**Related Topics**
- Do not Store Connection and Do not Store Environment in the Connection
Other Features

34.1 Metadata Cache

**Applies to:**
Local and SAP BusinessObjects Enterprise connections.

The metadata cache feature is not activated by default, meaning that the dimensions and members are loaded each time you connect to a data source.

You can activate the cache, meaning that the metadata is copied locally and not loaded each time you connect to a data source. Using the cache enables you to improve the connection time. To activate the cache, select EPM > User Options, then select the Activate Metadata Cache option.

You can clear the metadata cache. When the cache is cleared, the structure of the data source you are connected to is synchronized with the structure copied locally; which means that the members of dimensions that have been added, modified or deleted in the data source are loaded.

- You can define the frequency at which the cache is automatically cleared. Select EPM > User Options, then select the Clear Metadata Cache Frequency option and enter a number in the field. If you enter 1, the cache is cleared once a day.
- You can clear the cache whenever you want. Select EPM > More > Clear Metadata Cache or click the Clear Metadata Cache button in the Edit Connection and Create Connection dialog boxes, when editing and creating a connection.

34.2 Log File

The log can contain three types of information, including Planning and Consolidation EvDRE migration information:

- Infos.
- Errors.
- Warnings.

**Note:**
- By default, the log file contains the errors for any use of the EPM add-in and all types of information related to the Planning and Consolidation EvDRE migration.
The content of the log depends on what has been defined in the configuration file. For more information, see the SAP BusinessObjects EPM Solutions, add-in for Microsoft Office Installation guide.

To view the log, select EPM > More > Log.

Only the lastest 100 lines of the log files are displayed in this screen. You can view the entire log lines in the following log files:

- FPMXLCClient.dll.Excel.log
- FPMXLCClient.dll.Migration.log. This log file contains all the information related to the EvDRE migration.

The log files are stored locally at the following default location. In your explorer, enter: %temp%/log.

Note:
This location is displayed in the Log screen.

### 34.3 Information on Cubes

**Applies to:**
Financial Consolidation SSAS cubes.

You can display the following information on a cube:

- The name of the cube.
- The name of the database.
- The last time the cube was deployed.
- The last time the cube was processed.

To view the information on a cube, select a report that is connected to the cube you want to see information about and select EPM > More > Cube Information.

### 34.4 MDX Display

**Applies to:**
Local and SAP BusinessObjects Enterprise connections.

You can display the MDX query for the current data sheet. You can then copy the MDX query and reuse it.

To display the MDX query, select EPM > More > Display MDX.
EPM Add-in for Microsoft Office Word and PowerPoint

In this section, you will find:
- A list of the features that are common to the add-in for Microsoft Office Excel, Word and PowerPoint.
- Features that are specific to the add-in for Microsoft Office Word and PowerPoint.
- The list of options available for the add-in for Microsoft Office Word and PowerPoint.

35.1 Common Features to the Add-in for Microsoft Office Excel, Word and PowerPoint

Using the add-in for Microsoft Office Word and in Microsoft Office PowerPoint, you can perform the actions listed below. These features behave like in the add-in for Microsoft Office Excel. Therefore, to read more about the features, follow the links.
- Log on and connections. See Log On and Connections.
- Open and Save actions. See Open and Save a File.
- Report creation and member selection. You can create a report using the Report Editor and the EPM pane. You can also copy and paste reports. You can select dimension members in the Member Selector dialog box. See Report Creation.
  
  **Note:**
  Asymmetric reports are not supported in Microsoft Office Word and in Microsoft Office PowerPoint.

  - Several reports in a document or presentation. See Several Reports in a Sheet.
  - Report refresh. You can refresh the selected report or all the reports in the entire file. See Report Refresh.
  - Publication on a portal. See Report Publication to a Web Portal.
  - Custom members. See Custom Members.
  - Flash object insertion. See Flash Object Insertion.
  - Comment creation and search, using the dialog boxes that open when selecting EPM > Comments > Add Comment or Find Comments. See Comments.
  - Display MDX. See MDX Display.
  - Cube information. See Information on Cubes.
  - Log. See Log File.
  - Clear metadata cache. See Metadata Cache.
35.2 Additional Features in the Add-in for Microsoft Office Word and PowerPoint

Additionally, you can insert data, that is one value:
• for the context dimension members.
• for a specified set of dimension members. If you do not specify a member for all the dimensions of the cube or model, the context members are taken into account for the unspecified dimensions.

To insert data, select Insert Data from the EPM tab in the ribbon. The Insert Data opens. You can select a dimension, then a member for the dimension. You can then select other dimensions and other members, then click OK.

When you select the data in the document or presentation, the dimensions and members selected are displayed in the EPM pane. You can change the selection by clicking a member.

35.3 Options in the Add-in for Microsoft Office Word and PowerPoint

**Document or Presentation Options**

In the Document Options or Presentation Options, the following options area available:

**Note:**
All the other options are greyed out.

• **Totals** options. See Totals Placement.
• **Empty Data Behavior.** See Empty Row and Column Behavior.
• **Display Name.** See Display Name.
• **Auto Fit Column Width.** See Auto Fit Column Width.
• **Repeat Row Headers** and **Repeat Column Headers.** See Repeat Row Headers and Repeat Column Headers.
• **Set Default Value in Empty Cell** and **Empty Cell Default Value** options. See Empty Cell Default Value.
• **Number Format** option. The area enables you to enter how you want the data numbers to be displayed, including or not a 1000 separator and a decimal number. The default format is the following: 0.## (no 1000 separator and 2 decimal numbers).


• **Refresh Data on the Whole File when Opening it.** See Refresh Data on the Whole File when Opening it.
• **Clear Data on the Whole File when Saving it.** See Clear Data on the Whole File when Saving it.
• **Show Unauthorized Cell Text.** Show Unauthorized Cell Text
**Report Options**

By default, the report options are the one defined for the current file in the Document Options or Presentation Options. You can modify the options for the current report in the Options tab of the Report Editor. To do so, deselect Inherit Document Options or Inherit Presentation Options. All the options that remain greyed out are the ones that are greyed out in the Document Options or Presentation Options.

**Note:**

Some options are always available for selection. See Report Options.
Data Manager

36.1 About Data Manager

36.1.1 About Data Manager

The Data Manager is a Planning and Consolidation module that helps you move data into the system, copy or move data within and across applications, and export data from an application for use in an external tool. In addition, the Data Manager supports mapping and complex transformations of data. The Data Manager also allows you to export transactional and master data from an application within Planning and Consolidation to a file that you can use in an external tool.

The Data Manager is used with both
- SAP BusinessObjects Planning and Consolidation, version for the Microsoft platform
- SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver

The Data Manager is integrated with the Excel interface. Click the Data Manager tab to start the Data Manager.

You can set up system logic to work together with packages in the Data Manager. When you import data, most packages automatically run default logic, which is contained in the default.lgf file, for your application. You can also include logic files in packages, or you can prompt users for logic files that they would like to use.

36.1.1.1 About Packages

A package is a set of specific tasks that define the work to be done. These tasks are based on information you provide either by entering information in Data Manager package prompts. When using the Data Manager with SAP BusinessObjects Planning and Consolidation 10, version for the Microsoft Platform, you can also modify packages directly through Microsoft SQL Server.
Packages allow you to move data among your Planning and Consolidation databases and to effect business processes, such as legal consolidation and intercompany booking. By default, there are three types of packages within the Data Manager:

- Data Management
- Financial Processes
- System Administration

**Note:**
By definition, a package in the Data Manager is anything that has been added either by default or as the result of customization in the "Run Package" dialog box.

Packages in the Data Manager are standard and shared among all models within all environments in a given Planning and Consolidation installation.

The packages that come with Planning and Consolidation are designed to be dynamic, which means that you are not required to modify them in order for the packages to work with your models and dimensions. You can modify packages to behave differently or to perform additional functions. In the "Organize Package List" dialog box you can do the following:

- Add a package
- Modify a package
- Remove a package
- Copy a package
- Move a package

The planning and consolidation application version for Microsoft relies on SSIS packages whereas the version for SAP NetWeaver relies on process chains.

**Related Topics**
- Running a Copy Package
- Running Packages

---

### 36.1.1.2 About Process Chains

A process chain is a sequence of processes that are scheduled to wait in the background for an event. Some of these processes trigger a separate event that can in turn start other processes. A process in the context of process chains is a procedure inside of or external to an SAP system with a defined beginning and end.

**Related Topics**
- Load Process Chain Examples
- About the Import and Send Email Process Chain
- Using the SendMail Process Chain
36.2 Standard Packages

36.2.1 Standard Data Management Packages

You can use the packages provided in the Data Management package group to perform general data management tasks. If a file has an associated transformation file, you can modify the file or assign it directly to the package.

<table>
<thead>
<tr>
<th>Package Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>The &quot;Clear&quot; package clears the data in the Fact and FAC2 table by importing zero values. The optimize process clears all values from the table. Running this package also clears comments from the comments table. You can use the import.xls transformation file with this package.</td>
</tr>
<tr>
<td>Copy</td>
<td>The &quot;Copy&quot; package copies data between dimensions within the Planning and Consolidation application.</td>
</tr>
<tr>
<td>Default Formulas</td>
<td>The &quot;Default Formulas&quot; package executes default formulas stored in your Default.LGF file.</td>
</tr>
<tr>
<td>Export</td>
<td>The &quot;Export&quot; package exports data values from the Planning and Consolidation cube, including calculated values, into an ASCII file. You are prompted to enter a name for the export file and for a data selection to export. You can use the export.xls transformation file with this package.</td>
</tr>
<tr>
<td>Package Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Export Dimension Members     | The "Export Dimension Members" package exports dimension members, including master data, text, and hierarchies, to a flat file. You are prompted for the following selections:  
  - Filename  
  - Destination  
  - Source dimension  
  - A transformation file  
  - Language  
  - Filter for dimension values  
  - A delimiter  
  - Whether to include a header  
  - Whether to include calculated members  
  - Whether to include selected hierarchies |
| Export Transaction Data      | The "Export Transaction Data" package exports transaction data from an application to a flat file. You are prompted for the following selections:  
  - Destination  
  - A transformation/mapping file  
  - Source application  
  - Filter for dimension values  
  - A delimiter  
  - Whether to include a header  
  - Whether to include calculated members |
| FX Restatement               | The "FX Restatement" package is used for currency translation. A sample logic file, FXTrans.lgf, is provided as an empty file.                     |
| Import                       | The "Import" package imports one or more ASCII files into the current application. You are prompted for one or more import files and associated conversion files. The signs of the amounts are reversed based on the Account type. You can use the import.xls transformation file with this package. |
| Import Master Data           | The "Import Master Data" package allows you to load dimension member data directly into a Planning and Consolidation Dimension's Member Table.  |
### Package Name | Description
--- | ---
Import Transaction Data | The "Import Transaction Data" package imports one or more ASCII files into the current application. You are prompted for the following selections:
- One or more import files
- A transformation file
- The import mode (merge versus replace and clear)
- Whether to run default logic
- Whether to check work status settings
The signs of the amounts are reversed based on the Account type. You can use the `import.xls` transformation file with this package.

Move | The "Move" package lets you move any selection of data within an application. You are prompted for source and destination data selections for all dimensions. The package clears records in the fact table in the destination before it moves records from the source fact table. When the records have been moved to the destination, the package clears the records in the source table.

Ownership Calculation | The "Ownership Calculation" package calculates the overall ultimate ownership of an entity based on actual control of that entity.

---

### 36.2.1.1 Examples of Standard Data Management Packages

#### 36.2.1.1.1 Copy Example

The copy package copies data between dimension members within applications

**Prerequisite:**
The target cube must contain the following dimensions:

- Account
- Category
- Entity
- Time

The target data is aggregated prior to the copy process.

The process is as follows: the transaction data in the target selection is cleared to 0. All of the transaction data in the source selection is written into the target.
**Note:**
All members are copied for the Time, Entity, and Category dimensions. The transaction data in source is not affected by the copy process.

**Selections**
- **Source selection:** Account=CASH
- **Target selection:** Account=CASH1

**Source data**
- ACTUAL,CASH,2006.MAY,200
- ACTUAL,CASH,2006.JULY,300

**Pre-Copy Target Data**
- ACTUAL,CASH1,2006.MAY,100
- ACTUAL,CASH1,2006.JUNE,150

**Result**

**Post-Copy Target Data**
- ACTUAL,CASH1,2006.MAY,200
- ACTUAL,CASH1,2006.JUNE,0
- ACTUAL,CASH1,2006.JULY,300

### 36.2.1.1.2 Move Example

The move package lets you move any selection of data within an application. You are prompted for source and destination data selections for all dimensions. The destination fact table records are cleared before the source records are moved. The source fact table records are cleared after they are moved to the destination.

**Prerequisite:**
The target cube must contain the following dimensions:

- Account
- Category
- Entity
- Time

The target data is aggregated prior to the copy process.

The process is as follows: the transaction data in the target selection is cleared to 0. The transaction data in the source selection is be written to the target. The transaction data in the source is cleared to 0.

**Selections**
- **Source selection:** Account=CASH
- **Target selection:** Account=CASH1
Pre-Move Source Data
- ACTUAL,CASH1,2006.MAY,200
- ACTUAL,CASH,2006.JULY,300

Pre-Move Target Data
- ACTUAL,CASH1,2006.MAY,100
- ACTUAL,CASH1,2006.JUNE,150

Result
- Post-Move Source Data
  - ACTUAL,CASH,2006.0,0
  - ACTUAL,CASH,2006.0,0

Post-Move Target Data
- ACTUAL,CASH1,2006.MAY,200
- ACTUAL,CASH1,2006.JUNE,0
- ACTUAL,CASH1,2006.JULY,300

36.2.1.1.3 Import Transaction from a Data File Example

The Import Transaction from a Data File package imports one or more ASCII files into the current application.

**Prerequisites:**
- The target cube contains the Account, Category, and Time dimensions.
- The target data is aggregated prior to the copy process.

The process is as follows: if the record already exists in the data file in the cube, the record in the cube is overwritten by the corresponding record in the data file.

**Note:**
All dimension members in the record are treated as a composed key.

If the record does not exist in the data file, it is inserted as a new record. If there are duplicate records in the data file, just the last record is written into the cube. The records that exist in the cube (but not in the data file) are not affected.

**Records in the Data File**
- ACTUAL,CASH,2006.MAY,200
- ACTUAL,CASH,2006.MAY,500
- ACTUAL,CASH,2006.JULY,300

**Pre-Import Cube Records**
- ACTUAL,CASH,2006.MAY,600
36.2.1.1.4 Import Master Data from a Data File Example

The import master data from a data file package allows you to load dimension member data directly into a Planning and Consolidation Dimension's Member Table.

**Prerequisites:**
- The target cube contains the Account, Category and Time dimensions.
- The target data is aggregated prior to the copy process.

If the source dimension member (the member record in the data file) already exists in the environment, the source dimension member overwrites the member that exists in the application set.

**Note:**
ID is the only key that can be used to determine whether or not the member already exists.

If the source dimension member does not exist in the environment, the source dimension member is inserted into the environment as a new member.

The dimension members in the environment, but not in the source file, do not change.

**Example:**
In this example, the dimension is Account and the first date column is ID.

**Source Data**

<table>
<thead>
<tr>
<th>ID</th>
<th>Account</th>
<th>Category</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000000</td>
<td>AST, Current Assets,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11000000</td>
<td>ENDFLOW,</td>
<td>F_900,</td>
<td>ST,</td>
<td></td>
</tr>
<tr>
<td>11110000</td>
<td>AST, Petty Cash,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11112001</td>
<td>ENDFLOW,</td>
<td>F_900,</td>
<td>ST,</td>
<td></td>
</tr>
</tbody>
</table>

**Pre-Import Environment Account Members**

<table>
<thead>
<tr>
<th>ID</th>
<th>Account</th>
<th>Category</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11110000</td>
<td>ASTAA,</td>
<td>Cash,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11112001</td>
<td>ENDFLOW,</td>
<td>F_900,</td>
<td>ST,</td>
<td></td>
</tr>
</tbody>
</table>

**Result**

**Post-Import Environment Account Members**

<table>
<thead>
<tr>
<th>ID</th>
<th>Account</th>
<th>Category</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000000</td>
<td>AST, Current Assets,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11000000</td>
<td>ENDFLOW,</td>
<td>F_900,</td>
<td>ST,</td>
<td></td>
</tr>
<tr>
<td>11110000</td>
<td>AST, Petty Cash,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11112001</td>
<td>ENDFLOW,</td>
<td>F_900,</td>
<td>ST,</td>
<td></td>
</tr>
</tbody>
</table>
36.2.1.2 Load Process Chain Examples

The Load process chain has many useful data dump and data retrieval functions as follows:

- **Processing the Application**
  
  You can import data when you process the application or you can process the application without importing data.

- **Importing Into Cube**
  
  You can import a correctly-formatted ascii text file directly into the database.

- **Exporting from Cube**
  
  You can export an ascii text file that contains data from you Planning and Consolidation database

- **TASK Commands in the Load Process Chain**
  
  You can use the following TASK commands in the Load process chain.

  The syntax is as follows:

  ```
  TASK(TASKNAME,NAME,DTSTask_EvDTSDumpLoad.clsEvDTSDumpLoad_1)
  TASK(TASKNAME,DESCRIPTION,TASKNAME) TASK(TASKNAME,APPSET,apshell)
  TASK(TASKNAME,APP,finance) TASK(TASKNAME,USER,tonyd)
  TASK(TASKNAME,DATATRANSFERMODE,1) TASK(TASKNAME,PROCESSMODE, 2)
  TASK(TASKNAME,PROCESSCUBE,1) TASK(TASKNAME,PROCESSCUBE_FAC2,)
  TASK(TASKNAME,FILE,C:\...\Webfolders\ApShell\Finance\DataManager\DataFiles\Examples\Import.txt)
  TASK(TASKNAME,SQL,) TASK(TASKNAME,MDX,) TASK(TASKNAME,MAXMEMBERS,)
  TASK(TASKNAME,SELECTION,) TASK(TASKNAME,CLEARDATA,0)
  TASK(TASKNAME,TIMEIDFORMAT,0)
  TASK(TASKNAME,SELECTIONFROMTASK,"CATEGORY,TIME,ENTITY")
  TASK(TASKNAME,DIMLIST,"CATEGORY,TIME,ACCOUNT,ENTITY,DATASRC,INTCO,RPTCURRENCY")
  TASK(TASKNAME,RUNTHELOGIC,0) TASK(TASKNAME,GETMEASURE,)
  TASK(TASKNAME,MACHINENAME,) TASK(TASKNAME,VALIDATETMPFILE,)
  TASK(TASKNAME,MMNCOPY,)
  ```

36.2.2 Financial Process Packages

The following table contains standard financial processes packages that have been have been added to the Data Manager, by default.
The "Allocation" package processes allocation logic for the user, environment, and allocation according to the logic defined in allocation.lgf.

The "FXtrans" package is used for currency translation.

**Note:**
The packages in this group are of the task type "User Package."

### 36.2.3 System Administration Packages

Administrative packages are designed to perform operational tasks on the database, such as back-end data manipulation. These packages are also designed for metadata and master data maintenance. Using tasks that have been provided, you can optimize and manage non-application cube data. The majority of these tasks can be executed using either the Data Manager or the administrative console. They can also be designed in a single custom process chain for overall system maintenance. The default administrative packages are described in the following table:

<table>
<thead>
<tr>
<th>Package Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append</td>
<td>The &quot;Append&quot; package clears the table for all entity, category, and time member combinations found in the data source file and imports the data into the database. This package can also perform the following functions:</td>
</tr>
<tr>
<td></td>
<td>• Process the data into the Planning and Consolidation cube</td>
</tr>
<tr>
<td></td>
<td>• Run default logic against the imported data set. You can use the import.xls transformation file with this package.</td>
</tr>
<tr>
<td>Archive</td>
<td>The &quot;Archive&quot; package can be used to schedule archiving operations for selected dimensions.</td>
</tr>
<tr>
<td>Archive Audit Activity</td>
<td>The &quot;Archive Audit Activity&quot; package can be used to schedule archiving operations for audit activity.</td>
</tr>
</tbody>
</table>

**Note:**
The packages in this group are of the task type Admin Package.
36.3 Additional Packages

36.3.1 About Additional Packages

In addition to the standard packages provided with the Data Manager, SAP BusinessObjects Planning and Consolidation provides several additional packages that you can add to the Data Manager. These packages are either Microsoft SSIS packages or process chains, depending on the version of the planning and consolidation application that you are using.

The following table describes the sample packages.

The sample packages are located on the Planning and Consolidation file server in the `\DataManager\PackageFiles\Examples` folder of the associated environment and model.

36.3.1.1 Example Packages

Data Manager provides example packages that consist of process chains. The example package defines the user interface that passes information to the process chain.

Other than the `ImportUsingFTP` process chain, you do not need to modify process chains before you can add them as packages and run them. Alternately, you can use an example process chain as the starting point for a custom package.

**Note:**
The `ImportUsingFTP` process chain must be modified before it can be used.

These packages are available to all environments.
<table>
<thead>
<tr>
<th>Package Name</th>
<th>Description</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin_Makedim</td>
<td>Creates dimension members using a SQL table and schedules the processing of dimension members. For example, if a new member ID is added, this process updates the FAC2 table with the updated list.</td>
<td>MS</td>
</tr>
<tr>
<td>Admin_Optimize</td>
<td>Optimizes models with lite, incremental, or full option.</td>
<td>MS</td>
</tr>
<tr>
<td>AdminTask_LogicValidation</td>
<td>Validates the logic file.</td>
<td>MS</td>
</tr>
<tr>
<td>AdminTask_MakeDim</td>
<td>This process chain creates dimension members and schedules the processing of dimension members. For example, if a new member ID is added, this process updates the application data with the updated list.</td>
<td>NW</td>
</tr>
<tr>
<td>AdminTask_Process</td>
<td>Processes the application with incremental or full option.</td>
<td>MS</td>
</tr>
<tr>
<td>AdminTask_Validate</td>
<td>This process chain validates the logic file.</td>
<td>NW</td>
</tr>
<tr>
<td>Append</td>
<td>Appends an ASCII file into the current application.</td>
<td>MS</td>
</tr>
<tr>
<td>AuditBackup</td>
<td>Backs up audit data.</td>
<td>MS</td>
</tr>
<tr>
<td>AuditClear</td>
<td>Clears audit data.</td>
<td>MS</td>
</tr>
<tr>
<td>AuditPurge</td>
<td>Purges audit data.</td>
<td>MS</td>
</tr>
<tr>
<td>AuditRestore</td>
<td>Restores audit data.</td>
<td>MS</td>
</tr>
<tr>
<td>ClearComment</td>
<td>Clears comments from the comments table.</td>
<td>MS</td>
</tr>
<tr>
<td>Clear from Fact Table</td>
<td>Removes the data from the FACT and FAC2 tables. The optimize process synchronizes the FACT and FAC2 tables with the cube. Running this package also clears comments from the comments table.</td>
<td>MS</td>
</tr>
<tr>
<td>Clear the Journal Tables</td>
<td>Clears the Journals table and creates an output file.</td>
<td>MS</td>
</tr>
<tr>
<td>Package Name</td>
<td>Description</td>
<td>Version</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Clear_Journals</td>
<td>This process chain prompts you to select categories, time dimensions, and currency to clear from the &quot;Journals&quot; table.</td>
<td>NW</td>
</tr>
<tr>
<td>ClearComments</td>
<td>This process chain clears comments from the &quot;Comments&quot; table.</td>
<td>NW</td>
</tr>
<tr>
<td>Copy Model</td>
<td>Copies the model database.</td>
<td>MS</td>
</tr>
<tr>
<td>Copy from Fact Table</td>
<td>Copies the FACT table.</td>
<td>MS</td>
</tr>
<tr>
<td>Default_Formulas</td>
<td>This process chain executes default formulas stored in your default.xls file.</td>
<td>NW</td>
</tr>
<tr>
<td>Export_Journal</td>
<td>This process chain prompts you for the name of the export journal file and exports the Journals table.</td>
<td>NW</td>
</tr>
<tr>
<td>Export the Journal tables</td>
<td>Exports the Journals table to an output file.</td>
<td>MS</td>
</tr>
<tr>
<td>Full_Optimize</td>
<td>This process chain schedules a full optimization. It clears both real-time and short-term data storage and processes the dimensions. This option takes the system offline. It is best run during non-business hours.</td>
<td>NW</td>
</tr>
<tr>
<td>ICBooking (Intercompany Balance Booking)</td>
<td>This process chain tracks Intercompany balances to perform Intercompany eliminations. This process chain prompts you for entities, categories, currencies, and time dimensions for the user, environment, model, selection, and processes Intercompany booking according to the logic defined in icbooking.lgf</td>
<td>NW</td>
</tr>
<tr>
<td>ICData (Intercompany Reconciliation)</td>
<td>This process chain prompts you for entities, categories, currencies, and time dimensions and processes Intercompany booking for the user, environment, model, and selection according to the logic defined in icdata.lgf</td>
<td>NW</td>
</tr>
<tr>
<td>IC_Elimination</td>
<td>This process chain is used to perform Intercompany eliminations.</td>
<td>NW</td>
</tr>
<tr>
<td>Package Name</td>
<td>Description</td>
<td>Version</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Import</td>
<td>This process chain imports an ASCII file into the current application. You can specify the transformation file that defines conversion as well as data value signs.</td>
<td>NW</td>
</tr>
<tr>
<td>Import Access 2007</td>
<td>Imports the MS Access 2007 database into the FAC2 table.</td>
<td>MS</td>
</tr>
<tr>
<td>Import Access 2007 into Fact Table</td>
<td>Imports the Microsoft Access database into the FACT table. You can use the import.xls transformation file with this package.</td>
<td>MS</td>
</tr>
<tr>
<td>ImportAndSendMail</td>
<td>This process chain imports an ASCII file and send the result to a specific user.</td>
<td>NW</td>
</tr>
<tr>
<td>Import Category by Time into Fact Table</td>
<td>Imports Category by Time data into the fact table. You can use the Category_By_Time.xls transformation file with this package.</td>
<td>MS</td>
</tr>
<tr>
<td>Import_Descript</td>
<td>This process chain imports dimension member description records. Note that when these descriptions are entered in another language in the EVDESCRIPTION table (and the correct SAP NetWeaver language code is used), the descriptions appear in the language specified by the user. This setting can be modified in Interface for the Web.</td>
<td>NW</td>
</tr>
<tr>
<td>Import Dimension</td>
<td>Available for the purposes of backward compatibility.</td>
<td>MS</td>
</tr>
<tr>
<td>Import Excel2007 into Fact Table</td>
<td>Imports a Microsoft SQL Server database into the FACT table. When running this package, you are prompted for the SQL database and table to import.</td>
<td>MS</td>
</tr>
<tr>
<td>Import Excel2007</td>
<td>Imports the contents of a Microsoft Excel 2007 file into the Fac2 table. You can use the import.xls transformation file with this package.</td>
<td>MS</td>
</tr>
<tr>
<td>Import SQL into Fact Table</td>
<td>Imports a Microsoft SQL Server database into the FACT table. When running this package, you are prompted for the SQL database and table to import.</td>
<td>MS</td>
</tr>
<tr>
<td>Package Name</td>
<td>Description</td>
<td>Version</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Import SQL</td>
<td>Imports a Microsoft SQL Server database into the FAC2 table. You can use the import.xls transformation file with this package. When running this package, you are prompted for the SQL database to import.</td>
<td>MS</td>
</tr>
<tr>
<td>ImportUsingFTP</td>
<td>Allows you to import an ASCII file to download from an FTP site into the current application. You can use Microsoft SQL to modify the server name in the package. After you modify the server name, you can run this sample package at any time.</td>
<td>MS</td>
</tr>
<tr>
<td>ImportAndSendmail</td>
<td>Imports an ASCII file and sends the result to specific user.</td>
<td>MS</td>
</tr>
<tr>
<td>Import_Using_FTP</td>
<td>This process chain allows you to import an ASCII file to download from an FTP site into the current application. You can modify the server name within the package. After you modify the server name, you can run this package at any time.</td>
<td>NW</td>
</tr>
<tr>
<td>Legal_Consolidation</td>
<td>This process chain prompts you for categories, currencies, and time dimensions, and calculates consolidation for the user, environment, model, and selection, according to the logic defined in consolidation.lgf</td>
<td>NW</td>
</tr>
<tr>
<td>Light_Optimize</td>
<td>This process chain schedules a light optimization. A light optimization clears real-time data storage and moves it to short-term data storage. This option does not take the system offline, so you can schedule it to run during normal business activity.</td>
<td>NW</td>
</tr>
<tr>
<td>Load_Infoprovider</td>
<td>This process chain allows you to load data from one BI Cube into a Planning and Consolidation Application. To map the data, associate a transformation file.</td>
<td>NW</td>
</tr>
<tr>
<td>Move from Fact Table</td>
<td>Moves data from the FACT table.</td>
<td>MS</td>
</tr>
<tr>
<td>Opening_Balances</td>
<td>This process chain prompts you for entities, categories, currencies, and time dimensions, and calculates opening balances for the user, environment, model, and selection, according to the logic defined in consolidation.lgf</td>
<td>NW</td>
</tr>
</tbody>
</table>
### About the Import and Send Email Process Chain

You can use the “Import and Send Email” process chain to allow a user to do the following:

- Select files to attach to the email
- Designate a transformation file for the imported files
Select the import method (that is, merging data versus replacing it for identical records)
• Run default for stored values after the import
• Check work status settings during the data import
• Choose email recipients

To enable the system to send email, you must set up the email system parameters.

36.3.1.2.1 Using the SendMail Process Chain

To use the SendMail process chain, complete the To and CC fields in a package that you are creating or modifying.

To automate the completion of these fields, use the following TASK commands:

```
TASK(TASKNAME, NAME, DTSTask_Ev4DTSSendMail.clsDTSSendMail_1)
  TASK(TASKNAME, DESCRIPTION, TASKNAME)
  TASK(TASKNAME, MAILTO, )
  TASK(TASKNAME, MAILCC, )
  TASK(TASKNAME, MAILSUBJECT, )
  TASK(TASKNAME, MAILMESSAGE, )
  TASK(TASKNAME, MAILATTACHMENTS, )
  TASK(TASKNAME, MAILAPPSET, )
  TASK(TASKNAME, MAILUSER, )
  TASK(TASKNAME, ADDRESULT, 0)
```

36.3.1.3 Using the FTP Process Chain

You use the FTP task to transfer data files from an FTP site to the Planning and Consolidation server.

The syntax is as follows:

```
TASK(TASKNAME, NAME, DTSTask_EvDTSFTP.clsEvDTSFTP_1)
  TASK(TASKNAME, DESCRIPTION, TASKNAME)
  TASK(TASKNAME, SOURCESITE, )
  TASK(TASKNAME, SOURCEUSERNAME, )
  TASK(TASKNAME, SOURCEPASSWORD, )
  TASK(TASKNAME, PORTNUMBER, 0)
  TASK(TASKNAME, SOURCEFILENAME, )
  TASK(TASKNAME, DESTSITE, )
  TASK(TASKNAME, OVERWRITABLE, )
  TASK(TASKNAME, NUMRETRIESONSOURCE, 0)
```

36.3.2 Importing Transaction Data from an Information Provider

**Prerequisites:**

• The target cube contains the Account, Category and Time dimensions.
• The target data is aggregated prior to the copy process.

The data imported from the information provider overwrites the records in the cube that have matching keys. The records in the post-import cube are affected (but the data from the information provider is
not affected). If there are duplicate records in the data from the information provider, all the duplicate records are aggregated, using all of the dimensions as the key.

### Post-Mapping Information Provider Data

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTUAL</td>
<td>CASH</td>
</tr>
<tr>
<td>2006.JAN</td>
<td>500</td>
</tr>
<tr>
<td>2006.JAN</td>
<td>200</td>
</tr>
<tr>
<td>2006.FEB</td>
<td>200</td>
</tr>
</tbody>
</table>

### Pre-Import Cube Data

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTUAL</td>
<td>CASH</td>
</tr>
<tr>
<td>2006.FEB</td>
<td>100</td>
</tr>
<tr>
<td>2006.JAN</td>
<td>200</td>
</tr>
<tr>
<td>2006.APR</td>
<td>300</td>
</tr>
</tbody>
</table>

### Result

### Post-Import Cube Data

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTUAL</td>
<td>CASH</td>
</tr>
<tr>
<td>2006.FEB</td>
<td>200</td>
</tr>
<tr>
<td>2006.JAN</td>
<td>700</td>
</tr>
<tr>
<td>2006.APR</td>
<td>900</td>
</tr>
</tbody>
</table>

### 36.4 Adding or Modifying Packages

#### 36.4.1 Package Properties

The following table describes the fields you must complete when adding or editing packages. If any field is incorrect or left blank, the package generates an error when the package is executed.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;File Name&quot;</td>
<td>When you click &quot;File Name &quot; a dialog box is displayed where you specify the file that contains the package. Alternatively, you can browse for files.</td>
</tr>
<tr>
<td>&quot;PackageName&quot;</td>
<td>The name of the package. If the file contains packages, you can view a list of available packages.</td>
</tr>
<tr>
<td>&quot;Group&quot;</td>
<td>The folder group to which the package is added. You can define a new group here.</td>
</tr>
<tr>
<td>&quot;Description &quot;</td>
<td>A description of the package.</td>
</tr>
<tr>
<td>&quot;Task Type&quot;</td>
<td>You can control who has access to run the package.</td>
</tr>
<tr>
<td></td>
<td>- If you select &quot;Admin Package&quot;, only users who are Planning and Consolidation Administrators can run an administrative package. The package can still be saved to a team that does not comprise non-administrative users. A non-administrative user can see the package, but cannot execute it.</td>
</tr>
<tr>
<td></td>
<td>- If you select &quot;User Package&quot;, users who have been assigned the Execute Data Management task security privilege can execute the task.</td>
</tr>
</tbody>
</table>

**Example:**

PROMPT(MEMBERFROMTOINPUT,%TIME_DIM%,%SOURCE_TM%,%TARGET_TM%,Enter Source and Target Time,)

### 36.4.1.1 Adding Packages - version for Microsoft

When you add a package you add it to a package list in the DATAMANAGER\PACKAGEFILES\ folder.

To add packages proceed as follows:

1. In the Data Manager, click **Organize > Organize Package List**.
2. In the right side of the "Organize Package List" dialog box right-click and select **Add Package**.
3. Click **Select**.
4. In the "Open" dialog box under "PACKAGEFILES" browse to locate the file that you want to open, then click **Open**.
5. In the "Add Package" dialog box, select the "Task Type" from one of the following:
   - User Package
   - Admin Package
6. Under "Group", select the group to which you want to add the package.
7. Type a description of your package, then click **Add**.
The package is added to the package list.

36.4.1.2 Adding Packages - version for NetWeaver

When you add a package you add it to a package list in the OWNERSHIP\ folder.

To add packages proceed as follows:
1. In the Data Manager, click Organize > Organize Package List.
2. In the right side of the "Organize Package List" dialog box right-click and select Add Package.
3. Click Select.
4. In the dialog box browse to locate the process chain that you want to open, then click Open.
5. In the Add Package dialog box, select the Task Type from one of the following:
   • User Package
   • Admin Package
6. Under "Group", select the group to which you want to add the package.
7. Type a description of your package, then click Add.
   The package is added to the package list.
8. Click Close.

36.4.1.3 Modifying Packages - version for Microsoft

To modify packages proceed as follows:
1. In the Data Manager, click Organize > Organize Package List.
2. In the EPM pane, choose the package that you want to modify, right-click and select **Modify Package**. At this point you can do one of the following:
   - Change the file name
   - Modify the script
   - Change the Task Type
   - Select a different group
   - Modify the description

3. When you have completed your modifications, click **Save**.

4. Click **Save**

### 36.4.1.4 Modifying Packages, version for NetWeaver

To modify packages proceed as follows;
1. In the Data Manager, click **Organize > Organize Package List**.
2. In the EPM pane, choose highlight the package that you want to modify, right-click and select **Modify Package**. At this point you can do one of the following:
   - Change the file name
   - Modify the script
   - Change the task type
   - Select a different group
   - Modify the description

3. When you have completed your modifications, click **Save**.

4. Click **Save**

### 36.4.1.5 Customizing Packages

Package customization requires modifying the script. You modify scripts from the "Modify Package" dialog box.

1. Click **Modify Script**.
2. In the "Modify Script" dialog box you can click an item to view a number of values such as tasks, variables, and predefined constants. You can also modify the "Dynamic Package Script".
3. Click **Advanced**, which opens a second "Modify Script" dialog box that allows you to access the following functions:
   - PROMPT commands, which allow you to prompt the package user for selections or input
   - INFO commands, which allow you to set values for variables used in package processing
• TASK commands, which allow you to add one or more parameterized process chains to a package

4. Expand "Functions" to view all the functions that you can modify.
5. When you have finished your modifications click **Save**.

**Related Topics**
- About INFO Instructions
- Prompt Commands
- Predefined Constants

### 36.4.1.5.1 Predefined Constants

The following constants are in use by the system, and can be used within the context of the INFO instruction. You can define your own variable names, but they cannot match any of those in the following list. These variables are also available to other process chains within a package.

<table>
<thead>
<tr>
<th>Predefined Constant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%AC-COUNT_DIM%</td>
<td>Returns dimension name where dimension type = A.</td>
</tr>
<tr>
<td>%Model%</td>
<td>Returns current model name.</td>
</tr>
<tr>
<td>%Model_List%</td>
<td>Returns a list of models.</td>
</tr>
<tr>
<td>%MODELPATH%</td>
<td>Returns current model path. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>%ENVIRONMENT%</td>
<td>Returns current environment name.</td>
</tr>
<tr>
<td>%CATEGORY_DIM%</td>
<td>Returns dimension name where dimension type = C.</td>
</tr>
<tr>
<td>%CONVERSION-PATH%</td>
<td>Returns the Data Manager conversion folder path name. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>%DATAPATH%</td>
<td>Returns the current Data Manager data path. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>Predefined Constant</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>%DEFAULT_MEA-SURE%</td>
<td>Returns default measure type used in Planning and Consolidation.</td>
</tr>
<tr>
<td>%DIMS%</td>
<td>Returns list of dimensions based on the application.</td>
</tr>
<tr>
<td>%ENTITY_DIM%</td>
<td>Returns dimension name where dimension type = E.</td>
</tr>
<tr>
<td>%FACTDIMS%</td>
<td>Returns list of dimensions based on Microsoft SQL Server.</td>
</tr>
<tr>
<td>%LOGICPATH%</td>
<td>Returns logic folder path. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>%MEASURES%</td>
<td>Returns list of measures.</td>
</tr>
<tr>
<td>%OLAPSERVER%</td>
<td>Returns the Microsoft SQL Server server name.</td>
</tr>
<tr>
<td>%SELECTION-PATH%</td>
<td>Returns list of measures.</td>
</tr>
<tr>
<td>%SQLSERVER%</td>
<td>Returns OLAP server name.</td>
</tr>
<tr>
<td>%SQLPASS-WORD%</td>
<td>Returns the password for the Microsoft SQL Server.</td>
</tr>
<tr>
<td>%SQLUSER%</td>
<td>Returns Microsoft SQL Server user name.</td>
</tr>
<tr>
<td>%TEMPPATH%</td>
<td>Returns temp folder path for user. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>%TIME_DIM%</td>
<td>Returns dimension name where dimension time = T.</td>
</tr>
<tr>
<td>Predefined Constant</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>%TRANSFORMATIONPATH%</td>
<td>Returns the Data Manager transformation folder path. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>%TRIMMEDUSER%</td>
<td>Returns short User ID (without domain name).</td>
</tr>
<tr>
<td>%USER%</td>
<td>Returns full user name (with domain name).</td>
</tr>
</tbody>
</table>

36.4.1.5.2 Prompt Commands

**Prompt Commands**

A PROMPT command generates customized dialog boxes that prompt end users for answers. By completing these dialog boxes, the user can select such things as the files to upload, data to export, or target applications for selected data. When multiple PROMPT commands are entered in the same script, the system combines all of the prompts in one dialog box.

This rule applies to all PROMPT commands asking for the selection of a file, a delimiter or a text, but not to the COPYMOVE and SELECT prompts. The COPYMOVE and SELECT prompts are presented to the user individually, with as many dialog boxes as prompts are found in the script. All file selection prompts return the name of the selected file with the complete path. If the user leaves a selection field blank in a SELECT or COPYMOVE dialog box, the system assumes all members for that dimension (the system does not insert a range for the dimension in the returned statement).

Prompt commands are stored by package. Therefore, you can create multiple packages based on the same process chain template and provide different prompts to users for each package.

**Dynamically Passing Text to Logic**

You can dynamically pass text to logic as follows:

1. You use the PROMPT commant to prompt the user for a value to pass to a logic file, for example,
   
   PROMPT(TEXT,%TEXT%,”select a year”)

2. Use the %TEXT variable to pass the returned value to the package for example, to return the value of the %TEXT variable to the package:
   
   TASK(RUNLOGIC,FORMULASCRIPT,”*FUNCTION MYYEAR=%TEXT%"

3. In the Data Manager logic, use the dynamically created function as follows: *XDIM_MEMBERSET TIME=MYYEAR.INPUT

   **Note:**
   To enforce its validation at runtime, the logic file must use the .LGF extension.
Modifying Prompt Package Commands

To modify prompt package commands proceed as follows:
1. Click Organize > Organize Package List.
2. Select a package and choose Modify Package.
3. Click Modify Script.
4. Choose <Package name> Dynamic Package Script (MODIFYSCRIPT) PROMPT
5. Select the Type cell and select a prompt. Enter data as required.

Note:
You cannot select or deselect the Activate option until you save the package.

CHECKBOX Prompt() Command

The CHECKBOX Prompt() command is used to present the user with a checkbox to select or leave empty.

The syntax is as follows: PROMPT (CHECKBOX, [variable],[checkbox label text],[default value])

The default value can be 0 (unchecked by default) or 1 (checked by default).

Example:
PROMPT(CHECKBOX,%CheckBox%,"Test for CheckBox",1)

CHECKBOXGROUP Prompt() Command

The CHECKBOXGROUP Prompt() command is used to present the user with a set of check boxes to select or leave empty.

The syntax is as follows: Syntax: PROMPT (CHECKBOX, [variable],[label],[default values],[label for check items]

The default value can be 0 (unchecked by default) or 1 (checked by default).

Note:
You must separate multiple values with commas.

Example:
PROMPT(CHECKBOXGROUP,%CHECKGROUP%,"Test for CheckBox Group",{1,0,1},{"ch1","ch2","ch3"},,)

COMBOBOX Prompt() Command

The COMBOBOX Prompt() command is used to present the user with a combination box (that is, a drop-down list).
The syntax is as follows: `PROMPT (COMBOBOX, [variable],[label],[combo style],[default value],[select items])`

The default value determines the preselected choice (in terms of ordinality, starting with 0).

**Note:**
You must separate multiple values with commas.

Example:
```
PROMPT(COMBOBOX,%COMBOBOX%,"Test for Combobox:",0,t2,t1,t2)
```

---

**CONVERSION Prompt() Command**

The CONVERSION Prompt() command is used to prompt the user for a transformation file to use.

The syntax is as follows: `PROMPT(CONVERSION, [variable], [label], [mask], [path])`

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONVERSION</td>
<td>Select an existing DATA file.</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%CONVERSION%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user.</td>
<td>Please select a transformation file.</td>
</tr>
<tr>
<td>[mask]</td>
<td>The types of files to select.</td>
<td>Data files (<em>.txt), <em>.txt, All files(</em>.</em>),.*</td>
</tr>
<tr>
<td>[path]</td>
<td>The search path.</td>
<td>The transformation files directory.</td>
</tr>
</tbody>
</table>

**COPYBOXNO Prompt() Command**

The COPYBOXNO Prompt() command presents the user with a checkbox to select or leave empty. By default, this prompt type always presents the user with an empty checkbox.

The syntax is as follows: `PROMPT(CHECKBOXNO, [variable],[label],,,,)`

Example:
```
PROMPT(CHECKBOXNO,%CHECKBOXNO%,"Test for CheckBoxNo",,)
```

**TRANSFORMATION Prompt() Command**

The TRANSFORMATION Prompt() command is used to prompt the user for a transformation file.
The syntax is: `PROMPT(TRANSFORMATION, [variable], [label], [mask],, [path])`

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRANSFORMATION</td>
<td>Select an existing DATA file.</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%TRANSFORMATION%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Please select a transformation file.</td>
</tr>
<tr>
<td>[mask]</td>
<td>The file type(s) to display in the selected folder</td>
<td>Data files (*.txt), *.txt,</td>
</tr>
<tr>
<td>,</td>
<td>Reserved by the system.</td>
<td>Leave empty.</td>
</tr>
<tr>
<td>[path]</td>
<td>The search path</td>
<td>The transformation file directory.</td>
</tr>
</tbody>
</table>

**SELECT Prompt() Command**

The SELECT Prompt() command is used to prompt the user for a data range for example, for export.

The syntax is: `PROMPT(SELECT, [variable], [second variable], [label], [dimensions])`
<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT</td>
<td>Select one data range</td>
<td>SELECT</td>
</tr>
<tr>
<td></td>
<td>Select one data range.</td>
<td>Select one data range.</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%SELECTION%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Enter your selection</td>
</tr>
<tr>
<td>[dimensions]</td>
<td>The dimensions from which to select members</td>
<td>Category, Time, Entity</td>
</tr>
</tbody>
</table>

**DELIMITER Prompt() Command**

The DELIMITER Prompt() command is used to prompt the user for a delimiter to be used in the import or export file.

The syntax is as follows: `PROMPT(DELIMITER, [variable], [label])`

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DELIMITER</td>
<td>The data delimiter</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%DELIMITER%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Please select a delimiter.</td>
</tr>
</tbody>
</table>

**SELECTINPUT Prompt() Command**

The SELECTINPUT Prompt() command is used to allow the user to select only noncalculated members (for export, for example).

The syntax is as follows: `PROMPT(SELECTINPUT, [variable], [second variable], [label], [dimensions])`
### Where

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECTINPUT</td>
<td>Select one noncalculated data range</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%SELECTION%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user.</td>
<td>Enter your selection</td>
</tr>
<tr>
<td>[dimensions]</td>
<td>The dimensions from which to select members</td>
<td>Category, Time, Entity</td>
</tr>
</tbody>
</table>

**Note:**
If you need only one SELECTINPUT prompt command, use the following syntax to create the package script:

```plaintext
PROMPT(SELECTINPUT,%SOURCEENTITY%,"Enter Source Entity","%ENTITY_DIM%")
TASK(/CPMB/ALLOCATION_LOGIC,SELECTION,%SOURCEENTITY%)
```

**Note:**
If you need more than one SELECTINPUT prompt command, use the following syntax to create it:

```plaintext
PROMPT(SELECTINPUT,%SOURCEENTITY%,"Enter Source Entity","%ENTITY_DIM%")
PROMPT(SELECTINPUT,%TARGETENTITY%,"Enter Target Entity","%ENTITY_DIM%")
INFO(%EQU%,=)
INFO(%TAB%,;)
TASK(/CPMB/ALLOCATION_LOGIC,TAB,%TAB%)
TASK(/CPMB/ALLOCATION_LOGIC,EQU,%EQU%)
TASK(/CPMB/ALLOCATION_LOGIC,REPLACEPARAM,ASARENT%EQU%ASARENT%TAB%SOURCE%EQU%SOURCEENTITY%TAB
%TARGET%EQU%TARGETENTITY%)
TASK(/CPMB/ALLOCATION_LOGIC,MEMBERSELECTION,SOURCE%EQU%SOURCEENTITY%TAB
%TARGET%EQU%TARGETENTITY%)
```

**INFILE Prompt() Command**

The INFILE Prompt() command is used to prompt the user for a file to import.

The syntax is as follows: `PROMPT(INFILE, [variable], [label], [mask], [path])`
TEXT Prompt() Command

The TEXT Prompt() command is used to display a text message to the user.

The syntax is as follows: `PROMPT(TEXT, [variable], [label], [PWD], [VALIDATE LIST])`

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEXT</td>
<td>This is the function name.</td>
<td>None</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%TEXT%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>None</td>
</tr>
<tr>
<td>[PWD]</td>
<td>Use this variable when you want to display the password as asterisks (****) in the text box.</td>
<td>None</td>
</tr>
<tr>
<td>[VALIDATE LIST]</td>
<td>This parameter contains a list of items used to validate the input text. The delimiter must be a comma, and the list must close with a double quotation.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Example 1:**
This function shows a text box with the label Model list. The system validates the user entry against a model list.

`PROMPT(TEXT,%ModelList%,"Application list:",,"%Model_List%")`
Example 2:
This function shows a text box with the label Dimension list:. The system validates the user entry against a dimension list.

PROMPT(TEXT,%DIMLIST%,"Dimension list:","%DIMS%")

Example 3:
This function shows a text box with the label Alphabet list:. The system validates the user entry against A,B,C,D,E.

PROMPT(TEXT,%AlphabetList%,"Alphabet list:","A,B,C,D,E")

Example 4:
This function shows a text box with a password value shown in asterisks (*).

PROMPT(TEXT,%Password%,"Please enter your password",PWD)

SELECTION Prompt() Command

The SELECTION Prompt() command is used to prompt the user for an existing data selection file. The syntax is as follows: PROMPT(SELECTION, [variable], [label], [mask], [path])

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECTION</td>
<td>Select an existing data selection file.</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%SELECTION%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Please select a file</td>
</tr>
<tr>
<td>[mask]</td>
<td>The file type(s) to display in the selected folder</td>
<td>Data files (<em>.txt), <em>.txt,All files(</em>.</em>),.*</td>
</tr>
<tr>
<td>[path]</td>
<td>The search path</td>
<td>The selection files directory.</td>
</tr>
</tbody>
</table>

OUTFILE Prompt() Command

The SELECTION Prompt() command is used to prompt the user for the name of the export file. The syntax is as follows: PROMPT(OUTFILE, [variable], [label], [mask], [path])
<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>OUTFILE</td>
<td>An existing DATA file.</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%FILE%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Please select a file.</td>
</tr>
</tbody>
</table>
| [mask]       | The file type(s) to display in the selected folder | Data files (*.txt), *.txt, All files(*.*) | **COPYMOVEINPUT Prompt() Command**

The COPYMOVEINPUT Prompt() command prompts the user for two noncalculated data ranges (for copying data, for example).

The syntax is as follows: `PROMPT(COPYMOVEINPUT, [variable], [second variable], [label], [dimensions])`

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>COPYMOVEINPUT</td>
<td>Select noncalculated data ranges.</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%SELECTION%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Please select a file.</td>
</tr>
<tr>
<td>[dimensions]</td>
<td>The dimensions to select from</td>
<td>Category, Time, Entity</td>
</tr>
</tbody>
</table>

**COPYMOVE Prompt() Command**

The COPYMOVE Prompt() command is used to prompt the user for a source and destination data range.

The syntax is: `PROMPT(COPYMOVE, [variable], [second variable], [label], [dimensions])`
COPYBOXYES Prompt() Command

The COPYBOXYES Prompt() Command presents the user with a checkbox to select or leave empty. By default, this prompt type always presents the user with a selected checkbox.

The syntax is as follows: `PROMPT(CHECKBOXYES, [variable],[label],,,,)`

**Example:**

`PROMPT(CHECKBOXNO,%CHECKBOXNO%,"Test for CheckBoxNo",,,,,)`

INFILES Prompt() Command

The INFILES Prompt() command is used to prompt the user for a file to import.

The syntax is as follows:

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFILES</td>
<td>One or more DATA files</td>
<td>n/a</td>
</tr>
<tr>
<td>[variable]</td>
<td>The name of the returned variable</td>
<td>%FILE%</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Please select a file.</td>
</tr>
<tr>
<td>[mask]</td>
<td>The file type(s) to display in the selected folder</td>
<td><strong>.</strong>*</td>
</tr>
</tbody>
</table>

LOGICFILE Prompt() Command

The LOGICFILE Prompt() command is used to prompt the user for a logic file to import.

The syntax is as follows: `PROMPT(LOGICFILE, [variable],[label],[mask])`
**MESSAGE Prompt() Command**

The MESSAGE Prompt() command sets the text to be displayed to the user at the time the package is set.

**Example:**

PROMPT(MESSAGE,"When this package is running, end user functionality will be affected: Data cannot be sent to the database or incorrect numbers can be retrieved from the database")

**RADIOBUTTON Prompt() Command**

The RADIOBUTTON Prompt() command is used to present the user with a radio button control.

The syntax is as follows:  

```
PROMPT(RADIOBUTTON, [variable], [label], [default value],[label for choices],[values for choices])
```

**Example:**

PROMPT(RADIOBUTTON,%CHECKLCK%,"Select whether to check work status settings when importing data.",1,"Yes, check for work status settings before importing","No, do not check work status settings"),("1","0")

**SELECTIONFILE Prompt() Command**

The SELECTIONFILE Prompt() command is used to prompt the user for a file to import.

The syntax is as follows:  

```
PROMPT(SELECTIONFILE, [variable], [label], [mask], [path])
```
**MEMBERFROMTOINPUT Prompt() Command**

The MEMBERFROMTOINPUT Prompt() Command is used to prompt the user for an existing data selection file.

The syntax is as follows:

```
PROMPT(MEMBERFROMTOINPUT,[dim_type],[source_variable],[target_variable],[label])
```

<table>
<thead>
<tr>
<th>Where</th>
<th>Means</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[dim_type]</td>
<td>Select a data type.</td>
<td>n/a</td>
</tr>
<tr>
<td>[source_variable]</td>
<td>Source variable</td>
<td>n/a</td>
</tr>
<tr>
<td>[target_variable]</td>
<td>Target variable</td>
<td>n/a</td>
</tr>
<tr>
<td>[label]</td>
<td>The text to display to the user</td>
<td>Enter source and target time..</td>
</tr>
</tbody>
</table>

**36.4.1.5.3 INFO Instructions**

**About INFO Instructions**

An INFO instruction is used to define and assign a value to a script variable. It is not an executable instruction and does not affect the package directly.

The syntax for the INFO instruction is

```
INFO("variblename","value")
```

The INFO instruction parameters are defined as follows:

- variable name is the name of the variable
- value is the value of the variable
Instead of assigning a value directly to a task, the value (or part of it) can be replaced with the name of a variable defined in an INFO instruction. At runtime, the task replaces the name of all INFO variables found in all executable instructions with the current value of those variables, before executing the executable instructions.

The following example illustrates how to define a variable with an INFO instruction and how to use it in another instruction such as TASK:

```plaintext
INFO(%FILE%, IMPORT.TXT)
TASK("EVIMPORT","FILENAME", %FILE%)
```

You can nest one level of INFO variables inside other INFO variables as in the following example:

```plaintext
INFO(%PATH%,"C:\MyDir")
INFO(%FILE%,%PATH%IMPORT.TXT)
ITASK("EVIMPORT","FILENAME", %FILE%)
```

**Note:**
We recommend the use of expressions that are enclosed between some easily identifiable characters such as the % character for example, %VARIABLE%, which makes the script more readable and less subject to errors when the substitutions are performed.

All system-generated INFO variables comply with this practice.

### Adding INFO Instructions to a Package

You add multiple process chains to a process chain using the TASK command as follows:

1. Select **Organize > Organize Package List**.
2. Highlight the package you want to modify, right-click, then select **Modify Package**.
3. Click **Modify Script**.
4. Under "Dynamic Package Script (MODIFYSCRIPT) >INFO " click **INFO**.
5. Click **Save**.
6. Save the package.

**Note:**
You cannot select or deselect the Activate option until you have saved the package.

### Multi-line INFO Instructions

All instructions that you enter in package scripts must be written as one-line instructions. The exception to this rule is an INFO instruction that can be spread across multiple lines, to enhance the readability of the scripts.

**Note:**
Multi-line INFO instructions cannot be nested and cannot contain other instructions. They can contain predefined constants.
The syntax for Multi-line INFO instructions is as follows:

```
BEGININFO(variablename)
...
...(value)
...
ENDINFO
```

Example:

```
BEGININFO(%SQL_STATEMENT%)
    SELECT *
    FROM TBLFACT%APP%
    WHERE %SELECTION%
ENDINFO
```

**Dynamic Constants**

Dynamic Constants are predefined in the system, and can be used within the context of the INFO instruction. You can define your own constants and use your own naming convention for the names, but they cannot match any of those in the following list. These constants are also available to other process chains within a package.

Dynamic Constants are detailed in the following table:

<table>
<thead>
<tr>
<th>Dynamic Constant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%AC-COUNT_DIM%</td>
<td>Returns dimension name where dimension type = A.</td>
</tr>
<tr>
<td>%Model%</td>
<td>Returns current model name.</td>
</tr>
<tr>
<td>%Model_List%</td>
<td>Returns a list of models.</td>
</tr>
<tr>
<td>%APPBINAME%</td>
<td>Returns the model's binary name.</td>
</tr>
<tr>
<td>%Environment%</td>
<td>Returns current environment name.</td>
</tr>
<tr>
<td>%CATEGORY_DIM%</td>
<td>Returns dimension name where dimension type = C.</td>
</tr>
<tr>
<td>%CURRENCY_DIM%</td>
<td>Returns dimension name where dimension type = R.</td>
</tr>
</tbody>
</table>
### Dynamic Constant

<table>
<thead>
<tr>
<th>Dynamic Constant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%DATAS-RC_DIM%</td>
<td>Returns the dimension that contains the data source.</td>
</tr>
<tr>
<td>%DIMS%</td>
<td>Returns list of dimensions based on the model.</td>
</tr>
<tr>
<td>%ENTITY_DIM%</td>
<td>Returns dimension name where dimension type = E.</td>
</tr>
<tr>
<td>%PACKAGE%</td>
<td>Returns the name of the current package.</td>
</tr>
<tr>
<td>%TEMPPATH%</td>
<td>Returns temp folder path for user. The path returned has the trailing back slash () appended to it.</td>
</tr>
<tr>
<td>%TIME_DIM%</td>
<td>Returns the time dimension.</td>
</tr>
<tr>
<td>%USER%</td>
<td>Returns full user name (with domain name).</td>
</tr>
</tbody>
</table>

### 36.4.2 Logic Use in Packages

You can set up Planning and Consolidation logic to work together with your Data Manager packages. When the model imports data, most packages automatically run default logic, which is contained in `logic.lgf`. You can specify a different set of logic to run or you can specify that logic is not applied.

You can include a step inside a package that runs logic. The OSoftTaskLogic2008 custom Microsoft SSIS task allows you to set up parameters and run logic file or logic subroutines.

### 36.4.3 Package Object Syntax

The syntax for package objects (task, connection, step, global) is as follows:

```
OBJECT (TASKNAME, PROPERTY, VALUE)
```

**Example:**

```
TASK (EVIMPORT, FILENAME, IMPORT1.TXT)
```
36.5 Data Manager Tasks

36.5.1 Data Manager Tasks

You can run a package in the Data Manager or set the schedule on which it runs. Access to packages in the Data Manager is controlled by task security set by an administrator.

You can perform the following tasks with packages:
- Run or schedule packages
- Organize your favorite packages into a selected packages list
- View package status
- View schedule status

**Note:**
Schedule status and package status are not identical. They can be defined as follows:
- Package status displays the result of a package that has already executed.
- Schedule status displays the schedule on which various packages are set up to run.

36.5.2 Removing a Package from the List

To remove a package from the list, proceed as follows:
1. Click Organize > Organize Package List.
2. Highlight the package you want to remove and right-click.
3. Select Remove Package.
4. Click Yes at the prompt.

36.5.3 Running Packages

To run a package proceed as follows:
1. Click Run Package.
2. In the “Run Package” dialog box select the package you want to run.
3. Click **Run**. Depending on the type of package you are running, the Data Manager displays prompt values.

4. Type or select the prompt values in the various dialog boxes.

5. At one point you are prompted to select when you want to run the package. The choices are as follows:
   - Run
   - Schedule
   - Run and Schedule

6. If you want to run the package immediately, select **Run**, then click **Finish**.

**Note:**
When a package is run the data access rights of the user are applied.

**Related Topics**
- **Scheduling Packages**

### 36.5.3.1 Scheduling Packages

You schedule packages to be run in the "Run Package" dialog box.

1. Click **Finish**.
2. Under General, enter a "Name" and a "Description".
3. Under **Schedule Properties** select the frequency and time of day you want to run the schedule. You can enter additional properties by clicking **Advanced**.
4. When you have finished entering the scheduling information, select **Enable Schedule**, then click **Finish**.

### 36.5.3.2 Running a Copy Package

A copy package copies data within an application. You are prompted for source and destination data selections for all dimensions in the application.

1. Click **Run Package**.
2. In the Run Package dialog box, select the Copy package, then click **Run**.
3. In the "Copy" screen select one of the following:
   - **Merge data values**, if you want to copy all specified records, leaving all remaining records in the destination intact (does not add to existing data)
   - **Replace & clear data values** if you want to clear data in the destination area using the selected dimension list, then copy the data from the source to the destination.
4. Click **Next**.

**Note:**

Since the **Replace and Clear** option uses work status dimensions to determine which records are cleared, work status dimensions must be defined in the application. If they are not defined, a message is displayed and you cannot continue to run the package. You can define the dimensions in the "Administration Console", or use the "ModifyScript" package to set the work status dimensions.

**Example:**

```
Task(Task Name[DumpLoad], SELECTIONFROMTASK,"CATEGORY,ENTITY,TIME,DATASRC")
```

5. Select if you want to run default logic for stored values after importing. If you select:
   - **No**, the package does a straight copy of the data.
   - **Yes**, the copy package copies the data, then runs the default advanced formulas that apply to that data.
   
   then click **Next**.

6. Select if you want the system to copy work status settings when importing data. If you select:
   - **Yes**, the system copies work status settings with the data.
   - **No**, the system does not copy work status settings with the data.
   
   then click **Next**.

7. Select the members to copy and the location to which you want to copy them, then click **Next**.

8. Select when to run the package, then click **Finish**.

   If you select the **Schedule** option, you are prompted to enter the scheduling details.

**Example:**

Below are the database records before an import:

<table>
<thead>
<tr>
<th>Category</th>
<th>Entity</th>
<th>Time</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>US</td>
<td>2008.NOV</td>
<td>Sales</td>
<td>1000</td>
</tr>
<tr>
<td>Actual</td>
<td>EMEA</td>
<td>2008.NOV</td>
<td>Sales</td>
<td>1000</td>
</tr>
<tr>
<td>Actual</td>
<td>US</td>
<td>2008.NOV</td>
<td>Cash</td>
<td>200</td>
</tr>
<tr>
<td>Actual</td>
<td>EMEA</td>
<td>2008.NOV</td>
<td>Cash</td>
<td>200</td>
</tr>
</tbody>
</table>

**Input file records:**
### Results of import with clear:

<table>
<thead>
<tr>
<th>Category</th>
<th>Entity</th>
<th>Time</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>EMEA</td>
<td>2008.NOV</td>
<td>Cash</td>
<td>400</td>
</tr>
</tbody>
</table>

### Results of import with merge:

<table>
<thead>
<tr>
<th>Category</th>
<th>Entity</th>
<th>Time</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>EMEA</td>
<td>2008.NOV</td>
<td>Sales</td>
<td>1000</td>
</tr>
<tr>
<td>Actual</td>
<td>US</td>
<td>2008.NOV</td>
<td>Cash</td>
<td>200</td>
</tr>
<tr>
<td>Actual</td>
<td>EMEA</td>
<td>2008.NOV</td>
<td>Cash</td>
<td>400</td>
</tr>
</tbody>
</table>

### 36.5.4 Defining a Package Link

A package link is a series of tasks that are linked together in a sequence.

Package links are a feature of SAP BusinessObjects Planning and Consolidation, version for SAP NetWeaver. To define a package link, proceed as follows:

1. Click **Organize > Organize Package Link List**.
2. Click inside the "Organize Package Link List" dialog box, right-click, then select **Add Package Link**.
3. In the "Link Tasks Status" dialog box, type a package link name and description, then click **Add Task**.
4. In the "Package Task" dialog box type a name and description for the task.
5. Select a package from the list provided, then click **OK**.
6. Click **Save**, then **Close**.

The new package link is added to the list of package links.
36.5.4.1 Running a Package Link

To run a package link proceed as follows:

1. Click Run Package > Run Package Link.

2. In the "Run Package Link" dialog box, select the package link that you want to run, then click Run.

3. In the next set of screens you choose to:
   • Run the package link
   • Set prompts to select the following:
     • an infoprovder to load data
     • a transformation file
     • the data transfer mode
     • the method for importing data
     • run default logic for stored values
     • check work status when importing data

4. Click Finish.
   A message advises you that the package link is running on the server.

36.5.5 Modifying the List of Selected Packages

You can organize the list of selected packages as follows:

1. Select Organize > Organize Package List.

2. In the "Organize Package List" dialog box under "Package Name", select a package and right-click.

3. Select an option from the menu. You can do one of the following:
   • Add Package
   • Modify Package
   • Remove Package
   • Copy Package
   • Remove Package

36.5.6 Viewing Package Status
You can view the status of packages that are currently running and packages that have been completed as follows:

1. Select **View Status > View Status**
   The Package Status dialog box displays a resume of the various packages.
2. If you want to view the detail logs corresponding to the package, select the package, then click **Detail**.

### 36.5.7 Viewing Package Schedule Status

You can view the status of packages that have been scheduled.

1. Click **View Status > View Schedule Status**.
   The "Package Schedule Status" dialog box opens.
2. Select how you want to filter data, then click **Refresh**.
   The dialog box displays the details of the schedule including a history of when the package ran against the schedule.
3. If you want to view the details of the schedule, double-click the schedule name, which opens the "Job Detail" dialog box.
   At this point you can modify the scheduling parameters.
4. Click **OK** or **Cancel**.

### 36.5.8 Adding Multiple Process Chains to a Package

You can add multiple process chains to a process chain using the TASK command as follows:

1. Click **Organize > Organize Package List**.
2. Browse to locate the package to which you want to add a package chain.
3. Select the package then right-click.
4. Select "Modify Package".
5. Click **Modify Script**.
6. In the "Modify Script" dialog box, under "Dynamic Package Script (MODIFYSCRIPT)" click "TASK".
7. Under "Activate" select the tasks you want to include in the process chain.
8. Click **Save**.
   You return to the "Modify Package" dialog box where you can modify the group, package name, or description.
9. Click **Save**.
36.5.9 Importing and Exporting Data Having Multiple Key Figures

You can import and export transactional data that consists of more than one key figure for the same source into the same Planning and Consolidation application by using an additional keyword in the mapping section of the transformation file. Proceed as follows:

1. Select Transformation File > New Transformation File
2. Map the multiple key figures to the single key figure using a keyword in the mapping section of the transformation file.
3. Save the transformation file.
4. Run the package and choose the transformation file.

36.5.10 Retracting Master Data and Transaction Data

You can retract both master data and transaction data using the BADI process type called by a process chain.

Before running the BADI process type you must specify the filter in the data package script to indicate to the system which BADI implementation to call.

**Note:**
For master data, the BADI is called only once since packaging is not supported, however, for transaction data, the BADI is called for each package during the transaction data load.

The BADI implementation (syntax) is checked during validation. When validating a transformation file with a `start_routine` or `end_routine`, the system validates the results of these routines while the validation runs all code, except the commit (write).

**Note:**
For the retractor BADI, the system does not validate the syntax. You must validate the syntax of your BADI implementation.

You define `*start_routine` and `*end_routine` in the transformation file.

**Example:**
In the transformation file:

```plaintext
*Option
*start_routine = <filtervalue_start>
*end_routine = <filtervalue_end>
```

For each data package, before transformation, the system executes the BADI implementation for the start routine by the filter value = `filtervalue_start`. 
For master data and transaction data, the start_routine BADI is filled after the master data or transaction data has been read and made available.

For each data package, after transformation, the system executes the BADI implementation for end_routine by the filter value = filtervalue_end.

When *start_routine is not empty, the value in <filtervalue_start> is used to find the BADI implementation that is called before transformation. When *end_routine is not empty, the value in <filtervalue_end> is used to find the BADI implementation that is called after transformation.

For master data and transaction data, the end_routine BADI is called before the write (commit to NW). The value for <filtervalue_start> and <filtervalue_end> must be unique. When calling BADI, this value is used to find the correct BADI implementation. Although you can set the value for *start_routine and *end_routine to be the same, having different values may be more realistic. For masterdata, the BADI is based on the table level since master data extraction and retraction do not support packaging of data. For transaction data, the BADI is based on package level since packaging is supported.

### 36.5.11 About Delta Initialization

Delta initialization is a simple process to prime the source system to record changes after an initial extraction of data is made. A user who has sufficient rights can use the Organize Delta Initialization feature in Data Manager, version for SAP NetWeaver.

You create delta initializations via the "Organize Delta Initialization" dialog box, which displays the existing data initializations with the following information:

- Name
- Description
- InfoProvider
- Selection
- Status of latest load
- Time of latest load
- User of latest load
- Trigger full load at first run
- Number of the load
- Records of load
- Creating time
- Transformation file
- Package group of latest load
- Latest request

From the Organize Delta Initialization dialog box you can also perform the following:

- View the detailed parameters of a selected delta initialization.
- Modify a selected delta initialization.
• Remove the selected delta initialization.
• Load the updated delta initialization from server.
• Search in delta initializations.
• Filter a delta initialization by Name, Description and InfoProvider in the current page.

**Note:**
You can delete a delta initialization only if it has not been triggered. If a delta initialization has not been triggered you can modify all parameters; if it has been triggered you can modify only the description and field list.

### 36.5.11.1 Organizing Delta Initialization

You create a new delta initialization in the "Organize Delta Initialization" dialog box, which you access from the **Organize** menu.

Proceed as follows:

1. In the "Organize Delta Initialization" dialog box click **Organize > New**.
2. In the appropriate fields type a name and description for the delta initialization.
3. Click the icon next to the "InfoProvider" box and, from the "InfoProvider Selection" window, select the InfoProvider you want to use.
4. Under the "Selection" tab do the following:
   - Select the Dimension/File, Attribute, and Operator.
   - Type a low and high value where appropriate.
5. Under the "Dimension/Field List" tab select the dimensions, fields, and attributes from which you want to load data. The "Dimension/Field" list corresponds to the columns of source data in the InfoProvider.
6. Click **Save**, then in the dialog box type or select the name of the file that you are saving to the server.
7. Browse to locate the transformation file that you want to use.
8. If this is the first time you are loading this InfoProvider, select **Trigger a full load at the first run**. If you have already loaded this InfoProvider, do not select the trigger.
9. Click **OK**.

A message box informs you that the InfoProvider has been created successfully and the name of the delta initialization appears in the "Organize Delta Initialization" dialog box.

### 36.5.11.2 Modifying a Delta Initialization

If a delta initialization has not be triggered, you can modify all its parameters.
If a delta initialization has been triggered, you can modify the description and field list only. Other parameters appear greyed-out.

36.5.11.3 Running the Delta Initialization

You run the delta initialization from the Run Package dialog box.

1. Click Run Package > Run Package.
2. Select the "Package Group" and "Package Name", then click Run.
   A series of screens open in the "Run Package" dialog box in which you perform the following:
   • Select the delta initialization you want to run.
   • Select whether to run the default logic.
   • Select whether to check work status.
   • Select when to run the package.
3. Click Finish.
   A message informs you that the request to run the package on the server was successful and that the package is running.
4. Click OK.
   You can view the status of the package as well as the detail of the logs.

36.6 Data Transformations and Conversions

36.6.1 About Data Transformations

Data transformations allow you to map external data to internal Planning and Consolidation data structures.

The Data Manager performs data transformations and mapping using transformation and conversion files. To be successfully imported, the source data must be in the proper format. In this case, you can define the correct dimension members in the conversion file. When the Data Manager import package is run it reads the transformation file, which has a pointer to a conversion file, and correctly maps the data.

Two interfaces for Microsoft Excel workbook files are required to perform data transformations. The files are as follows:
### Transformation File

The transformation file allows you to set up the rules for reading data from an external source and put it in the proper form for your system database. Transformation files are Microsoft Excel files that contain one worksheet, named Instructions. The Instructions worksheet contains the following sections:

- **Options**: contains definitions for various options that you can set for your transformation.
- **Mapping**: defines how data is mapped to the Planning and Consolidation database.
- **Conversion**: defines which conversion sheet to use with which dimensions.

### Conversion File

The conversion file allows you to map member names from external to internal dimension structures. You can set up multiple sheets in a conversion file so that many transformations can access the same conversion workbook. You can have one conversion file per dimension.

### 36.6.1.1 Defining a Transformation File

To define a transformation file proceed as follows:

1. In Data Manager, click **Transformation File > New Transformation File...**
   
   The Excel page opens to the transformation worksheet, which displays the three sections.

2. In each section enter the required data for:
   
   - Options
   - Mapping Function
   - Conversion

   **Example:**

   AccountConv.xls is the name of the Account dimension conversion file.

   Account = AccountConv.xls

   Amount = AccountConv.xls (Use the Amount keyword with the ConvertAmountWDim transformation option.)

   Account = AccountConv.xls!newaccount

   Account = [COMPANY]AccountConv.xls!newaccount

After you set up the transformation and conversion files you run packages to use those files to define the data transformation.
36.6.1.1.1 Transformation File: Options

1. In Data Manager click **Transformation File > New Transformation File...**
   The Excel page opens to the transformation worksheet, which displays the three sections.

2. In the "Options" section, enter the required data. The following table contains a list of available options and descriptions for each option. The following table contains a list of available options that the team lead or administrator can set for the transformation, and descriptions for each option:
<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMOUNTDECIMALPOINT=text character</td>
<td>. (period)</td>
<td>This option allows you to specify a non-period decimal point for countries that use a different character, such as a comma. The character specified in this option must differ from the character specified for the DELIMITER.</td>
</tr>
<tr>
<td>CONVERTAMOUNTWDIM=dimension name</td>
<td>&lt;Account&gt;</td>
<td>This option specifies which dimension to look at for value calculations. You must specify a dimension conversion sheet using the Amount *Conversion option. If there is no formula in the Formula column of the &quot;Amount conversion&quot; sheet, this parameter has no effect at all. For example, in a case where the &quot;Formula&quot; column has the following formula: <code>&lt;value&gt;*1.10</code>, all accounts are increased by 10% during the conversion.</td>
</tr>
<tr>
<td>CONVERT_INTERNAL = YES</td>
<td>NO</td>
<td>This option compares input member names with columns in the conversion file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If NO, the input member names are compared with the external column in conversion file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If YES, the input member names are compared with the internal column in conversion file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Recommendation:</strong> Do not change the default setting. This setting is here for the purposes of backward compatibility only. There are no reasons to change this in Planning and Consolidation 7.0 and later versions.</td>
</tr>
<tr>
<td>CREDITNEGATIVE= YES</td>
<td>NO</td>
<td>This option specifies whether to treat credit as a negative amount. If YES, credit amounts are treated as negative.</td>
</tr>
<tr>
<td></td>
<td>YES</td>
<td>If NO, credit amounts are treated as positive.</td>
</tr>
<tr>
<td>Option</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This option reverses the signs for a given account. If this parameter is set to NO, the option reverses the sign for all amounts referring to an ACCOUNT type (LEQ, INC).</td>
</tr>
<tr>
<td>CREDITPOSITIVE</td>
<td>= YES</td>
<td>NO</td>
</tr>
<tr>
<td>DELIMITER text_character</td>
<td>SPACE</td>
<td>TAB</td>
</tr>
<tr>
<td>FORMULA =</td>
<td>&lt;empty&gt;</td>
<td>This option sets the K2 functions referenced by the master data member's formula attribute.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>This option is only used for importing master data. It is illegal when running other packages.</td>
</tr>
<tr>
<td>HEADER= YES</td>
<td>NO</td>
<td>YES</td>
</tr>
<tr>
<td>MAXREJECTCOUNT=empty_string</td>
<td>-1</td>
<td>positive number</td>
</tr>
<tr>
<td>Option</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NULLAMOUNTVALUE</td>
<td>a space character</td>
<td>Allows the business user to assign a value to null records.</td>
</tr>
<tr>
<td>= &lt;text_character&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OUTPUTDELIMITER</td>
<td>(comma)</td>
<td>Same as DELIMITER, but used to define the delimiter when using the transform</td>
</tr>
<tr>
<td>= &lt;text_character&gt;</td>
<td></td>
<td>export to export data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OUTPUTHEADER=</td>
<td>empty string</td>
<td>Allows the business user to use a custom header to export data. Will be</td>
</tr>
<tr>
<td>&lt;text_string&gt;</td>
<td></td>
<td>ignored if the transformation file is used to import data. The business</td>
</tr>
<tr>
<td></td>
<td></td>
<td>user can use{CRLF} to create more than one row for the header. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MyCompany Data{CRLF}Category,Time,Account,Entity,Datasrc,Intco,RPTCurrency,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Amount.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The above example must be placed all in the same cell in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>transformation file.</td>
</tr>
<tr>
<td>ROUNDAMOUNT=integer</td>
<td>There is no default.</td>
<td>This option specifies the amount of decimal places to which values are to</td>
</tr>
<tr>
<td></td>
<td>You must define this</td>
<td>be rounded during the transformation. By default, there is no rounding</td>
</tr>
<tr>
<td></td>
<td>option.</td>
<td>during data transformation. If you use this option, you must enter a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>parameter. The integer can be zero or any positive integer.</td>
</tr>
</tbody>
</table>
This option sets the selection rules when you are extracting transaction data from an infoprovider. Use the following parameter definitions to set your selection:

- `<Dimension1_techname>` is the technical name of the dimension.
- `<Dimension1_value>` is the value of a condition statement set to this dimension.

**Example:**

```
0SX_ACCS, US;0SX_CSLC, 1
```

This is the result of the following selection statement: 0SX_ACCS=US and 0SX_CSLC= 1

This option is only used for importing transaction data from an infoprovider. It is illegal when running other packages.

**Note:**
This option is used for loading transactional data

<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| SELECTION = <Dimension1_techname>, <Dimension1_value>; <Dimension2_techname>, <Dimension2_value> | <empty> | This option sets the selection rules when you are extracting transaction data from an infoprovider. Use the following parameter definitions to set your selection:

- `<Dimension1_techname>` is the technical name of the dimension.
- `<Dimension1_value>` is the value of a condition statement set to this dimension.

**Example:**

```
0SX_ACCS, US;0SX_CSLC, 1
```

This is the result of the following selection statement: 0SX_ACCS=US and 0SX_CSLC= 1

This option is only used for importing transaction data from an infoprovider. It is illegal when running other packages.

**Note:**
This option is used for loading transactional data |
<table>
<thead>
<tr>
<th>Option</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SKIP= integer</td>
<td>0 (zero)</td>
<td>This option specifies the number of lines to skip at the top of a data file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example:</strong> Use this option to skip header lines during transformation.</td>
</tr>
<tr>
<td>SKIPIF= text_string</td>
<td>empty_string</td>
<td>This option causes the transformation to skip a line in the data file if it</td>
</tr>
<tr>
<td>text_string2</td>
<td></td>
<td>begins with the specified strings. The strings are separated by</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If a record contains &lt;text_string&gt; or &lt;text_string2&gt;, the record is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>skipped. To include all lines in the transformation, set this option to an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>empty string. If you use this option, you must enter a parameter.</td>
</tr>
<tr>
<td>VALIDATERECORDS= No</td>
<td>No</td>
<td>This option specifies whether or not to validate records. If this parameter</td>
</tr>
<tr>
<td>Yes</td>
<td></td>
<td>is set to No, validation does not occur. If this parameter is set to Yes,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>you must check the following items before the import:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Validate the mapping.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ensure that the members exist.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify that the record is proper for the Planning and Consolidation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When this option is enabled, the following rules apply:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If a member ID is not mapped, the record associated with the ID is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rejected during validation and ignored.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the import file has an extra field that is not mapped, all records are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rejected during validation.</td>
</tr>
</tbody>
</table>

36.6.1.1.2 Transformation File: Mapping Function
The mapping section of the transformation file defines how data is mapped to the Planning and Consolidation database.

**Example:**
For a header row that defines a column named "AccountVal", you can map the "Account" dimension to the "Account" field from the data file as follows: \( \text{Account} = \text{AccountVal} \)

The following table details the available mapping functions:

<table>
<thead>
<tr>
<th>Mapping Function</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COL(A)</td>
<td>A = column index in the data file</td>
<td>This function defines a dimension for a field in the data file when the data file does not have a header row. See the note below about automatic field names when you do have a header row. <strong>Example:</strong> Account = (^{\ast}\text{COL}(2))</td>
</tr>
<tr>
<td>(^{\ast}\text{COL}(A, B:C))</td>
<td>A = column index in the data file, B:C = the start and end positions within the column</td>
<td>This function defines a dimension for a subset of a field in the data file. <strong>Example:</strong> Account = (^{\ast}\text{COL}(3,1:4))</td>
</tr>
</tbody>
</table>
| FLD              | - Column index of the data file  
- Delimiter character  
- Index of value by array that identified by delimiter | |
<p>| P_ACCT           | P_ACCT(4:12) | Defines a subset of the values of a dimension, called &quot;short name&quot; as well. |</p>
<table>
<thead>
<tr>
<th>Mapping Function</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*FCOL(A:B)</td>
<td>A:B = the start and end positions within the data row</td>
<td>This option allows you to define the start and end character columns for each field when you are using Fixed format data files. In the example below, the columns 4 through 7 represent the Account dimension. <strong>Example:</strong> Account=*FCOL(4:7)</td>
</tr>
<tr>
<td>*MVAL(A:B) or Dimension =*MVAL(keyfiguretype1</td>
<td>dim_mem1</td>
<td></td>
</tr>
<tr>
<td>*NEWCOL(A)</td>
<td>A = dimension member</td>
<td>This function creates a new field with the given value. <strong>Example:</strong> Account=*NEWCOL(Revenue)</td>
</tr>
</tbody>
</table>
### Mapping Function

<table>
<thead>
<tr>
<th>Mapping Function</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Str(string)</strong></td>
<td>Not applicable</td>
<td>This function adds a text string to the members of a column. This function is useful if you need to map data file fields to fields in your database that have the same names, except that the field names contain extra characters (either before or after the name). <strong>Example:</strong> Entity = *Str(NE) + *COL(1)</td>
</tr>
</tbody>
</table>
| **PAD (A,B,C,D)** | A = Field name  
B = Total length  
C = Padding direction  
D = Padding character | Use to format exported data into fixed-width records. Use in conjunction with the **NONE** delimiter. The padding character is optional and is a space by default. **Example:** Account=*Pad(Account,10,L) Account=*Pad(Account,10,L,0) |
| **If (Condition1 then Action1;Condition2 then Action2;Default Action)** | Condition1 - If this evaluates to "True," map using Action1  
Condition2 - If Condition1 is "False" and Condition2 is "True," map using Action2  
Default Action – If both Condition1 and Condition2 are "False", map using this Default Action  
Condition1 and Condition2 can contain multiple items that are added together (using the plus (+) sign) |  |
<table>
<thead>
<tr>
<th>Mapping Function</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>This function allows you to test a series of conditions, and to apply a corresponding action if the condition is true.</td>
</tr>
</tbody>
</table>

**Example:**

- Product=*if (Product+ID+Entity = *str(148552) then *str(MHarn);ID(1:1) = *str(C) then *str(XX) ; *str(YY)) |
- If the sum of the product, ID, and entity value are equal to 148552 then change product value to MHarn or Else IF first value of ID field is equal to C then Change Product value to XX |

**Note:**
The *STR() function must be used when evaluating numeric constants in an *IF statement.

**Example:**
Examine the following series of datasets, mapping function examples, and result sets to gain an understanding of how the *IF function can be used in various scenarios:

**Data Set 1:**

<table>
<thead>
<tr>
<th>PRODUCT, ID, ENTITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>14,85,52</td>
</tr>
<tr>
<td>AB,CD,EF GH,IJ,KL</td>
</tr>
</tbody>
</table>

**Mapping Function 1:**

Product=*IF (Product+ID+Entity = *Str(148552) then *str(MHarn);ID(1:1) = ...
<table>
<thead>
<tr>
<th>Mapping Function</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>*str(C)</td>
<td>then *str(XX) ; *str(YY))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Result Set 1:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRODUCT, ID, ENTITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MHarn, 85, 52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AB, XX, EF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>YY, IJ, KL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data Set 2:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Entity, SEntity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>U1000000, US01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Z2000A01, CA03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>K3430000, JP04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mapping Function 2:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Entity=*IF(*col(1,1:1)=U then SEntity;*col(1,1:1)=Z then *col(1,3:6); *STR(ERR))</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Result Set 2:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Entity, SEntity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>US01, US01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A01, CA03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ERR, JP04</td>
</tr>
</tbody>
</table>

### 36.6.1.1.3 Transformation File: Conversion Section

The *CONVERSION section of the transformation file defines which conversion sheet to use with which dimensions. Use the following syntax to associate a dimension with a conversion sheet:

Dimension Name = [COMPANY]WorkbookName[!SheetName]

**Note:**
Items in brackets are optional.
The following table describes the variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DimensionName</td>
<td>Either the dimension name to correlate with the conversion file or the keyword Amount. Use the Amount option to specify the conversion file to be used if you specify the ConverAmountWDim option in the *Options section. This allows you to use a formula to scale the input or output values.</td>
</tr>
<tr>
<td>Workbookname</td>
<td>The name of the conversion file</td>
</tr>
<tr>
<td>SheetName</td>
<td>This is the name of the worksheet to use within the conversion file. If a name is not specified, the system assumes the sheet name is Conversion.</td>
</tr>
<tr>
<td>[ COMPANY]</td>
<td>If [COMPANY] is defined then the Data Manager tries to obtain the conversion file from the main company Data Manager folder. Otherwise the Data Manager looks in the appropriate Site folder.</td>
</tr>
</tbody>
</table>

If [COMPANY] is defined then the Data Manager tries to obtain the conversion file from the main company Data Manager folder. Otherwise the Data Manager looks in the appropriate site folder.

**Examples:**
Where AccountConv.xls is the name of the Account dimension conversion file.

Account = AccountConv.xls

Amount = AccountConv.xls  Use the Amount keyword with the ConvertAmountWDim transformation option

Account = AccountConv.xls!newaccount

Account = [COMPANY]AccountConv.xls!newaccount

**36.6.1.2 Sample Transformation File**

When copy or import data between models and need to map the dimensions that are different, you can create a transformation file to map the dimensions.

The following table contains a list of the dimensions in a sample source and target application:
The following is an example of a transformation file created to map dimensions from a source to a target application.

*OPTIONS

| FORMAT = DELIMITED |
| HEADER = YES |
| DELIMITER = |
| SKIP = 0 |
| SKIPF = |
| CREDITNEGATIVE=NO |
| CONVERTAMOUNTWIDIM= |
| MAXREJECTCOUNT= |
| VALIDATERECORDS=YES |

*MAPPING

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Cat</td>
</tr>
<tr>
<td>Account</td>
<td>Acc</td>
</tr>
<tr>
<td>Entity</td>
<td>Ent</td>
</tr>
<tr>
<td>Time</td>
<td>Tim</td>
</tr>
<tr>
<td>Rptcurrency</td>
<td>Currency</td>
</tr>
<tr>
<td>Intco</td>
<td>Int</td>
</tr>
<tr>
<td>Datasrc</td>
<td>Dat</td>
</tr>
</tbody>
</table>

*CONVERSION

36.6.2 Data Conversions
Conversion files define the mapping by dimensions from external member names to internal member names. They also provide the ability to perform arithmetic and data decimal places during the conversion. You create one conversion file per dimension in a transformation.

Each conversion file can contain one or more sheets for different types of data transformations.

### 36.6.2.1 Creating, Validating, and Copying Conversion Files

To create a conversion file:
1. In the Data Manager select **Conversion Files > New Conversion File**.
2. Enter data as required.

   **Recommendation:**
   We recommend you give the conversion file the same name as the dimension for which it is being used.

To validate a conversion file:
1. Open the conversion file then select **Conversion Files > Validate and Process Conversion File**.
2. In the dialog box, locate the conversion file, then click **Save**.

To copy a conversion file:
1. Select **Conversion Files > Copy Conversion File**.
2. In the dialog box, locate the conversion file you want to copy, then click **Save**.

### 36.6.2.2 Keywords and Wildcards Used in Data Conversions

You can use the following values in data conversions.

- ***skip**

  If you want to ignore external data (as listed in the "External" column), you can place the keyword "*skip" in the "Internal" column, as in the following example.

<table>
<thead>
<tr>
<th>External</th>
<th>Internal</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCPAY</td>
<td>*skip</td>
</tr>
</tbody>
</table>

- **Wildcards**
You can use the asterisk (*) and question mark (?) wildcards in the External or Internal columns. An asterisk (*) stands for any character, while a question mark (?) stands for any single character. For example, if you want to reference all members, use the asterisk (*). This would be useful to apply a formula to all members. The formula in the following example would increase all members by 10 percent:

<table>
<thead>
<tr>
<th>External</th>
<th>Internal</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>*</td>
<td>Value*1.10</td>
</tr>
</tbody>
</table>

### 36.6.2.3 Using Javascript with Conversion Files

The Data Manager supports Microsoft Visual Basic (VB) script in conversion files. While Microsoft Visual Basic for Applications (VBA) can be used successfully in some instances, we cannot guarantee it for Interface for Excel.

**Important:**

To use Javascript you must ensure that the following parameters are set:

- **CONVERT_INTERNAL**
  
  If the transformation option `Convert_internal = NO`, Javascript can be used in the Internal column.
  - If transformation option `Convert_internal = YES`, Javascript can be used in the External column.

Mandatory: Precede the Javascript code with the following string: `js:`

You can use Javascript code in IF statements.

**Examples:**

The following examples illustrate Javascript string manipulation commands:

- `js: %external%.substring(0,2)`
  
  This example returns a Long containing the number of characters in a string.

- `js: %external%.length`
  
  This example returns the length of the string contained in external.

- `js: %external%.replace("apples", "oranges");`
  
  This example returns a string in which a specified substring has been replaced with another substring a specified number of times.
You can use Javascript in the FORMULA column.

Example:
The following item is an example of a Javascript command that can be used in the formula column:
\[ \text{js:Math.round(VALUE*Math.pow(10,2))/Math.pow(10,2)}; \]
If the source value is 200.356, the target value is 200.36.

36.7 Data Transfer and Preview

36.7.1 About Data Transfer and Preview

There are several options for transferring data in Data Manager.

The upload and download functions allow you to move flat files such as .txt and .csv files from your local hard drive to the Data Manager Data Files folder on the server.

You also transfer data in and out of the planning and consolidation application using packages and, in the case of the planning and consolidation application for NetWeaver, process chains.

The Data Manager also allows you to preview your data files. This is useful when you are creating a transformation file and want to see a preview of the data presentation. You can preview Microsoft Access database (mdb), Microsoft Excel, and ASCII text data files. You can preview data files that reside on the server in the Company site or other Site directories.

Note:
The system administrator can determine which files can be uploaded into Planning and Consolidation. You can set the size parameter in the process chain template to specify how many rows of data to transfer at a time. The optimal value for this parameter depends on the SAP NetWeaver system and on additional processing of the data that might occur. Typically, values between 2,000 and 20,000 offer the best performance.

36.7.1.1 Uploading or Downloading Data

To upload or download flat files to and from your local hard drive,

1. Click one of the following:
   - Upload Data
• Download Data

2. Browse to locate the flat file you want to upload or download.
3. Click one of the following:
   • Upload
   • Download

### 36.7.1.2 Downloading a Text File from the Database

To download a text file from the database:

1. In the Data Manager click **Download Data**.
2. In the "Data Manager - Download" dialog box, browse to locate the text file that you want to download, then click **Download**.
3. In the next dialog box, select the destination for the file, then click **Save**.

### 36.7.1.3 Previewing Data

You can preview the first 200 lines of data. To preview data:

1. In the Data Manager click **Data Preview**.
2. Select the file that you want to preview then click **Open**.
3. Depending on the type of file you opened, perform one of the following actions:
   • For text files select a data type from the list:
     - Fixed width
     - Delimited
     **Note:**
     If you select delimited files, you must also select a delimiter.
   • For Microsoft Excel files, select from the Select a worksheet list.
   • For database files, select a table from the Select a table list.
4. Click **Open**.
5. In the dialog box select a different file and click **Open** to preview another file. Choose Cancel when you are done previewing your data.
6. When you have finished previewing data, click **Cancel**.
You can perform some tasks (reporting and input tasks, user interface actions, etc.) by using the provided APIs in Visual Basic for Applications (VBA).

**Note:**
These APIs are accessible via standard MS Excel commands: in the Developer tab, select the Visual Basic button. Then, in the Microsoft Visual Basic window, select Tools > References. Select the FPMXLClien reference. Then, select View > Object Browser. In the drop-down list on the top, select FPMXLClien.

In the list of classes:
- The IEPMAutomationAPI class contains the macros that can executed for the EPM add-in (but cannot be used with the EPMExecuteAPI function).
- The IEPMEexecuteAPI class exposes all the macros that you can execute directly from a worksheet cell, by using the EPMExecuteAPI function. For more information, see EPMExecuteAPI.

**Note:**
- You can customize your VBA code by associating events. See Custom VBA Functions (Events).
- Any API that is not explained in this documentation is not supported.
- In Microsoft Office Word and Powerpoint, the EPM add-in APIs are not supported.

### 37.1 Macros

### 37.1.1 Connections

#### 37.1.1.1 Connect

This API enables you to actually connect an existing connection to a cube or model.
### 37.1.1.2 ConnectAllReports

This API enables you to connect all the reports of the workbook at once.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login As String</td>
<td>Login to a connection. Optional.</td>
</tr>
<tr>
<td>Password As String</td>
<td>Password to a connection. Optional.</td>
</tr>
</tbody>
</table>

### 37.1.3 ChangeReportConnection

This API enables you to connect a report to another connection (the connection must be already connected).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login As String</td>
<td>Login to a connection. Optional.</td>
</tr>
<tr>
<td>Password As String</td>
<td>Password to a connection. Optional.</td>
</tr>
</tbody>
</table>
### 37.1.4 GetConnections

This API returns the list of the connections for the specified worksheet.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.5 GetActiveConnection

This API returns the active connection for the specified Excel worksheet.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.6 SetActiveConnection

This API enables to select a connection as the active connection.
**Parameter** | **Description**
---|---
File as Object | Name of the Excel worksheet or name of the Word document or name of the Powerpoint presentation.

connectionString As String | Connection. Mandatory.
Examples:
- "_EPM_[SolutionName]_[%server%:%port%]_[%environment%]_[%model%]"
- "_EPM_[SolutionName]_[%server%:%port%]_[%environment%]_[%model%]"
- "_EPM_LOCAL_[%oqy file name%]"

### 37.1.2 Reports

#### 37.1.2.1 CreateReport

This API enables you to create a report with one member in the row axis and one member in column axis.
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory</td>
</tr>
<tr>
<td>ConnectionString As String</td>
<td>Connection. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM</em>[SolutionName]_[%server:%port%][%environment%][%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM</em>[SolutionName]_[%server:%port%][%environment%][%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM_LOCAL</em>[%oqy file name%]&quot;</td>
</tr>
<tr>
<td>ReportName as string</td>
<td>Report Name. Mandatory.</td>
</tr>
<tr>
<td>ColumnMemberName as string</td>
<td>Specify the member for the column axis. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>• Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>• or dimension:member, where you can specify either the caption or unique name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>• or hierarchy:member, where you can specify either the caption or unique name for the hierarchy and for the member</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> we recommend that you use:</td>
</tr>
<tr>
<td></td>
<td>• dimension:member for Planning and Consolidation connections,</td>
</tr>
<tr>
<td></td>
<td>• hierarchy:member for the other connections.</td>
</tr>
<tr>
<td>ColumnMemberDynamicRelation as integer</td>
<td>See below the list of values available. Mandatory.</td>
</tr>
<tr>
<td>RowMemberName as string</td>
<td>Specify the member for the row axis. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>• Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>• or dimension:member, where you can specify either the caption or unique name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>• or hierarchy:member, where you can specify either the caption or unique name for the hierarchy and for the member</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> we recommend that you use:</td>
</tr>
<tr>
<td></td>
<td>• dimension:member for Planning and Consolidation connections,</td>
</tr>
<tr>
<td></td>
<td>• hierarchy:member for the other connections.</td>
</tr>
<tr>
<td>RowMemberDynamicRelation as integer</td>
<td>See below the list of values available. Mandatory.</td>
</tr>
<tr>
<td>StartRange as range</td>
<td>Starting Excel cell for the report. Optional.</td>
</tr>
</tbody>
</table>

List of supported dynamic relations values:
37.1.2.2 AddMemberToRowAxis

This API enables you to add the specified dimension member (and its dimension if it is not already set) or to replace the dimension member (if the specified dimension is already set) in the row axis of the specified report.
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportID as string</td>
<td>Identifier of the report. Mandatory. Example: &quot;002&quot;</td>
</tr>
<tr>
<td>MemberName as string</td>
<td>Mandatory.</td>
</tr>
<tr>
<td></td>
<td>• Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>• <code>dimension:member</code>, where you can specify either the caption or unique name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>• <code>hierarchy:member</code>, where you can specify either the caption or unique name for the dimension and for the member</td>
</tr>
</tbody>
</table>

**Note:**
we recommend that you use:
• `dimension:member` for Planning and Consolidation connections,
• `hierarchy:member` for the other connections.

| DynamicRelation as integer  | See below the list of values available. Mandatory.                                                   |

List of supported dynamic relations values:
• Member = 1
• Children = 2
• Member and Children = 3
• Descendants = 4
• Member and Descendants = 5
• Leaves = 6
• Same Level = 7
• Siblings = 8
• Ascendants = 9
• Member and Ascendants = 10
• Member and Leaves = 11
• Property = 12
• Named Set = 13
• Member OffSet = 14
• Member Property = 15

**Note:**
The refresh action is required to update the report.

### 37.1.2.3 RemoveMemberFromRowAxis
This API enables you to remove the specified dimension member (and its dimension if it is the only member for this dimension in the report) from the row axis.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
<tr>
<td>MemberName as string</td>
<td>Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>* or dimension:member, where you can specify either the caption or unique</td>
</tr>
<tr>
<td></td>
<td>name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>* or hierarchy:member, where you can specify either the caption or unique</td>
</tr>
<tr>
<td></td>
<td>name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>we recommend that you use:</td>
</tr>
<tr>
<td></td>
<td>* dimension:member for Planning and Consolidation connections,</td>
</tr>
<tr>
<td></td>
<td>* hierarchy:member for the other connections.</td>
</tr>
<tr>
<td>DynamicRelation as integer</td>
<td>See below the list of values available. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Applies only to dimension members that have been selected with the same</td>
</tr>
<tr>
<td></td>
<td>dynamic relation.</td>
</tr>
</tbody>
</table>

List of supported dynamic relations values:
- Member = 1
- Children = 2
- Member and Children = 3
- Descendants = 4
- Member and Descendants = 5
- Leaves = 6
- Same Level = 7
- Siblings = 8
- Ascendants = 9
- Member and Ascendants = 10
- Member and Leaves = 11
- Property = 12
- Named Set = 13
- Member OffSet = 14
- Member Property = 15

**Note:**
The refresh action is required to update the report.
### 37.1.2.4 GetRowAxisDimensionCount

This API returns the number of dimensions in the row axis of the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.5 GetRowAxisMembers

This API returns the list of the dimension members of the row axis for the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.6 GetRowAxisOwner

This API returns the ID of the report that is the owner of the row axis for the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.7 AddMemberToColumnAxis
This API enables you to add the specified dimension member (and its dimension if it is not already set) or to replace the dimension member (if the specified dimension is already set) in the column axis of the specified report.

### Description

**Parameter** | **Description**
--- | ---
Worksheet as sheet | Excel worksheet name containing the report. Mandatory.
ReportID as string | Identifier of the report. Mandatory. Example: "002"
MemberName as string | Mandatory.
  • Dimension member name (caption or unique name)
  • or dimension:member, where you can specify either the caption or unique name for the dimension and for the member
  • or hierarchy:member, where you can specify either the caption or unique name for the dimension and for the member

**Note:**
we recommend that you use:
  • dimension:member for Planning and Consolidation connections,
  • hierarchy:member for the other connections.

DynamicRelation as integer | See below the list of values available. Mandatory.

List of supported dynamic relations values:
- Member = 1
- Children = 2
- Member and Children = 3
- Descendants = 4
- Member and Descendants = 5
- Leaves = 6
- Same Level = 7
- Siblings = 8
- Ascendants = 9
- Member and Ascendants = 10
- Member and Leaves = 11
- Property = 12
- Named Set = 13
- Member OffSet = 14
- Member Property = 15

**Example:**

```vbnet
Option Explicit
Dim client As New FPMXLClien.EPMAddInAutomation
Sub Example()
    client.AddColumnHeader Sheet1, "000", "Australia", 2
End Sub
```
**37.1.2.8 RemoveMemberFromColumnAxis**

This API enables you to remove the specified dimension member (and its dimension if it is the only member for this dimension in the report) from the column axis.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
<tr>
<td>MemberName as string</td>
<td>Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>or dimension:member, where you can specify either the caption or unique name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>or hierarchy:member, where you can specify either the caption or unique name for the dimension and for the member</td>
</tr>
<tr>
<td>Note:</td>
<td>we recommend that you use:</td>
</tr>
<tr>
<td></td>
<td>* dimension:member for Planning and Consolidation connections,</td>
</tr>
<tr>
<td></td>
<td>* hierarchy:member for the other connections.</td>
</tr>
<tr>
<td>DynamicRelation as integer</td>
<td>See below the list of values available. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Applies only to dimension members that have been selected with the same dynamic relation.</td>
</tr>
</tbody>
</table>

List of supported dynamic relations values:
- Member = 1
- Children = 2
- Member and Children = 3
- Descendants = 4
- Member and Descendants = 5
- Leaves = 6
- Same Level = 7
- Siblings = 8

**Note:**
The refresh action is required to update the report.
- Ascendants = 9
- Member and Ascendants = 10
- Member and Leaves = 11
- Property = 12
- Named Set = 13
- Member OffSet = 14
- Member Property = 15

**Note:**
The refresh action is required to update the report.

### 37.1.2.9 GetColumnAxisDimensionCount

This API returns the number of dimensions in the column axis of the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.10 GetColumnAxisMembers

This API returns the list of the dimension members of the column axis for the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.11 GetColumnAxisOwner

This API returns the ID of the report that is the owner of the column axis for the specified report.
### 37.1.2.12 AddMemberToPageAxis

This API enables you to add the specified dimension member (and its dimension if it is not already set) or to replace the dimension member (if the specified dimension is already set) in the page axis of the specified report.

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportID as string</td>
<td>Identifier of the report. Mandatory. Example: &quot;002&quot;</td>
</tr>
</tbody>
</table>
| MemberName as string| Mandatory.  
  • Dimension member name (caption or unique name)  
  • or dimension:member, where you can specify either the caption or unique name for the dimension and for the member  
  • or hierarchy:member, where you can specify either the caption or unique name for the dimension and for the member  
  **Note:** we recommend that you use:  
  • dimension:member for Planning and Consolidation connections,  
  • hierarchy:member for the other connections. |
| DynamicRelation as integer | See below the list of values available. Mandatory. |

List of supported dynamic relations values:

- Member = 1
- Children = 2
- Member and Children = 3
- Descendants = 4
- Member and Descendants = 5
- Leaves = 6
- Same Level = 7
- Siblings = 8
- Ascendants = 9
• Member and Ascendants = 10
• Member and Leaves = 11
• Property = 12
• Named Set = 13
• Member OffSet = 14
• Member Property = 15

**Note:**
The refresh action is required to update the report.

### 37.1.2.13 RemoveMemberFromPageAxis

This API enables you to remove the specified dimension member (and its dimension) from the page axis.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportID as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
<tr>
<td>MemberName as string</td>
<td>Mandatory.</td>
</tr>
<tr>
<td></td>
<td>• Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>• or dimension:member, where you can specify either the caption or unique</td>
</tr>
<tr>
<td></td>
<td>name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>• or hierarchy:member, where you can specify either the caption or unique</td>
</tr>
<tr>
<td></td>
<td>name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>we recommend that you use:</td>
</tr>
<tr>
<td></td>
<td>• dimension:member for Planning and Consolidation connections,</td>
</tr>
<tr>
<td></td>
<td>• hierarchy:member for the other connections.</td>
</tr>
<tr>
<td>DynamicRelation as integer</td>
<td>See below the list of values available. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Applies only to dimension members that have been selected with the same</td>
</tr>
<tr>
<td></td>
<td>dynamic relation.</td>
</tr>
</tbody>
</table>

List of supported dynamic relations values:
• Member = 1
• Children = 2
• Member and Children = 3
• Descendants = 4
• Member and Descendants = 5
• Leaves = 6
• Same Level = 7
• Siblings = 8
• Ascendants = 9
• Member and Ascendants = 10
• Member and Leaves = 11
• Property = 12
• Named Set = 13
• Member Offset = 14
• Member Property = 15

Note:
The refresh action is required to update the report.

37.1.2.14 GetPageAxisMembers

This API returns the list of the dimension members of the page axis for the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportID as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

37.1.2.15 GetUnrecognizedMembers

This API returns the list of the dimension members that are used in the specified report but that are not recognized in the cube or model.
### 37.1.2.16 GetPageAxisOwner

This API returns the ID of the report that is the owner of the page axis for the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportID as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.17 GetActiveReportName

This API returns the name of the active report of the specified Excel worksheet.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.18 GetAllReportNames

This API returns the name of all reports for the specified Excel worksheet.
### 37.1.2.19 GetDataBottomRightCell

This API returns the bottom-right Excel cell of the data range of the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.20 GetDataTopLeftCell

This API returns the top-left Excel cell of the data range of the specified report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.1.2.21 GetShift

This API returns the shift value between the report data range and the row or column axis of the specified report.
### 37.1.2.22 SetShift

This API sets the shift value between the report data range and the row or column axis of the specified report.

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
<tr>
<td>IsRow as boolean</td>
<td>• The &quot;true&quot; value returns the shift value for the row axis.</td>
</tr>
<tr>
<td></td>
<td>• The &quot;false&quot; value returns the shift value for the column axis.</td>
</tr>
<tr>
<td>Value as integer</td>
<td>Shift value.</td>
</tr>
</tbody>
</table>

**Note:**
The refresh action is required to update the report.

### 37.1.3 GetMemberDimension

This API returns the dimension of the specified dimension member.
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| ConnectionString As String | Connection. Mandatory.  
Examples:  
- "_EPM_[SolutionName]_[%server%:%port%]_[%environment%]_[%model%]"  
- "_EPM_[SolutionName]_[%server%:%port%]_[%environment%]_[%model%]"  
- "_EPM_LOCAL_[%oqy file name%]" |
| MemberName As String | Mandatory.  
- Dimension member name (caption or unique name)  
- or dimension:member, where you can specify either the caption or unique name for the dimension and for the member  
- or hierarchy:member, where you can specify either the caption or unique name for the dimension and for the member  
**Note:**  
we recommend that you use:  
- dimension:member for Planning and Consolidation connections,  
- hierarchy:member for the other connections. |

**37.1.4 GetMemberHierarchy**

This API returns the hierarchy of the specified dimension member.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectionString As String</td>
<td>Connection. Mandatory. Examples:</td>
</tr>
<tr>
<td></td>
<td>• _EPM_[SolutionName_]_%server%:%port%_%environment_%model%&quot;</td>
</tr>
<tr>
<td></td>
<td>• _EPM_[SolutionName_]_%server%:%port%_%environment_%model%&quot;</td>
</tr>
<tr>
<td></td>
<td>• _EPM\ LOCAL_%oqy file name%&quot;</td>
</tr>
<tr>
<td>MemberName As String</td>
<td>Mandatory.</td>
</tr>
<tr>
<td></td>
<td>• Dimension member name (caption or unique name)</td>
</tr>
<tr>
<td></td>
<td>• or dimension:member, where you can specify either the caption or unique</td>
</tr>
<tr>
<td></td>
<td>name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td>• or hierarchy:member, where you can specify either the caption or unique</td>
</tr>
<tr>
<td></td>
<td>name for the dimension and for the member</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>we recommend that you use:</td>
</tr>
<tr>
<td></td>
<td>• dimension:member for Planning and Consolidation connections,</td>
</tr>
<tr>
<td></td>
<td>• hierarchy:member for the other connections.</td>
</tr>
</tbody>
</table>

### 37.1.5 GetDimensionList

This API returns the list of all dimensions for the specified connection.
**Parameter** | **Description**  
---|---  
ConnectionString As String | Connection. Mandatory.  
  Examples:  
  - "_EPM_[SolutionName]_[%server%:%port%][%environment%][%model%]"  
  - "_EPM_[SolutionName]_[%server%:%port%][%environment%][%model%]"  
  - "_EPM_LOCAL_[%oqy file name%]"

### 37.1.6 GetHierarchyList

This API returns the list of all hierarchies for the specified connection.

**Parameter** | **Description**  
---|---  
ConnectionString As String | Connection. Mandatory.  
  Examples:  
  - "_EPM_[SolutionName]_[%server%:%port%][%environment%][%model%]"  
  - "_EPM_[SolutionName]_[%server%:%port%][%environment%][%model%]"  
  - "_EPM_LOCAL_[%oqy file name%]"

### 37.1.7 GetHierarchyMembers

This API returns the list of all dimension members for the specified dimension.
37.1.8 Get MDX Request

**Applies to:**
Local or SAP BusinessObjects Enterprise connections.

This API returns the MDX request performed by the EPM add-in against an ODBO data source.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet as sheet</td>
<td>Excel worksheet name containing the report. Mandatory.</td>
</tr>
<tr>
<td>ReportD as string</td>
<td>Identifier of the report. Mandatory.</td>
</tr>
</tbody>
</table>

37.1.9 Book Publication and Distribution

### 37.1.9.1 OpenDistributionWizardOnSpecificTemplate

This API selects the specified distribution template, and opens the distribution wizard.
### 37.1.9.2 OpenBookPublicationWizardOnSpecificTemplate

This API selects the specified server folder ("Public" or a team), then select the book publication template, and opens the book publication wizard with this selection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileName as string</td>
<td>Excel distribution template. Mandatory.</td>
</tr>
<tr>
<td>TeamId as string</td>
<td>Blank value for &quot;Public&quot; folder or the team name. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.2 Macros used in EPMExecuteAPI function

For all APIs listed in this section, you must mention EPMExecuteAPI before the name of the API you want to execute.

The general syntax is the following: Application.Run EPMExecuteAPI, APIName, DisplayedText, Arg1, Arg2 ...

- APIName: DataManagerRunPackage for example
- DisplayedText: when launched from Application.Run, this parameter is not used and you can leave it empty (see the example below).
- Arg1, Arg2, etc: all the parameters needed for the macro.

Example:

```vba
Application.Run "EPMExecuteAPI", "DataManagerRunPackage", "", "Import", "Packages", ""
```

### 37.2.1 Connections


### 37.2.1.1 OpenConnectionManager

This API opens the **Connection Manager** dialog box.

No parameter.

### 37.2.1.2 CloseConnection

This API enables you to disconnect a specific connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectionString as String</td>
<td>Connection. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM</em>[SolutionName]_[%server%:%port%][%environment%][%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM</em>[SolutionName]_[%server%:%port%][%environment%][%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM_LOCAL</em>[%oqy file name%]&quot;</td>
</tr>
</tbody>
</table>

### 37.2.1.3 GetConnectionStatus

This API gets the status of a specified connection, that is if the connection is connected or not.
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| ConnectionString as String | Connection. Mandatory.  
Examples:  
- "_EPM_[SolutionName]_[%server%:%port%][%environment%][%model%]"  
- "_EPM_[SolutionName]_[%server%:%port%][%environment%][%model%]"  
- "_EPM_LOCAL_[%oqy file name%]" |

### 37.2.1.4 GoOffline

This API makes the current workbook an offline workbook. An offline workbook can be read by any user, even the users that do not have the EPM add-in installed.

No parameter.

### 37.2.1.5 GoOnline

This API makes the current offline workbook an online workbook. An online workbook can only be read by users that have the EPM add-in installed.

No parameter.

### 37.2.1.6 Logoff

This API disconnects all the connections used in the current workbook.

No parameter.

### 37.2.2 Excel
37.2.2.1 OpenExcelWorkbook

This API opens a specified Microsoft Office Excel workbook.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>filePath As String</td>
<td>Path (including the file name) to the Excel file to open.</td>
</tr>
</tbody>
</table>

37.2.2.2 CloseExcel

This API closes the current Microsoft Office Excel instance.

No parameter.

37.2.3 Word and PowerPoint

37.2.3.1 LaunchPowerPoint

This API launches a Microsoft Office PowerPoint instance.

No parameter.

37.2.3.2 OpenPowerPointPresentation

This API opens a specified Microsoft Office PowerPoint presentation.
### 37.2.3.3 LaunchWord

This API launches a Microsoft Office Word instance.

No parameter.

### 37.2.3.4 OpenWordDocument

This API opens a specified Microsoft Office Word document.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>filePath As String</td>
<td>Path (including the file name) to the Word file to open.</td>
</tr>
</tbody>
</table>

### 37.2.3.5 OpenInsertDataDialog

This API opens the Insert Data dialog box.

No parameter.

### 37.2.4 Navigation

#### 37.2.4.1 Back
This API performs a Back. It will undo the last EPM add-in navigation operation.
No parameter.

### 37.2.4.2 Collapse

This API enables you to perform a collapse on the current cell.
No parameter.

### 37.2.4.3 CollapseMember

This API enables you to perform a collapse on a specified member.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cellRef As String</td>
<td>cell reference containing the member to collapse.</td>
</tr>
</tbody>
</table>

### 37.2.4.4 Expand

This API enables you to perform an expand on the current cell.
No parameter is needed.

### 37.2.4.5 ExpandMember

This API enables you to perform an expand on a specified member.
### 37.2.5 Drill Through

#### 37.2.5.1 DrillThrough

**Applies to:**
Planning and Consolidation connections.

This API displays information from an external database or the Journals database, for the current connection.

No parameter.

#### 37.2.5.2 DrillThroughToURL

**Applies to:**
Planning and Consolidation connections.

This API displays information in a web browser for any URL, for the current connection.

No parameter.

### 37.2.6 Context Members

#### 37.2.6.1 GetContextMember
This API returns the unique name of the context member of the specified dimension.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectionString As String</td>
<td>Connection. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM</em>[SolutionName]<em>[%server%:%port%]</em>[%environment%]_[%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM</em>[SolutionName]<em>[%server%:%port%]</em>[%environment%]_[%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>• &quot;<em>EPM_LOCAL</em>[%oqy file name%]&quot;</td>
</tr>
<tr>
<td>DimensionName As String</td>
<td>Dimension caption. Mandatory.</td>
</tr>
</tbody>
</table>

### 37.2.6.2 SetContextMember

This API enables you to change the context member for the specified dimension.
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connectionString As String</td>
<td>Connection. Mandatory.</td>
</tr>
<tr>
<td>Example:</td>
<td></td>
</tr>
<tr>
<td>• &quot;<em>EPM</em>[SolutionName]_[%server%:%port%][%environment%][%model%]&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;<em>EPM</em>[SolutionName]_[%server%:%port%][%environment%][%model%]&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;<em>EPM_LOCAL</em>[%oqy file name%]&quot;</td>
<td></td>
</tr>
<tr>
<td>DimensionName As String</td>
<td>Dimension caption.</td>
</tr>
<tr>
<td>MemberName As String</td>
<td>Name of the member you want to specify as the context member. Mandatory.</td>
</tr>
<tr>
<td>• Dimension member name (caption or unique name)</td>
<td></td>
</tr>
<tr>
<td>• or dimension:member, where you can specify either the caption or unique name for the dimension and for the member</td>
<td></td>
</tr>
<tr>
<td>• or hierarchy:member, where you can specify either the caption or unique name for the dimension and for the member</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>we recommend that you use:</td>
</tr>
<tr>
<td>• dimension:member for Planning and Consolidation connections,</td>
<td></td>
</tr>
<tr>
<td>• hierarchy:member for the other connections.</td>
<td></td>
</tr>
</tbody>
</table>

### 37.2.7 Comments

#### 37.2.7.1 OpenAddCommentEditor

This API opens the Add Comment dialog box.

No parameter.
37.2.7.2 OpenFindCommentsEditor

This API opens the Find Comments dialog box.
No parameter.

37.2.8 Open/Save from Server

37.2.8.1 OpenServerInputFormFolder

Applies to:
Planning and Consolidation connections.
This API opens the file selection dialog box on the server folder dedicated to input forms.
No parameter.

37.2.8.2 OpenServerReportFolder

Applies to:
Planning and Consolidation connections.
This API opens the file selection dialog box on the server folder dedicated to reports.
No parameter.

37.2.8.3 OpenServerRootFolder

Applies to:
Planning and Consolidation connections.
This API opens the file selection dialog box on the server root folder.
No parameter.

### 37.2.8.4 SaveToServerRootFolder

**Applies to:**
Planning and Consolidation connections.
This API opens the dialog box that enables to save a file to the server.
No parameter.

### 37.2.9 OpenDimensionAndMemberSelector

This API opens the dialog box that enables you to select dimensions and members for a specified connection.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConnectionString as String</td>
<td>Connection. Mandatory.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>&quot;<em>EPM</em>[SolutionName]<em>[%server%:%port%]</em>[%environment%]_[%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;<em>EPM</em>[SolutionName]<em>[%server%:%port%]</em>[%environment%]_[%model%]&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;<em>EPM_LOCAL</em>[%oqy file name%]&quot;</td>
</tr>
</tbody>
</table>

### 37.2.10 OpenReportEditor

This API opens the **Report Editor** dialog box.
No parameter.
37.2.11 Options

37.2.11.1 OpenUserOptions

This API opens the User Options dialog box.
No parameter.

37.2.11.2 OpenSheetOptions

This API opens the Sheet Options dialog box.
No parameter.

37.2.11.3 OpenContextOptions

This API opens the Context Options dialog box.
No parameter.

37.2.12 Refresh

37.2.12.1 Refresh

This API performs a refresh on:
• the active report, for Microsoft Office Excel,
• the active document, for Microsoft Office Word,
• the active presentation, for Microsoft Office PowerPoint.

No parameter.

### 37.2.12.2 RefreshActiveReport

This API performs a refresh on the active report.

No parameter.

### 37.2.12.3 RefreshActiveSheet

This API performs a refresh on:
• the active worksheet, for Microsoft Office Excel,
• the active document, for Microsoft Office Word,
• the active presentation, for Microsoft Office PowerPoint.

No parameter.

### 37.2.12.4 RefreshActiveWorkbook

This API performs a refresh on the active workbook.

No parameter.

### 37.2.12.5 RefreshSelectedCells

This API performs a refresh on the selected cells.

No parameter.
37.2.13 Save Data

37.2.13.1 SaveWorksheetData

 Applies to:  
Planning and Consolidation connections.  
This API performs a save on the worksheet data.  
No parameter.

37.2.13.2 SaveWorkbookData

 Applies to:  
Planning and Consolidation connections.  
This API performs a save on the workbook data.  
No parameter.

37.2.13.3 SaveAndRefreshWorksheetData

 Applies to:  
Planning and Consolidation connections.  
This API performs a save and a refresh on the worksheet data.  
No parameter.

37.2.13.4 SaveAndRefreshWorkbookData
**37.2.14 OpenWorkStatusEditor**

**Applies to:**
Planning and Consolidation connections.
This API opens the Change Work Status dialog box.
No parameter.

**37.2.15 Planning**

**37.2.15.1 Spread**

**Applies to:**
Planning and Consolidation connections.
This API opens the Spread dialog box.
No parameter.

**37.2.15.2 Trend**

**Applies to:**
Planning and Consolidation connections.
This API opens the Trend dialog box.
No parameter.
37.2.15.3 Weight

Applied to:
Planning and Consolidation connections.
This API opens the Weight dialog box.
No parameter.

37.2.16 Book Publication

37.2.16.1 CreateBookPublicationTemplate

This API opens the Book Publication Template dialog box.
No parameter.

37.2.16.2 OpenBookPublicationTemplate

This API opens the dialog box that enables to select an existing book publication template.
No parameter.

37.2.16.3 ValidateBookPublicationTemplate

Applied to:
Planning and Consolidation connections.
This API validates the active book publication template.
No parameter.
37.2.16.4 SaveAsBookPublicationTemplate

**Applies to:**
Planning and Consolidation connections.
This API opens the dialog box that enables to save a book publication template to the server.
No parameter.

37.2.16.5 SaveBookPublicationTemplate

This API performs a save of the current book publication template.
No parameter.

37.2.16.6 OpenBookPublicationWizard

This API opens the Book Publication wizard that enables you to launch a book publication.
No parameter.

37.2.17 Distribution and Collection

37.2.17.1 CreateDistributionTemplate

This API opens the Distribution Template dialog box.
No parameter.
### 37.2.17.2 OpenDistributionTemplate

This API opens the dialog box that enables to select an existing distribution template.

No parameter.

### 37.2.17.3 ValidateDistributionTemplate

**Applies to:**
Planning and Consolidation connections.

This API validates the active distribution template.

No parameter.

### 37.2.17.4 SaveAsDistributionTemplate

**Applies to:**
Planning and Consolidation connections.

This API opens the dialog box that enables to save a distribution template to the server.

No parameter.

### 37.2.17.5 SaveDistributionTemplate

This API performs a save of the current distribution template.

No parameter.

### 37.2.17.6 OpenDistributionWizard
This API opens the **Distribution Wizard**.
No parameter.

37.2.17.7 **OpenCollectionWizard**

This API opens the Collection wizard that enables you to launch a data collection.
No parameter.

37.2.18 **OpenSpecificDocument**

**Applies to:**
Planning and Consolidation connections.

This API opens a specific document that is stored in the Documents view of Planning and Consolidation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>documentName As String</td>
<td>Name of the file to open.</td>
</tr>
<tr>
<td>teamId As String</td>
<td>Team that has access to this document.</td>
</tr>
<tr>
<td>subFolderRequested As String</td>
<td>Folder.</td>
</tr>
<tr>
<td>subModule As String</td>
<td>Folder.</td>
</tr>
</tbody>
</table>

**Note:**
The last three parameters define the path to the document.

37.2.19 **Data Manager**

37.2.19.1 **DataManagerClearSavedPromptValues()**

This API clears saved prompt values.
37.2.19.2 DataManagerCreateConversionFile()

This API creates a conversion file in the Data Manager.

37.2.19.3 DataManagerCreateConversionSheet()

This API creates a conversion sheet in the Data Manager.

37.2.19.4 DataManagerCreateNewTransformationSheet()

This API creates a new transformation sheet in the Data Manager.

37.2.19.5 DataManagerOpenConversionFileDialog()

This API opens the "Conversion File" dialog box.

37.2.19.6 DataManagerOpenDataPreviewDialog()

This API opens the "Data Preview" dialog box.

37.2.19.7 DataManagerOpenFileDownloadDialog()

This API opens the "File Download" dialog box.
37.2.19.8 DataManagerOpenFileDialogUploadDialog()

This API opens the "File Upload" dialog box.

37.2.19.9 DataManagerOpenOrganizePackageDialog()

This API opens the "Organize Package" dialog box.

37.2.19.10 DataManagerOpenRunPackageDialog()

This API opens the "Run Package" dialog box.

37.2.19.11 DataManagerOpenRunPackageLinkDialog()

This API opens the "Run Package Link" dialog box.

37.2.19.12 DataManagerOpenScheduleStatusDialog()

This API opens the "Schedule Status" dialog box.

37.2.19.13 DataManagerOpenTransformationFileDialog()

This API opens the "Transformation File" dialog box.
### 37.2.19.14 DataManagerOpenViewLinkStatusDialog()

This API opens the "View Link Status" dialog box.

### 37.2.19.15 DataManagerOpenViewStatusDialog()

This API opens the "View Status" dialog box.

### 37.2.19.16 DataManagerRunPackage(packageId As String, groupId As String, teamId As String, fileName As String)

This API allows you to run a package.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>packageId As String, groupId As String, teamId As String</td>
<td>packageId=Package Name</td>
</tr>
<tr>
<td></td>
<td>groupId=Package Group</td>
</tr>
<tr>
<td></td>
<td>teamId=Team</td>
</tr>
</tbody>
</table>

**Note:**
The comma must be used as the delimiter.

### 37.2.19.17 DataManagerRunPackageLink

This API allows you to run a package link.
### 37.2.19.18 DataManagerValidateConversionFileDialog()

This API opens a dialog box that allows you to validate a conversion file.

### 37.2.19.19 DataManagerValidateServerTransformationFileDialog()

This API launches validation of the server transformation file.

### 37.2.19.20 DataManagerValidateTransformationFileDialog()

This API opens the "Validate Transformation File" dialog box.

### 37.3 Assigning a Control Form to a Macro

You can assign a control form to a macro.

**Example:** Assigning a button to the Refresh macro

```vbnet
Option Explicit
Dim client As New EPMAddInAutomation
Sub Button5_Click()
    client.Refresh
End Sub
```
37.4 Custom VBA Functions (Events)

You can customize your VBA code by associating the events listed below. You can use these custom functions when you build Visual Basic for Applications (VBA) modules.

- **BEFORE_CONTEXTCHANGE**
  Use this function to execute a custom operation before changing the context.

- **AFTER_CONTEXTCHANGE**
  Use this function to execute a custom operation after changing the context.

- **BEFORE_REFRESH**
  Use this function to execute a custom operation before the system refreshes the data.

- **AFTER_REFRESH**
  Use this function to execute a custom operation after the system refreshes the data.

- **BEFORE_SAVE**
  Use this function to execute a custom operation before the system saves data into the database.

- **AFTER_SAVE**
  Use this function to execute a custom operation after the system saves data into the database.

- **BEFORE_EXPAND**
  Use this function to execute a custom operation before the system expands the EVDRE reports.

- **AFTER_EXPAND**
  Use this function to execute a custom operation after the system expands the EVDRE reports.

**Applies to:**
Planning and Consolidation connections

**Example:** *Syntax with the AFTER_REFRESH event*

```vba
Function AFTER_REFRESH()
    MsgBox "AFTER"
    AFTER_REFRESH = True
End Function
```
Languages

• Application language. You can change the application language. The command names in the EPM tab are displayed in the language you have selected when you re-start the application.

  **Note:**
  If you have opened the EPM add-in from SAP BusinessObjects Enterprise BI launch pad, the add-in inherits the SAP BusinessObjects Enterprise BI launch pad application language defined for the current user.

• Data language. You can change the data language. If the data language you select does not exist in a cube or model, members are displayed in the cube/model default language. Because the EPM add-in is integrated into Microsoft Office Excel, Word and PowerPoint, it inherits all the Windows international settings for number and date defaults and formats.

When connecting to an SAP NetWeaver BW InfoCube, you choose the data language.

  **Note:**
  If the language of the retrieval tool is not available in the SAP NetWeaver BW InfoCube, internal IDs will appear as names for the members.

To change the languages, use the Application Language and Data Language options in EPM > User Options.
You can consult the following information:

• The current version of the EPM add-in, by selecting EPM > About > About EPM Add-in. The screen that opens states the EPM add-in version and copyright information.

• The updates that are available, by selecting EPM > About > Check for Updates. For more information about update, see Update.
40.1 Extended Analytics Analyzer Report Migration

You can migrate reports created with SAP BusinessObjects Extended Analytics Analyzer 7.5.

To do so, open the workbook containing the reports. Then, follow one of these steps:

- Perform a log on. All the reports are automatically connected if the connections are correctly defined.
- Select Report Actions > Manage Connections > Report Connections and connect the reports you want. If a cube has changed, you can change the connection for a report.

Then, perform a refresh. All the members are identified as EPM members (“=EPMOLapMember” is displayed in the formula bar when you select a member in the report.)

The following items are not migrated: attribute filtering, Flash objects.

**Note:**
The dynamic formatting sheet is migrated when you open the workbook. The structure levels are applied.

**Caution:**
When you migrate the reports, Extended Analytics Analyzer should not be installed.

**Related Topics**
- Log On and Log Off
- Connection Management

40.2 Planning and Consolidation EvDRE Migration

You can migrate EvDREs created with SAP BusinessObjects Planning and Consolidation 7.5.

This chapter aims to help you with the EvDRE migration by listing:

- All the EvDRE items that are migrated.
- The EvDRE items that are not migrated. Not all items are listed, as the possible cases are so numerous. For certain items that are not migrated, the EPM add-in equivalent features that you will be able to use in your reports after migration, are referred to in this chapter.
Note:
As a general rule, when launching the migration, the items that cannot be migrated are listed in the log file.

Caution:
You cannot migrate a protected worksheet or workbook.

Note:
- When migrating sheets, the EV functions are kept and some of them continue to work with EPM add-in. For more information on the EV functions that are not recognized by the EPM add-in, refer to the SAP BusinessObjects EPM Solutions, add-in for Microsoft Office, What's New guide.
- What is called an "application" in version 7.5 of Planning and Consolidation is called "model" in version 10. What is called "application set" in version 7.5 is called "environment" in version 10.
- An EvDRE can generate several reports.

40.2.1 EvDRE Formula

An EvDRE is migrated if:
- Its formula does not contain another formula, therefore inserting additional parentheses.
- Its formula contains only one or two separator characters, depending on the number of parameters, two or three.

So the EvDRE formula must be defined as follows to be migrated:
- =EVDRE("ModelName",KeysRange). For example: =EVDRE("Planning",A14:B19)

Note:
- The EvDRE formula, the KeysRange and the ExpansionsRange must be on the same sheet. Otherwise, the EvDRE will not be migrated.
- It is not necessary to write the model name. You can alternatively reference a cell that contains the model name. For example: =EVDRE(F2,A14:B19,A22:D28) where cell F2 contains the model name. The model name can be in another worksheet. For example: =EVDRE(Sheet2!D8,A14:B19,A22:D28), where cell D8 of Sheet2 contains the model name.

40.2.2 KeysRange

The following ranges are migrated:
- PageKeyRange. For more information, see KeysRange.
- ColKeyRange. For more information, see RowKeyRange and ColKeyRange Members.
- RowKeyRange. For more information, see RowKeyRange and ColKeyRange Members.
40.2.3 Report Members and Axes

The reports are migrated:

- If there is no ExpansionsRange defined for the EvDRE, the reports are migrated based on the definition of the EvDRE resulting reports in the sheet.

  **Note:**
  In this case, the migrated reports will be static, they will not contain any dynamic member selection.

- If an ExpansionsRange is defined for the EvDRE, the reports are migrated based on the ExpansionsRange content. For more information, see ExpansionsRange.

- The PageKeyRange members are migrated to what is called the "page axis" of a report in the EPM add-in.
- The RowKeyRange members are migrated to what is called the "row axis" of a report in the EPM add-in.
- The ColKeyRange members are migrated to what is called the "column axis" of a report in the EPM add-in.

In an EPM add-in report (on a Planning and Consolidation connection), a dimension can be used only in one of the three axes (page, row or column). Therefore, if a dimension is used in the RowKeyRange or the ColKeyRange, and also in the PageKeyRange, once migrated, the dimension remains in the row or column axis, and the dimension is displayed in the page axis range just for your information, but it is not used and its member is not identified by a formula beginning with =EPMOlapMember().

In some cases, members in the RowKeyRange or the ColKeyRange are not recognized as valid members and are not migrated. For more information, see RowKeyRange and ColKeyRange Members.

The empty rows and columns contained in the EvDRE reports are migrated and remain in the migrated reports.
About Keys and Headings

For each KeyRange, the keys are migrated into `EPMOlapMember`. In the keys cells, the descriptions of members are displayed by default. You will then be able to choose another display name for members in the Member Selector dialog box. For more information, see Member Name to Display.

The headings are left in the sheet just for information (they are not identified as `EPMOlapMember`). After the migration, they will be automatically deleted as soon as you perform a refresh that changes the members displayed in the report. There is no equivalent to headings in the EPM add-in.

### 40.2.3.1 PageKeyRange Members

The PageKeyRange members are migrated to what is called the "page axis" of a report in the EPM add-in.

<table>
<thead>
<tr>
<th>Member</th>
<th>Migrated or not</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identified by a formula beginning with <code>=EVCVW(</code></td>
<td>not taken into account. The formula remains after migration but is not migrated into a formula beginning with <code>=EPMOlapMember(</code>.</td>
</tr>
<tr>
<td>Identified by a formula different from <code>=EVCVW(</code></td>
<td>migrated. The member is identified by a formula beginning with <code>=EPMOlapMember(</code></td>
</tr>
<tr>
<td>Hard-coded member</td>
<td>migrated. The member is identified by a formula beginning with <code>=EPMOlapMember(</code></td>
</tr>
<tr>
<td>For example: 2010.TOTAL</td>
<td></td>
</tr>
<tr>
<td>Several members separated by a comma</td>
<td>migrated. The members altogether are identified by a formula beginning with <code>=EPMOlapMultiMember(</code>.</td>
</tr>
</tbody>
</table>

**Note:** When several members are selected for the same dimension in the page axis, the data on the members are automatically aggregated in the report.

- If a member appears in several dimensions, the dimension to which the member is attached may not be identified. For this reason, you should always specify the dimension caption for each member in the PageKeyRange on the left column to the members column.

<table>
<thead>
<tr>
<th>Time</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007.TOTAL</td>
<td>YTD.PERIODIC</td>
</tr>
</tbody>
</table>
• If the PageKeyRange references several ranges, all the ranges will be migrated into only one page axis for all the EvDRE reports, following this rule: if several members of the same dimension appears in the different ranges, only the first one read by the migration process is migrated. The other members of the dimension are still displayed but they are not recognized as an EPMOlapMember.

Unrecognized and Not Migrated Members

In some cases, members are not recognized as valid members or simply not migrated.

When a member is not recognized in the page axis (for example, a member has been deleted from the environment):

• The following sentence is displayed in the log: The member '{0}' at position [{1},{2}] is not valid.
• The member remains in the page axis range just for your information, but it is not identified by a formula beginning with =EPMOlapMember().

40.2.3.2 RowKeyRange and ColKeyRange Members

• All the members contained in a RowKeyRange (beginning with the top-left member in the range) are migrated to what is called the "row axis" of a report in the EPM add-in.
• All the members contained in a ColKeyRange (beginning with the top-left member in the range) are migrated to what is called the "column axis" of a report in the EPM add-in.

<table>
<thead>
<tr>
<th>Member</th>
<th>Migrated or not</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identified by any formula</td>
<td>migrated.</td>
</tr>
<tr>
<td></td>
<td>The member is identified by a formula beginning with =EPMOlapMember()</td>
</tr>
<tr>
<td>Hard-coded member</td>
<td>migrated.</td>
</tr>
<tr>
<td>For example: 2010.TOTAL</td>
<td>The member is identified by a formula beginning with =EPMOlapMember()</td>
</tr>
<tr>
<td>ev_before and ev_after parameters</td>
<td>migrated.</td>
</tr>
<tr>
<td></td>
<td>The member is identified by a formula beginning with =EPMInsertedMember()</td>
</tr>
</tbody>
</table>

Note:

• All member formulas are migrated. The formulas that reference other cells are also migrated and continue to reference the same cell.
• Members whose formula begin with =EPMInsertedMember() are "fake" members, meaning that they do not have the standard behavior of members in the EPM add-in. These members ensure the continuity of the row or column axis.
• If at least one of the row or column axes does not contain any member, the report is not migrated.
• When there is more than one dimension in a row or in a column axis and if one member is not recognized, the entire row or column is not valid. See below.
• When migrated, the Microsoft Office Excel "General" number format is automatically applied to all the cells of the row and column axes.
• All the merged cells in the row and column axes are automatically unmerged during the migration process.

**Unrecognized and Not Migrated Members**

In some cases, members are not recognized as valid members or simply not migrated.

When a member is not recognized in a row or page axis (for example, a member has been deleted from the database):

• The following sentence is displayed in the log: *The member '{0}' at position [{1},{2}] is not valid for the dimension '{3}’*
• The member cell is colored in magenta on a row or column created temporarily. You can easily spot the members that you will not find in your report.

As soon as you perform a refresh on the report, the temporary rows and columns for the unrecognized members are deleted. For more information, see [After Migration](#).

### 40.2.3.3 About Axes

**About Axes**

• The EPM add-in does not support reports when the page axis is not above both row and column axes. Therefore, if a PageKeyRange is not above the RowKeyRange and ColKeyRange, the report is not migrated. So that you can migrate the report, move the PageKeyRange above the RowKeyRange and ColKeyRange.
• The EPM add-in does not support reports when the column axis is under the row axis. Therefore, if a ColKeyRange is under the RowKeyRange, the report is not migrated.
• When the RowKeyRange is on the right side of the ColKeyRange, the report is migrated.
• If two EvDREs reference a part of the same report range (that is at least one cell in common and not the full range), whether it is the PageKeyRange, the RowKeyRange or ColKeyRange: only the report that is overridden by the other report is migrated.
• If a report is located between the data range and the RowKeyRange or the data range and ColKeyRange of another report, only one report is migrated (the first one that is read during the migration process). To migrate both reports, move the inside report outside of the other report.
• If an EvDRE contains several report ranges, here is how the number of reports is determined: the RowKeyRange contains more than one range and the ColKeyRange also; the lowest number of ranges determines the number of reports to be migrated.

For example, if the RowKeyRange contains 2 ranges and the ColKeyRange contains 3 ranges, 2 reports will be created.

• The first report will use the first range of the RowKeyRange and the first range of the ColKeyRange.
• The second report will use the second range of the RowKeyRange and:
- the second and third ranges of the ColKeyRange, if the ranges are on the same row.
- the second range of the ColKeyRange (and the third range is not migrated), if the ranges are not on the same row.

### Shared KeyRanges

As a general rule the EPM add-in supports the share of an entire axe (that is the exact same range of cells), not just a part of it.

**Caution:**

Also, an axis can be shared only if the reports that share the axis are on the same model. If two reports on a different model share a KeyRange, the migration process unshares the KeyRange and the following message is displayed in the log file: *Range row [ ] - column [ ], row [ ] - column [ ] is used by 2 different EvDRE reports, but on different models ([model name] <-> [model name]): axis sharing is not be possible.* Only one report is migrated (the first one that is read during the migration process).

- "Butterfly" reports are migrated.
- If two reports share the same ColKeyRange, and the RowKeyRange of report 2 is not aligned on the RowKeyRange of report 1, after migration, the two row axes will be automatically aligned. Same case if you have two ColKeyRange that are not aligned.
- If two reports share an axis: if report 000 is valid and 001 is not valid and therefore not migrated, report 000 is migrated and does not share an axis with report 001.
- If two EvDREs in the same sheet reference the exact same ColKeyRange and RowKeyRange, the second EvDRE is not migrated.
- If two EvDREs in the same sheet reference a range that is part of another EvDRE ColKeyRange or RowKeyRange, the second EvDRE is not migrated.
- If one EvDRE contains two reports that share the same PageKeyRange, for example:
  - Report 2 contains the Time dimension in the ColKeyRange or RowKeyRange and in the PageKeyRange. After migration, Time will not be included in the page axis.
  - Since both reports share the PageKeyRange, after migration, the Time dimension will not be part of report 1.

### 40.2.4 ExpansionsRange

Here is the list of ExpansionsRange parameters that are migrated and the ones that are not migrated.

The parameters below are migrated:

- ExpandIn. COL and ROW are migrated. SHEET is not migrated.

**Note:**

About SHEET:

- If reports have already been generated based on the SHEET parameter, the reports can be migrated.
- The EPM add-in equivalent feature is: [Workbook Sheets' Automatic Generation](#).
• Dimension.
• MemberSet. See MemberSet.
• BeforeRange. See BeforeRange and AfterRange.
• AfterRange. See BeforeRange and AfterRange.

The values below are not migrated:
• Suppress. You can use the EPM add-in equivalent feature: the Remove Empty Rows and Remove Empty Columns options. See Empty Row and Column Behavior.
• Insert. You can use the EPM add-in equivalent feature: entering members directly in a sheet or using the Member Selector dialog box. See Member Entry Directly in a Sheet and Member Entry Using the Member Selector.

Note:
During the migration process, the ExpansionsRange is read from left to right. When there are several dimensions in an axis, the inner and outer dimensions are therefore kept in the original order.

40.2.4.1 MemberSet

Here is the list of MemberSet values that are migrated and the ones that are not migrated:

Hard-coded
Hard-coded values are migrated, whether they are are static (for example: 2007.TOTAL) or dynamic (for example: LDEP(2,2008.TOTAL,Y)).

Note:
When several members are specified, the members are migrated only if the delimiter character is a comma.

Formula
Any formula is migrated, based on the EPM function called "EPMDimensionOverride".

In the EPMDimensionOverride function, the ReportID parameter will specify one or more reports, the Dimension parameter will specify the dimension and the Members parameter will specify the migrated formula.

For more information, see EPMDimensionOverride.

After migration, in the MemberSet row, the cell that contains the EPMDimensionOverride function appears in yellow.

Caution:
So that the migrated report continue to function, do not delete the cell in yellow. You can move it to another cell in the sheet. For more information, see After Migration.
Range

The two following ways of entering a range are supported: =EVRNG(A1 and A5:D8)

- When a range is defined for a row axis:
  - The members in the first column are migrated.
  - If the members are not only in the first column but in other columns, the members are ignored and therefore not migrated.
  - If a cell in the first column does not contain any member, the cell is anyway migrated into what is called a "local member" in the EPM add-in. This local member is attached to the member in the above cell.
  - If a member is not recognized as a valid member, it is however migrated into an empty local member.

  **Note:**
  For more information on local members, see [Local Members](#).

- If none of the members in the first column of the range is recognized as a valid member, the following text is displayed in the log: *The expansion range [Q4:Q6] should contain at least one recognized member.*

- The other columns of the range are migrated, based on the EPM function EPMCcopyRange.
  In the EPMCcopyRange function, the ReportID parameter will specify the report, the Rows parameter will specify TRUE and the SourceRange parameter will specify all the columns of the range except for the first column.

  For more information, see [EPMCcopyRange](#).

After migration, in the MemberSet row, the cell that contains the EPMCcopyRange function appears in yellow.

**Caution:**
So that the migrated report continue to function, do not delete the cell in yellow. You can move it to another cell in the sheet. For more information, see [After Migration](#).

**Example:**
In this EvDRE:

- The second row references a range (N12:Q14).
- In the first column of the range, there are the members ACTUAL and FORECAST, and the third cell does not contain any member.
- The range contains three other columns.
Once migrated, here is what happens:

- The members in the first column of the range replace the members already existing in the second row of the report.
- The other columns of the range are migrated, based on the EPM function EPMCopyRange. The EPMCopyRange function replaces the range reference in the MemberSet parameter (see the cell selected and the formula bar).

- The third cell of the first column of the range that does not contain any member is migrated into a local member, as you can see in the formula bar.

- When a range is defined for a column axis:
  - The members in the first row are migrated.
• If the members are not only in the first row but in other rows, the members are ignored and therefore not migrated.
• If a cell in the first row does not contain any member, the cell is anyway migrated into what is called a "local member" in the EPM add-in. This local member is attached to the member in the left cell.
• If a member is not recognized as a valid member, it is however migrated into an empty local member.
• If none of the members in the first row of the range is recognized as a valid member, the following text is displayed in the log: *The expansion range [Q4:Q6] should contain at least one recognized member.*

• The other rows of the range are migrated, based on the EPM function called "EPMCopyRange".

In the EPMCopyRange function, the ReportID parameter will specify one or more reports, the Rows parameter will specify FALSE and the SourceRange parameter will specify all the rows of the range except for the first row.

For more information, see [EPMCopyRange](#).

After migration, in the MemberSet row, the cell that contains the EPMCopyRange function appears in yellow.

**Caution:**
So that the migrated report continue to function, do not delete the cell in yellow. You can move it to another cell in the sheet. For more information, see [After Migration](#).

**Note:**
If no member is recognized in the axis of a report, but the MemberSet members are valid, the members from the context are applied in the axis after the migration. Once you refresh the sheet, the members specified in the MemberSet replaces the members in the report axis.

### 40.2.4.2 BeforeRange and AfterRange

The two following ways of entering a range are supported: `=EVRNG { and A5:D8`

The ranges for BeforeRange and AfterRange are migrated, based on the EPM function called "EPMInsertCellsBeforeAfterBlock".

In the EPMInsertCellsBeforeAfterBlock function: the ReportID parameter will specify the report; the Dimension parameter will specify the dimension; the Before parameter will specify TRUE to insert the cells before the dimension members, FALSE to insert the cells after the dimension members; the Range parameter will specify the entire migrated range.

For more information, see [EPMInsertCellsBeforeAfterBlock](#).

After migration, in the BeforeRange or AfterRange row, the cell that contains the EPMInsertCellsBeforeAfterBlock function appears in yellow.
Caution:
So that the migrated report continue to function, do not delete the cell in yellow. You can move it to another cell in the sheet. For more information, see After Migration.

40.2.5 SortRange

The SortRange is not migrated. You can use the EPM add-in equivalent feature: Data Sorting. For more information, see Data Sorting. Also, for more information on the EPM add-in equivalent feature for the InsertAfter and InsertBefore parameters, see Member Sorting and Grouping by Properties.

40.2.6 OptionRange

Note:
- For each option, the values supported and therefore migrated are: Y, Yes, N, No. The other values are not migrated.
- When several options are specified, the options are migrated only if the delimiter character is a comma. For example: AutoFitCol=Y,NoRefresh=N

The following options are migrated:
- AutoFitCol. Equivalent feature in the EPM add-in: Auto Fit Column Width.
- NoRefresh. Equivalent feature in the EPM add-in: Freeze Data Refresh.
- NoSend. Equivalent feature in the EPM add-in: Use as Input Form.
- ShowComments. Equivalent feature in the EPM add-in: Keep Formula on Data and Show Source Data in Comments.
- SQLOnly. Equivalent feature in the EPM add-in: Display only Base Level Data.
- SuppressNodata.
  - When the value is N or No, after migration, the Remove Empty Rows and Remove Empty Columns options are selected in the EPM add-in. You can view these options in the Sheet options and the Options tab of the Report Editor. See Empty Row and Column Behavior.
  - When the value is Y or Yes, after migration, in the EPM add-in, the Remove Empty Rows and Remove Empty Columns options are selected and a filter on rows that contain 0 is created so that rows with zero are not displayed in the report. You can view these options in the Sheet options and the Options tab of the Report Editor. You can view filter on 0 data in the Data Filtering tab of the Report Editor. See Empty Row and Column Behavior.
Note:
In the EPM add-in, some options that apply to a specific report cannot inherit the sheet options. In this case, the inheritance option is automatically deselected and the following text is displayed in the log: Deactivate Sheet Options Inheritance. For more information on the report options inheritance, see Report Options.

The following options are not migrated:
- Bottom. Equivalent feature in the EPM add-in: Data Ranking.
- ExpandOnly.

Caution:
If the ExpandOnly option is set to Y or YES, the entire EvDRE is not migrated and the following text is displayed in the log: Warn: The EVDRE function in cell [cell reference] will not be migrated because the option expandOnly is true.
- HideColKeys. In the EPM add-in, you can choose the name you want to display for members. Member Name to Display
- HideRowKeys. In the EPM add-in: you can choose the name you want to display for members. Member Name to Display
- PctInput.
- QueryEngine.
- QueryType.
- QueryViewName.
- SortCol. Equivalent feature in the EPM add-in: Member Sorting and Grouping feature in the Member Selector. See Member Sorting and Grouping by Properties.
- SuppressDataCol. Equivalent feature in the EPM add-in: Excluding Members.
- SuppressDataRow. Equivalent feature in the EPM add-in: Excluding Members.
- Top. Equivalent feature in the EPM add-in: Data Ranking.

40.2.7 Format Migration

When migrating an EvDRE, the format settings are migrated along and stored in what is called a dynamic formatting sheet in the EPM add-in. For each EvDRE migrated, one dynamic formatting sheet is created and is applied to all the EvDRE reports.

Note:
- However, if several EvDRE reference the exact same FormatRange, only one dynamic formatting sheet will be created in the EPM add-in.
- All the format settings that are not specified in an EvDRE are left blank in the EPM dynamic formatting sheet (in the Use column cells), meaning that no format is applied.
If several formatting sheets are generated during the migration process, they are named as follows and do not exceed 31 characters: [full or partial name of the sheet containing the EvDRE]_000. The following sheets are incremented: 001, 002, etc.

**Related Topics**
- Dynamic Formatting Template Definition

### 40.2.7.1 Format Range

FormatRange is migrated into a dynamic formatting sheet in the EPM add-in.

- When the FormatRange is left blank, a formatting sheet is created based on the following:
  - The format of the top-left cell of the RowKeyRange is applied in the formatting sheet as the row default format for headers.
  - The format of the top-left cell of the ColKeyRange is applied in the formatting sheet as the column default format for headers.
  - The format of the top-left cell of the data range is applied in the formatting sheet as the row and column default format for data.
  - The format of the top-left cell of the PageKeyRange is applied in the formatting sheet as the page axis default format for headers.

- When the FormatRange value is one cell, a formatting sheet is created based on the following:
  - The format of the top-left cell of the RowKeyRange is applied in the formatting sheet as the row default format for headers.
  - The format of the top-left cell of the ColKeyRange is applied in the formatting sheet as the column default format for headers.
  - The format of referenced cell is applied in the formatting sheet as the row and column default format for data.
  - The format of the top-left cell of the PageKeyRange is applied in the formatting sheet as the page axis default format for headers.

- When the FormatRange value is greater than one cell and references a full set of formatting features (within six columns), a formatting sheet is created based on these features. For more information, see **Columns of the Formatting Range**.

### 40.2.7.2 Columns of the Formatting Range

When the FormatRange value is greater than one cell and references a full set of formatting features (within six columns), a dynamic formatting sheet is created based on these features, in the EPM add-in.
**Note:**

- If none of the rows is recognized, no EPM dynamic formatting sheet is created.
- If two rows contain the exact same values except for the USE and PARAMETERS columns, all the format in the USE and PARAMETERS are concatenated and migrated.
- If two rows contain the exact same values except for the FORMAT column, the format of the second row is migrated and overwrites the format the first row.

40.2.7.2.1 CRITERIA column

The values below are migrated:

<table>
<thead>
<tr>
<th>Migrated Value</th>
<th>Where in the EPM add-in formatting sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULT</td>
<td>In the Default Format area of the Hierarchy Level Formatting area or the Page Axis Formatting, depending on the value in the EVALUATE IN column of the EvDRE formatting range. In the Row and Column Banding area, if the ODDROWS parameter is in the APPLYTO column.</td>
</tr>
<tr>
<td>CALC</td>
<td>In the Calculated Member Default Format area of the Dimension Member/Property Formatting area.</td>
</tr>
<tr>
<td>INPUT</td>
<td>In the Inputable Member Default Format area of the Dimension Member/Property Formatting area.</td>
</tr>
<tr>
<td>{dim.property}=&quot;{value}&quot; supports &quot;different-from&quot; (&lt;&gt; and comma-delimited list of values</td>
<td>A row with the property and its format is added to the Dimension Member/Property Formatting area.</td>
</tr>
<tr>
<td>KEY=&quot;{string}&quot;</td>
<td>A row with the member and its format is added to the Dimension Member/Property Formatting area.</td>
</tr>
<tr>
<td>CHANGED</td>
<td>In the Changed Member Default Format area of the Dimension Member/Property Formatting area.</td>
</tr>
</tbody>
</table>

The values below are not migrated:
- STATUS=n
- LOCKED
- HEADING="\{string\}"
- FORMULA
- VALUE = | <> | < | > | <= | >= \{value\}
40.2.7.2.2 EVALUATE IN column

The values below are migrated:

<table>
<thead>
<tr>
<th>Migrated Value</th>
<th>Where in the EPM add-in formatting sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>{blank} or ALL</td>
<td>In the Row or/and Column areas or the Page Axis Formatting area.</td>
</tr>
<tr>
<td>PAGE</td>
<td>In the Page Axis Formatting area.</td>
</tr>
<tr>
<td>COL</td>
<td>In the Column areas.</td>
</tr>
<tr>
<td>ROW</td>
<td>In the Row areas.</td>
</tr>
<tr>
<td>ROWCOL</td>
<td>In both Row and Column areas.</td>
</tr>
</tbody>
</table>

The value below is not migrated:

- CELL

40.2.7.2.3 FORMAT column

Only the formatting settings specified in the USE and PARAMETER columns are migrated.

40.2.7.2.4 USE column

The values below are migrated in the Use column cells of the EPM dynamic formatting sheet:

- ALL
- BORDER
- CONTENT
- FONT
- FONTBOLD
- FONTCOLOR

**Note:**
FONTCOLOR is migrated as FontColorIndex.

- FONTNAME
- FONTSIZE
- FONTSTYLE
- FRAME
- HORIZONTALALIGNMENT
- INDENTLEVEL
- LOCK
- NUMBERFORMAT
- PATTERN
- PROTECTION
- STYLE
• VERTICALALIGNMENT

**Note:**
When a list of values is specified:
• The values are migrated only if the delimiter character is a comma.
• The comma is migrated as a vertical bar (pipe) character.

The value below is not migrated:
• {VBA property}

40.2.7.2.5 PARAMETERS column

The values below are migrated, also in the **Use** column cells of the EPM dynamic formatting sheet:
• CONTENT
• FONTBOLD
• FONTCOLOR

**Note:**
FONTCOLOR is migrated as FontColorIndex.

• FONTNAME
• FONTSIZE
• FONTSTYLE
• HORIZONTALALIGNMENT
• INDENTLEVEL
• LOCK
• NUMBERFORMAT
• STYLE
• VERTICALALIGNMENT

The value below is not migrated:
• {VBA property}

Also, about the syntax:
• **This syntax is migrated:** {Format property} = "value"
• **This syntax is not migrated:** {Format property} = {dimension}.{property}

40.2.7.2.6 APPLY TO column

The values and the parameter below are migrated:
The value below is not migrated:
- KEY

### 40.2.8 Migration Log

The migration log lists the migration steps and the items that are migrated or not.

Here are the main steps, that you will see in the log file:

**Note:**
Within each step, the log can display detailed information, when a member is not recognized, for example.

<table>
<thead>
<tr>
<th>Main Steps displayed in the log</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Evdre migration for the sheet [SheetName] is starting.</td>
<td>Indicate the beginning of the analysis for a sheet. For each sheet migrated, this text appears.</td>
</tr>
<tr>
<td>There are [number] EVDRE functions detected in the sheet.</td>
<td>Indicate the number of EvDRE detected.</td>
</tr>
<tr>
<td>Start reading evdre options...</td>
<td>Check that the ExpandOnly option is not set to Y or YES. If it is set to Y or YES, the EvDRE is not migrated.</td>
</tr>
<tr>
<td>Start analyzing evdre functions...</td>
<td>The analysis will determine the number of reports that will be migrated. If an EvDRE or a report will not be migrated, this information is written below this step.</td>
</tr>
<tr>
<td>Start process with evdre number [number]...</td>
<td>The migration process starts for the EvDRE. For each EvDRE, this text appears.</td>
</tr>
<tr>
<td>Start reading page axis...</td>
<td>The page axis is read. Valid members are migrated. For each member that is not migrated, a text is displayed within this step.</td>
</tr>
<tr>
<td>Start reading member definition...</td>
<td>The page axis members are read from the ExpansionRange if there is one.</td>
</tr>
</tbody>
</table>
Main Steps displayed in the log | Explanations
---|---
Start reading formatting sheet... | The format settings are analyzed.
Start reading the report 000... | The report is read. For each report, this text appears.
Start reading row axis... | The row axis is read. Valid members are migrated. For each member that is not migrated, a text is displayed within this step.
Start reading column axis... | The column axis is read and the members are migrated (or not if not recognized). Valid members are migrated. For each member that is not migrated, a text is displayed within this step.
Start reading evdre options... | Options are migrated. For each option migrated, a text is displayed within this step.
The Evdre migration for the sheet [SheetName] is done. | Indicate that the migration of the sheet has been performed.

**Accessing the Log**

There are two ways of accessing the log:

- The latest lines of the log file can be displayed by selecting **EPM > More > Log**.

  **Note:**
  In this screen, errors that are not linked to the migration but to any use of the EPM add-in are also displayed. For more information, see **Log File**.

- You can also view the whole migration log file. To do so, in your explorer, enter: `%temp%/log` and open the `FPMXLClient.dll.Migration.log` file.

**40.2.9 Launching the EvDRE Migration**

**Note:**
You can migrate files with the following formats: xls, xlsx, xlsm, xlt, xltx and xltm.

To migrate EvDREs created with SAP BusinessObjects Planning and Consolidation, select **EPM > More > EvDRE Migration**.

**Connection**
Before you actually launch a migration, you must create in the EPM add-in the connections to the models used in the EvDRE. If no connection has been created on a model used in an EvDRE, the EvDRE is not migrated and the following text is displayed in the log: *The application name '{0}' is not valid.* For more information on connections in the EPM add-in, see **Types of Connections**.
When launching the migration, the **Change Connection** dialog box opens and enables you to select a connection to a model used in the EvDRE.

If there are several EvDREs in a sheet on several models, you can migrate all the EvDREs at the same time, as long as:

- All the models are on the same environment.

  If there are several EvDREs in a sheet on several models that do not have the same environment, you cannot perform the migration in one time.

- The connections to all the models used in the EvDRE are created in the EPM add-in.

**Selection of the Worksheets and Workbooks to Migrate**

Using the **EvDRE Migration** dialog box, you can migrate:

- All the EvDREs on the active worksheet.
- All the EvDREs in the active workbook.

**Caution:**
The migration of a worksheet or a workbook can only be performed once. For this reason, it is recommended that you make a copy of your 7.5 workbooks before migrating.

- All workbooks contained in a specified folder (and its subfolders) on the Planning and Consolidation server.
- All workbooks contained in a specified folder (and its subfolders) on your local machine or elsewhere on the network.

**Note:**
If you select the **Planning and Consolidation Server** or **Local** option, the migrated workbooks do not overwrite the original workbooks. You can choose whether the original workbooks and the migrated workbooks will be stored in the same folder or in different ones, using the **Do not move original workbooks in a different folder** option.

- So that each original workbook is kept in the folder you select, select the **Do not move original workbooks in a different folder** option. So for each workbook, the folder will contain: the original workbook, the migrated workbook and - only for folders that are not on the Planning and Consolidation server - one log file per workbook.

**Note:**
When migrating workbooks on the Planning and Consolidation server, you can still view the general log of the EPM add-in by selecting **EPM > More > Log**.

- Alternatively, you can also ask that the original workbooks are automatically moved to a dedicated folder called **Migration Copy**. Therefore, the folder you have selected will only contain the migrated workbooks. And the **Migration Copy** folder will contain the original workbooks and, only for folders that are not on the Planning and Consolidation server - one log file per workbook. To do so, simply deselect the **Do not move original workbooks in a different folder** option.

**Note:**
- An original workbook is automatically renamed the following way: #Copy of Original#[original name]
  
  A file whose name begins with #Copy of Original# cannot be migrated (using the **Planning and Consolidation Server** or **Local** option).
- A migrated workbook is automatically named with the original name.

**Note:**
- If there are sub-folders, the same structure with the same sub-folders is created.
- A refresh is not automatically performed after the migration.

### 40.2.10 After Migration

Once you have performed an EvDRE migration, colors can be displayed in some cells:
- Cells in magenta indicate that members are not recognized (for example, a member has been deleted from the database).
- Cells in yellow contain EPM functions after the migration of the MemberSet, BeforeRange or AfterRange parameters.

**Caution:**
So that the migrated reports continue to function, do not delete cells in yellow.

Here is what you can do after the migration:
- If you have migrated the active worksheet or workbook (using the **Active Worksheet** or **Active Workbook** option) and you are not satisfied with the migration: Close your file without saving it. Open it again, make your modifications and launch the migration again.
- If you have migrated all the workbooks contained in a specified folder (using the **Planning and Consolidation Server** or **Local** option) and you are not satisfied with the migration of one or more files: Delete the migrated workbook(s). Make a copy of the original workbook(s). Rename the workbook(s), deleting the prefix #Copy of Original# (to be able to launch a migration again). Make your modifications and launch the migration again.
- If you are satisfied with the migration, perform the following actions:
  - If cells appear in magenta, indicating unrecognized members, be sure that you do not want to use these members anymore. For more information on unrecognized members, see **RowKeyRange Members** and **ColKeyRange Members**.
  - Once you are sure that you want to validate the migration process, perform a refresh: row and columns containing cells in magenta are deleted.
  - If cells appear in yellow, indicating EPM functions, move the EPM functions to other cells in the sheet and do not delete them.

**Note:**
However, always leave a blank row or column between a function and a report. Also, it is recommended that you move the function above all the reports. Otherwise, if you move a report in the sheet, the functions will also be moved.
- You can then delete all the ranges that are linked to the EvDRE and that are not used by the EPM add-in. Do not delete the cells containing formula beginning with `=EPM0lapMember()` or `=EPM0lapMultiMember()` or `=EPMInsertedMember()`. 

---

Migration
Note:
If outside the reports some format settings remains from the EvDRE, you can use the Microsoft Office Excel standard function to delete the formatting. You can then refresh the reports and the migrated formatting will be applied.

Tip:
• If you want to use a report as a template using any Planning and Consolidation connection, select a cell in the report, then select EPM > Edit Report > Options and select the Do not Store Connection option. For more information, see Do not Store Connection and Do not Store Environment in the Connection.
• If a report was used before migration as an input form, select a cell in the report, then select EPM > Edit Report > Options and select the Use as an Input Form option. For more information, see Use as Input Form.
## More Information

<table>
<thead>
<tr>
<th>Information Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Help Portal</td>
<td>Navigate to <a href="http://help.sap.com/businessobjects">http://help.sap.com/businessobjects</a> and on the “SAP BusinessObjects Overview” side panel click <strong>All Products</strong>. You can access the most up-to-date documentation covering all SAP BusinessObjects products and their deployment at the SAP Help Portal. You can download PDF versions or installable HTML libraries. Certain guides are stored on the SAP Service Marketplace and are not available from the SAP Help Portal. These guides are listed on the Help Portal accompanied by a link to the SAP Service Marketplace. Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact your customer support representative.</td>
</tr>
</tbody>
</table>
  - Installation guides: [https://service.sap.com/bosap-instguides](https://service.sap.com/bosap-instguides)  
  - Release notes: [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes)  
  The SAP Service Marketplace stores certain installation guides, upgrade and migration guides, deployment guides, release notes and Supported Platforms documents. Customers with a maintenance agreement have an authorized user ID to access this site. Contact your customer support representative to obtain an ID. If you are redirected to the SAP Service Marketplace from the SAP Help Portal, use the menu in the navigation pane on the left to locate the category containing the documentation you want to access. |
| Docupedia                            | [https://cw.sdn.sap.com/cw/community/docupedia](https://cw.sdn.sap.com/cw/community/docupedia)  
Docupedia provides additional documentation resources, a collaborative authoring environment, and an interactive feedback channel. |
| Developer resources                  | [https://boc.sdn.sap.com/](https://boc.sdn.sap.com/)  
<table>
<thead>
<tr>
<th>Information Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP BusinessObjects articles on the SAP Community Network</td>
<td><a href="https://www.sdn.sap.com/irj/boc/businessobjects-articles">https://www.sdn.sap.com/irj/boc/businessobjects-articles</a></td>
</tr>
<tr>
<td></td>
<td>These articles were formerly known as technical papers.</td>
</tr>
<tr>
<td>Notes</td>
<td><a href="https://service.sap.com/notes">https://service.sap.com/notes</a></td>
</tr>
<tr>
<td></td>
<td>These notes were formerly known as Knowledge Base articles.</td>
</tr>
<tr>
<td>Forums on the SAP Community Network</td>
<td><a href="https://www.sdn.sap.com/irj/scn/forums">https://www.sdn.sap.com/irj/scn/forums</a></td>
</tr>
<tr>
<td>Training</td>
<td><a href="http://www.sap.com/services/education">http://www.sap.com/services/education</a></td>
</tr>
<tr>
<td></td>
<td>From traditional classroom learning to targeted e-learning seminars, we can offer a training package to suit your learning needs and preferred learning style.</td>
</tr>
<tr>
<td>Online customer support</td>
<td><a href="http://service.sap.com/bosap-support">http://service.sap.com/bosap-support</a></td>
</tr>
<tr>
<td></td>
<td>The SAP Support Portal contains information about Customer Support programs and services. It also has links to a wide range of technical information and downloads. Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact your customer support representative.</td>
</tr>
<tr>
<td>Consulting</td>
<td><a href="http://www.sap.com/services/bysubject/businessobjectsconsulting">http://www.sap.com/services/bysubject/businessobjectsconsulting</a></td>
</tr>
<tr>
<td></td>
<td>Consultants can accompany you from the initial analysis stage to the delivery of your deployment project. Expertise is available in topics such as relational and multidimensional databases, connectivity, database design tools, and customized embedding technology.</td>
</tr>
</tbody>
</table>
Index

A
active connection 18
add-in
   installation 15
   re-activate 16
asymmetric report
   create 73
auto completion 61
autofill 61
axes
   switch 112

B
blank column
   insert 60
blank row
   insert 60
book publication
   connection 168
   launch 175
   template 169
Business Process Flow 229

C
cache
   activate 233
chart
   dynamic, insert 153
comment
   create 221
   display in a cell 222
   modify 221
   search 223
connection
   active 18
   book publication actions 168
   distribution actions 168
   local 19
migration actions 373
open and save actions 31
Planning and Consolidation 19
SAP BusinessObjects Enterprise 19
   select 20
   store in report 78
context 35
conversion files 301, 302
custom member
   create 130
   delete 133
   enable, disable 133
   export 134
   import 135
   manage 129
   modify 133
   order 131
formatting (continued)
   dynamic, define template 155
   dynamic, presentation 155

G
group
   member, by properties 68

I
INFO instructions 260, 273
INFO instructions, adding 274
INFO instructions, multi-ling 274
input form
   enter data 217
   publish to web portal 167
   insert members 71
   installation 15
javascript 302
journals
   open view 227

K
keywords 301

L
language
   application, select 351
   data, select 351
local member 84
log file 233
log off 17
log on 17
logic 276

M
member
   collapse 116
   custom, manage 129
   enter in a cell 59
   enter using Member Selector 63
   exclude 120
member (continued)
   exclude, dynamically 89
   expand 112
   filter by properties 69
   group by properties 68
   identification 51
   insert 71
   keep 119
   local 84
   name to display 65
   properties, display 52
   rename 89
   select using Member Selector 63
   select using Report Editor 57
   sort by properties 68
member recognition
   activate 62
   presentation 59

O
   offline mode 163

P
   package descriptions 241
   package link 280
   package list 277
   package, definition 239
   packages, adding 257, 258
   packages, properties 256
   packages, scheduling 278
   PowerPoint
      add-in features 235
   process chain, definition 240
   process chain, FTP 255
   publication
      book, connection 168
      book, launch 175
      book, template 169
   Q
   quick link
      create 127
   R
   rank
      data 83
   refresh
      data 95
   report
      asymmetric, create 73
      create manually 59
      create using copy/paste 72
      create using the pane 52
      create using the Report Editor 54
      delete 93
      highlight 92
      layout rules 37
      move 58
      options 77
      ownership-based hierarchies, create 75
      publish to web portal 167
      refresh 95
   report (continued)
      several reports 91
      shift 58
      store connection 78
   Report Editor
      create report 54
      insert shift 58
      move 58
      place dimension 56
      place dimension in page axis 58
      select member 57
   S
   sheets
      created automatically 161
   sort
      data 79
      member, by properties 68
   U
   update 15
   W
   wild cards 301
   Word
      add-in features 235
   work status
      change 225